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Warranty 2
Tektronix warrants that this product will be free from defects in materials and workmanship for a period of
one (1) year from the date of shipment. If any such product proves defective during this warranty period,
Tektronix, at its option, either will repair the defective product without charge for parts and labor, or will
provide a replacement in exchange for the defective product. Parts, modules and replacement products used
by Tektronix for warranty work may be new or reconditioned to like new performance. All replaced parts,
modules and products become the property of Tektronix.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the
expiration of the warranty period and make suitable arrangements for the performance of service. Customer
shall be responsible for packaging and shipping the defective product to the service center designated by
Tektronix, with shipping charges prepaid. Tektronix shall pay for the return of the product to Customer if
the shipment is to a location within the country in which the Tektronix service center is located. Customer
shall be responsible for paying all shipping charges, duties, taxes, and any other charges for products returned
to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or
inadequate maintenance and care. Tektronix shall not be obligated to furnish service under this warranty a) to
repair damage resulting from attempts by personnel other than Tektronix representatives to install, repair or
service the product; b) to repair damage resulting from improper use or connection to incompatible equipment;
c) to repair any damage or malfunction caused by the use of non-Tektronix supplies; or d) to service a product
that has been modified or integrated with other products when the effect of such modification or integration
increases the time or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY
OTHER WARRANTIES, EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
TEKTRONIX’ RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE
AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY.
TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR
THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.



Warranty 9(b)
Tektronix warrants that the media on which this software product is furnished and the encoding of the programs
on the media will be free from defects in materials and workmanship for a period of three (3) months from the
date of shipment. If any such medium or encoding proves defective during the warranty period, Tektronix will
provide a replacement in exchange for the defective medium. Except as to the media on which this software
product is furnished, this software product is provided “as is” without warranty of any kind, either express or
implied. Tektronix does not warrant that the functions contained in this software product will meet Customer’s
requirements or that the operation of the programs will be uninterrupted or error-free.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the
expiration of the warranty period. If Tektronix is unable to provide a replacement that is free from defects in
materials and workmanship within a reasonable time thereafter, Customer may terminate the license for this
software product and return this software product and any associated materials for credit or refund.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY
OTHER WARRANTIES, EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
TEKTRONIX’ RESPONSIBILITY TO REPLACE DEFECTIVE MEDIA OR REFUND CUSTOMER’S
PAYMENT IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR
BREACH OF THIS WARRANTY. TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR
ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF
WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF
SUCH DAMAGES.
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Welcome What’s New in this Release

What’s New in this Release

What’s New in this Release
TLA Application software contains support for the following new TLA products and enhancements:

TLA7S08 and TLAS16 Serial Analyzer Modules. The new TLA7S08 and TLA7S16 Serial Analyzer
Modules and related probes provide support for analyzing and testing PCI Express Generation 1
and 2 products.

TLA5000B Logic Analyzers. The TLA Application software supports both the TLA5000B Logic
Analyzers and the TLA5000 Logic Analyzers.

Several software enhancements are included to support your TLA product. Refer to the release notes on
the TLA Application CD for the latest information. You can also access the release notes by selecting:

Start > All Programs > Tektronix Logic Analyzer > TLA Release Notes
Welcome

Technical Support
Tektronix welcomes your comments about products and services. Contact Tektronix via mail, telephone,
or through the Web site. Click Contacting Tektronix for more information.

Tektronix also welcomes your feedback. Click Customer Feedback for suggestions for providing feedback
to Tektronix.

About the TLA7000 Series Logic Analyzer

Overview
The TLA7000 Series Logic Analyzer combines high-speed timing resolution, wide channel count, and
deep memory in an instrument that is easy to use.

The TLA7000 Series Logic Analyzer provides simultaneous state and timing measurements through a
single probe, eliminating the need for multiple, complicated probing devices.

Mainframes
There are two styles of mainframes: portable and benchtop. The mainframes have the following features:

You can use up to 2 modules per TLA7012 and up to 6 modules per TLA7016 mainframe.

You can connect up to 8 mainframes, which increases the maximum number of modules from 2 to
16 for the TLA7012 and from 6 to 48 for the TLA7016. The TekLink cable is required if you are
connecting two TLA7012/16 mainframes together. The TL708EX 8-port instrument hub and expander
is required for linking 3 to 8 TLA7012/16 mainframes in a single test system.
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Welcome About the TLA7000 Series Logic Analyzer

Logic Analyzer Module
The logic analyzer module supports the iLink tool set, which provides you with tools to take digital and
analog measurements through a single logic analyzer probe, display time-correlated views of digital and
analog waveforms, and analyze multi-channel buses and eye diagram validation. Logic analyzer modules
also feature MagniVu, an acquisition technology that enables each of the logic analyzer modules to offer
125 picosecond timing resolution on all channels. MagniVu technology gives you a high-resolution
window into the actual signal activity for each channel. Other logic analyzer module features include:

8 GHz timing analysis with 120, 235, or 450 MHz state analysis for TLA7Axx modules, 8 GHz timing
analysis with 235 or 450 MHz state analysis for TLA7NAx modules and 2 GHz timing analysis with
100 or 200 MHz state analysis for TLA7Nx/Px/Qx modules.

The ability to merge up to five modules (TLA7Axx/TLA7NAx modules) for up to 680 channels on a
single timebase or merge up to three modules (TLA7Nx/Px/Qx modules) for up to 408 channels
on a single timebase.

34 to 136 channels per LA module for maximum channel counts of 6,528 per logic analyzer. This can
provide an 8 mainframe TLA7016 system configured (via software) with one TLA7016 mainframe as a
master and 7 TLA7016 mainframes as expansions. The TekLink cable is required if you connect two
TLA7016 mainframes. The TL708EX 8-port instrument hub and expander is required for connecting
3 - 8 TLA7016 mainframes.

Serial Analyzer Module
The serial analyzer module provides you with tools to analyze serial buses using mid-bus or slot probes.
Two different serial analyzer modules are available with different types of probes. Both modules can be
used with PCI Express Generation 1 and Generation 2 serial buses.

The TLA7S08 8-Channel Serial Analyzer modules provide a means to analyze data on PCI Express
x1 and x4 links.

The TLA7S16 16-Channel Serial Analyzer modules provide a means to analyze data on PCI Express
x1 x4, and x8 links and a single direction of an x16 link.

Pattern Generator Module
The TLA7PG2 pattern generator module is a 64-channel, programmable pattern generator module with
sequential control that plugs into the TLA7000 series mainframes, and is designed for use as an integral
component of the TLA7000 series of logic analyzers. As a general-purpose instrument, it supports
applications for functional verification and stress testing of design prototypes.

User Interface
The user interface is a Windows platform-based application. This means that the logic analyzer is fully
compatible with a wide range of PC hardware and software accessories, such as networked instrumentation
and printers.
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TLA Family of Logic Analyzers
The TLA family of logic analyzers consists of the TLA5000B and the TLA7000 Series Logic Analyzers.
The TLA7000 Series offers the highest performance for today’s demanding applications and consists of
portable and benchtop modular mainframes with expansion capability. Instrument modules include logic
analyzer, serial analyzer, and pattern generator. A full line of complementary support products for popular
processors and buses is available for the entire TLA family.

TLA7012 Portable Mainframe

TLA7016 Benchtop Mainframe
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Welcome About the TLA5000B Series Logic Analyzer

About the TLA5000B Series Logic Analyzer

The TLA5000B Series Logic Analyzer combines high-speed
timing resolution, wide channel count, and deep memory in
an instrument that is easy to use.

The TLA5000B Series Logic Analyzer provides
simultaneous state and timing measurements through a
single probe, eliminating the need for multiple, complicated
probing devices.

Logic Analyzer
The logic analyzer implements a breakthrough feature called MagniVu, a new acquisition technology that
enables 125 picosecond timing resolution on all channels. MagniVu technology gives you a window
into the actual signal activity for each channel.

User Interface
The user interface is a Windows platform-based application. This means that the logic analyzer is fully
compatible with a wide range of PC hardware and software accessories, such as networked instrumentation
and printers.

TLA Family of Logic Analyzers
The TLA family of logic analyzers consists of the TLA5000B and the TLA7000 Series. The TLA5000B
offers a selection of standalone logic analyzer instruments that make 500 ps-deep memory timing
resolution available to designers of today’s mainstream embedded systems. A full line of complementary
support products for popular processors and buses is available for the entire TLA family.

NOTE. Unless otherwise indicated, all references to the TLA5000B Series Logic Analyzers apply to both the
TLA5000B and TLA5000 instruments.

Microsoft Windows
The user interface operates under the Microsoft® Windows operating system. Microsoft recommends the
following to ensure that your instrument is protected:

Use an internet firewall

Install operating system updates regularly

Use up-to-date antivirus software
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Getting Started Customer Feedback

Customer Feedback
Tektronix values your feedback on our products. To help us serve you better, please send us any
suggestions, ideas, or other comments you may have regarding the TLA Series Logic Analyzer.

Direct your feedback to us by email to:

techsupport@tektronix.com

In the subject field, please indicate TLA Customer Feedback.

Or FAX at (503) 627-5695, and include the following information:

TLA Logic Analyzer

TLA Application software version

TLA modules (for example, TLA7P4, TLA7PG2, or TLA7E2)

Microprocessor or bus support package and version.

For specific information on your TLA Series Logic Analyzer, go to the System menu, select System
Properties, and click on the appropriate property page.

The following items are important, but optional:

Your name

Your company

Your mailing address

Your phone number

Your FAX number

Enter your suggestion below. Please be as specific as possible.

Please indicate if you would like to be contacted by Tektronix regarding your suggestion or comments.

TIP. To copy the above information to your email text editor, right-click the mouse and click Copy. The above
information will be copied to the clipboard where you can paste it into any text editor.

To include screen shots of the user interface, press the Alt key and the Print Screen key simultaneously to
copy the image to the clipboard. Paste the image into Microsoft Paint and save the image as a .BMP file.
You can then attach the file to your email (depending on the capabilities of your email editor).
Getting Started

TLA7012 Front Panel Controls
The TLA7012 front panel controls provide you with the most common functions at your finger tips.
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Getting Started TLA7012 Front Panel Controls

General-Purpose Knob

Use this knob as an all-around positioning and selection
control.
Run/Stop

Press this button to start and stop data acquisitions.
Cursor1/Cursor 2

If a data window is active, press C1 or C2 to select cursor
1 or 2. You can then use the General-Purpose knob to
move the cursor.

Mark
If a data window is active, press the Mark button to select a user mark or press and hold to access a selection
dialog box that shows all user marks. You can then use the General Purpose knob to move the mark.

iView
To attach an external oscilloscope, press the iView button to activate the Add iView External Oscilloscope
wizard. If an external oscilloscope attached, pressing the iView button shows or hides the iView
waveforms in the waveform window.

MagniVu
Press this button to add and delete MagniVu waveforms from an active waveform window. A MagniVu
source must be present in the system to add the waveform.

System

Press this button to activate the System window.
Setup

Press this button to activate the last accessed Setup
window. Press the button again to cycle through all the
Setup windows.
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Getting Started TLA7012 Front Panel Controls

Activity
If a Listing or Waveform window is active, pressing the Activity button toggles the Data Window Activity
Monitor on and off. If any other window is active, pressing this button opens the Probe properties dialog
box. Press the button again to close the dialog.

Trigger
Press this button to activate the last accessed Trigger window. Press the button again to cycle through all
the Trigger windows.

Listing
Press this button to activate the last accessed Listing window. Press the button again to cycle through all
the Listing windows.

Waveform
Press this button to activate the last accessed waveform window. Press the button again to cycle through
all the Waveform windows.

Search/Back/Forward
Press the back arrow button to search backward as currently defined for the active data window. Press the
Search button to activate the Search Definition dialog box. Press the forward arrow to search forward
as currently defined in the active data window.

7



Getting Started Getting Started Example

Vertical position

Turn the knob to scroll vertically through the display window.
Horizontal position

Turn the knob to scroll horizontally through the display
window.
Vertical Size

Turn this knob to change the vertical scale of the waveform
in the display window.
Horizontal Scale

Turn this knob to change the horizontal scale of the
waveform in the display window.

Touch Screen
Press this button to turn the touch screen capabilities on or off.

Ctrl Button
Use this button as you would the Control key on your keyboard. It can be used in conjunction with the
touch screen or mouse to select multiple items.

Shift Button
Use this button as you would the Shift key on your keyboard. It can be used in conjunction with the
touch screen or mouse to select multiple items.

Getting Started Example
This is a brief example that shows how to acquire and display data.

Click here to acquire data from a TTL circuit that you provide.

Click here to load and display example data.
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Getting Started LA Module Setup

LA Module Setup
If you haven’t already done so, connect your probes to the system under test. Refer to your installation
manual and individual probe documentation for connection information.

From the File menu, select Default System to return the instrument to the power-on default condition.

You will need at least one of the following probes. Click the links for information on connecting the probes.

Continue

Displaying Data from a Saved Sample

1. Click in the toolbar to start the New Data Window wizard.

2. Click Listing and then click the Next button.

3. Click Add Data Source.

4. Click Browse.

5. Use the dialog boxes and browsers to navigate to the following directory:

C:\Program Files\TLA 700\Samples\TLA700 Samples\Data Files

6. Select any sample file and click Open.

7. Click Add to add the data to the new data window, and then click the Next button.

8. Enter a name for the new data window or use the default name, and then click the Finish button.

View the Sample Data

View the Sample Data
You can now view the sample data.

Examine the Waveform

Displaying Data from a Saved Sample
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Getting Started Overview of Connection Choices

Overview of Connection Choices
You can connect to your instrument in three different ways: Remote Host, Remote Desktop, or Local.
In addition, you can choose to work offline, without connecting to the instrument, to modify setups
or view data files previously saved to your PC.

Connecting as a remote host allows you to control the instrument remotely, and then store the data locally
on your PC.

Remote host mode is best for:

Connecting to an instrument over a LAN (must be using V5.0 software or above)

Sending data to where the application is running

NOTE. When you open the application on the remote computer, the instrument name is shown in the title bar. A
TLA7016 is always connected as remote host because there is no internal computer in a TLA7016.

Connecting as a remote desktop means that you are running the application on the instrument from your
PC and storing the data on the instrument.

Remote desktop is best for:

Connecting site-to-site over a network

Troubleshooting from a remote location

Viewing data that is stored on the instrument

NOTE. You can use remote desktop to start the TLA Server, and then connect as remote host.

Connecting locally means that you are working directly on the instrument.

Using Local is best if you:

Want to run the application and store the data on the instrument

Have a printer connected to the instrument

Related Topics
Connect to a Networked Instrument

Configuring your TLA7000 without a TL708EX
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Getting Started Configuring your TLA7000 without a TL708EX

Configuring your TLA7000 without a TL708EX

Overview
Use this dialog box to change the configuration of your TLA system when you only have two mainframes
connected with a TekLink cable. You can change which TLA is the mainframe and which one is the
expansion mainframe using this dialog box. For TLA7016 instruments you can also open the Network
Properties dialog box from here.

NOTE. This dialog is only accessible if the system has no more than two TLA7000 mainframes connected with a
TekLink cable.

To use the TLA Configuration dialog box, perform the following steps:

1. Select Choose TLA from the File menu to open the TLA Connection dialog box.

2. Select an instrument, and then click the TLA Configuration button.

The TLA Configuration dialog box opens.

3. Select the desired configuration under Mainframe and Expansion Configuration.

4. To edit the network properties, select the TLA7016 instrument, and then click the Network Properties
button.

Related Topics
Connect to a Networked Instrument

Network Properties
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Getting Started Connect to a Networked Instrument

Connect to a Networked Instrument
From the TLA Connection dialog box, select the instrument that you want to connect to and click the
Connect button. You can customize your startup by specifying whether to run power-on diagnostics and
whether to automatically connect to a selected instrument each time you login.

NOTE. If you choose to automatically reconnect to an instrument, the next time that you start the TLA application,
it will open in the offline mode.

To change your customized settings, select Choose TLA from the File menu. Note that the TLA Server
must be running on your instrument to populate the TLA Connection dialog box. To start the TLA Server,
click the TLA Server Control icon in the Windows system tray and select Start TLA Server. The TLA
Server does not run on your PC.

If you want to view the configuration of your TLA system,
select an instrument, and then click the TLA Configuration
button. (This button is not active until you have selected a
TLA.)
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Getting Started Connect to a Networked Instrument

The instruments that are listed in the TLA Connection dialog
box are determined by the network search properties.

You can change these properties by clicking the
icon and entering your preferences in the Network Search
Preferences dialog box.

TIP. If you do not know the host name or IP address, select the Locate TLA systems on local subnet check box. This
will find any TLA instrument that is connected to the same subnet as your host PC in the search.

What would you like to do next?
Learn About the LA Setup Window.

Learn About the LA Trigger Window.
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Getting Started Network Search

Network Search
Use the Network Search dialog box to set the preferences for the search criteria that the Connection dialog

box uses. You can open this dialog box by clicking in the Connection dialog box.

1. Select Locate TLA systems on local subnet to include any TLA system connected to the same subnet as
your host PC in the search.

2. Select Include these hostnames or IP in search to include the instruments listed in the Hostname or IP
text box in the search. If you know the name of an instrument, you can add it directly by entering the
name in the Add hostname or IP text box and then clicking the Add button. This adds the instrument
to the search but not to the Connection dialog box. The instrument must be found in the search to be
added to the Connection dialog box.

3. To remove an instrument from the search, select it from the Hostname or IP text box, and then click
the Delete Selection button.

4. To update the Hostname or IP text box, click Replace All with TLAs found on subnet.

5. Click the Search button to search the subnet according to the criteria that you have set, and update the
Connection dialog box. When the search is completed, the Network Search dialog box closes and
the Connection dialog box is updated.

Related Topics
Connect to a Networked Instrument

Overview of Connection Choices
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Network Properties

Overview
Use the Network Properties dialog box to configure the Host Name and IP address of your networked
instruments.

Behavior
This dialog box appears when you click the Network Properties... button in the TLA Configuration dialog
box. The Default name is a combination of the TLA7016 Interface Module model number and the serial
number. Select Use the following Name to assign a unique name. The TLA7016 Interface Module will
attempt to get its IP address automatically when Obtain Address Automatically is selected.

NOTE. This dialog is only supported on TLA7016 mainframes.
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Getting Started Options of Powering On and Off

To Use
1. Select either Default name or enter one of your choosing in the Use the following Name text box.

2. Click the Look Up IP Address button to find an IP address.

3. To specify an IP address, select Use the following Address, and then enter the IP Address, Subnet
Mask, and Gateway.

Options of Powering On and Off
To power on the instrument without the TLA application starting, perform the following steps:

1. Access the System folder using the following path: Program Files\TLA \System.

2. Click TLA700SU.bat and use your right mouse button to click Edit.

3. Enter the characters REM in front of the following line:

C:\ WINDOWS\COMMAND\START /MAX .\TLA700.EXE.

You can set how you want the instrument to power off through a program labeled Mainframe Utilities
located in the Windows Control Panel.

The utility also provides a screen dim mode where you can reduce the brightness by 60%. Refer to the
help provided with the utility for more information on both functions.

TIP. Access the Mainframe Utilities by clicking the Windows Start button, pointing to Settings and Control Panel, and
then clicking Mainframe Utilities.

Software Setup
From the File menu, select Default System to return the instrument to the power-on default condition.

You have completed the LA module setup. If you have a DSO module, you can now set it up to acquire
a signal. Click here for instructions.

Acquire the Data
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Acquire the Data

Click in the toolbar.

TIP. To achieve the best possible signal-to-noise ratio on live waveforms through the analog probe outputs, use an
external oscilloscope when the logic analyzer acquisition is not running.

View the Data

View the Data
1. From the Window menu, click Waveform 1.

2. To view the data in the Listing window, go to the Window menu and click Listing 1.

By default the data for a given module is displayed in only one window: the Waveform window for data
acquired with the DSO, and the Listing window for data acquired with the LA.

This completes the example.

Examine the Waveform

DSO Module Setup
1. Connect the DSO probes to the target system.

2. From the System window, click the DSO Setup button.

3. From the DSO Setup window, click the Autoset button.

NOTE. The Autoset feature works best with repetitive signals.

This completes the DSO module setup.

Acquire the Data
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Examine the Waveform
You can use the Waveform window controls to view and measure the waveforms. Here are some
suggestions for getting started:

Use the scroll bars to display data that is currently off-screen.

Click in the toolbar and select a mark to jump to.

Select Cursor 1 and drag the cursor handle to a new location. The handles shown along the top of the
display are for fine control; those at the bottom are for coarse control. Note the change in the cursor
time readouts in the Cursor toolbar.

Click the button to display an external oscilloscope waveform.

Click the button to display a MagniVu waveform.

(DSO module and external oscilloscope only.) Click a waveform label, at the left of the window, and
drag the cursor again. Note the change in the cursor voltage readouts in the Measurement toolbar.

To zoom data, click and drag the mouse over the area that you want to zoom. The window will zoom
to the data when you release the mouse button.

To increase the size of the area in which the data is displayed, select Full Screen from the View menu.

Click (Zoom Out) or (Zoom In) in the toolbar to change the horizontal scale.

Select a waveform header and the whole row is highlighted, making it easier to view.

Double-click (or any other waveform label). You can change the color and size
(size is also changeable directly) of the waveform in this property page. Click OK to complete the
changes and return to the Waveform window.

Click the + on the waveform label to expand the waveform into the individual channel elements.

Drag the split box (above the top arrow of the vertical scroll bar) down to display a second data area.
You can now view two different portions of the same acquisition memory.

TIP. If you are using a portable mainframe, use the front panel knobs to change the horizontal scale and to scroll
the data.

Viewing Other Types of Waveforms
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Viewing Other Types of Waveforms

Add the MagniVu version of the data at any time by clicking the button or use the following
steps. (MagniVu Data is always acquired with your other data.)

1. Click (Add Waveform) in the toolbar.

2. From the Data Source list, select LA1 - MagniVu.

3. Select a MagniVu waveform or group (for example, Mag_A3), and click Add.

4. Click the Close button when you have finished adding waveforms.

When viewing LA channel groups, you can view the data as busforms or as magnitude waveforms by right
clicking the mouse over a data label and selecting either Display Busform or Display Magnitude. You can
also expand the channel group into the individual busforms by clicking the + on the label.

Or,

1. Double-click the label of a channel group waveform. (If you do not have a channel group waveform,

click , select an LA Data Source, and choose a group to display. Confirm and exit the dialog box.)

2. From the Waveform Properties tab, click the Options button.

3. Select Busform or Magnitude, and click OK to close the Waveform Options dialog box.

4. Click OK. The waveform is displayed accordingly.

Tip
Click here to load and view an example of a magnitude waveform.

Related Topics
Multi-Channel Magnitude LA Waveforms

Multi-Channel Busform LA Waveforms

Examine the Listing Data
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Viewing a Magnitude Waveform Sample

1. Click in the toolbar to start the New Data Window wizard.

2. Click Waveform and click the Next button.

3. Click Add Data Source.

4. Enter the following path into the File name box, or click browse to navigate to the SampleSystem.tla file:

C:\Program Files\TLA700\Samples\TLA700 Samples\Data Files\SampleSystem.tla

5. Click the Add button. The SampleSystem data source is added to the list of data sources.

6. Click LA under SampleSystem.tla and click the Next button.

7. Enter a name for the new data window or use the default name and then click the Finish button.

8. Choose one of the following procedures:

a. Right-click the mouse over any data label and select Display Magnitude.

Or

a. Double-click the new Down Count label.

b. Click Options and select Magnitude, click OK twice to close the dialog boxes.

c. Click the Zoom buttons to view a sawtooth waveform. The waveform is a graphic representation
of counter data.

To examine the listing data click here.
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Examine the Listing Data
Here are some suggestions for viewing Listing window data:

1. Use the scroll bars to display data that is currently off-screen.

2. Click in the toolbar and select Cursor 1.

3. Drag the cursor handle to a new location. The handles shown along the left of the display are for
fine control; those at the right are for coarse control. Note the change in the cursor sample number
and delta time readouts in the Cursor toolbar.

4. Click the toolbar Font buttons to change the display font size.

5. Drag the split box (beside the left arrow of the horizontal scroll bar) over to display a second data area.
You can now view two different portions of the same acquisition memory.

6. Double-click an address or data column label (for example, ). You can change the attributes
of the column in this property page.

7. From the Column property page, try loading a symbol file: click the radix button box, choose the
Symbolic radix, click the Symbol File button, and choose a symbol file.

8. Confirm and exit the property page.

Searching on Selected Data
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Searching on Selected Data
1. Double-click a data entry in one of the columns of the Listing window. The data is now selected. Click

in the toolbar to copy the data onto the clipboard.

2. Click in the toolbar.

3. From the Search Definition drop-down list, select a saved search definition from the selected data
window or type in a new search name.

NOTE. To add a search definition from another data source, click the Load button to open the Load Search dialog box.

4. Click the Start from drop-down list to select where you want to start searching and enter the number of
occurrences to find in the occurrence text box.

5. Click the Search Options… button to open the Search Options dialog box and select what action you
want the logic analyzer to take when the search is successful.

6. Type a Description of the search in the Description text box.

7. From the Search drop-down list, select the data source.

8. Paste the data that you copied from the Listing window into the appropriate text box in the Find area by
pressing CTRL+V (the paste shortcut key combination). You can use the same method for pasting
a quick entry into a trigger program definition.

9. Use the Group/Channel drop-down list to select the column from which you copied the data.

10.Click Search Forward. The logic analyzer displays the next instance of the specified data. Once
you have defined the search criteria, you can click the Search Forward or Backward toolbar buttons
for additional searches.

Performance Analysis
If you intend to do performance analysis with your LA module, you need to define the channel and
clocking setups in the Setup window.

You may also want to load a microprocessor support package that contains the predefined channel
setups and clocking setups.
System Setup

System Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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LASetup Window

LA Setup Window

Overview
The primary function of the Setup window is to configure the LA module for compatibility with the system
under test. This is where you specify channel groups, set thresholds, select the clock rate, define compare
parameters, and select filter and analysis tools. Additional selections configure the LA module for best
compatibility with the type of data you want to acquire.

Behavior
Before you acquire and display data, you must set up the LA module using the LA Setup and Trigger
windows. Together, these windows determine what data will be acquired. Each module has a Setup window
and Trigger window, each of which is set up individually. It is a good idea to configure the Setup window
before the Trigger window, because some of the Setup window settings affect Trigger window selections.

To Use
To open the LA Setup window, go to the System window and click the LA module Setup icon.

Click the buttons for further information:

Clocking

LA Acquire Control Selections

LA Module Memory Depth

Microprocessor Support Package Indicator

Filter Definitions Dialog Box

iCapture Analog Feeds

AutoDeskew Window

iVerify Window

LA Activity Indicator Tab

Probe Thresholds Tab

Channel Grouping Table

LA Probe Channels/Names Table

TIP. To repeat a setup in another LA module, save the setup, go to the File menu, and click Load Module to duplicate
the setup in the second module.
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For quick access to the Setup window press the Setup button on the front panel of your instrument or on

the system navigation toolbar . Continue to press the Setup button to cycle through all the
acquisition module Setup windows in the system.

Related Topics
LA Trigger Window

Loading a Saved Module

Loading a Saved System

. . LA Setup Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Clocking

Overview
Use Clocking to select one of the basic clocking modes. Custom Clocking is available if a microprocessor
support package is loaded. Your clocking choice determines further clocking selections. Refer to each
clocking mode for details on these selections.

NOTE. Clocking and state speeds will vary by module. Please refer to the following table for clocking and state
speeds available on your module.

Clocking Modules and state speeds
TLA7K at
733 MHz and
1.2 GHz

TLA7Axx at
120 MHz,
235 MHz, and
450 MHz

TLA7NAx at
235 MHz and
450 MHz

TLA7N/P/Q at
100 MHz and
200 MHz

TLA520x at
235 MHz

Internal X X X X
Internal 2X X X X X
Internal 4X X X X
External X X* X X
External 2X X X
External 4X X
External 450 X**
Custom X X X X
*Maximum state speed is 235 MHz

**External 450 MHz clocking is only available with the 450 MHz PowerFlex option
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Behavior
There are two basic types of clocking supported by the logic analyzer - asynchronous and synchronous.
With asynchronous clocking, the logic analyzer generates its own internal clock signal that is used to
sample data from the system under test. All samples are taken at regular, fixed intervals. The asynchronous
clocking modes are Internal, Internal 2X, and Internal 4X. Acquisitions taken with asynchronous clocking
are often referred to as timing acquisitions and are best viewed in the Waveform window.

With synchronous clocking, the system under test generates a clock signal that is used to drive when the
logic analyzer samples are taken. The clock signal may be a fixed frequency, or it may be highly erratic.
The synchronous clocking modes are External, External 2X, External 4X, External 450, Source Sync,
and Custom. Acquisitions taken with synchronous clocking are often referred to as state acquisitions and
are best viewed in the Listing window.

Internal Clocking. Internal clocking acquisitions are useful for observing the timing relationships among
various digital signals.

Internal 2X Clocking. Internal 2X clocking gives twice the timing resolution of Internal clocking at the
cost of half of the logic analyzer’s input channels.

Internal 4X Clocking. Internal 4X clocking gives four times the timing resolution of Internal clocking
at the cost of three quarters of the logic analyzer’s input channels.

External Clocking. External clocking can be used to synchronize the logic analyzer acquisition samples
to a clock signal from the system under test. Multiple clock signals and qualifiers can be used to write
complex clocking equations for capturing data values only at times when they are valid or interesting
to look at.

External 2X Clocking. External 2X clocking is useful for capturing data where the clock signal is up to
twice as fast as the logic analyzer’s normal maximum synchronous speed. This allows the fastest possible
clock signal to drive an acquisition at the expense of half the logic analyzer’s input channels.

External 4X Clocking. External 4X clocking is useful for capturing data at up to four times the logic
analyzer’s normal maximum synchronous speed. This allows the fastest possible data rate for an
acquisition at the expense of three quarters of the logic analyzer’s input channels.

External 450 Clocking. External 450 MHz clocking can be used to synchronize the logic analyzer
acquisition samples to a clock signal from the system under test. Using all of your acquisition channels,
this allows a maximum data rate of 450 Mb/s at the maximum synchronous speed of your logic analyzer.
Or you can achieve a data rate of 470 Mb/s by sampling on both clock edges. The state speed is limited to
235 MHz and you can only use half of the acquisition channels when you sample on both clock edges.

Custom Clocking. Custom clocking mode is only available when a support package has been loaded. It
gives special access to the advanced clocking features of the logic analyzer module in order to track the
complex behavior of a digital device or bus protocol.

Related Topic
LA Trigger Window
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LA Acquire Control Selections
The LA Acquire Control Selections determine what data is stored. In addition to channel and time stamp
data, Acquire specifies whether to store timing violation information (glitches), setup and hold violation
information, or blocks of data around requested samples.

Select Normal to store only the requested channel data.

Select Glitch to store glitch data for each data channel. Glitch mode is available only in Internal
clocking mode. Glitch mode limits memory depth to half the maximum depth and limits the sample
period to 10 ns or greater. When Glitch mode is selected, the Memory Depth or Clocking sample
period changes if necessary.

Select Blocks to store a block of samples around each qualified sample. Data qualification (Transitional,
Conditional, Start/Stop, and None) produces storage events that set the beginning and the end of a
block. The block includes 31 samples before storage and 31 samples after storage.

Select Setup/Hold to store setup and hold violation data for each data channel. Setup/Hold mode
is available only in External clocking mode. Setup/Hold mode limits memory depth to half of the
memory depth and limits the sample period to 10 ns or greater for TLA7Lx/Mx/Nx/Px/Qx logic
analyzer modules, or 4 ns or greater for TLA7Axx/TLA7NAx logic analyzer modules and TLA5000B
Series logic analyzers. When Setup/Hold mode is selected, the Memory Depth or Clocking sample
period changes if necessary.

Related Topics
Clocking

LA Setup Window
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LA Module Memory Depth
Use the Memory Depth selection to specify the total number of samples acquired by the logic analyzer
module. If you do not require full memory depth, select a lesser value to reduce the amount data to
search through to find the data of interest.

For a given memory depth there is a tradeoff between the clock sample rate and data record length. A
faster sample rate provides a shorter but more detailed data record length.

NOTE. Selecting Glitch mode reduces the available memory depth by half (for storing glitch information), while
selecting Internal (Asynchronous) 2X Clocking doubles the available memory depth.

Related Topics
Selecting Memory Depth: A General Approach

LA Acquire Control Selections

Internal 2X Clocking
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Microprocessor Support Package
A microprocessor support package is a software application that allows the logic analyzer to acquire
and disassemble microprocessor data.

Some microprocessor supports utilize a hardware probe adapter that is attached directly to the
microprocessor in the system under test to capture microprocessor signals.

The LA Setup window shows which microprocessor support package is currently installed.

Related Topic
Loading Support Packages
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Channel Grouping Table

Overview
Channel grouping organizes the LA probe channels to match the configuration of the system under test.
This table is part of the LA Setup window.

Behavior
Any number of groups can be created. Each channel group can contain any combination of module
channels. You are not restricted from mixing or repeating channels from various groups.

The default channel groups correspond to the hardware arrangement of the probe connectors.

If a microprocessor support package is loaded, the channel groups are defined for you.

NOTE. If a microprocessor support package is loaded, you should not change or delete the default channel groups.
Accurate disassembly analysis might be lost. You can still add and delete new channel groups.

Channel groups defined in the channel grouping table are used in other displays and setup controls. The
order of the groups in this table determines the order of presentation in other parts of the application.

The column between the group name and the probe channels defines the number of channels in a group.
For example: (5-0) indicates there are six channels in the group and (0-0) indicates there is only one
channel in a group. A zero (0) refers to the least significant bit.

To Use
Depending on your application, match the channel groups to the address and data buses, or match the
channel groups to other channels of interest. Then name the channel groups for easy identification.

Use the Cut and Paste selections from the Edit menu to change the order of channels in a group.

Channel grouping is set in the LA Setup window.

Related Topics
LA Channel Group Name

LA Probe Channel Grouping

Compare Definition Dialog Box
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LA Channel Group Name
Each channel group must have a name. You can use the default name, or you can enter another name as
long as it is unique within the module. There is no limit to the number of groups you can create. However,
you must list all probe channels that make up each group.
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Highlight Channel Names Dialog Box

Overview
Use this dialog box to search for and highlight specific channel names in the LA Setup window. This
makes it easy to view and edit channel names if your setup uses several channels for different functions.

Behavior
You can enter a string of characters in the text box and select the appropriate search criteria. When you
click Apply or close the dialog box, the instrument searches the channel table for the requested text string.
If a channel matches the search criteria, the channel name will be highlighted. You can enter multiple
strings, separated by spaces, for performing searches. The space-separated strings are logically ORed.
That is, the channel name that matches any one of the strings will be highlighted.

To Use
1. Open the dialog box by selecting Highlight Channel Names in the Edit menu of the LA Setup window.

2. Enter the text that you want to find. For example, enter RESET to search for any channel names
that have RESET as part of the name.

3. Select the search criteria.

4. Click Apply or OK.

The instrument will search for the channel names with the matching text. The text, if found, will be
highlighted as shown below. In this example, the instrument found and highlighted the RESET text under
channel 3 for the C2 group.
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LA Probe Channel Grouping
You must list all the channels that make up each channel group. The channels are named according to their
physical probe section name and channel number.

For example: channel 0 of section C2 is listed as C2(0) in the channel grouping table. The section names
correspond to the probe labels found on the module panel. Channels are color-coded at the probe tip.

Use Channel Group Expressions to specify channels or groups in the Probe Channels field.

Related Topic
Advanced Clocking

Channel Group Expressions
Valid expressions for channels and groups are as shown in these examples:

Example Description

A3(7-0) Group A3, channels 7 through 0

A3(5-3) Group A3, channels 5 through 3

A3(7) Group A3, channel 7

A3() Group A3, all channels (7-0)

A3 Group A3, all channels (7-0)

~Reset A channel with a custom name

These expressions are used in the LA module Setup window channel grouping table.
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LA Probe Channels/Names Table

Overview
Use the LA Probe Channels/Names table to enter names for individual channels, add and remove channels
from a group, change the polarity of individual channels, or define which channels to use during compare
operations. This table is part of the LA Setup window.

Behavior
The Table Shows box allows you to choose different modes, to access alternative views of the LA Probe
Channels/Names table. Different operations can be performed in each table view. For more information on
the functionality of a mode, click the associated mode button.

Selected Group Mode

Channel Polarity Mode

Channel Compare Mode

Selecting the channel group name from the Group Name column causes the Probe Channels/Names
table to show the channels in that group.

NOTE. If a microprocessor support package is loaded, do not change the channel assignments of the default channel
groups because accurate disassembly analysis may be lost. You can still add channel groups and change the
channel assignments within the new groups.

Related Topics
Internal 2X Clocking

Adding LA Channels

Changing LA Polarity

Reusing LA Channels

Setting Compare Parameters
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LA Activity Indicator Tab

Overview
Use the Activity indicators dialog box to show the real-time signal activity at the logic analyzer probe tip.
The activity symbols indicate whether signals are high, low, or changing.

Behavior
If the activity indicators show no activity, the problem could be that there is no signal, an incorrect
threshold voltage level, or the channel lead is not connected. If all the channels associated with a probe
are inactive, check the probe connections to the logic analyzer module.

Channel activities under Internal 2X clocking mode show activities after demultiplexing occurs rather
than probe tip activities. Therefore, the activity shown for a demultiplexed destination channel will
always match the activity of its demultiplexed source channel, regardless of what the real physical
signal activity is at the destination channel probe tip.

To Use
From the Setup window, click the Probes button to open the Probe Properties dialog box. Click the
Activity tab to display the channel activity.

TIP. To add probe activity indicators to the Waveform or Listing window, click the Activity button that is in the
Waveform or Listing window.

For quick access to the Activity tab, press the Activity button on the front panel of your instrument.

Related Topics
Internal 2X Clocking

Probe Info Tab

Probe Thresholds Tab
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Probe Thresholds Tab
Use to set the input threshold voltage settings for probe channels, clocks, and qualifiers of the current LA
module. Changes are immediately executed even during acquisition.

The Threshold box contains values that are set in the Preset tab of the Options dialog box. Select a probe’s
channel or a probe’s clock/qual box from the table and change the value in the Threshold box. Click Set
All to change all fields to the value set in the Threshold box.

To open this dialog box, refer to Setting LA Probe Thresholds.

Related Topics
Probe Info Tab

LA Activity Indicator

Presets Properties
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Probe Info Tab
This tab is intended for information purposes only. It contains a listing of the probes connected to the
logic analyzer and the set of channels coming through each probe.

Related Topics
Probe Thresholds Tab

LA Activity Indicator Tab
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iCapture Analog Feeds

Overview
The iCapture Analog Feeds control which digital data signals (via the probed channels on which they
reside) are assigned to each TLA7Axx analog output. You assign data signals in one of two ways. You can
select an individual channel, and then assign it to an analog output channel. Alternatively, you can select a
group of channels, and then select the analog output channels to which you want them assigned.

The Physical Module field, which is located at the top of the dialog box, allows you to select which logic
analyzer module channels you want to direct to an oscilloscope.

NOTE. iCapture Analog Feeds are only available in TLA7Axx modules.
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Behavior
Under Analog Output Attenuation, select an attenuation level based on the amplitude of the signals being
assigned. 5X Attenuation is best suited for small amplitude, high-performance signals for improved signal
to noise ratio. Please note that waveforms displayed on your oscilloscope will be displayed at twice their
normal height since the attenuating factor is 5X and not 10X.

After selecting which module contains channels that you want to output, you use the contents of Select
Channels to choose one or more specific channels to use as feeds for analog outputs. Select Channels
contains a drop-down list that you can use to choose the manner in which digital channels are displayed.
The drop-down list provides the following display options:

By Group - displays channels organized by channel group. Only channel groups that are defined in the
LA Setup window can be displayed using this option. In addition, a group can only be expanded if it
contains channels from the selected physical module.

By Probe - displays channels that are alphanumerically organized by individual channel. All channels are
displayed when this option is selected, regardless of whether they are part of a group that is defined in
the LA Setup window.

By Name - displays channels by name assigned to them from the LA Setup window. Channels that have
not been assigned custom names are not listed when using this selection.
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Selecting Individual Channels
After you have chosen a digital channel to output, you can assign it to an analog output channel by clicking
a channel button under Assign To. You can confirm that the digital signal was correctly routed by
reviewing the analog feed assignment information under Current Routing.

Selecting Groups of Channels
When you select multiple digital channels to output, you can assign them to one or more analog output
channels by selecting the check boxes associated with the target channels. If you are interested in more
digital channels than you have analog outputs, use the Analog Feed Cycling buttons to cycle the selected
digital channels through the selected analog outputs. You can additionally direct the system to exclude
channels assigned to unchecked outputs, which guarantees that channel assignments to unselected outputs
are preserved. To do so, select the check box labeled Exclude channels assigned to unchecked outputs.

NOTE. The system reassigns digital channels only when the assigned digital channel is a member of the channels
that you specified for output in Selected Channels and the analog output channel to which the digital channel is
assigned is not selected.

If one or more of the selected digital channels are already assigned to an analog output, those channels are
highlighted under Select Channels. As you feed digital channels to the selected analog output channels,
this highlighting changes to reflect current channel routing.

Use the following Analog Feed Cycling buttons to cycle the selected digital channels to the selected
analog output channels.

- Assigns up to the first four (depending on number of analog output channels selected) digital
channels to the selected analog output channels.

- Assigns the selected digital channels to the selected channel outputs in groups equal to the
number of channel outputs selected. The order in which the digital channels are assigned is from the
bottom of the list to the top.

- Assigns the selected digital channels to the selected channel outputs, in groups equal to the
number of channel outputs selected. The order in which the digital channels are assigned is from the
top of the list to the bottom.

- Assigns up to the last four (depending on the number of analog output channels selected)
digital channels to the selected analog output channels.

The Current Routing group box displays read-only details about the assignment of individual data
signals to analog outputs and the oscilloscope input channels to which they are physically connected. It
additionally provides a System Inter-probing button that you can click to reassign oscilloscope destination
of data signals.

TIP. To acquire the best possible signal-to-noise ratio on live waveforms through the analog probe outputs, use an
external oscilloscope when the logic analyzer acquisition is idle.
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The iCapture Analog Feeds dialog box retains the channel assignment settings for each TLA7Axx module
represented in the System window. When using Analog Feed Cycling, you can assign channels using
one of the previously described control buttons, then close the dialog box. Later, when you reopen the
dialog box, you can resume assigning digital channels to analog outputs. However, if you change either
the setup of groups or any channel names, channel assignment settings will return to defaults the next
time the dialog box is opened.

When using the logic analyzer’s demultiplexing capabilities to acquire digital data, the analog output data
may not match the digital data. The analog output connector always gets the signal directly from what
is present at the probe tip. For a demultiplexed destination channel, the digital data comes from the
demux source channel and not from the probe tip. Looking at the LA Setup dialog box channel grid, you
can easily tell which analog output channels will not match the digital data: Demultiplexed destination
channels (pink background) and channels forced to 1 or 0 (yellow background) will not match.

Related Topics
System Inter-Probing

Changing Signal Routing

Setting Up Analog Feeds
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Multiplexed Signals

Overview
You can acquire data from multiplexed address/data buses without double probing. The logic analyzer can
demultiplex the probe channels and store the results as separate address and data samples.

To Use
To use this feature, go to the System window and click the LA module Setup window button. Select
External clocking, click More to open the Clocking dialog box, and then click Advanced Clocking.
Click the Probe Demux button to display the Probe Demux dialog box and choose the probe channels
that you want to demultiplex.

Generally when using the demultiplex feature, you must also assign separate sample clocks to address
and data groups. (You do this in the Advanced Clocking dialog box where you made the Multiplex
selection). First, define the two sample clocks then assign one clock to the address groups and the other
clock to the data groups.

NOTE. Although you can include MagniVu data with your multiplexed data in a data window, the MagniVu data is
not demultiplexed.

Related Topics
Advanced Clocking

Probe Demultiplexing
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Sample Suppression

Overview
Sample Suppression allows you to control how many instrument samples are initially made available for
display each time new data is acquired. After acquisition, use the show or suppress controls in the Listing
or Waveform window to view or suppress more data samples.

Behavior
Sample suppression does not affect the number of samples stored in the instrument during acquisition.
Samples that are suppressed are not lost and can be shown at any time, using the Show check box in the
Listing or Waveform window.

There are three ways to control sample suppression:

Show All acquired samples - This makes all samples acquired by the instrument visible immediately
after the acquisition.

Show N samples around the trigger - This shows one block of samples with the trigger centered in the
block of samples. All other samples are suppressed.

Re-use existing sample suppression relative to - This keeps the setting currently being used to show
data in the Listing or Waveform window and applies it to newly acquired data. Suppression can be kept
relative to the trigger point or beginning of memory.
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Compare Definition Dialog Box

Overview
Before you can compare data, you must use the Define Compare dialog box to specify the source of the
reference data, the number of samples to compare, and how to align the reference data. To enable the
Compare Definition dialog controls, you must select the Enable Data Compare check box.

A summary of the sample being compared is displayed at the bottom of the dialog. This area shows the
sample that is being compared in the current acquisition using the current compare range and alignment
settings.

To open the Compare Definition dialog box from the LA Setup window, click the Define Compare button.

NOTE. To view compared data, select Show Compare in the Waveform Window or Listing Window Properties tab.

Reference Data Source
Select a reference data source from any of the installed modules or from a saved setup.
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Compare Data Region
You can compare all data between the system under test and the reference data. You can also compare a
range of data with respect to the beginning of memory or around the trigger location.

Data Source Alignment
Align the data with respect to the beginning of memory or to the trigger location. You can also specify the
number of samples to offset the data.

Compare limitations
You can compare only the main LA data. You cannot compare glitch data, disassembler group data,
MagniVu data, External Oscilloscope or DSO data. Although you cannot compare disassembler group
data directly, you can compare the raw, nondisassembled data in a Listing window by using one of the
channel groups defined in the LA Setup window. To view these raw channel groups in a Listing window,
click the Add Toolbar button to add the channel group to the window.

Related Topics
Channel Compare Mode

Repetitive Properties Dialog Box

Defining Compare Parameters

Listing Windows Properties
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Filters

Filter Definitions Dialog Box

Overview
Use this dialog box to display and manage all filters in the logic analyzer.

Behavior
The dialog box displays all modules and filters currently used by the logic analyzer. Use the tree controls
to expand and collapse the filter contents of the modules. Modules are listed first, followed by any loaded
data sources, and then the filters. Loaded data sources consist of a file name and a module name (for
example, System1.tla:LA-1).

To Use
Manage the filters using the toolbar buttons at the top of the dialog box, the right mouse button context
menu, or the keyboard. By selecting a module in the dialog box, you can attach a new filter to the module,
load an existing filter, or paste a new filter using the clipboard contents and attach it to the module. By
selecting a filter, you can cut, copy, paste filter contents, load another filter’s contents from the Load Filter
Dialog Box, or you can view or edit the filter’s contents through the Define Filters dialog box.
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Define Filter Dialog Box

Overview
The logic analyzer normally displays all data acquired by the probes from the target system. Frequently,
it displays data that you are not interested in. You can use data filters to display only the data that you
want to see in the data window.

Use filters to do the following:

Hide specific data. For example, you can define a filter to hide data when all of the data in a channel
group is equal to FFFF.

Show specific data. For example, you can define another filter to show data from a specific address.

Color specific data. For example, you can define a filter to display data to another address with a
specified color.

Behavior
Filters are made up of clauses and events and are very similar to trigger
definitions. Use the drop-down list located at the upper left corner
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of each clause to select an action for each clause. All clauses in the filter are evaluated beginningwith the first

clause.

When you select a Show or Hide action, you can fill in the event fields by using the drop-down lists or
text boxes to define the event that you want to either show or hide.

When you select a Color action, a color options button appears where you can click the color options for
your filter. After you select the color options, you can fill in the event fields to further define the data that
you want to filter for the specific event.

You can edit events and clauses by clicking the mouse at the right-end of the clause and either placing the
mouse over the indicator or right-clicking the mouse to display a context-sensitive menu.

Filters are saved as part of the module setups. You can load filters when you need them. You can also edit
and rename filters. When you apply a filter to a data window, the filter name is appended to the data label
(for example LA1: FilterA: A3 indicates that FilterA is attached to the A3 channel group of module LA1).

To Use
Use this dialog box similarly to the trigger window by defining events and clauses for the filter. By default
the filter is enabled if it is not enabled, click the Enable this Filter check box.
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. . Filters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Load Filter Dialog Box

Overview
Use this dialog box to load filter contents from any current or saved module setups.

Behavior
This dialog box loads filter contents from any saved module setup files or system setup files. The load
operation replaces all settings in the selected filter (specified in the title bar). If no filter is selected, the
load operation creates a new filter and attaches it to a module.

When a module setup name or system setup name appears in the File Name text box, all modules and
filters associated with that setup are listed in the center of the dialog box. If a module has a filter attached,
you can select and load that filter.

To Use
Enter a module setup or a system setup name in the File Name text box or click the Browse button to locate
a module or system setup file. Select a filter from the setup to enable the Load button; click the load button
to load the filter. You can also double-click the filter to automatically load the filter.

NOTE. If you load a filter that uses groups or channels that are not included with the module, the events will be
discarded. A message box will display, explaining what happened.

Related Topic
Load Filter Browser Dialog Box
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Load Filter Browser Dialog Box
Use this dialog box to find TLA module or system setup files that contain filters. This dialog box is similar
to the standard Open Dialog Box. The main exception is that the Content area describes whether the
module has any filters defined.

Use the dialog box to browse the file system for filters. After you select a file name and click the Open
button, the dialog box closes and adds the file name to the File Name field of the Load Filter Dialog Box.

TIP. If you don’t see the file that you want, make sure that the file is a valid TLA module setup file or system setup file.
These files have the .tla suffix.
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Applying Filters
When you apply a filter to a data window, the filtered data appears as a data source. The filter name is
appended to the data source name in a data window. The filter must be defined before you can apply it
to a data window.

1. In the Listing window, click the column name; in the Waveform window, click a waveform name.

2. Right-click the mouse to open the context menu.

3. Select Apply Filter followed by the filter name.

You can add a new column or waveform with filtered data by clicking the Add Column or Add Waveform
icons and selecting a filtered data source:

1. In the Listing window, click (the Add Column icon); in the Waveform window, click (the
Add Waveform icon), .

2. In the new dialog box, select a data source that contains filtered data. For example, LA1:Filter1.

3. Select the data group that contains the filtered data.

4. Click the Add button followed by the Close button.
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Color Options Dialog Box

Overview
Use this dialog box to control the color of groups.

Behavior
You can specify whether the foreground and background colors apply to a specific group or to all groups.

To Use
Determine whether you want to use separate colors for an individual group or the same color for all
groups. Click the color button to select the foreground and background color from the color matrix. In
addition to using a basic color, you can click More Colors… at the bottom of the color selection box to
define custom colors.
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Channel Import and Export

Channel Import and Export Formats
Channel import/export uses a structured text file format to organize the import and export information.
Only formatted text files can be processed by the parser.

The import or export file is separated into multiple lines by EOL (EOL can be CR, LF, or CRLF). During
channel importing or exporting, the parser processes one line at a time. The following lines are allowed
in the file:

Comment Lines

Control Lines

Information Lines

Click Sample File to view a Channel Import/Export file.

Related Topics
Channel Setup Import Dialog Box

Channel Setup Export Dialog Box

Channel Setup Import Behavior
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Channel Setup Import Behavior
Be aware of some of the behavior of the logic analyzer when it imports channel setup files:

The logic analyzer detects the delimiters used in the imported file. Therefore it is important to use only
one delimiter in the file. If you need to embed the delimiters in a channel name or channel group
name, enclose the name with quotes.

The import operation will update the channel setup parameters related to the selected fields. For
example, if a user-defined channel name is selected, the old channel name will be replaced by the new
name without any warnings. Similarly, if there are two lines in the imported file setting for the same
channels, the second line receives the new name.

The import operation will not change the channel setup parameters related to unselected fields. A
skipped field (an empty field name between two delimiters) acts as an unselected field.

User-defined channel names must be unique. If an imported user-defined channel name exists, the two
channels will exchange their user-defined channel names (for example, if you have A0(0):A and
A0(1):B, and you set A0(1) to A, the result will be A0(0):B and A0(1):A).

If an imported file contains a channel definition for a channel that does not exist, the channel definition
will be ignored and a warning message will be saved in the error log file. You may experience this
when importing a file to a narrow module.

If an imported file does not contain channel definitions for all the channels of the logic analyzer, the
definitions of the missing channels remain unchanged. This may happen when you import a file to
a wide module.

The parser processes one line at a time. It will stop processing on any unrecognizable line and then
display an error message.

All warning and error messages will be written to a file named ImportExportError.log in the same
location as the import file.
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Channel Setup Export Dialog Box

Overview
Use this dialog box to export channel setups to a text file. The setups can then be imported by another
logic analyzer.

Behavior
This dialog box allows you to save the channel setups to a text file listed in the Export Path box. You can
also click the Browse button to save the file to a folder of your choosing. You have the choice of exporting
individual channel information or group information by selecting the appropriate Export Selections. If you
select Export Channel Information, you can specify the type of information that you want to export by
selecting one or more of the check boxes. You can select one of four field delimiters to separate the fields
within the file; an empty field is represented by two consecutive field delimiters in the file.

Any warning or error messages are saved in a log file in the same location as the exported file.

To Use
Select Export Channel Setup… from the File menu. Specify a file name and the path to the file. Use the
other selections in the dialog box to define the channel information and delimiters. Click the Export
button to export the file.

Related Topics
Channel Setup Import Dialog Box

Channel Import and Export Formats

Channel Setup Import Behavior
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Channel Setup Import Dialog Box

Overview
Use this dialog box to import channel setups from a saved location.

Behavior
This dialog box allows you to specify the channel setup information that you want to import. Specify the
file location in the Import Path box or click the Browse button to browse the file system for the file. The
channel setups are normally saved in a text file.

Select the Automatically detect from file to import all fields from the import file. Select Custom options to
specify the fields that you want to import by selecting one or more custom options. If you try to import
a field that does not exist in the import file, the logic analyzer will display a warning message. Click
the Import button to import the setups. Warning and error messages are saved in a log file in the same
location as the imported file.

To Use
Select Import Channel Setup… from the File menu while the Setup window is active. Locate the import
file, specify the import options in the dialog box, and then click the Import button.

Related Topics
Channel Setup Export Dialog Box

Channel Import and Export Formats

Channel Setup Import Behavior
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Sample Channel Setup File
The following file shows an example of the different parts of a Channel Import/Export file.

//////////////////////////////////////////////////////////////////////////////

// TLA Channel Import/Export File

// Created on June 10, 2007 at 16:05:27

// by TLA Import/Export Utility Version: 1.0.001

// (Field Delimiter: <Tab>)

//////////////////////////////////////////////////////////////////////////////
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//////////////////////////////////////////////////////////////////////////////

// Remove all user-defined channel names

//+ResetAllChannels

//

// Remove all channel groups

//+RemoveAllGroups

//////////////////////////////////////////////////////////////////////////////

//////////////////////////////////////////////////////////////////////////////

// Channel definition format

//+ChannelFormat : HWName UserName Polarity Compare

//////////////////////////////////////////////////////////////////////////////

C0(7) NMI - TRUE

C0(6) IGNNE# - TRUE

C0(5) EADS# - TRUE

C0(4) SRESET - TRUE

C0(3) HOLD - TRUE

C0(2) KEN# - TRUE

C0(1) LOCK# - TRUE

C0(0) RDY#= - TRUE

Q3 Q3 - TRUE

Q2 Q2 - TRUE

Q1 Q1 - TRUE

Q0 Q0 - TRUE

CK3 CLK - TRUE

CK2 RDY# - TRUE

CK1 BRDY# - TRUE

CK0 BRDYC# - TRUE

//////////////////////////////////////////////////////////////////////////////

// Group definition format

//+GroupFormat : GroupName ChannelList

//////////////////////////////////////////////////////////////////////////////
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Data D31 D30 D29 D28 D27 D26 D25 D24 D23 D22 D21 D20 D19 D18 D17 D16 D15 D14

D13 D12 D11 D10 D9 D8 D7 D6 D5 D4 D3 D2 D1 D0

Control BLAST# AHOLD HLDA BOFF# M/IO# D/C# W/R# SMIACT#

DataSize BS8# BS16# BE3# BE2# BE1# BE0#

Misc CLK= ADS#

Cache KEN# EADS# FLUSH#

Misc2 BREQ# INTR LOCK# PLOCK# RDY#= BRDY#= BRDYC#= HOLD IGNNE# FERR# RESET

SRESET NMI

. . Channel Import and Export . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Comment Lines
All lines starting with "//" are treated as comments, unless the very next character is a ’+’, which signifies a
control line. The "//" can also be used to initiate a comment on the end of "non-comment" line. In this
case, a delimiter is needed before the "//", all text between the "//", and the end of the line is treated as a
comment (ignored by the parser). Examples of using comments lines are shown below:

////////////////////////////////////////////////////////////////////////////

// TLA Channel Import/Export File

// Created on June 10, 2007 at 16:05:27

// by TLA Import/Export Utility Version: 1.0.001

// (Field Delimiter: <Tab>)

////////////////////////////////////////////////////////////////////////////

Related Topics
Control Lines

Information Lines

Sample Channel Setup File

Channel Setup Import Behavior

. . Channel Import and Export . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Control Lines
All lines starting with "//+" are treated as control lines. This special character sequence is used to mark
instructions to the parser. Each word in a control line is considered as a keyword, which can be recognized
by the parser. Only delimiters and predefined keywords are allowed in a control line. Each control line
signifies a structure, which is used to organize the information in the following information lines.
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The first keyword in a control line specifies the name of the defined structure. The keywords after
the structure name specify the names of the structure items. Currently, there are four structure names
available, ResetAllChannel, RemoveAllGroups, ChannelFormat, and GroupFormat. The keywords
are not case sensitive.

ResetAllChannels
This keyword works as a command to remove all user-defined channel names as shown in the following
example:

//////////////////////////////////////////////////////////////////////////////

// Remove all user-defined channel names.

//+ResetAllChannels

//////////////////////////////////////////////////////////////////////////////

RemoveAllGroups
This keyword works as a command to remove all of the channel groups.

///////////////////////////////////////////////////////////////////////////////////

// Remove all channel groups.

//+RemoveAllGroups

///////////////////////////////////////////////////////////////////////////////////

ChannelFormat :
This is a structured line containing the following fields: HWName, UserName, Polarity, Threshold, and
Compare.

HWName. This is the hardware name of the channel. It is required in all ChannelFormat structures. The
hardware name of the channel should never be empty in the information lines. For normal acquisition
channels, the syntax is the hardware pod name followed by the channel number enclosed in parentheses,
(for example, A0(1) or A0(2)). The syntax for clock and qualifier channels is the type identifier "CK " or "
Q" respectively, followed by a number (for example, CK0, CK1, Q0, or Q1). This field is not case sensitive.

UserName. This is the user-defined name of the channel. This field is case sensitive. The user name
should be unique among channels; otherwise the latest defined name will replace the pre-existing name.
The user name must not contain embedded spaces, commas, or tabs. The TLA application allows
semicolons in channel names. When using semicolons as delimiters, embed the channel name and the
delimiter within double quotes ("sample;name"). Similarly, if you want to embed "//" in the channel name,
the channel name and the "//" symbol must be enclosed in double quotes.

Polarity. This is the polarity of the channel. The values for this field are + and -.

Threshold. This is the threshold voltage of the channel. The syntax is the voltage value and the unit, (for
example, 2.5V, or 100mV). This field is not case sensitive.
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Compare. This field contains the compare enable/disable information of the channel. Values for this field
are TRUE and FALSE. This field is not case sensitive.

///////////////////////////////////////////////////////////////////////////////////////

// Channel definition format

//+ChannelFormat: HWName UserName Polarity Threshold Compare

///////////////////////////////////////////////////////////////////////////////////////

C1(7),RESET,-,1.5V,TRUE

GroupFormat
This is a structured line containing the following fields: GroupName and ChannelList .

GroupName. This field defines the group name. This field is case sensitive. The group name must be
unique; otherwise the later-defined name replaces the previous-defined name. The group name must not
contain embedded tabs. When using delimiters with the name, embed the group name and the delimiter
within quotes ("sample name").

ChannelList. This field is a list of channel names assigned to the group. This field is case sensitive.
The channel names can be user-defined names or probe-based names. When using probe-based names,
there are several ways to specify the channels. For individual channels, the syntax is the hardware pod
name followed by the channel number enclosed in parentheses (for example A0(1) or A0(2)). Groups
of contiguous channels can be specified using a range of channel numbers within the parentheses (for
example, A0(7-0) or A1(3-5)). When you want to specify all channels in a hardware pod, you can use
a shorthand notation using an empty pair of parentheses (for example, A0() or A1()). The syntax for
clock and qualifier channels is the type identifier "CK " or " Q" respectively, followed by a number (for
example, CK0, CK1, Q0, or Q1). Multiple channels or channel groups must be separated by delimiters.
Embedded spaces are not allowed.

The number of the channel names is unlimited. The parser reads the delimiter-separated names until
it finds an EOL character or a "//" sequence. You can break a long line into several lines by adding
a delimiter followed by the ‘\’ character before you add each EOL character. The parser treats those
lines as a single line.

//////////////////////////////////////////////////////////////////////////////

// Group definition format

//+GroupFormat:GroupName ChannelList

//////////////////////////////////////////////////////////////////////////////

Control,BLAST,AHOLD,HLDA,BOFF,M/IO,D/C,W/R,SMIACT

Data,D31,D30,D29,D28,D27,D26,D25,D24,D23,D22,D21,D20,D19,D18,D17,D16,,\

D15,D14,D13,D12,D11,D10,D9,D8,D7,D6,D5,D4,D3,D2,D1,D0

Address,A0(),A1(),A2(),A3()
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Related Topics
Comment Lines

Information Lines

Sample Channel Setup File

Channel Setup Import Behavior
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Information Lines
Lines not starting with "//" or "//+" are treated as information lines. An information line can be separated
into several fields by a pre-defined delimiter. The orders of the fields are declared in the control line
defined earlier. For more information, see the Sample File.

Related Topics
Control Lines

Comment Lines

Sample Channel Setup File

Channel Setup Import Behavior
System Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Serial Analyzer Setup Window

Serial Analyzer Setup Window
The Setup window provides access to all controls needed to configure the serial analyzer module to capture
data from a particular serial data stream or link.

A dedicated status area at the top of the window provides basic status information for the current link.
Controls at the left side of the window define the link, define the reference clock, and to specify how to
store data.

The channel activity indicators in the Setup window provide a visual indication of the signal activity at the
probe. The module always acquires data and updates the status indicators. The legend items in the status
area near the top of the Setup window describes the various signal states.

52



System Setup Status Area

. . Serial Analyzer Setup Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Status Area
The status area is located near the top of the Setup window. It provides status information for the Setup
window and includes the following components:

Text messages

Command buttons

Channel activity indicator legend

Link status readout

Text messages provide informational, warning, or violation messages about the status of the Setup
window and the module. Some messages include an Acknowledge button. These messages appear when
you make a change to the instrument settings that may require your further interaction. Click the Ack
button to dismiss the message.

The channel activity indicator legend defines the signal status of the channels and the system under test
(SUT) clock signals. The following table lists the possible values and their indication.

Indicator Meaning Description
No signal No signal activity and none was

expected
Missing signal No signal activity. The channel is

connected to a lane on the system
under test and a signal is expected.

Signal Signal activity. A symbol lock was not
achieved.

Data signal Signal activity. The serial analyzer has
achieved symbol lock. In case of the
SUT clock, a valid clock was detected
at the front panel connector.

If the indicators appear different than what you expect, this could indicate a possible problem with the
probe or the signals at the system under test. The legend is always on the screen unless another status
message is displayed.

The right side of the status area shows key information about the current condition of the link. The top
readout displays the link width during the previous update interval and the bottom readout displays the
transfer rate. The readout displays “Link not Trained” when the link is not trained or when no channels are
active. If the link width changes during the update interval, the readout displays “Varies.”
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Autoset Status
When a link has trained, the serial analyzer can detect the training results for each lane. When this occurs,
the serial analyzer displays a status message along with the Ack button and the Autoset button. When you
click the Autoset button, the serial analyzer automatically completes the following setups for the link:

Link direction

Link width. The highest lane number among the trained lanes plus one.

Channel-to-lane associations. The Setup window displays the associations with lines connecting
from the lanes to the activity indicators.

Channel polarity

The serial analyzer can only detect changes in the transfer rate when Transfer Rate is set to Track Training.
If the Transfer Rate is set to one of the fixed rates, the serial analyzer cannot detect the signals at the link
when they train to a different rate. These changes are reported in the status area.

To disregard the changes and dismiss the status message, click the Ack button.
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Left Side Control Area
The Left-side controls configure the behavior of the serial analyzer. The area contains three groups of
controls: the link definition group, reference clock source group, and the link data storage group.

Link Definition Group
The name of the link appears on the tab at the upper left side of the control area. You can rename the
link by clicking text and entering a new name.

Select one of the Acquire buttons to identify the upstream and downstream lanes for capturing data. The
selection that you make impacts the appearance of the channel-lane assignment area on the right side. For
example, if you acquire downstream data, the upstream channel-lane assignments become unavailable.

Select the maximum link width from the drop-down list. The link widths depend on the other settings
in the Link Definition group, such as the number of channels in the module and the Acquire selections.
It is a good idea to select the largest width to which the link can train because the link can down-train
during operation. If the serial analyzer detects changes that may require further user interaction, it displays
a message in the status area.

Select the transfer rate from the drop-down list. Use Track Training when you want the serial analyzer to
watch the TS1 an TS2 training sequences to determine the transfer rate that the link is trying to establish
or to anticipate and to follow any rate changes.
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Reference Clock
The serial analyzer can synchronize its reference clock to one of two sources.

Select Recovered from Data to synchronize the serial analyzer with a clock signal embedded in the data
signal.

Select SUT to use an external clock from the system under test and then select one of the clock rates from
the drop-down list. The serial analyzer receives the clock signal from the external clock cable connected to
the system under test.

Data Storage Area
Use the Data Storage area to specify the data format and the amount of data to acquire and the type of
filtering. The data volume is expressed in terms of symbols per lane with a maximum of 32 M symbols
per lane.

Use the Trig Pos control to specify where the trigger will appear in memory (1% accuracy within the
data record).

In addition to specifying the amount of data to acquire, you can also filter data during an acquisition cycle.

Use the filters from the drop-down list or define your own by clicking (the Define Filter button). The
filtering applies to both upstream and downstream data and does not restrict any triggering.

Use the Define Filter function to define a filter that meets your needs. After you create a filter, you can
save it for future use. The new filter appears in both the upstream and downstream lists. The last filter that
you use becomes the selected filter in the lists.
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Channel-Lane Assignment Area
The Channel-Lane Association area provides controls for making logical connections between module
channels and the logical lanes of the Listing and Waveform windows. The area consists of graphical
representations of the module bordered by the upstream and downstream lanes. The downstream and
upstream lanes provide connection points to the module.

Connector groups (of four Channel Activity Indicators) represent the connectors on the front of the serial
analyzer. Each group has four channels consisting of a channel emblem, a polarity indicator, and two
channel connection points (one on each side of the emblem). The SUT Clock emblem shows the activity
of the clock when you select the SUT clock as the reference clock source.

Use the polarity indicators to change how the serial analyzer senses the differential signal on a channel.
The plus and minus signs represent the normal or inverted polarity. The buttons show the last trained value
after you click the Autoset button. However, the values do not automatically track training.

When the probes are connected to the system under test, the appearance of the emblems represent the
status of the signals at the probe tips. Refer to the legend at the top of the Setup window to understand
the signal status.

The easiest way to connect the lanes to the module connectors is to click the Autoset button after the serial
analyzer has detected training. You can also manually connect the lanes to the module connector by
clicking the mouse on a lane and dragging a line to the desired module connector.
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External Oscilloscope Setup Window

Setting Up External Oscilloscope Communication
The iView External Oscilloscope Setup wizard provides instructions to connect your Tektronix logic
analyzer to an external Tektronix oscilloscope, enabling communication between the two instruments.

If the external oscilloscope that you are adding does not appear in the list, then the logic analyzer does
not have the files necessary to support your model of external oscilloscope. In this event, go to the
Tektronix Web site and download the latest external oscilloscope support files.

After you complete the process of adding your external oscilloscope to the logic analyzer system, you
can set up your oscilloscope from the logic analyzer System window.

You must specify horizontal and vertical settings on external oscilloscope. In addition, if the external
oscilloscope is triggering the TLA, you must specify the trigger settings on the external oscilloscope.
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Setting Up External Oscilloscope Communication
The iView External Oscilloscope wizard provides instructions to connect your Tektronix logic analyzer to
an external Tektronix oscilloscope, enabling communication between the two instruments.

If the external oscilloscope that you are adding does not appear in the list, then the logic analyzer does
not have the files necessary to support your model of external oscilloscope. In this event, go to the
Tektronix Web site and download the latest external oscilloscope support files.

After you complete the process of adding your external oscilloscope to the logic analyzer system, you
can set up your oscilloscope from the logic analyzer System window.

You must specify horizontal and vertical settings through your external oscilloscope’s user interface.
In addition, if your external oscilloscope is triggering the TLA, you must specify trigger settings
using your external oscilloscope’s user interface.
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iView Setup Window

Overview
A Setup window is available to assist you in verifying, changing, and testing the external oscilloscope
settings.

Before acquiring and displaying a waveform, you must first establish a connection between your Tektronix
Logic Analyzer and external oscilloscope using the Add iView External Oscilloscope setup wizard.

To Use
To access the setup wizard from the System menu, click Add iView External Oscilloscope. Then step
through the external oscilloscope setup process, following the provided directions that guide you through
physically connecting the instruments, choosing both your GPIB address and where to display your
external waveform data, and initializing the system trigger.

The Connections tab contains diagrams that help you to confirm that your logic analyzer and external
oscilloscope are physically connected correctly. Diagrams are available for confirming the physical
connection of both your logic analyzer and your specified external oscilloscope. Click the TLA
Connections button to display the logic analyzer diagram, or click the TDS Connections button to display
the diagram for the external oscilloscope that you specified in the setup wizard.

To open the iView Setup window from the System window, click the iView Setup button.

Related Topic
Troubleshooting Connections
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Troubleshooting External Oscilloscope Communication
If you experience difficulty in establishing communication between your logic analyzer and external
oscilloscope, the following checklist will assist you in identifying and correcting the problem.

Diagnostic Checklist
Is your external oscilloscope turned on?

Is the GPIB configuration on your external oscilloscope set up correctly? (See your oscilloscope’s
online help.)

Are your cable connections securely attached?

Did you select the correct model number for the external oscilloscope to which you are connecting?

Use the Back button to return to the window where you specified the external oscilloscope model
number and make changes as necessary.

Have you correctly connected the cables between your logic analyzer and external oscilloscope?

Use the Back button to return to the windows that describe the proper cable configuration between
your logic analyzer and external oscilloscope. Alternatively, you can cancel the setup wizard and
begin the setup process again.

If you specified the external oscilloscope GPIB address instead of letting the setup wizard automatically
detect it for you, did you correctly select the GPIB address where your external oscilloscope is
set to communicate?

Use the external oscilloscope’s user interface to ensure that the GPIB address you selected in the setup
wizard agrees with the GPIB address at which the external oscilloscope is set to communicate.

Once you correct the communications problem, the error message will disappear when you press the
Next button to establish communication.
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Signal Routing from the Logic Analyzer

Overview
Use the Route from LA dialog box to send probe data from a logic analyzer channel to the currently
selected oscilloscope channel. To display the Route from LA dialog box, select Route from LA from the
context menu associated with a selected oscilloscope channel waveform.

Behavior
The Route from LA dialog box displays the currently defined inter-probe connection and the feed for the
oscilloscope channel. This item cannot be selected and is displayed for information only. If no inter-probe
connection is defined for the oscilloscope channel, the field is empty.

To Use
Click the System Inter-probing button to change the contents of the scroll list by adding or changing
the connection to the logic analyzer.

Click the Select Channel button to select a new logic analyzer channel to feed the inter-probe connection
to the oscilloscope channel. This button is made available when an inter-probe connection is defined.

Related Topics
Signal Routing to the Oscilloscope

Routing a Signal from a Logic Analyzer Output Channel

Routing a Signal to an Oscilloscope Input Channel
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Signal Routing to the Oscilloscope

Overview
Use the Route to DSO dialog box to send probe data from the selected logic analyzer channel to one of the
oscilloscope channels. To display the Route to DSO dialog box, select Route to DSO from the context
menu associated with a selected LA channel waveform. The Route to DSO context menu item is only
enabled if the selected waveform is a TLA7Axx channel.

Behavior
The Route to DSO dialog box provides a list of oscilloscope channels that have inter-probe connections
defined to the logic analyzer. If no inter-probe connections are defined, the list is empty. If the oscilloscope
list contains the desired LA channel, then that list item is picked by default.

The check box named Add waveform to view is unchecked by default because the waveform view
typically contains waveforms for the oscilloscope of interest. Selecting this check box and clicking OK
will add a waveform of the selected oscilloscope destination to the view.

To Use
Select an oscilloscope channel and click OK to feed the logic analyzer channel to the inter-probe
connection attached to the oscilloscope channel.

Click the System Inter-probing button to change the destination list contents by adding or deleting the
connections for the logic analyzer.

60



System Setup System Inter-Probing

Related Topics
Signal Routing from the Logic Analyzer

Routing a Signal from a Logic Analyzer Output Channel

Routing a Signal to an Oscilloscope Input Channel
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System Inter-Probing

Overview
Because the TLA application cannot sense probe physical connect/disconnects, it is unable to manage
logic analyzer or oscilloscope mapping automatically. Therefore, you must use the System Inter-probing
dialog box to manually specify which connectors between the logic analyzer and oscilloscope are fitted
with probe connections.

Behavior
When an inter-probing connection is created, the oscilloscope signal name changes to reflect the logic
analyzer channel that is feeding it. The signal name is visible in both the DSO Setup channel tabs and as
the waveform element label. The rule that the system uses for generating the DSO signal name is to make
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it identical to the LA channel name. The system also automatically adjusts the time alignment dialog to
incorporate whatever signal path delay is determined for the oscilloscope individual signal. The delay is a
single time value, based on both the cable length and the particular path of the logic analyzer channel feed.

NOTE. Your ability to use the LA Setup, Time Alignment, and Waveform windows depends on correct set up and
maintenance of system inter-probing.

To Use
To create an inter-probing connection, click either an oscilloscope or logic analyzer channel button.
The system responds by changing the cursor to the shape of a probe connector. Then click a button
corresponding to the opposite end of the connection to establish the connection. Upon establishing an
inter-probing connection, the cursor changes back to the normal shape.

NOTE. If you click anywhere other than on a legal endpoint for the connection, then no connection is made and the
cursor changes back to the normal shape.

To delete a system inter-probing connection, click either endpoint button of the existing connection. When
a connection is deleted, the oscilloscope signal name changes to the normal default and the oscilloscope
individual signal time alignment is set to zero.

Related Topics
Setting Up Analog Multiplexing

Analog Multiplex Cables
System Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Clocking

Basic Clocking Dialog Box

Overview
The Clocking dialog box displays when you select External clocking in the LA Setup window. Use
this dialog box to define either basic or advanced clocking parameters. Basic clocking allows you to
specify an external clock definition by creating up to four single-phased clocking equations. Advanced
Clocking allows you to set up multiple-phase clocking, probe demultiplexing, and clocking controls
for external clocking.
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Custom Clocking
Custom clocking is used only with microprocessor support packages. Custom clocking can enable and
disable a variety of microprocessor-specific clock cycle types (such as DMA cycles).

For more information see the instructions that accompanied your microprocessor support package.

Microprocessor Support Package
A microprocessor support package is a software application that allows the logic analyzer to acquire
and disassemble microprocessor data.

Some support packages include a hardware probe adapter that is attached directly to the
microprocessor in the system under test to capture microprocessor signals.

The LA Setup window shows which support package is currently installed.
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Sample Clock Definition
When you use external clocking, you have the option of further defining the sample clock by using
clocking equations in the Clocking dialog box. With Basic clocking (the default) you can define a single
sample clock. If you click Advanced Clocking you can define up to two sample clocks, and assign the
sample clocks to different channel groups.

You can define up to four single-phased clock expressions that are logically OR’ed. Each expression
contains the following controls (listed from left to right):

Clock edge select. Select rising or falling edge.

NOTE. You can select the edges of up to four active clocks. The same clock (rising or falling edge) can be used in
different clock expressions.

Clock source select. Select any of the available clock channels.

Qualifier select (3). Specify additional qualifier channels here. Select a normal or inverted version of each
qualifier channel. These selections are visible only if a clock is selected in the Clock select field.

Clocking Equations
Clocking equations are used with external clocking to further qualify when data is sampled. The
equations consist of a Boolean combination of events that link clock and qualifier lines. Data is
sampled and stored in memory only when this clock equation is true.

Qualifiers
An external signal that acts as a gate for the sample clock.

When the external signal is false, the sample clock is not allowed to load acquired data into memory.
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Internal Clocking
Internal clocking uses the logic analyzer’s internal clock to determine when to sample data.

Typically, internal clocking is used for timing analysis.
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Internal 2X Clocking
Internal 2X clocking doubles the speed at which data samples are taken. When you set Clocking to Internal
2X, each memory depth choice in the drop-down list is doubled. Note that in Internal 2X clocking mode,
half the logic analyzer input channels are traded for twice the sampling speed and data acquisition depth.

Internal 2X clocking is useful for applications where higher timing resolution over the same time window
is required.

Related Topic
Internal 2X Clocking Details
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Internal 4X Clocking
Internal 4X clocking quadruples the speed at which data samples are taken. When you set Clocking to
Internal 4X, each memory depth choice in the drop-down list is quadrupled. Note that in Internal 4X
clocking mode, three quarters of the logic analyzer input channels are traded for four times the sampling
speed and data acquisition depth.

Internal 4X clocking is useful for applications where higher timing resolution over the same time window
is required.

Related Topic
Internal 4X Clocking Details
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Advanced Clocking

External Clocking

Overview
External clocking synchronizes data sampling with the clock of the system under test. This lets you be
more selective about the data you sample. This type of clocking is best for state (listing data) analysis.

Behavior

When you select the External clocking mode, the system
responds by displaying the More button. Click this button to
display the Clocking dialog box that you can use to define
sample clocks. Then click the Advanced clocking button to
display the Group Clocking table that you can use to set
advanced clocking parameters for all channels.

Related Topics
Demultiplexing External Data Signals

Selecting Clock Qualification for an LA Module

Merged Module External Clocking
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External 2X Clocking

Overview
External 2X clocking synchronizes data sampling with the clock of the system under test. This lets you be
more selective about the data you sample. This type of clocking is best for state (listing data) analysis.

Behavior
How the system samples data in External 2X mode is dependent on how you specify data sampling. If you
choose to sample data on either the rising or falling edge of the clock signal, the highest possible clock
speed and data rate of your sample will be twice the synchronous speed of your instrument. However, if
you choose to sample data on both the rising and falling edge of the clock signal (called double data rate
or DDR), the highest possible clock speed of your sample will be equal to the synchronous speed of your
instrument and the highest possible data rate of your sample will be faster than twice the synchronous
speed of your instrument.

NOTE. To increase the availability of clocks for driving data, clock and qualifier channels do not demultiplex in
External 2X clocking mode.
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Double Data Rate
For a double data rate acquisition, the logic analyzer takes two samples for each clock cycle of the test
system. Samples are generally taken based on the rising and falling edges of the clock signal. The
data rate of the acquisition is therefore double the rate of the clock signal that is driving it.
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External 4X Clocking

Overview
External 4X clocking synchronizes data sampling with the clock of the system under test. This allows you
to be more selective about the data you sample. This type of clocking is best for state (listing data) analysis.

Behavior
When you select External 4X clocking mode, the system responds by displaying the More button. Clicking
this button displays the 4X Clocking dialog box, which you use to define clock edges and data alignment.

NOTE. To increase the availability of clocks for driving data, clock and qualifier channels do not demultiplex in
External 4X clocking mode.
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External 450 Clocking

Overview
External 450 clocking is only available with TLA7NAx logic analyzer modules loaded with a 450 MHz
PowerFlex option (Option 45). External 450 clocking synchronizes data sampling with the clock of the
system under test. This lets you be more selective about the data you sample. This type of clocking
is best for state (listing data) analysis.

Behavior
If you sample data on either the rising or falling edge of the clock signal, the highest possible clock speed
and data rate of your sample will equal to the synchronous speed of your instrument (450 MHz/ 450 Mb/s).
However, if you sample data on both the rising and falling edge of the clock signal (called double data rate
or DDR), the highest possible clock speed of your sample will be 235 MHz and the highest possible data
rate of your sample will be twice the clock speed of your sample (470 Mb/s). In addition, you will only
have half the number of input channels available.

NOTE. To increase the availability of clocks for driving data, clock and qualifier channels do not demultiplex in
External 450 clocking mode.
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Merged Module External Clocking
If you use external clocking with a merged module formation and you use a single external clock source,
you only need to connect the clock probe from the master module to the clock source.

This condition is also true for all other signal lines, such as qualifier lines, used in the clock equation.

Related Topics
Merge Modules Properties

Clocking Dialog Box
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Advanced Clocking Dialog Box

Overview
Use Advanced clocking to set up multiple-phase clocking, probe demultiplexing, and clocking controls for
external clocking. Multiple-phase clocking specifies two different sample clock equations, and assigns an
equation to separate probe groups to clock in sample data.

Sample Clocks Tab
You can define two sample clock equations. Each equation can consist of up to four single-phased clock
expressions that are logically OR’ed. The equations determine when to sample data.

NOTE. You can select the edges of up to four active clocks. You can select the rising or falling edge of the same
clock in the other expressions. For example: Select the rising or falling edge of Clk 0 for each expression because it
is the same clock.

Advanced clocking is set up through the Setup window. Select External clocking and then click More.

Group Clocking Tab
Use to set advanced clocking parameters for all channels.

The Group Clocking tab contains the following columns: Group, Sample Clock, Pipeline Delay, and
Setup/Hold Window.

Group displays the name for each module-defined channel group.

In Sample Clock, select one of the two sample clock equations you defined in the Sample Clocks
tab to sample this group’s channels.
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In Pipeline Delay, select the number of clock cycles by which to delay the sampling.

In the Setup/Hold Window, select the Setup and Hold window area at which sampling is valid.

The Setup and Hold Window graphic displays both the clock signal and a channel group. The white area
of the channel group is fixed and represents the property of the acquisition system, based on the module
specification. This window dynamically changes, based on the group selected and the Setup and Hold
Window settings. By default, data is sampled just before the clock edge. But by modifying the settings in
the Setup and Hold Window, you can sample data prior to and after the clock edge.

Please be aware of the following:

Conflicts are possible when groups share channels.

Conflicts are noted in the Group Clocking table (see Conflict indications below).

Conflicts do not prevent acquisition.

Value settings closer to the top of the Group Clocking override later settings.

Making changes to the Setup/Hold Window of any clock channel used in the definition of Sample
Clock 1 may result in no samples being acquired.

Conflict Indications
<Default> !!!. This group is programmed to use the default setting, but one or more shared channels are
forced to another value by the programming of another group.

<Value> !!!. This group is programmed to use the value shown, but one or more shared channels are forced
to another value by the programming of another group earlier in the table.

Probe Demultiplex Tab
Set up Probe Demultiplex if you are acquiring data from a multiplexed address/data bus.

An S designator, such as SD3 or S2D3, indicates the slave module of a merged module. SD3 indicates
slave module 1 (the "1" is not shown) and S2D3 indicates slave module 2.

Probe Demultiplex steers single probe channels into pairs of channels to eliminate double probing
on multiplexed busses.

Click the Probe Demux tab, located in the Advanced Clocking dialog box. Then choose which probe
channels you want to demultiplex by either selecting the check box associated with each probe channel
or clicking the Select All button to demultiplex all probe channels.
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External 2X Clocking Dialog Box
Overview

To display the External 2X Clocking Dialog Box, specify
External 2X clocking in the LA Setup window and click the
More button. You use this dialog box to define external 2X
clocking parameters, which allow you to acquire data at
a rate of nearly twice the base synchronous speed of the
acquisition module. However, the increased synchronous
speed comes at the expense of half the acquisition
channels.

To Use
From the External 2X clocking dialog box, choose the clock edge with which you will acquire data, and
then select any available clock signal. For each group, click the associated Setup/Hold Window field
and align data in relation to the specified clock edge. The Setup/Hold Window graphic illustrates your
clock edge and data alignment settings.

NOTE. If a rising clock edge or falling clock edge is chosen, one data sample is taken per clock cycle. However, if
both clock edges are selected, there are two data samples taken per clock cycle, one at each clock edge. This is
referred to as External 2X DDR (double data rate) clocking mode. Probe demultiplexing on all acquisition channels
is used implicitly to provide the 2X clocking capability.
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External 4X Clocking Dialog Box
Overview

You use this dialog box to define External 4X clocking
parameters. The Setup/Hold Window graphic illustrates
your clock edge, data alignment, and delay settings.
To Use

To display the External 4X Clocking Dialog Box, specify
external 4X clocking in the LA Setup window and click the
More button.

From the External 4X Clocking dialog box, choose the clock edge that you will use to sample data, and
then select any available clock signal. For each group, click the associated Setup/Hold Window field and
align data in relation to the clock edge. Then set the delay for each group in relation to the clock edge
for the second sample.

NOTE. External 4X clocking is a double data rate clocking mode. Probe demultiplexing on all acquisition channels
is used implicitly to provide the 4X clocking capability.
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External 450 Clocking Dialog Box
Overview

You use this dialog box to define External 450 clocking
parameters. The Setup/Hold Window graphic illustrates
your clock edge, data alignment, and delay settings.
To Use

To display the External 450 Clocking Dialog Box, specify
External 450 clocking in the LA Setup window and click the
More button. From the External 450 Clocking dialog box,
choose the clock edge that you will use to sample data, and
then select any available clock signal.

For each group, click the associated Setup/Hold Window field and align data in relation to the clock edge.
Then set the delay for each group in relation to the clock.

NOTE. If a rising clock edge or falling clock edge is chosen, one data sample is taken per clock cycle. However, if
both clock edges are selected, there are two data samples taken per clock cycle, one at each clock edge. Sampling on
both clock edges makes External 450 a double data rate (DDR) clocking mode. The state speed is limited to 235 MHz
but the data rate is 470 Mb/s when you sample on both clock edges. You also give up half of your acquisition channels
when you are in DDR clocking mode. Probe demultiplexing on all acquisition channels is used implicitly to provide the
double data rate clocking capability when you are sampling on both clock edges.
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Probe Demultiplexing

Overview
You display probe demultiplexing from the External Clocking dialog box by selecting the External
clocking from the LA Setup window, and then clicking the Probe Demux tab. This allows you to enable
demultiplexing for the logic analyzer input channels in groups of eight at a time, as well as demultiplexing
on individual clock and qualifier channels.
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Behavior
All channels available for demultiplexing are displayed in the scrolling region of the tab, with the scroll
bar enabled as necessary. There may be channels present from up to five merged modules. Channels from
slave modules are shown with the S, S2, S3, and S4 designations preceding the channel name.

When the check box next to a demultiplex set is selected, the data from the source channels is fed directly
into the destination channels internal to the logic analyzer module. Any external signals connected to the
destination channels of the module are ignored.

To Use
Click the Select All button in the Probe Demux tab to select all check boxes; Click the Clear All button to
clear all of the check boxes.

The channels available for demultiplexing and the demultiplex mapping depend on the width of the module
and the type of demultiplexing you select. For TLA7Axx logic analyzer modules and TLA5000B series
logic analyzers you select either 2X demultiplexing or 4X demultiplexing.

Mappings for each module width are shown in the following tables.

2X Demultiplexing
The following table contains the probe channels available for 2X demultiplexing, depending on the
width of the module. For TLA7NAx logic analyzer modules 2X demultiplexing is enabled only when
you have the 450 MHz PowerFlex option loaded.
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136 Channel Module 102 Channel Module 68 Channel Module 34 Channel Module
A3 >D3

A2 >D2

A1 >D1

A0 >D0

C3 >C1

C2 >C0

E3 >E1

E2 >E0

CK2 >Q3

CK3 >Q2

CK0 >Q1

CK1 >Q0

A3 >D3

A2 >D2

A1 >D1

A0 >D0

C3 >C1

C2 >C0

CK0 >Q1

CK1 >Q0

A3 >C3

A2 >C2

A1 >D1

A0 >D0

A3 >C3

A2 >C2

4X Demultiplexing
The following table contains the probe channels available for 4X demultiplexing, depending on the
width of the module.

136 Channel Module 102 Channel Module 68 Channel Module 34 Channel Module
A1 >A0, D1, D0

A3 >A2, D3, D2

C3 >C2, C1, C0

E3 >E2, E1, E0

CK3 >CK2, Q3, Q2

CK1 >CK0, Q1, Q0

A3 >A2, D3, D2

A1 >A0, D1, D0

C3 >C2, C1, C0

CK1 >CK0, Q1, Q0

C3 >C2, A3, A2

A1 >A0, D1, D0

C3 >C2, A3, A2

NOTE. To increase the availability of clocks for driving data, clock and qualifier channels do not demultiplex in
External 2X or External 4X clocking mode.

The Ax, Cx, Dx and Ex designations in the above tables represent blocks of eight data channels, while the
CKx and Qx designations represent single clock and qualifier channels. The channel to the left of the arrow
is the demultiplex source, while the channels to the right of the arrow are the demultiplex destination. The
source and destination channels form a demultiplex set.
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Related Topic
Demultiplexing External Data Signals
Module Setup

Loading Saved Setups to an LA module
1. In the System window, click the LA Setup button.

2. From the File menu, select Load Module.

3. Click Browse to search for the system or module with the setup you want. You can also enter the
path in the File name text box.

4. Select the file and click Open; the Load Module dialog box appears with a list of modules in the
saved file.

5. Select the module you want and click Load.

If the setup does not load, refer to Load System Options Dialog Box for a list of possible problems.
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Loading Support Packages
1. In the System window, click the LA Setup button.

2. From the File menu, click Load Support Package.

3. Select the support package you want to load.

4. Click Load.

Related Topic
Setting Up Clocking for Support Packages
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Merging Modules
Before you can merge modules in the application, modules must be physically connected as described in
the TLA Series Logic Analyzer Installation Manual.

The following rules and restrictions must be followed when merging modules:

Only 102 channel and 136 channel modules can be merged.

TLA7Nx modules can be merged together, or with either TLA7Px or TLA7Qx modules.

TLA7Nx, TLA7Px and TLA7Qx modules cannot be merged with TLA7Lx and TLA7Mx modules.

TLA7Axx/TLA7NAx modules cannot be merged with TLA7Nx, TLA7Px, TLA7Qx, TLA7Lx,
or TLA7Mx modules.
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Any combination of TLA7Axx and TLA7NAx modules (up to five) can be merged.

Modules containing different memory depths can be merged but will default to the shallowest memory
depth being used.

The maximum merged combinations are 5 TLA7Axx and TLA7NAx, 3 TLA7Nx/Px/Qx, or 2
TLA7Lx/Mx. The following graphic illustrates how to orient modules in a multiple module merge.

The maximum merged combinations are 5 TLA7Axx and
TLA7NAx, 3 TLA7Nx/Px/Qx, or 2 TLA7Lx/Mx. The graphic
illustrates how to orient modules in a multiple module merge.

The number of channels in the master module must be equal to or greater than the number of channels
in the modules with which it is merged. If there is a second slave module, the first slave must have
greater than or equal to the number of channels in the second slave module. Slave 3 cannot have more
channels than the master, slave 1, or slave 2. Slave 4 cannot have more channels than the master,
slave 1, slave 2, or slave 3.

Modules cannot be merged between a mainframe and an expansion mainframe; merged modules must
be in the same physical mainframe.

To merge a module to an established merged set, the established merged set must first be unmerged
through software. Only unmerged modules can be used to create a merged configuration.

Use the following steps to merge logic analyzer modules.

1. From the System menu, click System Configuration.

2. Click the Merge Modules tab.

3. Click the merge button. The button closes and the module icons become one to indicate that the
modules are merged.

4. Click the OK button

Related Topics
Merge Modules Properties

Calibrating Modules
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Merging LA Modules
Use the following steps to merge logic analyzer modules.

1. From the System menu, click System Configuration.

2. Click the Merge Modules tab.

3. Click the merge button. The button closes and the module icons become one to indicate that the
modules are merged.

4. Click the OK button

Related Topics
Calibrating Modules

Guidelines for Merging Modules
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Saving LA Setups
1. In the System window, click the LA Setup button.

2. From the File menu, click Save Module.

3. Select the folder.

4. Enter the file name if you want a new name.

5. Enter any comments you want to save with the file.

6. Click the option button associated with the save option you want: Save All Data, Save Only
Unsuppressed Data, or Don’t Save Data

7. Click Save.
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Adding LA Channel Groups
1. In the System window, click the LA Setup button.

2. From the Edit menu, select Add Group. The name UserGrp appears under Group Name. To rename
this group by select it and enter a new name.

3. To add a channel to the new group, go to Probe Channels/Names and click the corresponding button for
the channel you want to add.

Clicking a section button listed under Probe adds that section to the group.

TIP. Use the right mouse button when the cursor is in the channel grouping table.
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Adding LA Channels
1. In the System window, click the LA Setup button.

2. Click the Group Name where you want channels added.

3. Click the button under Probe Channels/Names that corresponds to the channel you want to add. For
example, if you want to add channel 6 from section A2, click the button as shown.

TIP. You can add whole sections by clicking the button to the left of the section name.

Related Topic
Setup Window
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Deleting LA Channel Groups
1. In the System window, click the LA Setup button.

2. Click the Group Name you want to delete.

3. From the Edit menu, select Delete Group.

TIP. Use the right mouse button when the cursor is in the channel grouping table.
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Deleting LA Channels
1. In the System window, click the LA Setup button.

2. Click the Group Name where you want channels deleted.

3. Click the button under Probe Channels/Names that corresponds to the channel you want to delete.
When the channel is deleted, the X on the channel button disappears.

NOTE. A dot may appear on the button after you remove the channel. The dot signifies that another channel
group is using that channel.
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Reusing LA Channels
To use a channel in more than one group:

1. In the System window, click the LA Setup button.

2. Click the Group Name where you want to reuse an existing channel.

3. Click the button under Probe Channels/Names that corresponds to the channel you want add to the
group. When the channel is selected, an X appears on the button.

NOTE. Conflicts are possible when groups share channels. Conflicts are noted in the boxes. Conflicts do not prevent
acquisition. Value settings closer to the top of the list override later settings.
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Setting LA Probe Thresholds
1. In the System window, click the LA Setup button.

2. Click the Probes button.

3. Click the Thresholds tab.

4. Click the Threshold box in the table for the probe channels or clock/qualifier channels you want
to change.

5. Go to Threshold and enter or select the new threshold.

NOTE. The selection is determined by what is set in the Presets tab of the Application Options dialog box.

Related Topics
Presets Properties

Probe Thresholds Tab
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Changing LA Channel Polarity
1. In the System window, click the LA Setup button.

2. Click Channel Polarity in the Table Shows box.

3. Click the button under Probe Channels/Names that corresponds to the channel for which you want to
change polarity.
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Setting Up Channels for Negative Logic
1. In the System window, click the LA Setup button.

2. Click Channel Polarity in the Table Shows box.

3. For each channel group or individual probe channel that is connected to negative logic, change the
polarity from plus to minus.
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Setting Up Clocking for Support Packages
1. In the System window, click the LA Setup button.

2. Load your support package as described in Loading Support Packages.

3. Click the More button to open the Custom Options dialog box.

4. Make the selections that are appropriate for your specific support package. Refer to your specific
microprocessor support package manual.

5. Click OK.

. . Advanced Clocking . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Setting Compare Parameters
1. In the System window, click the LA Setup button.

2. In the Table Shows box, located at the bottom of the Setup window, select Channel Compare.

3. Select the channel groups or individual channels to compare.

4. Click the Define Compare button and set the compare parameters.

5. Click OK.

6. Open a Listing or Waveform window.

7. From the Edit menu, click Properties.

8. Select the colors for the compare operation.

9. Click OK.

Related Topics
Adding Reference Data to a Listing Window

Defining Compare Parameters

Viewing Compare Data

. . Advanced Clocking . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Setting Up Analog Multiplexing
1. From the LA Setup window, click the iCapture button. The system responds by displaying the iCapture
Analog Feeds dialog box.
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Module Setup Setting Up Analog Multiplexing

NOTE. Analog multiplexing is available only in TLA7Axx logic analyzer modules.

2. Specify signal routing between the LA module’s ANALOG PROBE OUTPUT connectors and both the
DSO module’s and external oscilloscope’s Analog IN connectors (as applicable).

3. Set up signal routing from the LA probe input channel to the LA module’s ANALOG PROBE
OUTPUT connectors.

4. Click the following links to complete the analog multiplexing setups.

Setting Up System Inter-Probing

Setting Up Analog Feeds

Changing Signal Routing

The following figure depicts the logical process of setting up analog multiplexing.

Establishing a Logical Connection

Use the following procedure to establish a logical connection between your logic analyzer and oscilloscope
from the Setup window.

1. Connect probe from the channels on system under test to the Tektronix Logic Analyzer.

2. Establish logical connections between the logic analyzer and the DSO, using the System Inter-probing
dialog box.

3. Determine which channels to route from the logic analyzer input to the Analog Output, using the
Analog Feeds dialog box.
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Reconfiguring an Existing Logical Connection

Alternately, you can use the following procedures to reconfigure the logical connection between your logic
analyzer and oscilloscope from the Waveform window.

Reconfigure logical connections from the logic analyzer to the oscilloscope:

1. Right-click the waveform label associated with a digital waveform being routed to the oscilloscope.

2. Select Route To DSO from the shortcut menu to display the Route to DSO dialog box.

3. Use the Route to DSO dialog box to modify probe data being sent from the logic analyzer to the
oscilloscope.

Reconfigure logical connections from the oscilloscope to the logic analyzer:

1. Right-click the waveform label associated with an analog waveform being routed from the logic
analyzer.

2. Select Route from LA from the shortcut menu to display the Route from LA dialog box.

3. Use the Route from LA dialog box to modify probe data being sent from the logic analyzer to the
oscilloscope.

How to

How to . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
. . Advanced Clocking . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Acquire

Acquisition Overview

Overview
When you start an acquisition, all modules start acquiring data together. (Exceptions are when one module
has been programmed to arm another or when a module has been turned off.) Modules stop acquiring data
individually, according to their trigger programming.

Starting and Stopping an Acquisition
In the Control bar, click Run to start an acquisition or press the Run/Stop button on the front panel.
The Tek icon on the right animates while the logic analyzer runs. Point at this icon with the mouse to
display a tool tip showing the instrument status.

There are two ways to acquire data: Single-run or Repetitive mode. Within Repetitive mode, you can
specify the following three conditions:
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How to Acquisition Overview

Save Module and Data

Stop if Compare with Reference is Equal or Not Equal

Stop After N Acquisitions

When comparing acquisition data against reference data, you can view the results in either a Listing
window or in a Waveform window.

Single-Run Mode
In Single-run mode, the logic analyzer automatically stops acquiring and displays data when it fulfills the
setup conditions. Use Single-run mode to find and display a specific event.

During acquisition, the logic analyzer monitors the data, looking for the events you specified in the Trigger
windows. When the specified events occur, the logic analyzer responds according to the selections you
made in the Setup and Trigger windows.

Repetitive-Run Mode
In Repetitive-Run mode, the logic analyzer keeps acquiring data until you click Stop or until it fulfills the
stop conditions.

You can use Repetitive-Run mode as follows:

To observe the same waveform or listing for a period of time

To stop after a set number of acquisitions for a period of time and look for differences

After each acquisition you can have the logic analyzer do the following tasks:

Save the system or module setups and data

Export the data to separate files or overwrite the same file

Compare the acquisition data against data in another LA module or a saved LA module file

Open a file or execute a set of defined tasks after the acquisition is complete. For example, you can
execute a command such as sending email or paging you that the logic analyzer has stopped.

Select Repetitive Properties from the System menu to select the different options for the Repetitive mode.

NOTE. You can minimize the time between acquisitions by specifying compare conditions under the LA Setup
window, deleting (not just minimizing) all data windows, and then starting the logic analyzer. When the logic analyzer
fulfills the compare conditions, you can create a new data window with the New Data Window wizard to view the data.

Related Topics
New Data Window Dialog Box

Setup Window

Compare Definition Dialog Box
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Repetitively Acquiring Data

To repetitively acquire data, toggle the arrow button to the right of the Run button.

Click Run. The module acquires data continuously until the stop conditions in the Repetitive dialog box
are met or until you click Stop. Clicking Stop ends the acquisition abruptly.

. . Acquire . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Specifying Multiple Acquisitions
1. From the System menu, click Repetitive Properties.

2. Select the Stop After check box.

3. Enter the number of acquisitions to execute.

4. Click OK.

TIP. Click the button to the right of the Run button to set the repetitive run mode.

To improve the response time of the logic analyzer during repetitive operations, you can delete any
unnecessary data windows. This allows the logic analyzer to spend time on processing data rather than
redrawing data in data windows.

Related Topic
Repetitive Properties Dialog Box

. . Acquire . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Opening a Document or Program after an Acquisition
1. From the System menu, click Repetitive Properties.

2. Select the Open: <Name of program or document> check box.

3. Click the Open button.

4. In the Open dialog box, click the Browse button to locate the document or application you want to open.

5. Specify any arguments and file locations, if needed.

6. Click OK to close the Open dialog box.

7. Click OK.
How to . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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How to Calibrating Modules

Calibrate

Calibrating Modules
1. Save your system before performing calibration. Calibration invalidates acquired data.

2. From the System menu, click Calibration and Diagnostics.

3. Click the Self Calibration tab.

4. Select the module or modules to calibrate.

5. Click Run. Calibration time can take up to several minutes to complete, depending on the type of
modules chosen.

If the calibration fails, refer to the service manual for that particular module or contact your local Tektronix
service center.

Related Topics
Self Calibration Properties

Technical Support
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Calibrating Probes
For a DSO module:

1. In the System window, click the DSO Setup button.

2. Click a channel tab.

3. Attach probes that you want to calibrate to the PROBE COMPENSATION output through a dual-male
BNC adapter and Probe-cal Adapter board.

NOTE. Passive or unknown probes are not calibrated.

1. Click Probe Cal

2. Click Calibrate Chan < n> to calibrate the probe attached to the selected channel.

3. Click Calibrate All to calibrate the probes attached to all channels that can be calibrated.

The channel number and probe calibration status for each probe are displayed in the dialog box.

For an external oscilloscope:

Use the Vertical menu on the external oscilloscope to calibrate the probes.

Related Topic
Viewing Probe Status

How to . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Change the Data Window Display

Developing Custom Color Schemes
1. With the System active, go to the System menu and select Options.

2. Click the Colors tab.

3. Select the element you want to change.

4. Select a color for the element. This will be the default.

5. Click Save Scheme. You must enter a new name; you cannot save changes to a default color scheme.

6. Click OK.

Related Topic
Changing Defaults

How to . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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How to Selecting Channels for the Memory Compare

Comparing Data

Selecting Channels for the Memory Compare
1. In the System window, click the Setup icon.

2. In the Table Shows list, select Channel Compare.

3. Select the channels that you want to compare. You can compare all data channels, specific groups, or
individual channels by selecting the appropriate channels in the Probe Channels/Names table.

Related Topic
Compare Definition Dialog Box

. . Comparing Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Defining Compare Parameters
1. In the System window, click the LA Setup button.

2. Click the Define Compare button.

3. In the Define Compare dialog box, select the Enable Data Compare check box.

4. Select a reference data source from the list, or click Add Data Source to add reference data from a
saved file.

5. Select one of the following compare regions:

Use All Data Possible – Compares the entire acquisition against the reference data.

Partial Data around Ref Begin – Compares a specified number of samples after the beginning
of the reference data.

Partial Data around Ref Trigger – Compares a specified number of samples before or after the
trigger mark in the reference data.

6. Specify the data alignment.

7. Click OK.

. . Comparing Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Comparing Acquired Data with Saved Data
You can use the logic analyzer to compare acquired data against saved reference data. Use the Setup menu
to define the data channels that you want to use during the compare operations. You can further define the
number of samples that you want to compare as well as data alignment offset.
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How to Comparing Acquired Data with Saved Data

In the Listing and Waveform windows, you can use color to quickly identify the compared data. You can
set up one color to show where the acquired data does not equal the reference data. You can use another
color to show where the acquired data equals the reference data.

The following are guidelines for comparing data:

Select the Enable Data Compare check box to enable the memory compare.

Acquisition modules and reference modules must be the same width.

Specify the color of compare data in the Listing window or Waveform window, or use the default colors.

You cannot compare glitch data, disassembler group data, or MagniVu data. You can compare only
the main logic analyzer data.

Although you cannot compare disassembler group data directly, you can compare the raw nondisassembled
data by using the channel groups as defined in the Setup window. To view these channel groups in a
Listing window, use the Add Column toolbar button to add the channel group to the window.

The following figure shows a Listing window during a memory compare operation. Notice that some of
the data appears in a green, indicating that there were differences between the acquired data and the
reference data. Some of the data appears in red which indicates that there was no difference between
acquired data and the reference data.
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Specifying Stop Conditions for Compare Operations
1. From the System menu, click Repetitive Properties.

2. Select the Stop if Compare With Reference is check box.

3. In the associated list, select Equal or Not Equal.

4. Click OK.

NOTE. You must select Enable Compare in the Compare Definition Dialog box to stop the acquisitions when the
compare conditions are met.

TIP. Click the button to the right of the Run button to set the repetitive run mode.

Related Topic
Repetitive Properties Dialog Box
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Viewing Compare Data
1. In the Setup Window, click the Define Compare button.

2. In the Define Compare dialog box, click the Enable Data Compare check box and fill out the remaining
compare parameters. Click OK.

3. In the System Window, click the appropriate Listing or Waveform window icon.

4. From the View menu, click Properties.

5. Click the Listing or Waveform Window tab.

6. Select the color for memory differences (Acq != Ref).

If you want to display that the acquisition data equals the reference data (memory equalities), select
Acq = Ref and the desired color.

7. Click OK.

The compare data (memory differences or equalities) will be highlighted for the region that you specified
in the Compare Definition dialog.

NOTE. You can view compare data without having to reacquire data.

Related Topics
Selecting Channels for the Memory Compare

Compare Definition Dialog box

Defining Reference Data
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Channel Compare Mode

Overview
Use the Channel Compare mode in the Channels/Names table to view which probe channels will be used
during compare operations. Use this mode to set the individual probe channels to use during a compare
operation.

To Use
In the Table Shows box, click Channel Compare. The Probe Channels/Names table uses the following
conventions:

A check mark designator in the channel field indicates the selected channel will be compared against
reference data.

A blank designator in the channel field indicates the channel will not be compared with reference data.

A check mark designator in the group field indicates all channels in the selected probe group will be
compared with reference data.

A * designator in the group field indicates some channels in the selected probe group will be compared
with reference data.

A blank designator in the group field indicates none of the channels in the selected probe group will be
compared with reference data.

Use the Group Compare button to enable or disable the compare settings of all channels in the selected
group (the selected group may contain channels from one or more probes).

Use the All channels button to enable or disable the compare settings of all available channels.

Related Topics
Channel Polarity Mode

Selected Group Mode

Compare Definition Dialog Box
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Channel Polarity Mode

Overview
Use the Channel Polarity Mode to view the current channel polarity settings in the Probe Channels/Names
table. Use this mode to set the polarity of individual channels or of an entire probe.

To Use
From the LA Setup window, in the Table Shows box, click Channel Polarity. The Probe Channels/Names
table uses the following conventions:

A + designator in the channel field indicates no signal inversion. The signal displayed on screen is
the same polarity as the signal at the probe tip.

A – designator in the channel field indicates signal inversion. The signal displayed on screen is inverted
from the polarity of the signal at the probe tip.

A + designator in the group field indicates none of the channels in the selected probe group are inverted.

A – designator in the group field indicates all channels in the selected probe group are inverted.

A * designator in the group field indicates some channels in the selected probe group are inverted,
others are not.

Use the Selected group button to set or invert the polarity of all channels in the selected group (the selected
group may contain channels from one or more probes). Use the All channels button to set or invert the
polarity of all probe channels.

Related Topics
Channel Compare Mode

Selected Group Mode
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Selected Group Mode

Overview
Use the Selected Group mode to view the current channel settings in the Probe Channels/Names table. Use
this mode to add or remove individual probe channels from channel groups.

To Use
From the LA Setup window, in the Table Shows box, click Selected Group. The Probe Channels/Names
table uses the following conventions:

An X in the channel field means the channel is part of the selected channel group.

An * in the channel field means the channel is not part of the currently selected channel group but is a
part of another group.

A blank in the channel field means the channel is not part of any channel group.

An X, *, or blank designator in the group field applies to all channels in the selected probe group.

Related Topics
Channel Compare Mode

Channel Polarity Mode
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Create New Data Window

New Data Windows
The System window contains icons for each data window. You can use the New Window Data dialog
box to create new data windows. Once you create a new data window, the data window icon is displayed
in the System window.

Click in the toolbar and follow the instructions to create a new data window.
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Creating a New Listing Window
You can create a new Listing window that contains no data, data based on the active Listing window, or
data from a specified source.

1. From the Window menu, click New Data Window.

2. Click Listing, and then click the OK button.

3. Select the data source OR click one of the following option buttons:

You can select one ore more data sources, or click Add Data Source to add more saved data sources
to the list.

No data

Same columns/waveforms as active data window

MagniVu columns/waveforms based on the active data window

4. Enter a Window name or use the default.

5. Click Finish.

Related Topic
Opening a Saved Data Window

. . Create New Data Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Creating a Histogram Window that Contains No Data
1. From the Window menu, click New Data Window.

2. Click Histogram and then click Next.

3. Select No data and then click Next.

4. Enter a Window name or use the default.

5. Click Finish.

Related Topic
Opening a Saved Data Window
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Creating a New Histogram Window from a Data Source
1. From the Window menu, click New Data Window.

2. Click Histogram and then click the Next button.

3. Click Data from an LA in the system option button, and then click the Next button.

4. Select an LA module or click Add Data Source to add more saved Logic Analyzer data sources
to the list.

5. Select a group or a counter/timer and click the Next button.

6. Enter a Window name or use the default.

7. Click Finish.

Related Topics
Opening a Saved Data Window

Creating a Histogram Window that Contains No Data

. . Create New Data Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

New Histogram Data Page
Use to specify the data source for the new Histogram window:

1. Click Data from an LA in the system to use data from a currently installed logic analyzer or from a
saved logic analyzer.

2. Click the No data to create an empty Histogram window; you can add the data later.

3. Click Next.
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New Histogram Options Page
Use to select specific data options for the new Histogram window:

1. Select a data source. The data source can be from a logic analyzer or from saved TLA files.

2. Select a channel group or counter/timer from the selected logic analyzer.

3. Click Next.

Related Topic
Data Source Properties

. . Create New Data Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Creating a New Graph window
Use the New Data Window dialog box to create a new graph window. You can create a new Graph
window with data by following the instructions in the dialog box or you can create an empty Graph
window and add data later.

Click to access the New Data Window dialog box from the toolbar in the System window.

Related Topic
New Data Window Dialog Box
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Select Axis Type

Overview
Use this page to specify the X-axis and Y-axis for the empty Graph window.

Behavior
For either axis, you can select one of the following:

Sample Number. Use the drop-down list to select Begin, Trigger, or End.

Row Number. This selection is the same as the Sample Number but does not include any gaps due
to filtering.

Timestamp. Use the drop-down list to select either an Absolute timestamp or the Previous timestamp.

Value of Group. Use the drop-down list to select an Address, Data, or Control group.

The axis label will be the same as the type that you specify from the above list. After you set up the
window, you can use the Graph Window to further define each axis of the graph.

NOTE. Once you have specified the axis type using the wizard, you cannot change the type without creating a
new Graph window.

To Use
Select the axis type and click the Finish button to finish the wizard.

Related Topic
Add Series Dialog Box
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Axis Type Wizard

Overview
Use the Axis Type wizard to add a data series to an empty graph window. The wizard appears when
you click the Add Series toolbar button or select Add Series from the Edit menu in an empty Graph
window. It allows you to select the data source for the Graph window and then specify the X-axis and
Y-axis types for that data source.

In an empty Graph window, click the Add Series toolbar button to start the wizard.
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Creating a New Source Window
Before creating a Source window, be sure to load a microprocessor support package and set up the Listing
window that you will use with the Source window.

1. From the Window menu, click New Data Window.

2. Click Source and then click Next.

3. Select the existing Listing window option and then click Next.

4. Select a Listing Window, Data Source, and Listing Column.

5. Select a loaded symbol file or browse the system for a symbol file to load.

6. Click Next.

7. Enter a Window name or use the default name.

8. Click Finish.

Related Topics
Opening a Saved Data Window

Creating a Source Window without an Existing Listing Window

. . Create New Data Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

New Source Data Page
Use to specify the data for the new Source window:

1. Select An existing Listing window to use data from an existing Listing window.

2. Select the No Listing window to create an empty Source window; you can add the data later.

3. Click Next.
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New Source Options Page
Use to select specific data options for the new Source window:

1. Select a Listing window, data source, and listing column. The Source window will use the data from
these selections.

2. Select a symbol file to use.

3. Click Next.

Related Topic
Source Data Properties
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Creating a Source Window without an Existing Listing Window
1. From the Window menu, click New Data Window.

2. Click Source and then click Next.

3. Select the No Listing Window option and then click Next.

4. Enter a Window name or use the default name.

5. Click Finish.

Related Topic
Opening a Saved Data Window
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Creating a New Waveform Window from a Data Source
1. From the Window menu, click New Data Window.

2. Select Waveform and then click Next.

3. Select one or more of the listed data sources, or click Add Data Source to add more saved data sources
to the list.

4. Click Next.

5. Enter a Window name or use the default name.

6. Click Finish.

Related Topics
Opening a Saved Data Window

Creating a Waveform Window that Contains No Data

Creating a New Waveform Window that Contains Data Based on the Active Window
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Creating a New Waveform Window that Contains Data Based on the
Active Window

1. In the System window, click a Waveform window icon.

2. From the Window menu, click New Data Window.

3. Select Waveform and then click Next.

4. Select the Same columns/waveforms as active data window option or, if you want MagniVu data of
the active window, click the MagniVu columns/waveforms based on the active data window option.
Then click Next.

5. Enter a Window name or use the default name.

6. Click Finish.

Related Topics
Opening a Saved Data Window

Creating a Waveform Window that Contains No Data
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Creating a Waveform Window that Contains No Data
1. From the Window menu, click New Data Window.

2. Select Waveform and then click Next.

3. Select the No data option and then click Next.

4. Enter a Window name or use the default name.

5. Click Finish.

Related Topics
Opening a Saved Data Window

Creating a New Waveform Window that Contains Data Based on the Active Window
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Display Analog Data

Setting Up Analog Feeds
Analog feeds functionality allows you to assign multiple digital signals to the DSO using multiple analog
channel outputs. You can access the iCapture Analog Feeds dialog box from the LA Setup window by
clicking the iCapture button.

NOTE. Analog feeds functionality is only available in TLA7Axx logic analyzer modules.

Use the following procedure to set up this functionality from the iCapture Analog Feeds dialog box.

1. Select the LA module containing digital signals that you want to route to a DSO from the Physical
Module list box.

2. Select an analog output attenuation level.

3. From the Select Channels list box, choose a method of displaying channels: By Group - lists channel
groups as defined in the setup window. By Probe - lists channels by the probe name. By Name -
alphabetically lists channels by their name.

4. Select the digital signals that you want to route through analog channel outputs to the DSO.

5. Select the check boxes associated with the analog channel outputs, located under Analog Feed Cycling.

6. Click a button in the Analog Feed Cycling group box to assign the selected signals to the selected
channel outputs, in groups equal to the number of channel outputs selected.

7. Optionally select the check box labeled Exclude channels assigned to unchecked outputs.

8. Click the System Inter-probing button to display the System inter-probing dialog and select the DSO
inputs to which the signals will be routed.

Related Topics
Setting Up System Inter-Probing

Changing Signal Routing

Analog Feeds
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Setting Up System Inter-Probing
Only TLA7Axx modules, DSO modules, and external oscilloscopes can be displayed in the System
Inter-probing dialog box. If a TLA7Axx module and either a DSO module or external oscilloscope exist
but none are available, the dialog box can still be opened but is empty.

1. From the System menu, click System Inter-probing to display the System Inter-probing dialog box.

2. Click an LA, DSO or external oscilloscope channel button to begin the inter-probing connection. The
system responds by changing the cursor to the shape of a probe connector.

3. Click a channel button corresponding to the physical connection at the opposite end of the probe to
establish the probe connection. Upon establishing an inter-probing connection, the cursor changes
back to its normal shape.

NOTE. If you click the mouse anywhere other than on a legal endpoint for the connection, no connection is made and
the cursor changes back to its normal shape.

4. Repeat steps 1 and 2 for each LA module-to-DSO module or external oscilloscope physical connection
that you want to specify.

TIP. To remove an inter-probing connection, click one of its endpoints or use the Delete button.

You can use the Clear All button to remove all probe connections simultaneously.
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Routing a Signal from a Logic Analyzer Output Channel
1. From the Waveform window, right-click the waveform label associated with the oscilloscope to which
you want to route the digital signal.

2. In the context menu, click Route from LA. The Route from LA dialog box displays.

3. Click the Select Channel button. The Select Channel dialog box displays.

NOTE. The Select Channel button is disabled when you have not previously setup logical system inter-probing
connections. To perform this setup, click the System Inter-probing button.

4. Select a method of displaying channels.

5. Choose the channel on which the digital signal will be routed to the oscilloscope.

Related Topic
Routing a Signal to an Oscilloscope Input Channel

Setting Up System Inter-Probing
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Routing a Signal to an Oscilloscope Input Channel
1. From the Waveform window, right-click the waveform label associated with the logic analyzer module
from which you want to route the digital signal.

2. In the context menu, click Route to DSO. The Route to DSO dialog box displays.

3. Select the logic analyzer channel that you want to send to the oscilloscope.

NOTE. No logic analyzer channels display in the Route to DSO dialog box until you set up logical system inter-probing
connections. To perform this setup, click the System Inter-probing button.

4. When you want to add a new waveform to the waveform window containing the rerouted LA channel,
select the check box labeled Add waveform to view.

Related Topic
Routing a Signal from a Logic Analyzer Output Channel

Setting Up System Inter-Probing
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Changing Signal Routing
Use the following procedure to change digital signal routing from either a DSO channel input or a logic
analyzer channel output that is displayed on the Waveform window.

Routing from the LA
1. Right-click the label of the DSO channel waveform.

2. From the context menu, click Route from LA. The Route from LA dialog box displays.

3. Click the Select Channel button. The Select Channel dialog box displays.

NOTE. The Select Channel button is disabled when you have not previously setup logical system inter-probing
connections. To perform this setup, click the System Inter-probing button.

4. Select a method of displaying channels.

5. Choose the channel on which the digital signal will be routed to the DSO.

Routing to the DSO
1. Right-click the label of the LA channel waveform.

2. From the context menu, click Route to DSO. The Route to DSO dialog box displays.

3. Click the Select Channel button. The Select Channel dialog box displays.

NOTE. The Select Channel button is disabled when you have not previously setup logical system inter-probing
connections. To perform this setup, click the System Inter-probing button.

4. Select a method of displaying channels.

5. Choose the channel on which the digital signal will be routed to the DSO.

Related Topics
Setting Up System Inter-Probing

Setting Up Analog Feeds
How to . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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Edit

Edit Protocol Files
1. To open a protocol for editing from the Stack Definition pane, do one of the following:

Double-click the protocol you want to edit. The protocol is displayed in the Protocol Editor pane.

From the Protocol Editor pane select the File menu, and then select Open Protocol.

2. Type your changes directly in the Protocol Editor pane.

TIP. Use the Replace function to help you locate and replace text.

1. From the Protocol Editor pane, select the Edit menu and then select Replace…. The Replace dialog
box opens.

2. Type the text you want to change in the Find What text box.

3. Type the new text in the Replace with text box.

4. If the text is case sensitive, select the Match case check box.

5. Click Replace to replace the next instance of the text in the Find What text box with the new text in
the Replace text box. Click Replace All to replace all instances. Click Find Next to find the next
instance but not replace the text.
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Editing the Protocol Window Properties
Follow these steps to edit the Protocol Window Properties:

1. Place the cursor in the Protocol window and click View > Properties to display the Protocol Properties
dialog box.

2. Click the About Data tab to view the current data source information.

3. Click the Protocol window tab to adjust the display settings of the Protocol window.

4. Click the Column tab to adjust the column settings in the Packet view.

5. Click the Color tab to adjust the color settings in the Decode View.

6. Click the Marks tab to adjust the properties for the marks that you placed.

7. Click the Framer options tab to set the port address and packet identifier for framing the packets.

8. Click OK.

Related Topic
Protocol Window Properties
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Edit Relations Between Protocols
1. In the Stack Definition pane, right-click the protocol for which you want to edit the relations. The
Protocol shortcut menu appears.

2. From the Protocol shortcut menu, select Define Relations. The Protocol Setup dialog box appears,
displaying the Relations tab.

3. To remove any protocol from the Current Relations list, select the protocol, and then click the Remove
button.

4. To add any protocol to the Current Relations list, select the protocol you want to add from the Available
Protocols, and then click the Add button.

5. Click Up or Down to determine the order of the relations, and then click OK.

6. If you specify the Type of Relation as Single Parameter or Raw Data, enter hexadecimal values
preceded by 0x or binary values preceded by 0b. For example, to enter the 3 in hexadecimal, enter
0x3; to enter it in binary, enter 0b0011.
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Edit Stack Files
1. To open an existing stack file, select Open Stack from the File menu.

2. In the Open dialog box, select the stack to open and click OK.

3. To see how to edit the stack files, click the following links:

To Replace a Protocol from the Stack

To Remove a Protocol in the Stack

To Define a Protocol in the Stack

To Modify Relations Between the Protocols in the Stack
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Editing a Tool on the Tools Menu
1. From the System menu, click Options and then click the Tools tab.

2. In the User-Defined Tools box, select the tool that you want to edit.

3. Perform one or more of the following actions:

To move the tool up one position in the menu, choose the Move Up button.

To move the tool down one position in the menu, choose the Move Down button.

To change the menu text, command line (tool path and file name), command-line arguments, or the
initial directory, click the Edit button and then type the new information in the appropriate text box.

To specify a letter in the menu title as an accelerator key, precede that letter in the Menu Name box
with an ampersand. The first letter in the title is the accelerator key by default.

Related Topics
Removing a Tool from the Tools Menu

Adding a Tool to the Tools Menu
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Removing a Tool from the Tools Menu
To remove a tool from the Tools menu:

1. From the System menu click Options, and then click the Tools tab.

2. In the User-Defined Tools box, select the tool you want to delete and click the Delete button.

Related Topics
Editing a Tool on the Tools Menu

Adding a Tool to the Tools Menu
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Editing File Suffixes for the Source Window
1. In the System window, click the Source data window icon.

2. From the View menu, click Properties.

3. Click the Source Files tab.

4. Select Suffix List.

5. Select the file suffix that you want to change.

6. Click Edit.

7. Enter a new file suffix.

8. Click OK.

TIP. Click Save settings as application defaults to save the settings.

Click in the Source window to open the Properties dialog box.

Related Topics
Creating a New Source Window

Source Files Properties
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Editing Search Paths for the Source Window
1. In the System window, click the Source data window icon.

2. From the View menu, click Properties.

3. Click the Source Files tab.

4. Click the Search Path List option button.

5. Choose the search path you want to change.

6. Click Edit.

7. Enter a new search path or click Browse to define a new path to the source file.

8. Click OK.

TIP. Click Save settings as application defaults to save the settings.

Click in the Source window to open the Properties dialog box.

Related Topics
Creating a New Source Window

Source Files Properties
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Editing Symbol Files
You can edit any symbol file supplied by the support package. It is best to make a copy of the file and
then edit the copy.

NOTE. Do not change channel assignments. If you do so, the disassembler may not function correctly.

Most support packages provide two types of ASCII symbol files: pattern and range. Make a copy of the
type you need and edit it using an editor.

NOTE. Save the symbol file as ASCII. If saved in any other format, the symbol file cannot be used.

Related Topics
Symbol Tables

Color Properties
How to . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Export

Exporting Data from a Protocol Window
Follow these steps to export data from Protocol window

1. Place the cursor in the Protocol window, and select Export… from the Data menu to display the Export
Data dialog box.

2. In the Export Data dialog box, specify the file name and location that you want to export data to.

3. Under Export Range, select either Packet View or Decode View, and then select the export range.

4. If you want to include the Hex View, select the Append Hex View check box.

5. If you selected Packet View, you must also select the export options, including the delimiters you
want to use.

6. Click Save.

Related Topic
Export Data Dialog Box

114



How to Exporting Data from a Listing Window

. . Export . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Exporting Data from a Listing Window
1. In the System window, click the Listing window icon.

2. From the File menu, click Export Data.

3. In the Export Data dialog box, select the folder you want to export data into.

4. Enter a name for the exported file.

5. Click Options to specify the format options.

6. Select one of the Export ranges.

7. Click Save.

NOTE. Use a Tab or Semicolon as a delimiter when exporting data from a Listing window. If a Space or Comma is
chosen as a delimiter, the timestamp values are erroneously exported from the Listing window in picoseconds
without units.

Related Topics
Printing a Window

Printing a Source Window
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Exporting Histogram Data
1. In the System window, click the Histogram data window icon.

2. From the File menu, select Export Histogram.

3. In the Export Data dialog box, select the folder you want to export data into.

4. Enter a name for the exported file.

5. Determine how many rows of data you want to export and click the appropriate button.

6. Click Save.

NOTE. Click Options to change the field delimiters or to change how the bounds will be exported.
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How to Loading a Saved System

Load Setups and Systems

Loading a Saved System
1. From the File menu, click Load System.

2. Navigate to the directory where you saved your system.

3. Select the file and click Open.

NOTE. The saved system must exactly match the current system in order for all parts of the system to load. If the
saved system does not match, you can load parts of the saved system using the Load System Options dialog box.

The current version of software can load files saved under older versions of software.

Related Topics
Saving a System

Load System Options Dialog Box

. . Load Setups and Systems . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Loading Portions of a Saved System
1. From the File menu, click Load System.

2. Navigate to the folder where the saved file is located.

3. Click Options. The Load System Options dialog box opens.

4. Click a Saved System module and drag the module to a compatible module in the current system.
Reference data sources and data windows in the saved system load automatically.

NOTE. The icon itself will not drag. The cursor will change to a drag cursor. If you attempt to drag a saved module
to an incompatible current module the cursor changes to a no drop shape.

5. Click OK.

Related Topic
Open Options
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Loading a Saved Module
1. From the System window, click the Setup or Trigger button of the destination module.

2. From the File menu, click Load Module.

3. Navigate to the directory where you saved your file.

4. Select the file name and click Open.

5. Select the module you want to load in the Load Module dialog box.

6. Click Load.
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Adding a Data Source to an Active Listing Window
1. In the System window, click the appropriate data window icon.

2. From the Edit menu, click Add Column.

3. Select the Data Source or click Add Data Source if the source is not listed.

4. Select the columns and click Add.

5. Click Close.

TIP. Click to open the dialog box.
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Loading an LA Module with Saved Trigger Settings
1. In the System window, click the LA Trigger button.

2. Click the button, located in the trigger toolbar.

3. From the Load LA Trigger dialog box, click the Browse button to search for the trigger file. Then click
a filename from the displayed file listing to show all modules in the selected file.

NOTE. Alternatively, you can enter the path name to the desired trigger program.

4. Click the Open button to select the file. The Load LA Trigger dialog box lists the modules included in
the saved file. You can select only the module that contains the LA trigger settings.

5. Click Load.
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How to Loading an LA Module with Saved Trigger Settings

When a trigger program is not compatible with the current setup (for example, different groups), perform
the following adjustments, when necessary:

Groups that are used in group events are matched by name. If a match cannot be found, the event
defaults to the first available group.

Restored values are left-truncated or left-extended with don’t cares (XXXX ….) for word events;
left-extended with zeros for range events.

Channels used in channel events are matched by name. If a match cannot be found, the events are
matched by probe name. If a match is still not found, the trigger event defaults to the first available
channel.

Restore event values that are set by group (for example, Setup & Hold or Word events) by matching
groups by name. Groups in the current module that are not found in the trigger program being loaded
are assigned default settings. Settings for groups not defined in the current module are discarded.

The Arm Module actions that cannot be present because of target module conflicts are changed to
Do Nothing actions.

Word event definitions are merged with existing word event definitions. If word event definitions
have the same names as the current word event definitions then the new definitions will replace the
previous ones.

Channel groups in word events are matched by name. The restored values are left truncated or left
extended with don’t care values.

Channel groups in word events in the current module, that are not found in the trigger program being
loaded, are assigned default don’t care values.

Settings for channel groups in word events not defined in the current module are discarded.

Transition event definitions are merged with existing transition event definitions. If transition event
definitions have the same names as the current transition event definitions, then the new definitions
will replace the previous ones.

Channel groups in transition events in the current module, that are not found in the trigger program
being loaded, are enabled by default.

Settings for channel groups in transition events that are not defined in the current module are discarded.
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How to Adding MagniVu Data to a Listing or Waveform Window
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Adding MagniVu Data to a Listing or Waveform Window
1. In the System window, click the appropriate data window icon.

2. From the toolbar, click (the Add Column icon) or (the Add Waveform icon).

3. From the Data Source list, click MagniVu. If the source you want is not listed, click Add Data Source
and add the one you want to the list.

4. Select the required columns or waveforms.

5. Click Add. The column or waveform appears in the data window.

6. Click Close.

TIP. To quickly display MagniVu data, click in the data window. Click the button again to remove the
MagniVu data from the window.
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Loading Source Code Symbol Information
1. In the System window, click the Source data window icon.

2. From the Edit menu, click Properties.

3. Click the Data properties tab.

4. Click the Symbol File button to locate a symbol file in the file system.

5. Choose the symbol file.

6. Verify that the file information in the File Contents box shows that the Type is Range.

7. Click Open.

8. Click OK.

The new symbol file with source code is loaded in the Source window.

TIP. Click in the Source window to open the Properties dialog box.

You can also load the symbol file from the Symbols dialog box, which is accessible from the System menu.
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How to Loading Filters
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Loading Filters
1. Click the Filters button in the LA Setup window to open the Filter Definitions dialog box.

2. Click the button to open the Load Filter dialog box.

3. Enter a file name and path in the File Name box for the LA module or system setup that contain the
filters that you want to load. You can also click Browse to browse the file system.

4. Select the filter from the Load Filter dialog box.

5. Click the load button to load the filter to the LA module.
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Navigate in Data Windows

Moving to a Mark (Go To)
1. In the System window, click a Waveform or Listing window icon to open the window.

2. From the Edit menu, click Go To.

3. In the Go To dialog box, select the Mark option.

4. Select the mark from the available list.

5. Click OK.

Related Topics
Changing Mark Properties

Adding a Mark to a Data Window

Moving Marks

. . Navigate in Data Windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Modifying the Location of Cursors Using the Overview Markbar
1. In the System window, click a waveform or listing icon.

2. Click the cursor handle (in the data area mark bar or the overview mark bar) and drag the mark to
the new location.

Related Topics
Adding a Mark to a Data Window

Sending Stacked Marks to the Back
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How to Changing the Position of Cursors
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Changing the Position of Cursors
1. In the System window, click the Waveform or Listing window icon.

2. Click the cursor handle (in the data area mark bar or the overview mark bar) and drag the cursor to
the new location.

Alternate Method
1. In the System window, click a Waveform or Listing window icon.

2. From the View menu, click Cursor Toolbar if the cursor toolbar is not displayed.

3. Enter the cursor position using either the C1: or C2: cursor spin box.

Related Topics
Changing Mark Properties

Adding a Mark to a Data Window

Moving Marks

Sending Stacked Marks to the Back
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Print

Print Dialog Box
Use to print the current active window. You can print hard copies of the current data windows and
setup windows. Depending on the window, you can specify the print range and the number of copies.
You can also print to a file.

When printing Listing, Source, and Waveform windows, you can print data between two marks, such as
the trigger point and one of the data cursors. You can cancel printing at any time by pressing the ESC key.

From the File menu, click Print.

Related Topics
Exporting Data from a Listing Window

Exporting Histogram Data

121



How to Printing a Window
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Printing a Window
1. Go to the window that you want to print.

2. Go to the File menu and select Print.

3. Select a print range. The available options depend on the window that you want to print.

4. Click OK.

5. Click OK again to confirm.

To interrupt printing, press ESC. This will print the current active window.

Related Topics
Exporting Data from a Listing Window

Exporting Histogram Data
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Printing a Source Window
1. In the System window, click the Source data window icon.

2. From the File menu, click Print.

3. Select a print range. The available options depend on the window that you want to print.

4. Click OK.

5. Click OK again to confirm.

To interrupt printing, press ESC.

Related Topics
Exporting Data from a Listing Window

Creating a New Source Window
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How to Save Dialog Box

Save

Save Dialog Box
Use to save the system or a logic analyzer module to a file. A system file includes the setup information,
the trigger program, and acquired data from all modules (if you select Save Acquired Data). It also
includes all data windows and any links to data sources that were added.

A saved logic analyzer module file includes the setup information, the trigger program, and acquired data
from the current logic analyzer (if you select Save Acquired Data).

Saved system and module file names have a .tla file name extension. The initial default location for
saved files is C:\My Documents.

To open the Save dialog box from the File menu, click either Save System As or Save Module As.

Related Topics
Loading a Saved System

Loading a Saved Module

Loading an LA Module with Saved Trigger Settings
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Saving a System
You can save system setups to a saved system file

Go to the File menu and click Save System.

To save a system and change the name, do the following:

1. From the File menu, click Save System As.

2. Navigate to the directory where you want to save the system.

3. Go to File Name and enter the name you want.

4. Enter any comments you want to include.

5. Select the Save all Acquired Data option if you want the data (including measurement statistics)
to be included with the file.

6. Click Save.

Saved System File
A saved system file contains the setup and trigger program information needed to automatically
set up the logic analyzer with all installed modules. This file can also contain acquired data from
the modules.
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How to Saving a Module
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Saving a Module
Click a module icon in the System window, then go to the File menu and click Save Module.

To save a module and change the name, do the following:

1. From the File menu, click Save Module As.

2. Navigate to the directory where you want to save the module.

3. Go to File Name and enter the name you want.

4. Enter any comments you want to include.

5. Select the Save all Acquired Data option if you want the data to be included with the file.

6. Click Save.
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Saving Repetitive Acquisition Data
1. From the System menu, click Repetitive Properties.

2. Select the Save check box.

3. In the list associated with the Save check box, select Export Data.

4. In the From list, select a data window (this selection is only available with Export Data).

5. Enter a file name or click Browse to specify the location and file name.

6. Select whether to overwrite the existing file or to create a new file for each acquisition.

7. Click OK to close the dialog box and save your settings.

The data will be saved in an ASCII file with the .txt extension under the specified file name.

TIP. Click the button to the right of the Run button to set the repetitive run mode.

Related Topic
Repetitive Properties Dialog Box
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How to Saving Repetitive Module Setups and Data
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Saving Repetitive Module Setups and Data
1. From the System menu, click Repetitive Properties.

2. Select the Save check box.

3. In the list associated with the Save check box, select Save Module and Data.

4. In the From list, select a module.

5. Enter a file name or click Browse and specify the location and file name.

6. Select whether to overwrite the existing file or to create a new file for each acquisition.

7. Click OK to close the dialog box and save your settings.

To improve the response time of the logic analyzer during repetitive operations, you can delete any
unnecessary data windows. This allows the logic analyzer to spend time on processing data rather than
redrawing data in data windows.

Related Topic
Repetitive Properties Dialog Box
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Saving Repetitive System Setups and Data
1. From the System menu, click Repetitive Properties.

2. Select the Save check box.

3. In the list associated with the Save check box, select Save System and Data.

4. Enter a file name or click Browse and specify the location and file name.

5. Select whether to overwrite the existing file or to create a new file for each acquisition.

6. Click OK to close the dialog box and save your settings.

To improve the response time of the logic analyzer during repetitive operations, you can delete any
unnecessary data windows. This allows the logic analyzer to spend time on processing data rather than
redrawing data in data windows.

Related Topic
Repetitive Properties Dialog Box
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How to Setting the Search Options

Search

Setting the Search Options
The Search Options dialog box defines the action that you want the logic analyzer to take when the
search is successful. Access the Search Options dialog box from the Search Options… button in the
Define Search dialog box.

To create a new mark upon a successful search:

1. Select the Create new mark at point found check box.

2. Use the existing Mark Name Prefix or enter a new one in the Mark Name Prefix text box.

NOTE. When a new mark is created, the Mark Name Prefix and a numeric suffix are appended to the mark to
ensure that the new mark is unique.

126



How to Searching for Specifics in a Listing or Waveform Window
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Searching for Specifics in a Listing or Waveform Window
1. In the System window, click the appropriate data window icon.

2. From the Data menu, click Define Search, and then select Search.

3. From the Search Definition drop-down list, select a saved search definition from the selected data
window or type in a new search name.

NOTE. To add a search definition from another data source, click the Load button to open the Load Search dialog box.

4. Click Start from the drop-down list to select where you want to start searching and enter the number of
occurrences to find in the occurrence text box.

5. Click the Search Options… button to open the Search Options dialog box and select what action you
want the logic analyzer to take when the search is successful.

6. Type a Description of the search.

7. From the Search drop-down list, select the data source.

8. Use the drop-down lists under Find to select the criteria for which you want to search.

9. Right-click in the Search event area to open a context menu where you can cut, copy, or paste events.

NOTE. You can add and delete sources and enable or disable searches with the short cut edit menu.

10.Click either the Search Fwd or Search Back button. The first occurrence is marked according to
how the Search Options are set up.

TIP. Click to open the dialog box.

Related Topic
Searching for Source Data
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How to Scan Listing Mode
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Scan Listing Mode

Overview
The Scan Listing box is used to specify which direction to search in a Listing window when you move the
cursor in the Source window.

Behavior
The following options for the Scan Listing field are available:

Later – The Listing window scans samples executed after the sample identified by the active cursor.

Earlier – The Listing window scans samples executed before the sample identified by the active cursor.

Ask – When you change the position of the active cursor in the Source window, the Scan Listing dialog
appears and prompts you to specify the scan direction.

Auto – The Source window automatically selects the scan direction in the Listing window. The scan
direction is based on the relative position of the new and old cursor.

Moving the cursor between statements in the Source window does not necessarily move the cursor in the
same direction in the Listing window. This can happen, for example, if the statement in the new location
was executed both before and after the statement in the old location, such as when the statement is in a loop.
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How to Searching for Source Data
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Searching for Source Data
In the System window, click the Source data window icon.

1. From the Data menu, click Define Search.

2. Click either All Files to search all files identified by the symbol file, or select This File to search
the current file.

3. Enter a text pattern.

4. Click Search Fwd or Search Back. The first occurrence is marked by the active cursor.

NOTE. You can search for any text pattern including leading and embedded white space; trailing white space is
ignored.

The search operation follows the order of files as listed in the Source File properties tab. When you search
for data in all files, and one or more of the files cannot be found, the Source File Locator dialog box
displays, asking you to specify the file location.

If the search is not completed in a set amount of time, the Search Progress dialog box shows the status of
the search. You can let the search continue, or you can click Abort to stop the search.

TIP. Click to open the dialog box.

You can copy text to use as a search pattern from the Source window and paste it into the Source Window Search
Definition dialog box.

Related Topics
Searching for Specifics in a Listing or Waveform Window

Creating a New Source Window
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How to Adding Search Paths for the Source Window
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Adding Search Paths for the Source Window
1. In the System window, click the Source data window icon.

2. From the View menu, click Properties.

3. Click the Source Files tab.

4. Click the Search Path List option button.

5. Click Add.

6. Enter a search path or click Browse to define a path to the source file.

7. Click OK.

TIP. Click Save settings as application defaults to save the settings.

Click in the Source window to open the Properties dialog box.

Related Topics
Creating a New Source Window

Source Files Properties
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How to Searching in the Protocol Window
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Searching in the Protocol Window
Follow these steps to search for a data packet or a message pertaining to the packet:

1. Place the cursor in the Protocol window and click Data > Define Search to display the Search dialog box.

2. Select a protocol from a list of protocols. Use the drop-down list to select a protocol.

3. Select the fields to search from the Fields text box.

4. Select operation used to compare field values from the Operation group box.

5. Specify the value and the format for the selected field. The packets that have the specified values
are searched for in the Packet View.

6. Select either the << Back or Forward >> button to search before or after the current cursor position.

7. Clear the Enable Fields selection to search the packets based on the selected protocol.

Related Topic
Protocol Search Dialog Box
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Set Properties

Changing Data Window Properties
1. From the System window, click the appropriate data window icon.

2. From the View menu, click Properties.

3. Click a tab in the system Properties dialog box.

4. Enter the desired property changes.

5. Click OK.

TIP. Click in the data window to open the Properties dialog box.
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How to Setting the Waveform Style
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Setting the Waveform Style
1. In the System window, click the Waveform window icon.

2. Double-click the label of the LA waveform whose options you want to set.

NOTE. The Options selection is not available if you select a waveform with only one channel.

3. Click Options.

4. To display LA waveforms as a busform, click Busform.

5. To display LA waveforms as magnitude waveforms, click Magnitude.

6. If you selected Magnitude, select whether you want acquisition data interpreted as signed data.

NOTE. When you want to interpret the LA waveform as signed data, make sure you select a radix, such as signed
decimal, so that the readouts will display the correct information.

Related Topics
Setting Waveform Options

Setting the Waveform Limits

Showing Waveform Readouts
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How to Setting the Waveform Limits
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Setting the Waveform Limits
1. In the System window, click a Waveform window icon.

2. Double-click the label of the waveform whose options you want to set.

3. Click Options.

4. If you want the waveform limits locked to the DSO setup, click Lock to Setup.

5. If Lock to Setup is not checked, set the maximum and minimum value to display in the waveform.

The Max and Min values correspond to the top and bottom of the waveform range.

Related Topics
Setting Waveform Options

Setting the Waveform Style

Showing Waveform Readouts
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Determining the Data Source of the Selected Waveform
1. In the System window, click a Waveform window icon.

2. Double-click the label of the waveform about which you want to view attributes.

3. If not selected, select the waveform you want to change from the waveform list.

4. View the source of the waveform from the Source field, which is located in the upper-left corner
of the Waveform tab.

5. Click Cancel.

Source is only available when a single waveform is selected.

Related Topics
Changing Waveform Appearance

Changing the Height of a Waveform

Selecting the Radix of Busform Readouts

Changing the Color of the Selected Waveform

Controlling Whether a Waveform is Visible
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Selecting the Radix of Busform Readouts
1. In the System window, click a Waveform window icon.

2. Double-click the label of the waveform whose attributes you want to change.

3. If not selected, select from the Waveform list the waveform you want to change.

4. From the Radix list, select the waveform radix.

5. Click OK.

Related Topics
Changing Waveform Appearance

Changing the Height of a Waveform

Determining the Data Source of the Selected Waveform

Controlling Whether a Waveform is Visible

134



How to Changing the Zoom Options
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Changing the Zoom Options
You can change the zoom options by changing the system preferences.

To change the zoom options, select Options from the System menu. Under the Preference tab, click the
Click & Drag Zoom option to display a drop-down list with the following selections:

Zoom Immediately

Show Context Menu

Show Rectangle Only

Zoom Immediately
This is the default setting. To zoom data in a Waveform window, click and drag the mouse over the area
that you want to zoom. The window will automatically zoom after you release the mouse button. If you
click and drag from the left to the right, the window zooms to the selection. If you click and drag from the
right to the left, the window repeats the previous zoom operation.

When you zoom data in a Listing window, a context menu appears after you click and drag the mouse.
The context menu gives several choices where you can copy text, bitmaps, move cursors to the edge of
the rectangle, show, or suppress data.

Show Context Menu
Use this setting to show the context menu as soon as you click and drag the mouse over the zoom area.
Select one of the choices from the context menu.

Show Rectangle Only
Use this setting to draw a rectangle by clicking and dragging the mouse. You can then resize the rectangle
so that you can focus on the data of interest. Right-click the mouse to display a context menu with several
options for handling the data inside the rectangle.

NOTE. You cannot suppress or show oscilloscope data. The Suppress and show selections only function for logic
analyzer data.
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Setting the Default Trigger Tab
1. From the System menu, click Options to display the Options dialog box.

2. Click the Defaults tab.

3. Click the Trigger Window Style field and then select the desired trigger tab from the list box.
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Changing Column Properties
1. In the System window, click the Listing window icon.

2. From the View menu, click Properties.

3. From the Properties dialog box, click the Column tab.

4. Select the column whose properties you want to change.

5. Change the properties as desired.

6. Click OK.

TIP. Click to open the Properties dialog box.

Double-click the Column label to open the column tab.

Column Label
The column label is located at the top of the column. For example: Address.
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Changing Mark Properties
1. From the System window, click the appropriate data window icon.

2. From the View menu, click Properties.

3. Click the Marks Properties tab.

4. From the Mark list, select a mark and change the desired property.

5. Click OK.

TIP. You can also double-click the mark to open the Properties dialog box and display the Marks tab with the
particular mark selected.

In the data window click to open the Properties dialog box.
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Changing Properties for the Listing Window
1. In the System window, click the Listing window icon.

2. From the View menu, click Properties.

3. From the Properties dialog box, click the Listing Window tab.

4. Change properties as desired.

5. Click OK.

TIP. Click to open the properties dialog box.

Click the right mouse button when the pointer is in the data area and select properties.
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Changing the Start-Up Default Settings
1. From the System menu, click Options.

2. Click the Defaults tab.

3. Click the option and change the setting.

4. Click OK.

The settings here are used as defaults when creating a new data window.
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Adding File Suffixes for the Source Window
1. In the System window, click the Source data window icon.

2. From the View menu, click Properties.

3. Click the Source Files tab.

4. Select the Suffix List option.

5. Click Add.

6. Enter a file suffix.

7. Click OK.

TIP. Click Save settings as application defaults to save the settings.

Click in the Source window to open the Properties dialog box.

Related Topics
Creating a New Source Window

Source Files Properties
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Changing the Color of a Graph Mark
1. In the System window, click the Graph data window icon.

2. Double-click the mark that you want to change to open the Marks property page.

3. Click the Color button and select a new color.

4. Click OK.
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Changing the Data Series Range
1. In the System window, click the Graph data window icon.

2. Click in the toolbar of the Graph window to open the Graph window property pages.

3. Click the Series Data tab.

4. Enter new values for the minimum and maximum data range setting for each axis.

5. Click OK.
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Changing the Graph Drawing Style
1. In the System window, click the Graph data window icon.

2. Click in the toolbar of the Graph window to open the Graph window property page.

3. Click the Series Format tab.

4. Select the series type.

5. Use the drop-down lists in the Line section of the property page to change the line style, color, and
thickness. Use the drop-down lists in the Data Points area of the property page to change the data
point style, color, and thickness. The graphic in the property page provides a brief example of what
your changes will look like.

6. Click OK to close the property page.
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Changing the Graph Window Properties
1. In the System window, click the Graph data window icon.

2. Click in the toolbar of the Graph window to open the Graph window property pages.

3. Click the Graph Window tab.

4. Make the changes that you want to the:

Graticule

Select Show Graticule check box. You can set the color, style, and thickness using the drop-down
lists. If you want to hide the graticule, clear the Show Graticule check box.

X and Y axis

Enter new values for the minimum and maximum data range setting for each axis. If desired, enter
an new label for each axis.

Axis readout

Select the Show Readout check box. Select the color for the readout from the Color drop-down
list. If you do not want the readout to display, clear the Show Readout check box.

Background color

Click the Background color button at the bottom of the property sheet and select a background
color.

5. Click OK.
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PG Run Properties Dialog Box
The Pattern Generator Run Properties dialog box selections determine if the TLA Start button will start
and stop the pattern generator (PG) modules.

The When the TLA Runs list box selections are:

Ignore PG. Do not start or stop the pattern generator modules.

Start PG after TLA. When the TLA start button is pressed the LA modules will start before the
pattern generator modules.

Start PG before TLA.When the TLA start button is pressed the pattern generator modules will
start before the LA modules.

The two check box options are:

Stop PG when TLA stops. When this box is checked the pattern generator modules will be forced to
stop after all LA modules are finished acquiring data.

If this box is not checked the system will wait for all LA and PG modules to complete before indicating
that the system (PG and LA modules) are stopped.

If repetitive run, restart at each iteration. Normally the pattern generator will run once and stop
even in repetitive mode.

If this box is checked, the pattern generator will be restarted each iteration (Repeat count).
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Waveform Properties

Overview
Use the Waveform tab to setup, change, or view the properties of a waveform. The properties displayed in
the Waveform tab depend on the waveform that you select in the Waveform window.

Behavior
The following are properties that are common to all waveforms, regardless of whether you choose an
individual waveform, a waveform group, or an individual waveform within a waveform group:

Waveform: lists the label that displays in the Waveform window. You can select a different waveform
from the list. The list contains the names of all waveforms in the active window. The initial waveform
is the selected waveform or the first waveform if no waveform is selected. The list box is empty
if multiple waveforms are selected.

Height: controls the height of the waveform. Height can range from 10 to 500 pixels. The default
height of waveforms is fixed at 18 pixels.

To Use
To change waveform properties from the System window, click a Waveform window icon, double-click
the label of a waveform, and then click the Waveform tab.

Related Topics
Individual Waveform Properties

Group Waveform Properties

Individual Waveform Properties within a Waveform Group
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Waveform Window Properties

Overview
Use to format the current Waveform window.

Acq != Ref determines if data differences will be displayed during data compare operations.

Acq = Ref determines if data equalities will be displayed during data compare operations.
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How to Waveform Window Properties

Behavior
To display differences and equalities you must define a valid data reference and enable the comparison.

Show Graticule determines if a graticule will be displayed. Graticule color determines the color of
the graticule.

Show Violations determines if glitches or setup and hold violations will be displayed. Violation color
determines the color of glitches and violations. Glitches or setup and hold violations must be stored
before they can be displayed.

Background determines data area background color for the active data window.

Color Scheme determines the named color scheme for the active data window.

Snap cursors/marks to transition edges allows you to place the cursors or marks quickly on a transition
edge.

When you select a new color scheme, the color of all waveform data window elements reset to the new
color scheme (All color selections in this dialog box will change to the colors defined by the new color
scheme).

To Use
To change Waveform Window properties from the System window, click a Waveform window icon,
double-click a waveform label and then click the Waveform Window tab. You can also access this tab from
the toolbar, menu bar, or from the context menu (right-click the mouse anywhere on the waveform label).

Related Topics
Changing Waveform Window Properties

Waveform Tab

Changing Waveform Properties

Waveform Options

Color Settings

Making Violations Visible
How to . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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How to Setting Up Clock Groups

Set Up Clocking

Setting Up Clock Groups
1. Select the check box associated with the edge detectors that you want to use to define each clock group.

2. Click the Enable Reset check box to enable the clock group to restart the clock group complete detector,
in the event that all the edges in the clock group have not been seen.

a. Select the desired method of tracking when to restart the sample period.

b. Specify an amount in the Value field that indicates the number of heartbeats or nanoseconds that
must pass before the sample period restarts.

3. Click the Use External Reset check box to use an external clock for restarting the clock group complete
detector, in the event that all the edges in the clock group have not been seen. Note that selecting the
External Reset check box will override internal Enable Reset check box settings for all detectors.

a. Select an external clock from the drop-down list.

b. Optionally click the Invert Clock check box to restart the sample period when the clock edge is low.
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Setting Advanced Clocking Parameters
1. In the System window, click the LA Setup button.

2. From the Clocking list, select External.

3. Click the More button to display the basic Clocking dialog box.

4. Click the Advanced Clocking button to display advanced clocking functionality.

5. Select or enter the parameter you want to set in the Group Clocking table.

6. Click the Close button.
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Setting Up External Clocking for an LA module
1. In the System window, click the LA Setup button.

2. In the Clocking list, select External. The system responds by displaying the More button.

3. Click the More button to display the Clocking dialog box.

4. Click the Advanced Clocking button to display advanced clocking settings. Use this window to define
sample clocks and clocking parameters for all signals.

5. Optionally click the Group Clocking tab to specify clock parameters on a per-channel basis.

6. Optionally click the Probe Demux tab to display to specify which probe groups are to be demultiplexed.

NOTE. When using the external clocking, Glitch acquisition is not available.

Related Topic
LA Setup Window
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Setting Up External 2X Clocking for an LA module
1. In the System window, click the LA Setup button.

2. In the Clocking list, select External 2X. The More button displays.

3. Click the More button to display the 2X Clocking dialog box.

4. Select a clock edge for any available clock signal.

5. Align data in relation to that clock edge for each group.

Your clock edge and data alignment settings are illustrated in the Setup/Hold Window graphic.

NOTE. When using the External 2X clocking, setup and hold violation storage is unavailable.

Related Topic
LA Setup Window
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Setting Up External 450 Clocking for an LA module
1. In the System window, click the LA Setup button.

2. In the Clocking list, select External 450. The More button displays.

3. Click the More button. The External 450 Clocking dialog box displays.

4. Select a clock edge for any available clock signal.

5. Align data in relation to the clock edge for each group.

Your clock edge and data alignment are illustrated in the Setup/Hold Window graphic.

NOTE. When you select both the rising and falling clock edges, the state speed is limited to 235 MHz and you trade
half of your acquisition channels for a data rate that is double the state speed (470 Mb/s).

Related Topics
LA Setup Window

Clocking

External Clocking
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Setting Up External 4X Clocking for an LA module
1. In the System window, click the LA Setup button.

2. In the Clocking list, select External 4X. The More button displays.

3. Click the More button. The 4X Clocking dialog box displays.

4. Select a clock edge for any available clock signal.

5. Align data in relation to the clock edge for each group.

6. Set the delay in relation to the clock edge for the second sample.

Your clock edge, data alignment, and delay settings are illustrated in the Setup/Hold Window graphic.

NOTE. When using the External 4X clocking mode, setup and hold violation storage mode is unavailable.

Related Topic
LA Setup Window
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Setting Up Group Clocking
1. Select an edge detector for each channel group that will be used as the sample point for data.

2. Select setup and hold times for each channel group edge detector.

3. Select a clock group for each channel group.

4. In the Pipeline Delay column, select the number of clocking state machine (CSM) heartbeat clocks to
use for delaying data that is moving through the adjustable pipeline.

5. Select a sample clock for each channel group, which will be used to determine when to store data
in the logic analyzer.

6. Either click the Sync Speed option and specify a synchronous speed capture rate or click the Max Sync
Speed option to capture data at the module’s fastest possible rate.
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Setting Up Multiple Phase External Clocking
1. In the System window, click the LA Setup button.

2. In the Clocking list, select External. The system responds by displaying the More button.

3. Click the More button to display the Clocking dialog box.

4. If it is not already displayed, click the Advanced Clocking button to display advanced clocking settings.

5. Click the Sample Clocks tab and enter values for Sample Clock 1 and Sample Clock 2 equations.

6. Click the Group Clocking tab and select the sample clock, pipeline delay, and setup time for each
channel group.

NOTE. Making changes to the Setup/Hold Window of any clock channel used in the definition of Sample Clock
1 may result in no samples being acquired.

7. Click the Probe Demux tab and select the logic analyzer input channels to be demultiplexed.

8. Click the Close button.

Related Topic
Advanced Clocking
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Selecting Clock Qualification for an LA Module
1. In the System window, click the LA Setup button.

2. In the Clocking list, select External. The system responds by displaying the More button.

3. Click the More button to display the basic Clocking dialog box.

4. Select the clock and qualifiers to set up your clocking equation.

5. Click Close.

Related Topic
Clocking
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Setting Up Sample Clocks
1. Select a sample clock from the Sample Clock drop-down list.

2. Select a clock group from the drop-down list and then select the qualifiers and clock groups that
will define the sample clock.

3. If you want to set up more than one sample clock, repeat steps 1 and 2 for each sample clock setup
that you desire.

NOTE. Sample clock 0 is the master sample clock that controls when data is released from the clocking pipeline
to the trigger state machine and main logic analyzer acquisition memory.
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Demultiplexing External Data Signals
Use to route the same data signal to up to four different logic analyzer channels.

1. From the System dialog box, click the Logic Analyzer Setup button to display the LA Setup dialog box.

2. Set the Clocking to External. The system responds by displaying the More button.

3. Click More to display the LA Clocking dialog box.

4. Click Advanced Clocking to display the advanced clocking functionality.

5. Click the Probe Demux tab to specify which probe groups are demultiplexed.

6. Select the check boxes associated with the probe groups that you want to demultiplex.

7. Click OK to save your settings and close the Probe Demux dialog box.

8. Click Close to close the Advanced Clocking dialog box.

Related Topics
Advanced Clocking

Probe Demultiplexing
How to . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Set Up System

Setting Up Basic Clocking
1. In the System window, click the LA Setup button.

2. In the Clocking list, select External. The system responds by displaying the More button.

3. Click the More button to display the Clocking dialog box.

4. If it is not already displayed, click the Basic Clocking button to display basic clocking functionality and
enter values for your clocking equation.

5. Click Close.

Related Topics
Clocking Dialog Box

Setting Up Multiple Phase External Clocking

Advanced Clocking
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Selecting Memory Depth: A General Approach
To make the most effective use of memory depth use sample suppression to limit the number of data
samples acquired.

From the LA Setup window follow these steps to set the memory depth:

1. Use the Memory Depth drop-down list to select the maximum memory depth.

2. Click the Suppress… button to activate the Sample Suppression Dialog Box.

3. Make a selection in the dialog box to limit the number of samples initially displayed after each
acquisition.

For example: Show 1024 Samples around trigger.

During data acquisition memory is filled up to the selected depth (maximum in this case). After acquisition
only 1024 samples will be delivered to all data displays.

If the acquisition you are looking for is not visible, show more samples using the Show dialog box or
context menu in the Listing or Waveform window. This can be done without reacquiring data.

If too much data is delivered to all data displays, remove samples using the Suppress dialog box or context
menu in the Listing or Waveform window.

Related Topics
Suppress Samples Dialog Box

LA Memory depth
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Store

Storing LA Module Setup and Hold Violations
1. In the System window, click the LA Setup button.

2. From the Setup window, click the Clocking box and select External. If you have previously loaded a
support package, the Custom clocking selection is correct.

3. Click the Acquire box and select Setup/Hold.

NOTE. Setup/hold violation storage mode limits memory depth to half of the memory depth and limits the sample
period to 10 ns or greater for TLA7Lx/Mx/Nx/Px/Qx modules or 4 ns or greater for TLA7Axx/TLA7NAx modules and
TLA5000B Series logic analyzers.

4. Click the Define S/H button to display the Setup and Hold Storage dialog box.

5. Use the setup and hold list boxes to set up violation regions for the channel groups where you want to
detect and store violation data.

NOTE. Refer to Setup and Hold Storage Dialog Box for the range of allowable values and for an explanation of
conflict indications.

6. Click OK.
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Setting up Transitional Storage for the LA Module
1. In the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click Transitional from the Storage list box, located in the trigger toolbar.

4. Click the Change Detect button.

5. From the Change Detect dialog box, select the channel groups in which you want the logic analyzer to
detect a change in state for the transitional storage.

6. Click OK.

When you start the logic analyzer, the logic analyzer module will begin storing data when it detects a
change in any one of the selected channel groups.

Conflicts are possible when groups share channels. Conflicts are noted in the boxes. Conflicts do not
prevent acquisition. Value settings closer to the top of the list override later settings.

On TLA7Lx and TLA7Mx modules, the first transition state indication is random. On
TLA7Axx/TLA7NAx modules and TLA5000B Series mainframes, the first transition state indication is
always false. On TLA7Nx, TLA7Px and TLA7Qx, modules the first transition state always shows a
transition indication (even if there are no probes plugged in). One way to avoid triggering on a false first
transition indication is to set the first state to "If Anything Goto Next State". This will consume a state, but
will ensure that there is no false triggering on the first transition indication.

TIP. An easy method for setting up a transitional storage trigger is to load one of the EasyTrigger programs (Store on
all transitions, Store on channel transitions, or Store on group transition). If necessary you can modify the program
from the PowerTrigger tab.
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Storage Definition Dialog Box

Overview
Use this dialog box to define the condition when storage occurs after Conditional storage is selected in the
Trigger window toolbar. This dialog box defines an If event the same way as does the Clause definition
dialog box. The Then action stores a sample; this action cannot be changed.

To Use
To open the Storage definition dialog box, perform the following:

1. From the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Set Storage to Conditional and click the If/Then button in the Storage state.

A few things to keep in mind when using this dialog box:

Counter and timer events are not available in storage definitions.

Violation Storage is not available in internal 2X, internal 4X, external 2X or external 4X clocking
modes.

Storage Definition is not available from the EasyTrigger tab.

Snapshot events are not available in storage definitions.

Related Topic
Clause Definition Dialog Box

LA trigger Event Table

Storage Selection for an LA Module

Internal (Asynchronous) 2X Clocking
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Trigger a Logic Analyzer

Triggering a Logic Analyzer Using the Trigger Tab Page
Use the Trigger tab page to quickly add one of the following trigger programs:

Channel edge

Bus Value

Glitch

Trigger on Anything

Channel Value

Multi-Group Value

Setup and Hold

To use the Trigger tab page, do the following:

1. From the data window, click the Trigger tab page.

2. Drag a trigger from the Add Trigger group box to the waveform that you want to trigger on.

3. Edit the trigger expression under Trigger Details in the Trigger tab page.

4. Click Run.
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Adding a State to a Trigger Program
1. In the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. From the Edit menu, click Add State.

NOTE. The state is added after the currently selected state. If a state is not selected, then the state is added as
the last state.

TIP. Add State is also available on the toolbar of the Trigger window.
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Adding an If/Then Clause to a Trigger State
1. In the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. From the Overview group box, click the state in which you want to add a clause.

4. From the Edit menu, click Add If/Then Clause.

NOTE. The clause is added after the currently selected clause. If a clause is not selected, then the clause is added
as the last clause.

TIP. Add If-Then Clause is also available on the toolbar of the Trigger window.

Related Topic
Internal 2X Clocking Mode Trigger Programs
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Defining If/Then Clauses in a Trigger Program
1. In the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click the If/Then button of the clause you want to edit.

4. Make changes in the If/Then clause dialog box.

5. Click OK.

On TLA7Lx and TLA7Mx modules, the first transition state indication is random. On
TLA7Axx/TLA7NAx modules and TLA5000B Series mainframes, the first transition state is always false.
On TLA7Nx, TLA7Px and TLA7Qx modules the first transition state always shows a transition indication
(even if there are no probes plugged in). One way to avoid triggering on a false first transition indication is
to set the first state to "If Anything Goto Next State". This will consume a state, but will ensure that there
is no false triggering on the first transition indication.

If transitions are used as events, there will be a false indication of a transition. The first state needs to be
set up as "If Anything Then Next State."
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Defining Multiple Transition Recognizers
1. In the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click the corresponding If/Then button of the state clause you want to define.

4. In the event definition drop-down list box, click Transition and specify the related transition condition.

5. Optionally, from the Clause Definition dialog box, click the Add button to specify additional transition
events.

6. Click the Define Transition button to display the Transition Definition dialog box.

7. Click the Add button to add a new transition definition and specify the groups in which transition
events will be monitored.

NOTE. You can add as many transition event definitions as you want within the Transition dialog box. However,
you can only use eight events of any kind within an event clause. The events that are selected when you close
the Transition dialog box are used in the event clause.

8. In the event definition drop-down list box, click Transition and specify the related event action.

9. Optionally, click the Define Transition button to define a unique transition name.

NOTE. You can define up to 16 trigger events and two counters or timers for a given trigger setup.

TIP. An easy method for defining multiple transition recognizers is to load the Trigger on Nth occurrence of edge from
the Easy Trigger programs. If necessary, you can modify the program from the PowerTrigger tab.

Related Topics
Add Transition Dialog Box

Transition Definition Dialog Box
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Selecting Channels for an LA trigger Channel Event
1. In the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click the If/Then button of the clause you want to edit.

4. Select Channel in the first box of the If section.

5. Click the Select Channel button.

6. Do one of the following:

Double-click the desired channel group in the Select Channels dialog box and select the channel.

Click By Probe and select the channel.

Click By Name and select the name of the channel you assigned in the Setup window.

7. Click OK.
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Selecting When to Store Data
1. In the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Specify the desired storage mode in the Storage box, which is located in the LA Trigger dialog box
toolbar. Refer to Data Sample Storage Selections for definitions of the storage modes.

NOTE. This functionality is only available when defining trigger programs using the PowerTrigger tab. Otherwise, the
Storage box is disabled.
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Positioning the Trigger
1. In the System window, click the LA Trigger button.

2. Position the trigger using one of the following methods available from the trigger toolbar:

Move the Trigger Pos slider until the desired percentage of data before the trigger shows in the text field.

Enter the desired percentage in the text field.

Use the controls in the list box to reach the desired percentage.
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Triggering an LA Module on a Glitch
1. In the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click the corresponding If/Then button of the clause you want to edit.

4. Click Glitch in the If section of the Clause Definition dialog box.

NOTE. Glitches can only be selected when the Clocking selection in the LA Setup window is set to Internal.

Glitch storage is not available when the Clocking selection in the LA Setup window is set to either Internal 2X or
Internal 4X.

5. Click the Define Glitches button.

6. Select the channel groups for which you want to detect a glitch.

7. Click OK.

8. Click either Trigger or Trigger All Modules in the Then section of the Clause Definition dialog box.
Clicking Trigger will trigger the current module; Trigger All Modules triggers all modules, which is
the same as a system trigger.

9. Click OK.

TIP. An easy method for setting up a glitch trigger program is to drag-and-drop a glitch trigger into the Waveform
or Listing window from the Trigger tab page. Then make any necessary changes to the trigger expression, under
Trigger Details, to set up the trigger.

Alternatively, you can load the Trigger on glitch file from the EasyTrigger program list and then make
modifications to that program using the PowerTrigger tab.

Related Topic
Loading a Trigger from the Trigger Tab Page
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Triggering an LA Module on a Setup and Hold Violation
1. In the System window, click the LA Setup button.

2. From the Setup window, click the Clocking box and select External. If you have previously loaded a
support package, the Custom clocking selection is correct.
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3. Open the LA Trigger window.

4. Click the PowerTrigger tab.

5. Click the corresponding If/Then button of the clause you want to edit.

6. Click S & H fault in the If section of the Clause Definition dialog box.

NOTE. Setup and hold violation storage is unavailable when in External 2X or External 4X clocking modes. S & H
fault can only be selected when the clocking selection in the LA Setup window is set to External, External 2X, External
4X, or Custom. Custom is available when a support package is loaded.

7. Click the Define Violation button to display the Setup and Hold Event dialog box.

8. Select the channel groups for which you want to detect a setup and hold violation.

9. Enter the values in the corresponding channel group setup and hold list boxes.

NOTE. Refer to Setup and Hold Event Dialog Box for the range of allowable values and for an explanation of
conflict indications.

10.Click OK.

11.Select either Trigger or Trigger All Modules in the Then section of the Clause Definition dialog box.
Selecting Trigger will trigger the current module; Trigger All Modules triggers all modules, which is
the same as a system trigger.

12.Click OK.

TIP. An easy method for setting up a setup and hold violation trigger program is to drag-and-drop a Setup and Hold
trigger from the Trigger tab page into a Waveform or Listing window. Then make any necessary changes to the trigger
expression, under Trigger Details, to set up the trigger.

Alternatively, you can load a setup and hold violation trigger program from the Trigger on group
setup/hold violation file in the EasyTrigger program list and make modifications to that program from
the PowerTrigger tab.

Related Topics
Loading an LA with Saved Trigger Settings

Using the Trigger Tab Page
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Triggering an LA Module on Timer Values
1. In the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click the corresponding If/Then button of the clause you want to edit.

4. Click Timer in the If section of the Clause Definition dialog box.

5. Select the specific Timer.

NOTE. Counters and Timers share resources. For example if Counter 1 is selected, Timer 1 is not available as
an action or event.

6. Select the operation.

7. Select the value.

8. Click either Trigger or Trigger All Modules in the Then section of the Clause Definition dialog box.
Selecting Trigger will trigger the current module; Trigger All Modules triggers all modules, which is
the same as a system trigger.

9. Click OK.

Related Topic
Triggering an LA Module on Counter Values
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Triggering an LA Module on Counter Values
1. In the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click the corresponding If/Then button of the clause you want to edit.

4. Click Counter in the If section of the Clause Definition dialog box.

5. Select the specific counter.

NOTE. Counters and Timers share resources. For example if Counter 1 is selected, Timer 1 is not available as
an action or event.

6. Select the operation.

7. Select the value.

8. Click either Trigger or Trigger All Modules in the Then section of the Clause Definition dialog box.
Selecting Trigger will trigger the current module; Trigger All Modules triggers all modules, which is
the same as a system trigger.

9. Click OK.

Related Topic
Triggering an LA Module on Timer Values
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Triggering an LA Module on an Internal Signal
1. In the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click the corresponding If/Then button of the clause you want to edit.

4. Click Signal in the If section of the Clause Definition dialog box.

5. Select the signal.

6. Select the signal logic level.

7. Click either Trigger or Trigger All Modules in the Then section of the dialog box. Selecting Trigger
will trigger the current module; Trigger All Modules triggers all modules, which is the same as
a system trigger.

8. Click OK.

Related Topics
Internal Signaling

Trigger Action Signal Restrictions

Module Arming Using an LA Module
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Triggering an LA Module on a Word Event
1. In the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click the corresponding If/Then button of the clause you want to edit.

4. Click Word in the If section of the Clause Definition dialog box.

5. Click the Define Word button.

6. Enter the word values for each channel group.

7. Click the box to the left of the group to enable or disable each channel group.

8. Click OK.

9. Click either Trigger or Trigger All Modules in the Then section of the Clause Definition dialog box.
Selecting Trigger will trigger the current module; Trigger All Modules triggers all modules, which is
the same as a system trigger.

10.Click OK.

TIP. Define multiple word events by clicking Add in the Word Definition dialog box and assigning a name to the
definition. You can then select the definition from the Clause Definition dialog box directly.

An easy method for setting up a word event trigger is to load the Trigger on word value EasyTrigger
program. If necessary you can make modifications to the program from the PowerTrigger tab.
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Triggering an LA Module on a Snapshot Event
1. In the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click the corresponding If/Then button of the clause you want to edit.

4. In the Clause Definition dialog box, If section, select Snapshot from the event selection list.

5. Click the Define Snapshot button.

6. Click the box to the left of the channel group to enable or disable each channel group.

7. Click OK.

8. In the Then section of the Clause Definition dialog box click either:

Trigger - to trigger the current module.

Trigger All Modules - to trigger all modules, which is the same as a system trigger.

9. Click OK.
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Triggering on Group Data Values
1. In the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click the corresponding If/Then button of the clause you want to edit.

4. Click Group in the If section of the Clause Definition dialog box.

5. Select the channel group.

6. Select the operation for word recognition. Valid selections are = and Is Not.

7. Enter the value to recognize.

8. Click either Trigger or Trigger All Modules in the Then section of the Clause Definition dialog box.
Selecting Trigger will trigger the current module; Trigger All Modules triggers all modules, which is
the same as a system trigger.

9. Click OK.

TIP. An easy method for setting up a group data value trigger is to load the EasyTrigger programs Trigger on group
value. If necessary you can make modifications to the program from the PowerTrigger tab. Alternatively, you can
drag-and-drop a Multi-Group Value trigger from the Trigger tab page onto a waveform. Then make the necessary
selections in the trigger expression, under Trigger Details, to set up the trigger.

Related Topic
Using the Trigger Tab Page
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Triggering on Group Data Ranges
1. In the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click the corresponding If/Then button of the clause you want to edit.

4. Click Group in the If section of the Clause Definition dialog box.

5. Select the channel group.

6. Select the operation for range recognition. Valid selections are:

<, <=, >, >=, Is In and Is Not In.

7. Enter the values for the range.

8. Click either Trigger or Trigger All Modules in the Then section of the dialog box. Selecting Trigger
will trigger the current module; Trigger All Modules triggers all modules, which is the same as
a system trigger.

9. Click OK.

TIP. An easy method for setting up a group data value trigger is to load one of the EasyTrigger programs (Trigger on
group value outside of a range or Trigger on group value within a range). If necessary you can make modifications
to the program from the PowerTrigger tab. Alternatively, you can drag-and-drop a Multi-Group Value trigger from
the Trigger tab page onto a waveform. Then make the necessary selections in the trigger expression, under Trigger
Details, to set up the trigger.

Related Topic
Using the Trigger Tab Page
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Triggering an LA Module on a Single Channel
1. In the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click the corresponding If/Then button of the clause that you want to edit.

4. Select Channel in the If section of the Clause Definition dialog box.

5. Click the Select Channel button to display the Select Channel dialog box.

6. Select both the selection method and the channel that you want to trigger on, and then click OK.

7. Select the operation.

8. Select the logic level.

9. Click either Trigger or Trigger All Modules in the Then section of the dialog box. Selecting Trigger
will trigger the current module; Trigger All Modules triggers all modules, which is the same as
a system trigger.

10.Click OK.

TIP. An easy method for setting up a single channel trigger is to load one of the EasyTrigger programs (Trigger on
channel low/high or Trigger on channel transition edge). If necessary you can make modifications to the program
from the PowerTrigger tab. Alternatively, you can drag-and-drop a Channel Value or Channel Edge trigger onto a
waveform from the Trigger tab page. Then make the necessary selections in the trigger expression, under Trigger
Details, to set up the trigger.

Related Topics
Channel Selection

Using the Trigger Tab Page
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Triggering an LA Module on a Channel Group
1. In the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click the corresponding If/Then button of the clause you want to edit.

4. Click Group in the If section of the Clause Definition dialog box.

5. Select the channel group.

6. Select the operation for group recognition.

7. Select the group value or pattern.

8. Click either Trigger or Trigger All Modules in the Then section of the dialog box. Selecting Trigger
will trigger the current module; Trigger All Modules triggers all modules, which is the same as
a system trigger.

9. Click OK.

TIP. An easy method for setting up a channel group trigger is to drag and drop a Multi-Group Value trigger from the
Trigger tab page onto a waveform or listing window. Then make the necessary selections in the trigger expression,
under Trigger Details, to set up the trigger.

Alternatively you can load one of the EasyTrigger programs (Trigger on group value or Trigger on group transition). If
necessary, you can modify the program from the PowerTrigger tab.

Related Topic
Using the Trigger Tab Page
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Arming other Modules from an LA
1. In the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click the corresponding If/Then button of the clause you want to edit.

4. Select the event type in the If section of the Clause Definition dialog box.

5. Click Arm Module in the Then section of the Clause Definition dialog box.

6. Select the module you want to arm.

7. Click OK.

Related Topics
Internal Signaling

Trigger Action Signal Restrictions

Module Arming Using an LA
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Triggering other Modules from an LA
1. In the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click the corresponding If/Then button of the clause you want to edit.

4. Select the event type in the If section of the Clause Definition dialog box.

5. Click Trigger All Modules in the Then section of the Clause Definition dialog box.

6. Click OK.

NOTE. All trigger actions in the trigger program must be the same and can be either Trigger or Trigger All Modules.

TIP. An easy method for triggering all modules is to load the EasyTrigger program Trigger all modules when A occurs.
If necessary, you can modify the program from the PowerTrigger tab.

Trigger All Modules
Trigger All Modules is the same as a system trigger.
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Troubleshooting LA PowerTrigger Programs
If you have problems with your PowerTrigger program, try these suggestions:

Look at the trigger clauses. The clauses, although appearing to be evaluated simultaneously, have
precedence, and are given priority from top to bottom in the active state. Therefore, you will not trigger
when you think you should if you have a program like the following examples.

If Anything

Increment Counter 1

Else If Counter 1 > 5

Then Trigger

A trigger will never occur because the first clause is always true.

If counter 1 > 5

Then Reset Counter 1

And Increment Counter 2

Else if Counter 1 <= 5

Then Increment Counter 1

Else if Counter 2 > 10

Then trigger

A trigger will never occur because counter 1 will either be >5 or <=5.

Check for a bad probe channel: go to the Setup window and click Show Activity. This dialog box
shows activity at the probe tip. Click the Help button in the dialog box for a list of possible problems.

When setting up to trigger on channel group ranges, check that the channels in the group are assigned
in descending order in the Setup window. For example:

A3(7), A3(6), A3(4) or A3(7-0) is correct.

A3(6) A3(7), A3(4) or A3(0-7) is incorrect.

The values triggered on in the incorrect example will not be correct in the data windows. For example, if
the incorrect group above is in the range of F0 to 70 the only possible values to cause a trigger would be F0
and 70. Values in the range of F0 through 70 will not cause a trigger.

Check that the probe order is correct. Verify that you have the correct probe or probe channels
connected.

Check the progress of the trigger program in the Status monitor to see which state may be causing the
trigger problem.

On TLA7Lx and TLA7Mx modules, the first transition state indication is random. On the
TLA7Axx/TLA7NAx module and the TLA5000B Series mainframe, the first transition state indication
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How to Timer Event Target Value Limit

is always false. On TLA7Nx, TLA7Px and TLA7Qx modules the first transition state always shows a
transition indication (even if there are no probes plugged in). One way to avoid triggering on a false
first transition indication is to set the first state to "If Anything Goto Next State". This will consume a
state, but will ensure that there is no false triggering on the first transition indication.

Related Topics
Status Monitor Dialog Box

Internal 2X Clocking Mode Trigger Programs

Troubleshooting Triggering

. . Trigger a Logic Analyzer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Timer Event Target Value Limit
The maximum value that can be entered as an event value limit is 2,000,000 seconds, which is about 23
days.

Actual ending timer values up to the full 104-day limit can be read from the hardware and displayed
in the status monitor.

The 23-day limit is imposed by the user interface in the If/Then dialog.
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Use Data Measurements

Data Measurement Types and Definitions: Count
There are four LA data measurement types or categories. Click the following buttons for definitions
and algorithms of each measurement.

Count Measurements

Pattern Match

The number of occurrences of a specified group value.

Where is the total number of occurrences of the matched pattern in the gated region.

Xn is the pattern to match.

The total number of occurrences of the specified group value in the gated region is displayed in the Value column.
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Count Measurements
Edge Count

The total number of signal edges (positive and negative).

Where is the Edge Count.

X(LH) is an edge represented by a transition from Low to High.

X(HL) is an edge represented by a transition from High to Low.

The total number of signal edges in the gated region is displayed in the value column.
Cycle Count

The number of signal cycles in the specified region. One cycle is defined as the time period between rising edge to next
rising edge or from a falling edge to the next falling edge.

Where CCycle is the cycle Count.
Positive Pulse count

The number of positive pulses.

Where is the Positive Pulse Count.

The total number of positive pulses in the gated region is displayed in the Value column.
Negative Pulse Count

The number of negative pulses.

Where is the Negative Pulse Count.

The total number of negative pulses in the gated region is displayed in the Value column.
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Count Measurements
Violation Count

The of number of channel group setup/hold violations or number of glitch violations in the gated region. Setup/Hold violations
are only available for synchronous clocking. Glitch violations are only available for asynchronous clocking.

Where is the Violation Count.

The total number of violations in the gated region is displayed in the Value column.
Violation Rate

Ratio of the number of channel group setup/hold or glitch violations (depending on clocking mode) per number of seconds.

Where is the Violation Rate. is the number of violations in the gated region. N (S) is the number of seconds.

The rate at which violations occur in the gated region expressed as a fraction of total number of violation/seconds is
displayed in the Value column.
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Data Measurement Types and Definitions: Jitter
There are four LA data measurement types or categories. Click the following buttons for definitions
and algorithms of each measurement.

Jitter Measurements

Period Jitter

The timing variation in the period measured in seconds.

Where is the Period Jitter.

is the Period of the (n +1) Cycle.

is the Period of the First Cycle.

The difference of the Maximum period measured minus the Minimum period measured in the gated region is displayed in the
Value column. This is also called peak-to-peak period jitter.
Cycle-to-Cycle Jitter

The timing variation in the period in adjacent cycles measured in seconds.

Where is the Cycle-to-Cycle Jitter.

is the Period of the (n+1) Cycle.

is the Period of nth Cycle.

The difference of the Maximum cycle-to-cycle jitter minus the Minimum cycle-to-cycle jitter in the gated region is displayed in
the Value column. This is also called peak-to-peak cycle-to-cycle jitter.
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Data Measurement Types and Definitions: Minimum/Maximum
There are four LA data measurement types or categories. Click the following buttons for definitions
and algorithms for each measurement.

Minimum/Maximum Measurements

Group Min

The minimum value the group values.The lowest value of the group in the gate region is displayed in the Value column.
Group Max

The maximum of the group values.The highest value of the group in the gated region is displayed in the Value column.
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Data Measurement Types and Definitions: Time
There are four LA data measurement types or categories. Click the following buttons for definitions
and algorithms of each measurement.

Time Measurements

Frequency

Frequency is the reciprocal of the period of a signal measured in hertz (Hz).

.Where Fn is the Frequency and Pn is the Period.

The average frequency of all cycles in the gated region is displayed in the Value column.
Period

Time it takes for a complete cycle in the gated region. Reciprocal of frequency, measured in seconds (s).

Where Pn is the Period and T is the point in time of a Transition (Low to High or High to Low).

The average of all period measurements in the gate region is displayed in the Value column.
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How to Data Measurement Types and Definitions: Time

Time Measurements
Positive Pulse Width

The time duration of a positive pulse (low-high-low) measured in seconds (s).

Where is the Positive Pulse Width.

is the point in time of the Transition from High to Low.

is the point in time of the Transition from Low to High.

The average of all positive pulse width measurements in the gated region is displayed in the Value column.
Negative Pulse Width

The time duration of a negative pulse (high-low-high) measured in seconds (s).

Where is the Negative Pulse Width.

is the point in time of the Transition from Low to High.

is the point in time of the Transition from High to Low.

The average of all negative pulse width measurements in the gated region is displayed in the Value column.
Positive Duty Cycle

The ratio of the positive pulse to the total signal period expressed as a percentage (%).

Where Dn is the positive duty cycle.

is the Positive Pulse Width.

is the Period.

The average of all positive duty cycle measurements in the gated region is displayed in the Value column.
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How to Data Measurement Types and Definitions: Time

Time Measurements
Negative Duty Cycle

The ratio of the negative pulse to the total signal period expressed as a percentage (%).

Where Dn is the negative duty cycle.

is the Negative Pulse Width.

is the Period.

The average of all negative duty cycle measurements in the grated region is displayed in the Value column.
Channel-to-Channel Delay

Time delay between the edges of two different signals measured in seconds (s).

Where is the Channel to Channel Delay. is the Transition (location of the type of edge selected in the UI
using the drag and drop action) of the Destination Channel. This is indicated as the second channel selected during the
measurement setup. The average of the delay from the first edge of the type selected as the source to the first edge of the
type selected as the destination plus the delay from the second edge of the type selected as the source to the second edge
of the type selected as the destination…plus the delay from the nth edge of the type selected as the source to the nth edge of
the type selected as the destination for each pair of edges in the gated region is displayed in the Value column.

is the Transition of the Source channel. This is indicated as the first channel selected during the measurement setup.
The delay from the first edge of the type selected for each edge in the gated region is displayed in the Value column.
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Using LA Data Measurements
To use LA data measurements follow these steps:

1. Add a new measurement.

a. To select a measurement from the Add LA measurement context menu right-click on the
channel or group header.

b. Select Add LA Measurement and then select the measurement you want to add.

OR

a. Select the Setup page in the Measurements tab.

b. Click and drag a measurement item from Add Measurements to a channel or group in the
data window.

If a measurement is dropped onto any group, the measurement will be applied to all the channels in
the group.

2. Define gating.

a. Select gating type from the Gate drop-down list on the Setup page.

b. Select Display to analyze the samples in the visible display.

c. Select Cursors to analyze the samples between Cursor 1 and Cursor 2.

d. Select Full Record to analyze all the samples.

3. Select mode for analysis.

Select the Accumulate check box to add results to the existing measurement results.

OR

Clear the Accumulate check box to clear previous results and update with new results.

NOTE. The results are accumulated when you click Run but not when you click Recalc.

4. Analyze the data.

Results and statistics are displayed in the Statistics page. To get new data, click Run. To recalculate
measurements, click Recalc.

Related Topic
Adding Dual Channel Measurements
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Statistic Definitions for Data Measurements
Statistic Definition
Average The sum of the results calculated in the gated

region divided by the total number calculations. The
measurement is expressed in the same units as the data.

Min Minimum of all the results calculated in the gated region.

Max Maximum of all the results calculated in the gated region.

Standard Deviation A statistical measure of the spread of results. It is a measure
of variability expressed in the same units as the data.

Population The number of times the measurement was performed in

the gated region.
Note: The samples or data considered for calculating the results for all the above measurements and statistics are bound by
the gated region. Gating options include display, cursors, and full record.
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Adding Dual Channel Measurements
To add a dual channel measurement using drag and drop, do the following:

1. Select the Setup page from the Measurements tab.

2. Click and drag a measurement item from the Available Measurements list to the first channel. While
dragging to the first channel there is a tool tip that says on which channel the measurement is to be
dropped.

3. Drop the measurement button on the first channel. The tool tip will change to indicate the first channel
selected and that a second channel needs to be selected.

4. Click the channel header to select the second channel.
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How to Copying Filters

Use Data Filters

Copying Filters
1. Click the Filters button in the LA Setup window to open the Filter Definitions dialog box.

2. Double click the LA module that contains the filter that you want to copy. The filter list will expand to
show all filters attached to the selected LA module.

3. Select the filter and click the Copy button in the dialog box.

4. Select the LA module to which you want to copy the filter.

5. Click the Paste button.

TIP. You can also open the Filter Definitions dialog box from the Listing or Waveform window by selecting Filter
Definitions… from the Data menu.

. . Use Data Filters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Creating Filters
1. Click the Filters button in the LA Setup window to open the Filter Definitions dialog box.

Logic analyzers with filters attached to them have an expand and collapse button to the left of the name.

2. Select an LA module in the dialog box.

3. Click the New button to attach a new filter to the module.

4. Click the button to open the Define Filter dialog box where you can define the filter contents.

TIP. You can also open the Filter Definitions dialog box from the Listing or Waveform window by selecting Filter
Definitions… from the Data menu.
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Opening Filters
1. Click the Filters button in the LA Setup window to open the Filter Definitions dialog box.

2. Locate and double-click the LA module that contains the filter that you want to open.

3. Select the filter.

4. Click the Properties button to view and edit the filter contents in the Define Filter dialog box.

TIP. You can also open the Filter Definitions dialog box from the Listing or Waveform window by selecting Filter
Definitions… from the Data menu. Alternately, you can right-click a column label in the Listing window or a waveform
label in the Waveform window to display a context menu where you can access the filters.

. . Use Data Filters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Renaming Filters
1. Click the Filters button in the LA Setup window to open the Filter Definitions dialog box.

2. Locate and select the filter that you want to rename.

3. Right-click the mouse and select Rename from the menu.

4. Rename the filter.
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Use the Listing Window

Adding Reference Data to a Listing Window
1. In the System window, click the Listing window icon.

2. From the Edit menu, click Add Column.

3. In the Add Column dialog box, click the Add Data Source button.

4. Click Browse and search for the appropriate source.

5. After the source is added, select it in the Add Column dialog box.

6. Select the desired columns and click Add.

7. Click Close.

TIP. Click to open the dialog box.
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Adding a Column in a Listing Window
1. In the System window, click the Listing window.

2. From the Edit menu, click Add Column.

3. Select the Data Source.

4. If the data source you want is not listed, click Add Source to locate it.

5. Select the column by Group, Probe, or Name and then click Add.

6. Click Close.

TIP. Click to add a column.

. . Use the Listing Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Adding an Opcode Mark
Occasionally, you might want to change the way the disassembler interprets a cycle type. Mark Opcodes
synchronizes the disassembler. You must have a support package installed to use this feature.

1. In the System window, click the Listing window icon.

2. From the Edit menu, click Mark Opcode.

3. The pointer changes to a cross hair pointer.

4. Move the pointer to the data sample where you want to place an Opcode and click.

5. The Mark Opcode Dialog Box opens.

6. Double-click the Opcode type.

TIP. Move the pointer to the desired data sample and click the right mouse button. Select Mark Opcode.
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Moving Columns
1. In the System window, click the Listing window icon.

2. Move the pointer to a column label.

3. Click and drag the pointer to a new position.

The column appears in the new position after the mouse button is released.
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Showing Qualification Gaps in a Listing Window
1. In the System window, click the Listing window icon.

2. From the Edit menu, click Properties.

3. From the Properties dialog box, click the Listing Window tab.

4. Select Show Qualification Gaps.

5. Click OK.

Gaps are shown in the display with a horizontal gray line above the first data after the gap.

TIP. Click to open the Properties dialog box.
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Showing Glitches in a Listing Window
1. In the System window, click the Listing window icon.

2. From the Edit menu, click Properties.

3. From the Properties dialog box, click the Listing Window tab.

4. Select Show Glitches.

5. Select the glitch color.

6. Click OK.

Glitches are shown in the display by highlighting the character in the sample containing the glitch. In
binary data the individual bit containing the glitch is highlighted.

NOTE. You must select Glitches in the Acquire box of the Setup window before making an acquisition.

TIP. Click to open the Properties dialog box.

To see the individual glitch bit, change the radix of the column to binary.
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Displaying Information About Data Sources
1. In the System window, click the Listing or Waveform window icon.

2. From the Edit menu, click Properties.

3. Click the About Data tab.

TIP. Click in the data window to open the Properties dialog box.

. . Use the Listing Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Going to a Specific Column
1. In the System window, click the Listing window icon.

2. From the Edit menu, click Go To.

3. Click Column.

4. Select the column.

5. Click Go To.

TIP. Click to open the Go to dialog box.
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Creating Symbol Files
1. Open any text processor application. For example: WordPad.

2. Use lines beginning with a number sign (#) to indicate comments.

3. Enter a Symbol File Header. Include the #+ characters at the beginning of the line.

4. Enter symbol names and values.

The following is an example of a simple pattern symbol file.

# Pattern symbol file

# TSF Format Type Display Radix File Radix

# =============== ======= ============= ==========

#+ Version 2.1.0 PATTERN BIN BIN # Symbol Name Pattern Color

# ================ =========== ==========
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How to Creating Symbol Files

NUL X000 0000 SOH X000 0001 @blue STX X000 0010 @white @red

The following is an example of a simple range symbol file.

# Range symbol file with function symbols

# TSF Format Type Display Radix File Radix Offset

# =============== ======= ============= ========== ========

#+ Version 2.1.0 RANGE HEX HEX 00000000

#+ Function # Symbol Name Low High

# ============================== ======== ========

displayBanner 006035ba 00603675

buildMenus 00603676 006036e5

displayLCDmenu 006036e6 0060372f

There are four different types of range symbols. For more information on these range symbols, click
the symbol type you are interested in:

Function Range Symbols

Variable Range Symbols

Source Range Symbols

Color range symbols

When you create range symbols avoid defining symbols where the ranges overlap within a given type,
such as function or variable because overlapping ranges can produce unexpected results.

Color is an effective means for conveying information that allows you to view your data more efficiently
and highlight items of interest. Symbol files provide an easy way to color-code samples in your
acquisitions to help distinguish various features of the data. When you set the group radix to Symbolic
in the data window property sheet and then pick a symbol file with color information in it, the group
values may be displayed in color in a Listing or Waveform window. The foreground color as well as the
background color of the data can be set by the symbol file.

For a detailed description of symbol file syntax, see TLA Symbol File Format.

Related Topic
Symbols Dialog Box
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Symbol File Header
Use header lines to help the logic analyzer identify the contents of a symbol file.

Pattern Symbol File Header
The header line of a pattern symbol table has the following form:

#+ <file format version> PATTERN <display radix> <file radix>

The file format version contains three fields:

Major version number

Minor version number

Build number (for example, 2.0.0); each field is separated by a period.

The display radix field determines the radix used in the data windows and properties tab controls when
there is no symbol defined for a value (valid values for Pattern files are Hex, Oct, or Bin).

The file radix field specifies the radix used for the symbol values in the file; valid values for pattern files
are Hex, Oct, or Bin.

Range Symbol File Header
The header line of a range symbol table has the following form:

#+ <file format version> RANGE <display radix> <file radix> <offset>

The file format version contains three fields:

Major version number

Minor version number

Build number (for example, 2.0.0); each field is separated by a period.

The display radix field determines the radix used in the data windows and properties tab controls when
there is no symbol defined for a value (valid values for Pattern files are Hex, Dec, Oct, or Bin).

The file radix field specifies the radix used for the symbol values in the file; valid values for pattern
files are Hex, Dec, Oct, or Bin.

The offset is a 32-bit hexadecimal value added to the lower and upper bound of each range symbol read
from the file.
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Coloring Data
1. From the Systems window, click the Listing window icon.

2. Double-click a column heading to display the Listing Properties dialog box.

3. Change the radix to symbolic.

4. Click the Symbol File button to load a symbol tab with color symbols.

NOTE. You can use this column as a color source for other columns by double-clicking another column in the Listing
window. From the Listing Properties dialog box, click Same As in the Color group box.

Related Topics
Symbol Files

TLA Symbol File Format
How to . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Use the Oscilloscope

How to . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
. . Use the Oscilloscope . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Display Analog Waveforms

Adding a Waveform
1. In the System window, click the Waveform window icon.

2. From the Edit menu, click Add Waveform.

3. Select the Data Source. If the data source you want is not listed, click Add Data Source and select
your particular data source.

4. If you are adding a DSO or External Oscilloscope channel, Select the Channel and then click Add. If
you are adding a LA channel, select the Group, the Channel, and then click Add.

TIP. Click on the waveform toolbar to select a waveform to add.

From the front panel or from the waveform toolbar, click to add external oscilloscope
waveforms to the Waveform window.

From the front panel or from the waveform toolbar, click to add MagniVu waveforms to the
Waveform window for those main timebase waveforms that are already displayed in theWaveform window.
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Changing Waveform Appearance
1. In the System window, click a Waveform window icon.

2. Double-click the label of the waveform you want to change.

3. If not selected, select the waveform you want to change from the Waveform list.

4. In the dialog box, select the desired waveform Color, Height, Offset, Radix, Readout Options, and
Waveform Measurements, and select whether to Use Polarity and Show the Waveform.

NOTE. Radix and Use Polarity are only available for logic analyzer waveforms. Offset is only available for logic
analyzer, DSO, and external waveforms that are included in a waveform overlay. Waveform Measurements are only
available for DSO and external waveforms.

Related Topics
Selecting the Waveform Color

Changing the Height of a Waveform

Selecting the Radix of Busform Readouts

Determining the Data Source of the Selected Waveform

Controlling Whether a Waveform is Visible

Setting the Overlay Waveform Offset

Setting Up Waveform Measurements
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Selecting the Waveform Color
1. In the System window, click a Waveform window icon.

2. Double-click the label of the waveform you want to change.

3. If not selected, select the waveform you want to change from the Waveform list.

4. From the Color drop down list, select the desired waveform Color.

5. Alternately, select "Same As" and choose another waveform to use as the color source.

6. Click OK.

Related Topics
Changing Waveform Appearance

Changing the Height of a Waveform

Selecting the Radix of Busform Readouts

Determining the Data Source of the Selected Waveform

Controlling Whether a Waveform is Visible

. . Display Analog Waveforms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Displaying Waveform Readouts
1. In the System window, click a Waveform window icon.

2. Double-click the label of the waveform whose options you want to set.

3. Click Options.

4. If you want to show readouts, click Show Readouts.

5. If Show Readouts is checked, set the color of the displayed readouts.

Related Topics
Setting Waveform Options

Setting the Waveform Style

Setting the Waveform Limits
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. . Display Analog Waveforms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Changing the Waveform Time Scale (Time/Division)
1. In the System window, click a Waveform window icon to open the window.

2. If the Waveform Toolbar is not displayed, click Waveform Toolbar from the View menu.

3. Using the Time/Div control, select the time per division or enter the time/div if the desired value
does not appear in the list.

The center of the screen remains fixed when time per division changes. You cannot display less than
two horizontal divisions.

. . Display Analog Waveforms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Changing Waveform Window Properties
1. In the System window, click a Waveform window icon to open the window.

2. From the View menu, click Properties.

3. Select the Waveform Window tab.

4. In the dialog box, select whether or not to show graticules and violations.

5. Click Show Compare to enable comparison of data.

6. Use the drop-down list to select the color of glitches, graticules, and background.

7. Select the desired Color Scheme.

8. Select whether or not to snap cursors and marks to transition edges.

TIP. To quickly access the Properties dialog box, right-click in the Waveform window and select Properties.

Related Topics
Making Glitches Visible

Selecting the Glitch Color

Selecting the Graticule Color

Selecting the Background Color

Selecting the Active Data Window Color Scheme
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Controlling Whether a Waveform is Visible
1. In the System window, click a Waveform window icon.

2. Double-click the label of the waveform whose attributes you want to change.

3. If not selected, select from the Waveform list the waveform you want to change.

4. Click the Show Waveform check box.

5. Click OK.

Related Topics
Changing Waveform Appearance

Changing the Height of a Waveform

Selecting the Radix of Busform Readouts

Determining the Data Source of the Selected Waveform

Changing the Color of a Waveform

. . Display Analog Waveforms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Selecting the Violation Color
1. In the System window, click a Waveform window data icon.

2. Double-click a waveform label.

3. Click the Waveform Window tab.

4. Click the violation color from the Show Violations color drop-down list.

5. Click OK.

Related Topics
Making Violations Visible

Changing Waveform Window Properties
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Making Violations Visible
1. In the System window, click a Waveform window data icon.

2. Double-click a waveform label.

3. Click the Waveform Window tab.

4. Click the Show Violations check box.

5. Click OK.

When the Show Violations box is checked, violations are displayed on all waveforms.

Related Topics
Changing Waveform Window Properties

Selecting the Violation Color

. . Display Analog Waveforms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Selecting the Active Data Window Color Scheme
1. In the System window, click a Waveform window icon.

2. Double-click a waveform label.

3. Click the Waveform Window tab.

4. From the Color Scheme drop down list, select the color scheme for the active window.

Related Topics
Selecting the Glitch Color

Selecting the Graticule Color

Selecting the Background Color

Changing Waveform Window Properties
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Selecting the Background Color
1. In the System window, click a Waveform window icon.

2. Double-click a waveform label.

3. Click the Waveform Window tab.

4. From the Background drop down list, select the background color.

5. Click OK.

Related Topics
Selecting the Glitch Color

Selecting the Graticule Color

Changing Waveform Window Properties

Selecting the Active Data Window Color Scheme

. . Display Analog Waveforms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Selecting the Graticule Color
1. In the System window, click a Waveform window icon.

2. Double-click a waveform label.

3. Click the Waveform Window tab.

4. From the Show Graticule color list, select the graticule color.

5. Click OK.

Related Topics
Making Graticules Visible

Changing Waveform Window Properties
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. . Display Analog Waveforms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Making Graticules Visible
1. In the System window, click a Waveform window icon.

2. Double-click a waveform label.

3. Click the Waveform Window tab.

4. Click the Show Graticule check box.

5. Click OK.

When the Show Graticule box is checked, graticules are displayed on all waveforms.

Related Topics
Changing Waveform Window Properties

Selecting the Graticule Color

. . Display Analog Waveforms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Changing the Size of a Waveform
Move the cursor over the lower part of the waveform label until it changes from a pointer to a resize cursor.
Click the left mouse button and drag to change the size of the waveform.

Alternate Method
1. In the System window, click the Waveform window icon.

2. To open the waveform Properties dialog box, double-click the label of the waveform you want to resize.

3. Click the Waveform tab.

4. Enter the size you want the waveform to be using the Height spin box.

5. Click OK.

This procedure changes the size of the waveform by changing the size of the labeled waveform track. The
size of the waveform is also affected by the vertical input range setting.
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Jump Over Time Gaps in the Waveform Window
One way to jump over large time gaps in the Waveform window is to create a Listing window of the same
data as that of the Waveform window, and then lock the two windows together. As you move the cursor
through the Listing window, the cursor in the Waveform window will track and jump over the "dead" or
blank space between samples.

. . Display Analog Waveforms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Setting Waveform Options
1. In the System window, click a Waveform window icon.

2. Double-click the label of the waveform whose options you want to set.

3. Click the Options button.

From this dialog box you can:

Set whether to show readouts.

Set the waveform voltage limits.

Set the style of logic analyzer waveforms.

Set the readout color.

Related Topics
Setting the Waveform Style

Setting the Waveform Limits

Showing Waveform Readouts
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. . Display Analog Waveforms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Viewing an LA Waveform in Magnitude Mode
In the Waveform window, right-click on any LA busform label and select Display Magnitude from the
menu.

NOTE. Magnitude mode is only available for LA busforms. Magnitude mode is not available for DSO or External
Oscilloscope waveforms.

Alternate Method
1. In the System window, click the Waveform window icon.

2. Double-click an LA waveform.

3. Click Options.

4. Click Magnitude.

5. Click Signed data if you want to interpret the acquisition data as signed data.

NOTE. When you want to interpret the LA waveform as signed data, make sure you select a radix, such as signed
decimal, so that the readouts will display the correct information.

6. If Lock to Setup is not checked, set the maximum and minimum values to display in the waveform.

7. Click OK twice and adjust the time per division to view the waveform.

. . Display Analog Waveforms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Scrolling Between Samples in a Waveform Window
1. In the Waveform window, move the pointer to the center of the window.

2. Right-click the mouse and click either Go To Next Sample or Go To Prior Sample.

The Waveform window will scroll to the next or previous sample.

Use this method of scrolling over gaps in the waveform data where there are no data samples due to
clock or data qualification.

How to . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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How to Viewing Probe Status

Probes

Viewing Probe Status
Text describing the probe attached to a vertical channel and the probe status is displayed at the bottom of
each channel page. To view the status:

1. In the System window, click the DSO Setup button, and then click a channel tab.

2. Read the probe status.

Related Topic
Calibrating Probes

How to . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Set Up the Oscilloscope

Naming the Vertical Channel Signal
For a DSO module:

1. In the System window, click the External Oscilloscope Setup button, and then click the Setup tab.

2. Select the Channel for which you want to name the signal.

3. Enter the name (default is Channel number).

. . Set Up the Oscilloscope . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Selecting the DSO Horizontal Settings
For an external oscilloscope:

1. In the System window, click the External Oscilloscope Setup button, and then select the Setup tab.

2. Use the Depth Limit drop-down list to select the Memory Depth.

3. Use the Horizontal menu on the external oscilloscope to select the remaining horizontal settings.
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How to Setting Up Waveform Measurements

Take Measurements with Your Oscilloscope

Setting Up Waveform Measurements
1. In the System window, click the Waveform window icon.

2. Double-click the external waveform label for which you want to set up measurements, and then click
the Measurement Setup button.

3. Use the >> button to select up to three measurements from the Available Measurements list.

4. For each measurement type, select a Base-Top Determination method.

5. Select a Reference Level to use for the waveform measurements.

6. From the High-, Low-, and Mid-Reference list boxes, set the desired reference values or click the Set
Defaults button to use the default values.

7. Select the Gating method to use for the waveform measurement and then set the related parameters, if
applicable.

NOTE. You must first acquire waveform data before selecting the Marks gating method and setting related parameters.

8. Click OK.

Alternate Method
1. In the System window, click the Waveform window icon.

2. From the Waveform window, right-click the waveform label to display a context menu, and then
click Add/Delete DSO Measurements.

3. Use the >> button to select up to three measurements from the Available Measurements list.

4. For each measurement type, select a Base-Top Determination method.

5. Select a Reference Level to use for the waveform measurements.

6. From the High-, Low-, and Mid-Reference list boxes, set the desired reference values or click the Set
Defaults button to use the default values.

7. Select the Gating method to use for the waveform measurement and then set the related parameters, if
applicable.

NOTE. You must first acquire waveform data before selecting the Marks gating method and setting related parameters.

8. Click OK.
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Related Topic
Removing Selected DSO Waveform Measurements

. . Take Measurements with Your Oscilloscope . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Removing Selected Analog Waveform Measurements
1. In the waveform Properties dialog box, select the waveform containing measurements that you want to
remove and click the Measurement Setup button.

2. Select the waveform measurement that you want to remove from the Selected Measurements list
box and click the Remove button (<<).

3. Click OK.

Related Topic
Selecting DSO Waveform Measurements

. . Take Measurements with Your Oscilloscope . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Taking Voltage Measurements
1. In the System window, click a waveform icon.

2. Select a waveform.

3. Move Cursor 1 to the location on the waveform that you want to measure.

4. Read the voltage from the C1 readout on the Measurement toolbar.

5. Move Cursor 2 to another location on the waveform that you want to measure.

6. Read the voltage from the C2 readout on the Measurement toolbar.

7. Read the voltage difference between the two waveform locations from the Delta readout on the
Measurement toolbar.

Related Topics
Taking Time Measurements

Taking Delta Time Measurements

Taking Delta Volts Measurements

Taking Logic Analyzer Measurements
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Taking Delta Volts Measurements
1. In the System window, click a waveform icon.

2. Select a waveform.

3. Move Cursor 1 to the first location on the waveform that you want to measure.

4. Move Cursor 2 to a second location on the waveform that you want to measure.

5. Read the voltage difference between the two waveform locations from the Delta readout.

For LA Busform, the delta shows a sort of bit-wise difference. The delta is formed by treating C1 and C2
values as bit vectors, and setting a 1-bit in the delta at each position where C1 and C2 differ.

For example, in LA Busform if C1 has a group value of 0x8A and C2 has a group value of 0x0C, the
delta is 0x86 (the difference is 0x7E).

Related Topics
Taking Voltage Measurements

Taking Time Measurements

Taking Delta Time Measurements

Taking Logic Analyzer Measurements
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How to Taking Time Measurements

. . Take Measurements with Your Oscilloscope . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Taking Time Measurements
1. In the System window, click a waveform window icon.

2. Select a waveform.

3. Move Cursor 1 to the location on the waveform that you want to measure.

4. Read the time from the C1 readout on the Measurement toolbar.

5. Move Cursor 2 to another location on the waveform that you want to measure.

6. Read the time from the C2 readout on the Measurement toolbar.

7. Read the time difference between the two waveform locations from the Delta readout on the
Measurement toolbar or from the Delta Time toolbar.

Cursor time is relative to the system trigger.

Related Topics
Taking Delta Time Measurements

Taking Voltage Measurements

Taking Delta Volts Measurements

Taking Logic Analyzer Measurements

. . Take Measurements with Your Oscilloscope . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Taking Delta Time Measurements
To take a single Delta Time measurement do the following:

1. In the System window, click a waveform window icon.

2. Click the Add Delta Time toolbar button if the toolbar is not already displayed. Note that you can
have as many Delta Time toolbars as you want.

3. Select a waveform.

4. Move Cursor 1 to the location on the waveform where you want the time measurement to start.

5. Move Cursor 2 to another location on the waveform where you want the time measurement to end.

6. Read the time difference between the two locations from the Delta Time toolbar.
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How to Taking Delta Time Measurements

To lock the Delta Time do the following:

1. Click the drop-down list on the Delta Time toolbar button.

2. Select Lock Delta Time. This locks the cursors or marks in the Delta Time toolbar with respect to
delta time.

Lock Delta time is disabled if either of the following is true:

The data window is locked

You have an unmovable measurement point selected for the delta time calculation such as System
Trigger

The delta time readout is negative when C2 precedes C1.

For an LA Busform, the delta shows a sort of bit-wise difference. The delta is formed by treating C1 and
C2 values as bit vectors, and setting a 1-bit in the delta at each position where C1 and C2 differ.

For example, in LA Busform if C1 has a group value of 0x8A and C2 has a group value of 0x0C, the
delta is 0x86 (the difference is 0x7E).

TIP. You can take multiple Delta Time measurements by selecting different measurement points from the Delta Time
toolbar. Alternatively, you can add Delta Time toolbars to take additional measurements.
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How to Taking Logic Analyzer Measurements

Related Topics
Taking Time Measurements

Taking Voltage Measurements

Taking Delta Volts Measurements

Taking Logic Analyzer Measurements

. . Take Measurements with Your Oscilloscope . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Taking Logic Analyzer Measurements
1. In the System window, click a waveform icon.

2. Select a logic analyzer group magnitude, group digital, or channel digital waveform.

3. Move Cursor 1 to the location on the waveform that you want to measure.

4. Read the value of the logic analyzer waveform from the C1 readout on the Measurement toolbar.

5. Move Cursor 2 to another location on the waveform that you want to measure.

6. Read the value of the logic analyzer waveform from the C2 readout on the Measurement toolbar.

7. Read the value of the difference in time between the two waveform locations from the Delta readout
on the Measurement toolbar.

Values for logic analyzer channel digital waveforms are binary 0 or 1.

Values for logic analyzer group magnitude and group digital waveforms are in the selected radix. The
delta values are blank if you use a symbolic radix.

Related Topics
Taking Time Measurements

Taking Delta Time Measurements

Taking Voltage Measurements

Taking Delta Volts Measurements
How to . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Trigger an Oscilloscope

Determining Which Module is Set to Arm the DSO
1. In the System window, click the DSO Trigger button.

2. Read the text above the Mode control. The text tells which other module is programmed to arm this
module. There is no text if this module will be armed by the Run command or if the arming module
is disabled.
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How to Arming other Modules from a DSO

. . Trigger an Oscilloscope . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Arming other Modules from a DSO
1. In the System window, click the DSO Setup button.

2. Click the Trigger tab.

3. From the Action box, click Trigger & Arm.

4. Go to the box immediately below the Action box and select module you want to arm.

. . Trigger an Oscilloscope . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Setting Up the DSO Trigger
1. In the System window, click the DSO Trigger button.

2. Select a trigger Mode.

3. Select the trigger Action, and if available, the module acted upon or the signal to set.

4. Select the trigger position relative to the total memory depth.

5. Select the trigger Event Type.

6. Set the controls for your selected Event Type:

Alternate Method
1. In the System window, click the DSO Setup button.

2. Click the Autoset button.

Trigger Event Types
Trigger event types include: edge, pulse width, timeout, glitch, slew rate, runt, logic, immediate,
and wait for system trigger.
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How to Selecting the Trigger Action and Target for an External Oscilloscope

. . Trigger an Oscilloscope . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Selecting the Trigger Action and Target for an External Oscilloscope
1. In the System window, click the External Oscilloscope Trigger button.

2. Select the trigger event:

Oscilloscope triggers – The external oscilloscope initiates the trigger

TLA System trigger – The TLA System trigger initiates the oscilloscope trigger

3. Select the trigger action:

Trigger oscilloscope only

Trigger TLA too
How to . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Use the Waveform Window

Adding Reference Data to a Waveform Window
1. In the System window, click the Waveform window icon.

2. From the Edit menu, click Add Waveform.

3. From the Add Waveform dialog box, click the Add Data Source button.

4. Click the Browse button and search for the appropriate source.

5. After the data source is added, select it in the Add Waveform dialog box.

6. Select the desired waveforms.

TIP. Click to open the Add Waveform dialog box.
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General Application Information Running Extended Diagnostics

General Application Information

Running Extended Diagnostics
1. You may want to save your system before running diagnostics. Extended diagnostics will invalidate
your acquired data.

2. Disconnect any probes attached to your instrument.

3. From the System menu, click Calibration and Diagnostics.

4. Click the Extended Diagnostics tab from the Calibration and Diagnostics dialog box.

5. Select the test or set of tests you want to run.

6. Click the option button associated with the Run mode you want to use: One Time, Continuous, or
Until Fail.

7. Click Run. If you selected Continuous or Until Fail, you can click on the Abort or Stop buttons to
stop the process.

If the diagnostics fail, you can refer to the service manual for the particular product, or contact your
local Tektronix service center.

Related Topics
Extended Diagnostics

Technical Support

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Displaying Mainframe Information
Go to the System menu and click System Properties. The Mainframe tab appears.

TIP. If the System window is active, click the right mouse button while the pointer is outside any icon and click
System Properties.

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Displaying Module Information
1. Go to the System menu and click System Properties.

2. Click the appropriate module tab to display its properties.

TIP. Double-click the module icon in the System window.
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General Application Information Associating Modules with Data Windows

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Associating Modules with Data Windows
In System window, click inside the module icon. A white arrow points from the module icon to its
associated data windows.

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Associating Data Windows with Modules
In the System window, click the data window name.

A white arrow points from the module icon to the data window. If you have multiple data windows, the
arrow from the module icon may point to multiple data window icons.

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Running Mainframe Diagnostics
1. Exit the TLA application.

2. Click the Start button and go to the mainframe diagnostics using the following path:

Programs/Tektronix Logic Analyzer/TLA Mainframe Diagnostics.

If a failure occurs, contact your local Tektronix Technical Support representative.

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Defining Reference Data
1. In the System window, click the LA Setup button.

2. Click Define Compare to open the Define Compare dialog box.

3. Click the Enable Data Compare check box.

4. Click the Add Data Source button, then select the reference module from the list or click Browse to
search for a saved LA module.

5. Click the Add button to add the data source to the Reference Data Source list.

6. Select a Reference Data Source from the list.

7. Define the parameters in the Compare Data Region.

8. Define the parameters for the Data Source Alignment.

9. Click OK.
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General Application Information Customizing the System Tools menu

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Customizing the System Tools menu
You can customize the Tools sub-menu of the System menu by adding, editing, and deleting menu items.
You can add frequently used utilities to the Tools menu and run them from within your TLA. To do this,
use the Tools page in the Options dialog box (accessed from the System menu).

To add a tool to the Tools menu

As an example, the following procedure demonstrates how to add the Windows WordPad accessory to
the Tools menu.

1. From the System menu, click Options and then click the Tools tab.

2. Click the Add button to bring up the Tool Properties Dialog.

3. In the Menu Name text box, type WordPad.

4. In the Command box, browse or type the path and name of the program, for example:

C:\program files\accessories\wordpad.exe

5. In the Arguments text box, type any arguments to be passed to the program.

6. In the Initial Directory box, type the file directory where the command is located.

7. If you want the program to run in a minimized window, check the Run Minimized box.

Once the tool appears on the Tools menu, to run the program, just choose it from the menu or click
on its button in the Toolbar.

Arguments and commands with embedded spaces must be enclosed in quotes in the Tool Properties (App
Options) dialog in order for the commands to work.

Related Topics
Editing a Tool on the Tools Menu

Removing a Tool from the Tools Menu
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Data Window Information Adding a Data Source to an Active Waveform Window

Data Window Information

Adding a Data Source to an Active Waveform Window
1. In the System window, click a Waveform window icon.

2. From the Edit menu, click Add Waveform.

3. From the Data Source list, select a Data Source or click the Add Data Source button if the source is
not listed.

4. Click the Close button.

TIP. Click to open the dialog box.

To quickly add MagniVu waveforms, click in the waveform window. Or press the MagniVu
button on the front panel. Click the button again to remove the MagniVu data from the window.

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Opening a Saved Data Window
1. From the Window menu, click Load Data Window.

2. Click the Browse button to search for the file, or enter a path to the desired file.

3. Enter a Window name or use the default.

4. Once the file is found, click Open.

5. Click OK.

NOTE. The saved data file must be a saved system file.

Related Topics
Creating a Histogram Window that Contains No Data

Creating a New Histogram Window from a Data Source

Creating a Source Window that Contains no Data

Creating a New Source Window Correlated to an Existing Listing Window

Creating a New Waveform Window from a Data Source

Creating a New Waveform Window that Contains Data Based on the Active Window

Creating a Waveform Window that Contains No Data

209



Data Window Information Creating an Overlay Waveform

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Creating an Overlay Waveform
1. In the System window, click the Waveform window icon.

2. Click the label of a waveform you want to include in an overlay waveform.

3. Drag the waveform label to the second waveform that you want included in the overlay waveform. As
you drag the waveform label, a drop marker displays at the left edge of the waveform label. Use this
drop marker to determine which waveform you will be selecting to form a waveform overlay.

4. In the Add Overlay Waveform Name dialog box, either enter a name and click OK or simply click
OK to use the default overlay waveform name. This name will be prepended to all waveform labels in
the overlay waveform.

Related Topics
Overlay Waveform

Overlay Waveform Properties

Waveform Properties

Changing Waveform Properties

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Locking Windows
1. In the System window, click a Listing, Waveform, Graph, or Protocol window icon.

2. From the View menu, select Lock Windows.

3. From the Lock Windows dialog box, select which windows to lock together.

4. Click either the No time offsets or Current time offsets option button.

5. If you select No time offsets, select which window is the reference in the Reference Window list.

6. Click OK.

NOTE. You can lock Listing, Waveform, Graph, and Protocol windows only.
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Data Window Information Aligning Time of Correlated Data Sources

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Aligning Time of Correlated Data Sources
1. In the System window, click a Listing or Waveform window icon.

2. From the Data menu, select Time Alignment.

3. Perform the following steps for each data source:

4. Click OK.

Related Topics
Adding Reference Data to a Listing Window

Adding Reference Data to a Waveform Window

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Adding a Mark to a Data Window
From the Edit menu, click Add Mark. The mark appears at the center of the display and has default
properties.

NOTE. You cannot add a mark if you have not acquired data.

TIP. Use the right mouse button in the data area to add a mark at a particular sample.

Related Topics
Changing Mark Properties

Moving Marks
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Data Window Information Moving Marks

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Moving Marks
1. In the System window, click the appropriate data window icon.

2. Select the mark handle (in the data area mark bar or the overview mark bar) and drag the mark to
the new location.

NOTE. You cannot move begin, end, or trigger marks. If you drag a mark past the boundary of the data area using
a handle in the Data Area Mark bar, the data area scrolls to keep the mark in view. If you drag a mark off-screen
using its handle in the Overview Mark bar, the data area scrolls keeping the mark in view. The mark in the Data
Area Mark bar indicates that the mark is off screen with an arrow, such as if you scroll the data window,
causing the mark to move off screen.

Related Topics
Sending Stacked Marks to the Back

Adding a Mark to a Data Window

Changing Mark Properties

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Sending Stacked Marks to the Back
1. Select a mark you know is on top of another one.

2. From the Edit menu, select Send To Back.

TIP. Click the right mouse button on the mark and select Send To Back.
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Data Window Information Going to a Specific Mark

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Going to a Specific Mark
1. In the System window, click the appropriate data window icon.

2. From the Data menu, click Go To.

3. Click the Mark option button.

4. Select the mark you want to display.

5. Click the Go To button. The mark appears in the center of the display.

NOTE. When moving between marks in a Source window, the new mark may cause another source file to load in
the Source window.

TIP. In the data window, click to open the name of the dialog box.

Click the right mouse button on a mark and click Go To.

Related Topic
Adding a Mark to a Data Window

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Expand Channels
Expand Channels replaces all busforms in the selection set with their component channel waveforms.

After the operation is finished, the selection set is modified to contain only the added waveforms.

Related Topic
Collapse Channels
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Data Window Information Collapse Channels

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Collapse Channels

Overview
Collapse Channels replaces all channel waveforms with their container busform waveforms.

Behavior
Exactly one instance of each busform is added, no matter how many of its channels are actually present in
the selection set.

After the operation is finished, the selection set is modified to contain only the added waveforms.

Related Topic
Expand Channels

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Removing Data from a Listing or Waveform Window
1. Go to the data window where you want to remove a column or a waveform.

2. Select the column or waveform labels that correspond with the data you want removed.

3. From the toolbar, click Cut.

NOTE. Some columns or waveforms in the display may not be visible. This is generally true if a microprocessor
support package is in use. To verify that invisible columns or waveforms exist, open the Properties dialog box
and select the Column or Waveform tab. Check whether the Show Column or Waveform option is selected for
each column or waveform.
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Data Window Information Removing Waveforms from an Overlay Waveform

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Removing Waveforms from an Overlay Waveform
1. In the System window, click the Waveform window icon.

2. Click the label of a waveform you want to remove from the overlay waveform.

3. Drag the waveform label to the boundary of the overlay waveform. As you drag the waveform label,
a drop marker displays at the left edge of the waveform label. Use this drop marker to position the
waveform label outside of the overlay waveform.

Alternate Method
1. In the System window, click the Waveform window icon.

2. Double-click the waveform overlay to display the Waveform properties tab.

3. Click the label of a waveform you want to remove from the Overlay Waveforms list, and then use the
<< button to remove it from the overlay waveform.

NOTE. You cannot remove waveforms from an overlay waveform using the Waveform properties tab, unless they
were added using the Waveform properties tab in the current session. If you attempt to do so, selecting a waveform
label from the Overlay Waveforms list prompts the system to disable the << button.

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Naming Columns and Waveforms
From the Setup window for the LA, DSO, or External Oscilloscope, perform one of the following:

Rename the column under Group Name, located in the LA Setup window.

Rename the Signal Name for the channel, located in the DSO Setup window.

Rename the Channel, located in the External Oscilloscope Setup window.

Rename the Channel from the Waveform window using the right-click menu.

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Naming Individual LA channels
1. Go to the Setup window for the particular data window.

2. Rename the channel in the Probe Channels/Names table by entering a new name in the box to the
right of the probe channel.
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. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Storage

Overview
Storage refers to storing acquired data in memory. You can select storage modes that filter the data, discard
unwanted samples, and store only the data you want.

Storage Qualification
The trigger function block includes storage qualification that looks at sampled data. If the storage
conditions are met, a storage qualifier signal enables sampled data to pass into the acquisition memory as
qualified data. Any unqualified data samples are excluded.

Storage Setup
The Acquire box in the Setup window controls storage, using individual storage actions specified in
If/Then clauses and the Storage box in the Trigger window toolbar.

NOTE. On TLA7Lx and TLA7Mx modules, the first transition state indication is random. On TLA7Axx/TLA7NAx
modules and TLA5000B Series mainframes, the first transition state indication is always false. On TLA7Nx, TLA7Px,
and TLA7Qx modules, the first transition state always shows a transition indication (even if there are no probes
plugged in). One way to avoid triggering on a false first transition indication is to set the first state to "If Anything Goto
Next State". This will consume a state, but will ensure that there is no false triggering on the first transition indication.

NOTE. When global storage is set up to use transitional storage, to ensure that a false transition is not recorded,
the first state must be "If Anything Then Next State".

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Storage Selection for an LA Module
Use the Storage box to select the default storage rules for the module. The default storage setting can be
overridden by a storage action in a trigger clause definition.

The Storage box is located in the toolbar of the LA Trigger window.

Related Topics
Clause Definition Dialog Box

Data Sample Storage Selections
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. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Storing DSO Data in Memory
The acquisition memory works like a circular buffer, storing data samples until the entire memory is full.
After that, each new data sample overwrites the oldest existing sample.

This process continues until the trigger event is found and the post-trigger delay counter reaches the
specified value (based upon the trigger position selection), which stops the acquisition.

During the acquisition you can monitor the progress of the data storage process using the Status Monitor.

Displaying DSO Data
After storing the data you can display the acquired data in the data windows.

In the Waveform window the data is shown as analog waveforms.

In the Listing window the data is shown as a series of voltage values.
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. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Waveform Cursors

Overview
Cursors in a waveform data window are vertical lines that mark time points in the data record. The two
cursors are always present, although they may be off-screen. Each cursor has a handle in the Data Area
Mark bar and in the Overview Mark bar.

To Use
To select a cursor or other data mark, click its handle in the Data Area Mark Bar or Overview Mark Bar.
Selecting a mark changes its color. To edit a data mark, select the mark and then use the Edit menu. You
can select a cursor or user mark handle and drag the mark to a new location. You can drag a cursor past
the boundary of the data area using a handle in the Data Area Mark bar. The data area scrolls to keep the
cursor in view. If you drag a cursor off-screen using its handle in the Overview Mark bar, the data area
scrolls to keep the mark in view. The cursor in the Data Area Mark bar indicates that the cursor is off
screen with an arrow, such as if you scroll the data window, causing the cursor to move off screen.

Behavior
When you open a Waveform window, cursor C1 is active. The name of the active cursor is displayed in
bold text in the cursor bar. The active cursor is also displayed as a dashed line. Selecting a cursor handle or
changing the cursor position using the cursor bar readout makes the cursor the active cursor. Changing
the delta time readout changes the position of the inactive cursor.

Cursor time values that fall within an acquisition gap are forced to the closest valid display point. When
you place cursors on both sides of an acquisition gap, the displayed delta value is greater than the time
between the two data points.

If you drag a cursor past the boundary of the data area using a handle in the Data Area Mark bar, the data
area scrolls to keep the cursor in view. If you drag a cursor past the boundary using its handle in the
Overview Mark bar, the data area scrolls to keep the cursor in view. The cursor in the Data Area Mark bar
indicates that the cursor is off screen with an arrow, such as if you scroll the data window, causing
the cursor to move off screen.
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. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Time per Division
Use the Time/Division dialog box to select the horizontal time per division scaling for the current
Waveform window. The list contains standard time per division values in a 1, 2, 5 sequence. You can also
enter a non-standard time per division value in the Custom box. This can be any number between the
minimum and maximum values shown in the list. The default value is the current setting.

You can change the time per division from a Waveform window or from the Time/Division dialog box. To
access the Time/Division dialog box from the View menu, click Time/Div.

Related Topic
Changing the Time per Division
Clocking Information

Internal 2X Clocking Details

Overview
Internal 2X Clocking mode acquisition allows data to be acquired and displayed at twice the normal
maximum sample frequency of the logic analyzer. In this mode, half of the logic analyzer input channels
are traded for twice the speed and twice the acquisition depth.

The following example illustrates how Internal 2X Clocking acquisition differs from internal clocking
acquisition and demonstrates when it can be used in observing fast data values.

Acquiring Data
The logic analyzer is set up to acquire data from a target system probed by the A-3(7-0) channels and
the D3(7-0) channels. In the LA Setup dialog box, the A3(7-0) channels are used to form a group called
A3 and the D3(7-0) channels are used to form a group called D3. The logic analyzer is set to trigger
when Group A3 equals 01. Assume that the data present on the target system changes every clock cycle
and has the following pattern:

The data is shown in hexadecimal radix and the times are in relation to the logic analyzer trigger position.
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NOTE. The logic analyzer module used for this example has a minimum sample period of 2 ns for internal clocking
mode.

First, an Internal 2X acquisition is taken. The clocking mode is set to Internal in the LA Setup window.
The sample period is set to its minimum value of 2 ns. The acquisition samples stored in the logic analyzer
module are as follows:

Internal clocking acquisition examples
A3 Channels D3 Channels Time
01 31 0 ns
03 33 2.0 ns

Note that the data on the target system was changing too fast for the logic analyzer to capture all the
values. Next, an internal 2X clocking mode acquisition is taken. The clocking mode is changed to Internal
2X in the LA Setup window. The sample rate is now fixed at 1 ns. Also, each acquisition memory depth
setting is doubled under internal 2X clocking mode.

In internal 2X clocking mode, the A3 channels are routed or demultiplexed into the D3 channels. The
D3 channels actually see the physical signals coming from the A3 lines at the probe tip. This means that
any physical signal connections to the D3 channel are ignored. The demultiplex occurs internal to the
logic analyzer module, and does not require any external probing changes. With this arrangement, the
A3 channels are referred to as the demultiplex source channels and the D3 channels are the demultiplex
destination channels. Note in the LA Setup dialog box channel grid that all of the demultiplex destination
channels are highlighted in pink and demultiplex source channels are highlighted in blue when Internal
2X mode is selected.

For internal clocking acquisitions, the A3 channels in the acquisition sample are used to store data from
the A3 probe inputs while the D3 channels in the acquisition sample are used to store data from the D3
probe units. In internal 2X clocking mode, the A3 channels store data from the A3 probe inputs at time
t, while the D3 channels store data from the A3 probe inputs at time t + 1 ns. There are two logical
acquisition samples stored in each physical sample. The acquisition samples stored in the LA module in
internal 2X clocking mode are as follows:

Internal 2X clocking acquisition samples
A3 Channels D3 Channels Time
01 02 1.0 ns
03 04 3.0 ns

Viewing Acquired Data
When viewing internal clocking data in a Listing window, the window contents track the stored acquisition
data closely. A Listing window for the internal clocking acquisition above might look like the following:
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Listing window - internal clocking data
Sample A3 D3 Timestamp
0 01 31 0 ns
1 03 33 2.0 ns

In Internal 2X clocking mode, there are twice as many samples shown in the Listing window as there are
physically stored on the acquisition card. Each physical sample is expanded into its two component logical
samples, which are shown in the Listing window.

Listing window - internal 2X clocking data
Sample A3 D3 Timestamp
0 01 02 0 ns
1 02 -- 1 ns
2 03 04 2 ns
3 04 -- 3 ns

Looking at the A3 column in the Listing window, you can see that the data pattern matches the behavior
of the target system from which the data was acquired. In this window, samples 0 and 2 come directly
from the stored acquisition, while samples 1 and 3 are synthesized from the demultiplex destination data.
In order to form the synthesized data samples, the data from each demultiplex destination channel is
copied into its demultiplex source channel. The D3 column demonstrates how destination channels are
handled in a Listing window. For the stored data samples, the data values are shown; for the synthesized
samples, the data values are dashed out.

The Internal clocking data viewed in a Waveform window also tracks the acquisition sample format closely.

Waveform window - internal clocking data

A Waveform window view of internal 2X clocking data shows the demultiplex source channels changing
every sample, while the demultiplex destination channel data changes only once every other sample. There
is no dashing or other special display formatting performed for the demultiplex destination channels.

Waveform window - internal 2X clocking data
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The demultiplex source and destination channel mappings used for internal 2X clocking mode depend
on the logic analyzer module width. For more information about demultiplex channel mappings, see
Probe Demultiplexing.

Channel activities under internal 2X clocking mode show the activities after the demultiplex occurs,
rather than showing probe tip activities.

Glitch storage is not available under internal 2X clocking mode.

MagniVu data is unaffected by internal 2X clock modes because it always acquires non-demultiplexed
1X data.

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Internal 4X Clocking Details

Overview
Internal 4X mode acquisitions allow data to be acquired and displayed at four times the normal maximum
sample frequency of the logic analyzer. In this mode, three quarters of the logic analyzer input channels
are traded for four times the speed and four times the acquisition depth.

The following example illustrates how an Internal 4X acquisition differs from normal 1X acquisition and
demonstrates when it can be used in observing fast data transitions.

Acquiring Data
The logic analyzer is set up to acquire data from a target system probed by the A3(7-0), A2(7-0), D3(7-0),
and D2(7-0) channels. In the LA Setup dialog, the A3(7-0) channels are used to form a group called A3,
the A2(7-0) channels are used to form a group called A2, the D3(7-0) channels are used to form a group
called D3, and the D2(7-0) channels are used to form a group called D2. Under Internal 4X clocking,
data in the A3 channel is distributed to the A2, D3, and D2 channels. The logic analyzer is set to trigger
when Group A3 equals 01. Assume that the data present on the target system changes every 500 ps
and has the following pattern:
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The data is shown in hexadecimal radix and the times are in relation to the logic analyzer trigger position.

NOTE. The logic analyzer module used for this example has a minimum sample period of 2 ns for Internal clocking
mode.

First, an internal clocking acquisition is taken. The clocking mode is set to Internal in the LA Setup
dialog. The sample period is set to 2 ns. In internal clocking mode, no demultiplexing occurs; each
channel receives data directly from the probe tip. The acquisition samples stored in the logic analyzer
module are as follows:

Internal clocking acquisition samples
A3 Channels A2 Channels D3 Channels D2 Channels Time
01 2F 31 4F 0 ns
05 2B 35 4B 2.0 ns

Note that the data on the target system was changing too fast for the logic analyzer to capture all the values.

Next, an internal 4X clocking mode acquisition is taken. The clocking mode is changed to Internal 4X
in the LA Setup dialog. The sample rate is now fixed at 500 ps. Also, each acquisition memory depth
setting is quadrupled under 4X mode.

In Internal 4X clocking mode, the A3 channels are routed or demultiplexed into the A2, D3, and D2
channels. The A2, D3, and D2 channels actually see the physical signals coming from the A3 lines. This
means that any physical signal connections to the A2, D3, and D2 channels are ignored. The demultiplexing
occurs internal to the logic analyzer module and does not require any external probing changes. With this
arrangement, the A3 channels are referred to as the demultiplex source channels and the A2, D3, and D2
channels are the demultiplex destination channels. Note in the LA Setup dialog channel grid that all of the
demultiplex source and destination channels are highlighted when internal 4X mode is selected.

For normal acquisitions, the A3 channels in the acquisition sample are used to store data from the A3 probe
inputs, the A2 channels in the acquisition sample are used to store data from the A2 probe inputs, the D3
channels in the acquisition sample are used to store data from the D3 probe units, and the D2 channels in
the acquisition sample are used to store data from the D2 probe units. In 4X mode, data acquired from the
A3 source channel is distributed to the A2, D3, and D2 destination channels. The A3 channels store data
from the A3 probe inputs at time t, while the A2 channels store data from the A3 probe inputs at time

223



Clocking Information Internal 4X Clocking Details

t + 500 ps, the D3 channels store data from the A3 probe inputs at time t + 1 ns, and the D2 channels store
data from the A3 probe inputs at time t + 1.5 ns. There are four logical acquisition samples stored in each
physical sample. The acquisition samples stored in the LA module in 4X mode are as follows:

Internal 4X clocking acquisition samples
A3 Channels A2 Channels D3 Channels D2 Channels Time
01 02 03 04 1.0 ns
05 06 07 08 3.0 ns

Viewing Acquired Data
When viewing internal clocking data in a Listing window, the window contents track the stored acquisition
data closely. A Listing window for the internal clocking acquisition above might look like the following:

Listing window - internal clocking data
Sample A3 A2 D3 D2 Timestamp
0 01 2F 31 4F 0 ps
1 05 2B 35 4B 2.0 ns

In internal 4X clocking mode, there are four times as many samples shown in the Listing window as there
are physically stored on the acquisition card. Each physical sample is expanded into four component
logical samples, which are shown in the Listing window.

Listing window - internal 4X clocking data
Sample A3 A2 D3 D2 Timestamp
0 01 02 03 04 0 ps
1 02 -- -- -- 500 ps
2 03 -- -- -- 1.0 ns
3 04 -- -- -- 1.5 ns
4 05 06 07 08 2.0 ns
5 06 -- -- -- 2.5 ns
6 07 -- -- -- 3.0 ns
7 08 -- -- -- 3.5 ns

Looking at the A3 column in the Listing window, you can see that the data pattern matches the behavior of
the target system from which the data was acquired. In this window, samples 0 and 4 come directly from
the stored acquisition, while samples 1, 2, 3, 5, 6, and 7 are synthesized from the demultiplex destination
data. To form the synthesized data samples, the data from each demultiplex destination channel is
copied into the demultiplex source channel. The A2, D3, and D2 columns demonstrate how destination
channels are handled in a Listing window. For the stored data samples, the data values are shown; for the
synthesized samples, the data values are dashed out.

The 1X data viewed in a Waveform window also tracks the acquisition sample format closely.

Waveform Window - internal clocking data
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A Waveform window view of 4X data shows the demultiplex source channels changing every 500 ps,
while the demultiplex destination channel data changes only once every 2 ns. There is no dashing or other
special display formatting performed for the demultiplex destination channels.

Waveform Window - internal 4X clocking data

The demultiplex source and destination channel mappings used for internal 4X clocking mode depend
on the logic analyzer module width. For more information about demultiplex channel mappings, see
Probe Demultiplexing.

Channel activities under internal 4X clocking mode show the activities after the demultiplex occurs,
rather than showing probe tip activities.

Glitch storage is not available under internal 4X clocking mode.

MagniVu data is unaffected by internal 4X clock modes because it always acquires non-demultiplexed
1X data.
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. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

External 2X Clocking Details

Overview
External 2X clocking mode allows data to be acquired and displayed at twice the normal maximum sample
frequency of the logic analyzer. In this mode, half of the logic analyzer input channels are traded for
twice the speed and twice the acquisition depth.

The following example illustrates how external 2X clocking acquisition differs from external clocking
acquisitions and demonstrates how external 2X clocking can be useful in capturing data from target
systems with higher clock frequencies than the base synchronous speed of the logical analyzer module.

Acquiring Data
The logic analyzer is set up to acquire data from a target system probed by the A-3(7-0) channels and
the D3(7-0) channels. In the LA Setup dialog, the A3(7-0) channels are used to form a group called A3
and the D3(7-0) channels are used to form a group called D3. The logic analyzer is set to trigger when
Group A3 equals 01. Assume that the data present on the target system changes every clock cycle and has
the following pattern:

The data is shown in hexadecimal radix and the times are in relation to the logic analyzer trigger position.

For example, assume that the logic analyzer module has a maximum synchronous acquisition speed of
450 MHz. This means that there is a minimum time of 2.22 ns between successive clock edges that can
be captured in external clocking mode. The clock is running at a speed of 800 MHz, which only leaves
1.25 ns between successive rising clock edges. In external 2X clocking mode, the logic analyzer is capable
of capturing every rising or every falling edge of the 800 MHz clock.

First, an external clocking acquisition is taken. The clocking mode is set to External in the LA Setup
dialog box. The clock definition is set to the rising edge of CK0 in the External Clocking dialog box. The
acquisition samples stored in the logic analyzer module are as follows:
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External clocking acquisition samples
A3 Channels D3 Channels Time
01 31 0 ns
03 33 2.5 ns

Note that the data on the target system was changing too fast for the logic analyzer to capture all the
clock edges. Every other clock edge is missed. The timestamps stored in the acquisition samples are the
times of the actual captured clock edges.

Next, an external 2X clocking mode acquisition is taken. The clocking mode is changed to External 2X in
the LA Setup dialog box. The clock edge is set to the rising edge of CK0 in the External 2X Clocking
dialog box. The Setup/Hold windows for all groups are left at their default setting, which means that the
data is sampled just before the rising clock edge.

In external 2X clocking mode, the A3 channels are routed or demultiplexed into the D3 channels. The
D3 channels actually see the signals coming from the A3 lines at the probe tip. This means that any
physical signal connections to the D3 channel are ignored. The demultiplexing occurs internal to the
logic analyzer module, and does not require any external probing changes. With this arrangement, the
A3 channels are referred to as the demultiplex source channels and the D3 channels are the demultiplex
destination channels. Note in the LA Setup dialog channel grid that all of the demultiplex destination
channels are highlighted in pink and the demultiplex source channels are highlighted in blue when external
2X mode is selected.

For external clocking acquisitions, the A3 channels in the acquisition sample are used to store data from
the A3 probe inputs when a clock edge occurs, while the D3 channels in the acquisition sample are used to
store data from the D3 probe units. In external 2X mode, the A3 channels store data from the A3 probe
inputs when the first clock edge occurs, while the D3 channels store data from the A3 probe inputs when
the second clock edge occurs. Each set of two subsequent clock edges follows the same pattern: A3 stores
the data present at the first edge, while D3 stores the data at the following edge. There are two logical
acquisition samples stored in each physical sample. The acquisition samples stored in the LA module in
external 2X clocking mode are as follows:

External 2X clocking acquisition samples
A3 Channels D3 Channels Time
01 02 1.25 ns
03 04 3.75 ns

The timestamp values stored in the acquisition samples are actually the times of the second clock edges
associated with the data that was saved in the demultiplex destination (D3) channels.

Viewing Acquired Data
When viewing external clocking data in a Listing window, the window contents track the stored acquisition
data closely. A Listing window for the external clocking acquisition above might look like the following:
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Listing window - external clocking data
Sample A3 D3 Timestamp
0 01 31 0 ns
1 03 33 2.5 ns

In external 2X clocking mode, there are twice as many samples shown in the Listing window as there are
physically stored on the acquisition card. Each physical sample is expanded into its two component logical
samples, which are shown in the Listing window.

Listing window - external 2X clocking data
Sample A3 D3 Timestamp
0 01 02 0.25 ns
1 02 -- 1.25 ns
2 03 04 2.75 ns
3 04 -- 3.75 ns

Looking at the A3 column in the Listing window, you can see that the data pattern matches the behavior
of the target system from which the data was acquired. In this window, samples 0 and 2 come directly
from the stored acquisition, while samples 1 and 3 are synthesized from the demultiplex destination data.
In order to form the synthesized data samples, the data from each demultiplex destination channel is
copied into its demultiplex source channel. The D3 column demonstrates how destination channels are
handled in a Listing window. For the stored data samples, the data values are shown; for the synthesized
samples, the data values are dashed out.

In the Timestamp column, the timestamps for the generated samples (1 and 3) come directly from the
timestamps stored in the acquisition records. The timestamps for samples 0 and 2 are not stored anywhere
in the acquisition record, so they are generated by subtracting 1ns from the stored timestamp. The
generated timestamps are shown in italics and in a slightly smaller font than the actual stored timestamps.
Generated timestamps do not show exactly where the data was sampled, but they are reasonably close for
clock speeds approaching 800 MHz.

The external clocking data viewed in a Waveform window also tracks the acquisition sample format closely.

Waveform window - external clocking data

A Waveform window view of external 2X data shows the demultiplex source channel data changing every
sample, while the demultiplex destination channel data changes every other sample. There is no dashing or
other special display formatting performed for the demultiplex destination channels.
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Waveform window - external 2X clocking data

The demultiplex source and destination channel mappings used for external 2X clocking mode depend
on the logic analyzer module width. For more information about demultiplex channel mappings, see
Probe Demultiplexing.

Channel activities under external 2X clocking mode show the activities after the demultiplex occurs,
rather than showing probe tip activities.

Glitch storage is not available under external 2X clocking mode.

MagniVu data is unaffected by external 2X clock modes because it always acquires non-demultiplexed
1X data.

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

External 2X DDR Clocking Details

Overview
External 2X DDR clocking mode allows data to be acquired on both the rising and falling clock edges at
clock rates up to the normal maximum sample frequency of the logic analyzer. In this mode, half of the
logic analyzer input channels are traded for twice the data rate and twice the acquisition depth.

External 2X DDR clocking mode is a double data rate clocking mode, which means that two acquisition
samples are taken per clock cycle. Data is captured at the rising clock edge and at the falling clock edge
of each clock cycle. Therefore, the data rate of the acquisition is double the rate of the clock signal
that is driving it.

The following example illustrates how External 2X DDR clocking acquisitions differ from External
clocking acquisitions and demonstrates how External 2X DDR clocking can be useful in capturing data
from target systems with higher data rates than the base synchronous speed of the logic analyzer module.

Acquiring Data
The logic analyzer is set up to acquire data from a target system probed by the A3(7-0) channels and the
D3(7-0) channels. In the LA Setup dialog, the A3(7-0) channels are used to form a group called A3
and the D3(7-0) channels are used to form a group called D3. The logic analyzer is set to trigger when
Group A3 equals 01. Assume that the data present on the target system changes twice every clock cycle
and has the following pattern:
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The data is shown in hexadecimal radix and the times are in relation to the logic analyzer trigger position.
The arrows on the clock signal show which edges are actually captured by the logic analyzer for this
clocking mode.

For this example, assume that the logic analyzer module has a maximum synchronous acquisition speed of
450 MHz. This means that there is a minimum time of 2.22 ns between successive clock edges than can
be captured in external clocking mode. The clock is running at a speed of 400 MHz, which only leaves
1.25 ns between successive clock edges. In external 2X DDR mode, the logic analyzer is capable of
capturing every rising and every falling edge of the 400 MHz clock for a data rate of 800 Mb/s.

First, an external clocking acquisition is taken. The clocking mode is set to External in the LA Setup
dialog. The clock definition is set to the rising and falling edges of CK0 in the External Clocking dialog
box. The acquisition samples stored in the logic analyzer module are as follows:

External clocking acquisition samples
A3 D3 Timestamp
01 31 0 ns
03 33 2.5 ns

Note that the clock on the target system is changing too fast for the logic analyzer to capture all the clock
edges. All of the data associated with the falling clock edges is missed. The timestamps stored in the
acquisition samples are the times of the actual captured rising clock edges.

Next, an external 2X DDR clocking mode acquisition is taken. The clocking mode is changed to External
2X in the LA Setup dialog box. The clock edge is set to both edges of CK0 in the External 2X Clocking
dialog box. The Setup/Hold Windows for all groups are left at their default setting, which means that the
data is sampled just before the clock edge.

In external 2X clocking mode, the A3 channels are routed or demultiplexed into the D3 channels. The
D3 channels actually see the signals coming from the A3 lines at the probe tip. This means that any
probe signal connections to the D3 channels are ignored. The demultiplexing occurs internal to the
logic analyzer module, and does not require any external probing changes. With this arrangement, the
A3 channels are referred to as the demultiplex source channels and the D3 channels are the demultiplex
destination channels. Note in the LA Setup dialog channel grid that all of the demultiplex destination
channels are highlighted in pink and the demultiplex source channels are highlighted in blue when external
2X mode is selected.

For external clocking acquisitions, the A3 channels in the acquisition sample are used to store data from
the A3 probe inputs when a clock edge occurs, while the D3 channels in the acquisition sample are used to
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store data from the D3 probe units. In external 2X clocking mode, the A3 channels store data from the A3
probe inputs when the first clock edge occurs, while the D3 channels store data from the A3 probe inputs
when the second clock edge occurs. Each set of two subsequent clock edges follows the same pattern:
A3 stores the data present at the first edge, while D3 stores the data at the following edge. There are two
logical acquisition samples stored in each physical sample. The acquisition samples stored in the LA
module in External 2X DDR clocking mode are as follows:

External 2X clocking acquisition samples
A3 D3 Timestamp
01 02 1.25 ns
03 04 3.75 ns

The timestamp values stored in the acquisition samples are actually the times of the falling clock edges
associated with the data that was saved in the demultiplex destination (D3) channels.

Viewing Acquired Data
When viewing external clocking data in a Listing window, the window contents track the stored acquisition
data closely. A Listing window for the external clocking acquisition above might look like the following:

Listing window - external clocking data
Sample A3 D3 Timestamp
0 01 31 0 ns
1 03 33 2.5 ns

In external 2X clocking mode, there are twice as many samples shown in the Listing window as there are
physically stored on the acquisition card. Each physical sample is expanded into two component logical
samples, which are shown in the Listing window.

Listing window - external 2X clocking data
Sample A3 D3 Timestamp
0 01 02 0.25 ns
1 02 -- 1.25 ns
2 03 04 2.75 ns
3 04 -- 3.75 ns

Looking at the A3 column in the Listing window, you can see that the data pattern matches the behavior
of the target system from which the data was acquired. In this window, samples 0 and 2 come directly
from the stored acquisition, while samples 1 and 3 are synthesized from the demultiplex destination data.
In order to form the synthesized data samples, the data from each demultiplex destination channel is
copied into its demultiplex source channel. The D3 column demonstrates how destination channels are
handled in a Listing window. For the stored data samples, the data values are shown; for the synthesized
samples, the data values are dashed out.

In the Timestamp column, the timestamps for the generated samples (1 and 3) come directly from the
timestamps stored in the acquisition records. The timestamps for samples 0 and 2 are not stored anywhere
in the acquisition record, so they are generated by subtracting 1ns from the stored timestamp. The

231



Clocking Information External 2X DDR Clocking Details

generated timestamps are shown in italics and in a slightly smaller font than the actual stored timestamps.
Generated timestamps do not show exactly where the data was sampled, but they are reasonably close for
clock speeds approaching 450 MHz.

The External clocking data viewed in a Waveform window tracks the acquisition sample format closely.

Waveform window - external clocking data

A Waveform window view of external 2X clocking data shows the demultiplex source channel data
changing every sample, while the demultiplex destination channel data changes every other sample. There
is no dashing or other special display formatting performed for the demultiplex destination channels.

Waveform window - external 2X clocking data

The demultiplex source and destination channel mappings used for external 2X clocking mode depend
on the logic analyzer module width. For more information about demultiplex channel mappings, see
Probe Demultiplexing.

Clock Signals
In External 2X DDR clocking mode, the clock signal does not require a 50% duty cycle in order for
the logic analyzer to capture all of the clock edges, even at clock speeds approaching the maximum
synchronous speed of the module. There are actually two edge detectors used - one for rising edges and the
other for falling edges. Therefore, the time between rising clock edges must be greater than the minimum
clock period of the module (for example, 2.22 ns at 450 MHz) and the time between falling edges must also
be greater than the minimum clock period of the module. There is no constraint on the time from the rising
clock edge to the falling clock edge other than the minimum pulse width detectable by the logic analyzer.
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This property allows both the rising and falling edges of clock signals with a wide range of duty cycles to
be accurately captured.

If the clock signal used for an External 2X DDR acquisition has any glitches, it may cause the data to
be acquired incorrectly. Consider the following clock signal that contains a glitch after the falling edge
of the first cycle:

The rising edge of the glitch is captured because it is far enough away from the previous rising clock edge
to be noticed. However, the falling edge of the glitch is not captured because it is too close to the previous
falling edge of the clock signal. This causes an extra sample to be taken for the demultiplex source
channels and makes all subsequent source channel data misaligned with its proper demux destination data.

Channel activities under external 2X DDR clocking mode show the activities after demultiplexing occurs,
rather than showing probe tip activities.

Setup/Hold Violation storage is not available under external 2X DDR clocking mode.

MagniVu data is unaffected by external 2X DDR clocking modes because it always acquires
non-demultiplexed 1X data.

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

External 4X Clocking Details

Overview
External 4X mode acquisitions allow data to be acquired and displayed at approximately three to four
times the normal maximum sample frequency of the logic analyzer. In this mode, three quarters of the
logic analyzer input channels are traded for three to four times the speed and four times the acquisition
depth. The reason that the External 4X clocking mode data rate does not always increase by four times
above the base synchronous rate of the logic analyzer is that the Setup/Hold window requirements of
the logic analyzer on the acquisition data can limit the acquisition rate to a lesser value than if it were
constrained by the maximum clock speed alone.
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External 4X clocking mode is a double data rate (DDR) clocking mode, which means that the two
acquisition samples are taken per clock cycle. This means that the data rate of the acquisition is double the
rate of the clock signal that is driving it.

The following example illustrates how external 4X acquisition differs from external clocking acquisitions
and demonstrates how external 4X clocking can be useful in capturing data from target systems with higher
data rates than the base synchronous speed of the logic analyzer module.

Acquiring Data
The logic analyzer is set up to acquire data from a target system probed by the A3(7-0), A2(7-0), D3(7-0),
and D2(7-0) channels. In the LA Setup dialog, the A3(7-0) channels are used to form a group called
A3, the A2(7-0) channels are used to form a group called A2, the D3(7-0) channels are used to form a
group called D3, and the D2(7-0) channels are used to form a group called D2. The logic analyzer is set
to trigger when Group A3 equals 01. Assume that the data present on the target system changes twice
every clock cycle and has the following pattern.

The data is shown in hexadecimal radix and the times are in relation to the logic analyzer trigger position.

For this example, assume that the logic analyzer module has a maximum synchronous acquisition speed
of 450 MHz. This means that there is a minimum time of 2.22 ns between successive clock edges than
can be captured in external clocking mode. The clock is running at a speed of 667 MHz, which only
leaves 1.5 ns between successive clock edges. In external 4X mode, the logic analyzer is capable of
capturing every rising or every falling edge of the 667 MHz clock and also capturing an additional sample
between clock edges.

First, an external clocking acquisition is taken. The clocking mode is set to External in the LA Setup
dialog box. The clock definition is set to the rising edge of CK0 in the External Clocking dialog box. The
acquisition samples stored in the logic analyzer module are as follows:
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External clocking acquisition samples
A3 A2 D3 D2 Timestamp
01 2F 31 4F 0 ns
05 2B 35 4B 3 ns

Note that the data on the target system was changing too fast for the logic analyzer to capture all the
clock edges. Every other clock edge is missed. The timestamps stored in the acquisition samples are the
times of the actual captured clock edges.

Next, an external 4X clocking mode acquisition is taken. The clocking mode is changed to External 4X in
the LA Setup dialog box. The clock edge is set to the rising edge of CK0 in the External 4X Clocking
dialog box. The Setup/Hold windows for all groups are left at their default setting, which means that the
data is sampled just before the rising clock edge. The Second Edge Delay for each group is set to 750 ps
to take the second data sample just before the falling clock edge. Note that the logic analyzer does not
capture the falling clock edge.

In External 4X clocking mode, the A3 channels are routed or demultiplexed into the A2, D3, and D2
channels. The A2, D3, and D2 channels actually see the physical signals coming from the A3 lines at the
probe tip. This means that any physical signal connections to the A2, D3, and D2 channels are ignored.
The demultiplexing occurs internal to the logic analyzer module and does not require any external probing
changes. With this arrangement, the A3 channels are referred to as the demultiplex source channels and the
A2, D3, and D2 channels are the demultiplex destination channels. Note in the LA Setup dialog channel
grid that all of the demultiplex destination channels are highlighted in pink and the demultiplex source
channels are highlighted in blue when external 4X mode is selected.

For external clocking acquisitions, the A3 channels in the acquisition sample are used to store data from
the A3 probe inputs when a clock edge occurs; the A2 channels in the acquisition sample are used to store
data from the A2 probe inputs; the D3 channels in the acquisition sample are used to store data from the D3
probe units; and the D2 channels in the acquisition sample are used to store data from the D2 probe units.

In external 4X clocking mode, the A3 channels store data from the A3 probe inputs when the first clock
edge occurs; the A2 channels store data from the A3 probe inputs 750 ps after the first clock edge; the D3
channels store data from the A3 probe inputs when the second clock edge occurs; and the D2 channels
store data from the A3 probe inputs 750 ps after the second clock edge. Each set of two subsequent clock
edges follows the same pattern: A3 stores the data present at the first edge while A2 stores the data 750 ps
later. Then D3 stores the data at the next rising clock edge while D2 stores the data 750 ps later. There are
four logical acquisition samples stored in each physical sample. The acquisition samples stored in the LA
module in external 4X clocking mode are as follows:

External 4X clocking acquisition samples
A3 A2 D3 D2 Timestamp
01 02 03 04 1.5 ns
05 06 07 08 4.5 ns

The timestamp values stored in the acquisition samples are actually the times of the second clock edges
associated with the data that was saved in the second demultiplexed destination (D3) channels.
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Viewing Acquired Data
When viewing external clocking data in a Listing window, the window contents track the stored acquisition
data closely. A Listing window for the external clocking acquisition above might look like the following:

Listing window - external clocking data
Sample A3 A2 D3 D2 Timestamp
0 01 2F 31 4F 0 ns
1 05 2B 35 4B 3 ns

In external 4X clocking mode, there are four times as many samples shown in the Listing window as there
are physically stored on the acquisition card. Each physical sample is expanded into four component
logical samples, which are shown in the Listing window.

Listing window - external 4X clocking data
Sample A3 A2 D3 D2 Timestamp
0 01 02 03 04 0.5 ns
1 02 -- -- -- 1.0 ns
2 03 -- -- -- 1.5 ns
3 04 -- -- -- 2.0 ns
4 05 06 07 08 3.5 ns
5 06 -- -- -- 4.0 ns
6 07 -- -- -- 4.5 ns
7 08 -- -- -- 5.0 ns

Looking at the A3 column in the Listing window, you can see that the data pattern matches the behavior of
the target system from which the data was acquired. In this window, samples 0 and 4 come directly from
the stored acquisition, while samples 1, 2, 3, 5, 6, and 7 are synthesized from the demultiplex destination
data. In order to form the synthesized data samples (1 and 4), the data from each demultiplex destination
channel is copied into the demultiplex source channel. The A2, D3, and D2 columns demonstrate how
destination channels are handled in a Listing window. For the stored data samples, the data values are
shown; for the synthesized samples, the data values are dashed out.

In the Timestamp column, the timestamps for the second generated samples (2 and 6) come directly
from the timestamps stored in the acquisition records. The timestamps for the other samples are not
stored anywhere in the acquisition record. These timestamps are generated by offsetting them from the
stored timestamp. The timestamps for samples 0 and 4 are generated by subtracting 1 ns from the stored
timestamp. The timestamps for samples 1 and 5 are generated by subtracting 500 ps from the stored
timestamp. And the timestamps for samples 3 and 7 were generated by adding 500 ps to the stored
timestamp. The generated timestamps are shown in italics and in a slightly smaller font than the actual
stored timestamps. Generated timestamps to not show exactly where the data was sampled, but they are
reasonably close for clock speeds approaching 667 MHz.

The external clocking data viewed in a Waveform window tracks the acquisition sample format closely.

Waveform window - external clocking data
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A Waveform window view of external 4X clocking data shows the demultiplex source channels changing
every sample, while the demultiplex destination channel data changes every fourth sample. There is no
dashing or other special display formatting performed for the demultiplex destination channels.

Waveform window - external 4X clocking data

The demultiplex source and destination channel mappings used for external 4X clocking mode depend
on the logic analyzer module width. For more information about demultiplex channel mappings, see
Probe Demultiplexing.

Channel activities under external 4X clocking mode show the activities after the demultiplexing occurs,
rather than showing probe tip activities.

Glitch storage is not available under external 4X clocking mode.

MagniVu data is unaffected by external 4X clock modes because it always acquires non-demultiplexed
1X data.
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External 450 Clocking Details

Overview
External 450 MHz clocking mode allows data to be acquired on the rising, the falling or both the rising and
falling clock edges. This creates two clocking modes within External 450 clocking: single edge and both
edges. The External 450 clocking mode for both edges is also referred to as External 450 double data rate
(DDR) because the data rate of the acquisition is double the rate of the clock signal that is driving it. Note
that External 450 clocking is only available on TLA7NAx modules with the 450 MHz PowerFlex option.

Behavior
If you select either the rising or falling clock edge as the sample point, you can use all channels. The
maximum clock speed is 450 MHz and data rate is 450 Mb/s.

If you select both the rising and falling edges, External 450 MHz becomes a double data rate (DDR)
clocking mode, which means that two acquisition samples are taken per clock cycle. In this mode, you can
only use half of the channels, the maximum clock speed is 235 MHz, and the data rate is double the clock
speed (470 Mb/s). Data is captured at the rising clock edge and at the falling clock edge of each clock
cycle. Therefore, the data rate of the acquisition is double the rate of the clock signal that is driving it.

The functionality for External 450 DDR clocking is the same as External 2X DDR clocking. For more
information on double data rate see External 2X DDR Clocking Details.

The following table illustrates the differences between External 450 clocking mode and External clocking
mode.

Clocking mode Maximum clock rate Maximum data rate Channelsavailable
External, single edge 235 MHz 235 Mb/s/470 Mb/s All/Half
External, both edges 117 MHz 235 Mb/s/470 Mb/s All/Half
External 450,

single edge

450 MHz 450 Mb/s All

External 450, DDR

(both edges)

235 MHz 470 Mb/s Half

Viewing Acquired External 450 DDR Data
In External 450 DDR clocking mode, there are twice as many samples shown in the Listing window as
there are physically stored on the acquisition card. Each physical sample is expanded into two component
logical samples, which are shown in the Listing window.

The demultiplex source and destination channel mappings used for External 450 DDR clocking mode
depend on the logic analyzer module width. For more information about demultiplex channel mappings,
see Probe Demultiplexing.
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External 450 DDR Clock Signals
In External 450 DDR clocking mode, the clock signal does not require a 50% duty cycle for the logic
analyzer to capture all of the clock edges. There are actually two edge detectors used—one for rising edges
and the other for falling edges. Therefore, the time between rising clock edges must be greater than the
minimum clock period of the module (for example, 4.26 ns at 235 MHz) and the time between falling
edges must also be greater than the minimum clock period of the module. There is no constraint on the
time from the rising clock edge to the falling clock edge other than the minimum pulse width detectable
by the logic analyzer.

This property allows both the rising and falling edges of clock signals with a wide range of duty cycles to
be accurately captured.

If the clock signal used for an External 450 DDR acquisition has any glitches, it may cause the data to
be acquired incorrectly. Consider the following clock signal that contains a glitch after the falling edge
of the first cycle:

The rising edge of the glitch is captured because it is far enough away from the previous rising clock edge
to be noticed. However, the falling edge of the glitch is not captured because it is too close to the previous
falling edge of the clock signal. This causes an extra sample to be taken for the demultiplex source
channels and makes all subsequent source channel data misaligned with its proper demux destination data.

Channel activities under External 450 DDR clocking mode show the activities after demultiplexing
occurs, rather than showing probe tip activities.

Setup/Hold Violation storage is not available under External 450 DDR clocking mode.

MagniVu data is unaffected by External 450 clocking modes because it always acquires non-demultiplexed
1X data.
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Selecting Module Edge Detectors
1. Select a module from the Select Module list box.

2. For each edge detector, select the check box associated with the clock edges that you want to associate
with data transfer.

NOTE. Edge Detector 0 is the CSM Heartbeat Clock, which is the pulse for driving data through the system.

240



LA Trigger Information Trigger Tab Page

LATrigger Information

Trigger Tab Page

Overview
The Trigger tab page allows you to quickly and easily set up a trigger program. You can drag and drop
trigger programs directly from the Trigger tab page to a data window.

Behavior
The Trigger tab page is only active when a data window is active. Each data window has a unique
Trigger tab page. After dragging a trigger program to a data window, a trigger expression is displayed
under Trigger Details. The Undo Trigger and Redo Trigger buttons apply only to the current trigger
and the previous trigger. The Undo Trigger and Redo Trigger buttons are not active until you use a
drag and drop trigger setup.

To Use
Click any Trigger program button and drag it to the waveform or listing window. You can edit the trigger
expression using the controls on the Trigger tab page. The controls change depending on the trigger
expression.

Click the Undo Trigger button to restore the previous trigger setup. Click the Redo Trigger button to
restore the current drag-and-drop trigger setup.

Related Topics
EasyTrigger Programs

Triggering from the Trigger Tab Page

241



LA Trigger Information Trigger Window

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Trigger Window

Overview
The primary function of the Trigger window is for constructing a trigger program. You also use the Trigger
window to select how and when to store data; and to set the trigger position, which indicates the percentage
of samples that are stored after the trigger occurs.

If you have a TLA7Axx/TLA7NAx logic analyzer module or a TLA5000B Series logic analyzer, you
can additionally use the Trigger window to defer execution of the trigger state machine until the main
memory prefill amount is met. In addition, you can set both the MagniVu storage rate and the amount
of pretrigger MagniVu data to store.

Behavior
Before you acquire and display data, set up the LA module using the LA Setup and Trigger windows.
These windows determine what data will be acquired. Each module has its own Setup and Trigger
window, which are set up individually.

Configure the Setup window before the Trigger window, because some of the Setup window settings
affect Trigger window selections.

Trigger programs range from the simple to extremely complex. They are the key to logic analyzer
operation. One method for setting up a trigger program is to load a trigger program from the EasyTrigger
Program list. The trigger list, which is available from the EasyTrigger tab, contains simplified trigger
programs that hide many of the program implementation details, allowing you to focus on acquiring and
displaying data. You can then either view or alter the trigger program details from the PowerTrigger tab, as
necessary. Once you become familiar with trigger programming, you can also create trigger programs
without the help of predefined triggers from the EasyTrigger program list.

Click the following selections for further information:

LA Triggers

Trigger Program Structure for an LA Module

Trigger Window Structure
The Trigger window contains two tabs that summarize the trigger program to varying degrees.

The EasyTrigger tab contains a trigger program list, program controls, and both a description and graphic
example of the selected trigger program. The trigger list is categorized by trigger program function. Once
you have selected the trigger program that best fits your data requirements, click the trigger program to
display the underlying program controls. The program controls are a simplified representation of the
selected trigger program that allows you to select events and set event, timer, and counter values.

The PowerTrigger tab contains both an Overview section and a Trigger Detail section. The Overview
shows the general structure of the trigger program. The Trigger Detail summarizes activity within
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individual program states. You can click the If/Then button in the Trigger Detail to access the Clause
Definition dialog box, which is where the actual trigger programming takes place.

You can specify which trigger tab is displayed when you start the TLA application. From the System
menu, click Options, and then click the Defaults tab. Click the Trigger Window Style field and then select
the desired trigger tab from the list box.

Click the following selections for further information:

PowerTrigger Overview

PowerTrigger Detail

Clause Definition Dialog Box

Storage Selection for an LA Module

Trigger Position for an LA Module

MagniVu Trigger Position

MagniVu Storage Rate

Force Main Prefill

To Use
To open the LA Trigger window, go to the System window and click the LA module Trigger icon.

To load a trigger program, click the EasyTrigger tab and then select a trigger program. The system
responds by loading the selected trigger program, replacing the previous window contents with new
program controls, program overview text, and a sample trigger graphic.

Related Topics
Loading an LA with Saved Trigger Settings

LA Setup Window

Adding a State to a Trigger Program

Adding an If/Then Clause to a Trigger State

Trigger Programming Tips for an LA Module

System Trigger and Reference System Trigger Relationship
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LA Triggers

Overview
The trigger identifies when to stop acquiring data. The trigger also identifies the data of interest. The
trigger position determines how much data to store before and after the event of interest. Triggers also
provide the main reference points in the acquired data. There are two types of triggers: system and module.

System Trigger (Trigger All)
The system trigger is an overriding command to all modules that causes them to stop looking for a trigger,
and to acquire their post-trigger data, regardless of whether they have been armed or have fulfilled their
own trigger conditions.

The system trigger is the primary reference point for the entire data acquisition. In data windows,
timing and location information is relative to the system trigger. The system trigger is identified in the
data windows by the large T mark, .

Module Trigger (Trigger)
The module trigger is local to a module. When a trigger occurs, the module continues to acquire data until
the specified amount of post-trigger data is acquired, and then stops. Module triggers are identified in the
data windows by the small T mark, .

Related Topic
System Trigger Placement

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

System Trigger

Overview
The system trigger is a global trigger event that forces all untriggered modules or instruments to arm
immediately and trigger. Only one system trigger occurs per acquisition. When displaying data, the logic
analyzer uses the system trigger as the primary reference point for the acquisition. The data windows show
the system trigger and all module or instrument triggers. Module or instrument triggers can be forced by
the system trigger or specified by trigger programs.

The system trigger can be generated from any of several sources. Often, the system trigger is specified in a
trigger program. Any module or instrument can specify the system trigger as a trigger action (Trigger All
Modules). However, modules or instruments can also specify trigger actions other than system triggers,
and the system trigger does not have to originate from a module or instrument. The logic analyzer
can also accept a system trigger generated by an external source. External system triggers are input
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through the SYSTEM TRIG IN connector. Regardless of the source of the system trigger, all modules
or instruments must respond.

Use the System Trigger dialog box to specify triggering for the overall system.

System Trigger Source
The following options allow you to change the trigger programs of all modules from one location. A brief
functional description follows each System Trigger Source option.

Modules trigger independently - Trigger All Modules and Wait for System Trigger actions in all
trigger programs are changed to Trigger actions.

Systems triggered by this module - The trigger program of the selected module uses the Trigger All
Modules action, while all other programs will wait for the system trigger. You must use the associated
list box to select which module is used to trigger the system.

System triggered by the first module that triggers - Trigger actions in all programs are changed to
Trigger All Modules. If the system has an external oscilloscope, it is set up to wait for the system trigger.

Modules trigger using the current custom setup - Enabled by default when your trigger setups do not
match one of the previous system trigger options.

NOTE. When you apply a system trigger option, your choice will only affect those modules that currently have a
trigger action. Logic analyzer trigger actions include Trigger, Trigger All Modules, and Wait for System Trigger. DSO
and external oscilloscope modules are always affected because all of their actions result in triggering the module.

System Trigger In/Out Connectors
System Trigger In/Out Connector check boxes reflect the current state of the System Trigger In and System
Trigger Out connectors, and can be used to both enable and disable them.

If an external scope is enabled, the options chosen in System Trigger Source can affect the values and
sensitivity of the System Trigger In/Out check boxes.

Designated System Trigger
It is not uncommon to have a condition in which the acquisition completed, but an explicit system trigger
did not occur. (This means that there was neither an external system trigger, nor a system trigger generated
internally by a module trigger program.) To ensure that a time reference exists for the acquisition, the
logic analyzer must designate a system trigger. If no system trigger is generated during an acquisition
(the modules are internally triggered), the logic analyzer designates the latest-occurring module trigger
as the system trigger.

NOTE. If an acquisition does not complete because one or more modules did not receive a trigger or did not complete
the post-trigger acquisition, then you can manually stop the acquisition by clicking the Stop button. Clicking the Stop
button effectively generates a system trigger and completes the acquisition.
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Internal and External System Triggers
The system trigger is a latched event and it resets to a false state between acquisitions. The external
system trigger input uses real-time gating and is only active (capable of latching system triggers) during
the actual acquisition period.

The logic analyzer can also send an internally-generated system trigger out to the target system or to other
test equipment through the SYSTEM TRIG OUT connector. All the external signal inputs and outputs
operate at TTL levels. The connectors are located at the rear of the portable mainframe and at the front
of the benchtop mainframe.

Related Topics
Setting the System Trigger Source

Signal Properties

External Signal Selection

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

System Trigger Placement

Overview
There is only one system trigger. Because the system trigger is the primary reference point for an
acquisition, all acquisitions must have a system trigger identified, even if you did not specifically include
one in your trigger program.

Behavior
It is not always obvious how the logic analyzer places the system trigger. The logic analyzer determines
the system trigger by one of the following:

A system trigger occurs when the Stop button is clicked.

Data windows usually have at most one system trigger plus one module trigger per module.

If a module initiates the Trigger All Modules action, then the system trigger is also the module trigger
for that module.

If only module triggers are generated, then the latest occurring module trigger is designated the system
trigger.

Related Topic
System Trigger and Reference System Trigger Relationship
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Setting the System Trigger Source
1. From the TLA System toolbar, click the button. The system responds by displaying the System
Trigger dialog box.

2. Select a trigger option from the System Trigger Source group box.

3. If you chose to trigger the system from one module in the previous step, use the associated list box to
specify which module is used to trigger the system.

4. If you have an external oscilloscope, the System Trigger In/Out Connector check boxes are disabled and
automatically set by the system, based on the system trigger source option that you choose. Otherwise,
you can optionally disable these connectors if they are not in use.

NOTE. To save these settings as part of your system setup, you must perform a Save System operation. This step
enables you to reload your saved system settings in a later session.

Related Topic
System Trigger
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PowerTrigger Overview

Overview

The Overview portion of the PowerTrigger tab primarily
shows how the trigger program flows from one state to
the next. The arrow leading to State 1 is marked Run if
the module is not armed by another module. The arrow
is marked Armed By <name of module> if this module is
armed by another module.
Behavior

Arrows indicate the transfer of trigger program control
between states. Markers indicate system-level actions that
could occur if a clause in that state goes true. Use the
trigger overview to check that states are connected. With
the exception of State 1, all states must have an arrow
leading to them (indicating activation by another state), or
they will not execute.

These actions are all defined in the Clause Definition dialog box(es) for each state.

TIP. Double-click the State icon in the Overview to open the top-most clause definition for that state.
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PowerTrigger Detail

Overview
The PowerTrigger tab shows a summary of clause settings within the states. To open the Clause Definition
dialog box, click the If/Then button. The following dialog box displays:

To Use
You can enter comments in the text box. This feature is controlled by the View menu State Comments
selection.

The PowerTrigger tab is part of the LA Trigger window, which you can open by going to the System
window and clicking the LA Trigger window icon.

NOTE. There is a clause summary for each clause defined.

TIP. For lengthy trigger programs, click the State icon in the Overview to jump to the corresponding PowerTrigger
properties.

Related Topics
PowerTrigger Overview

Clause Definition Dialog Box

248



LA Trigger Information Data Sample Storage Selections

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Data Sample Storage Selections
Data sample storage is selected in the LA Trigger window by using the Storage box in the toolbar. The
following selections are available for PowerTrigger data sample storage.

All. Store all samples.

You can exclude a sample from being stored by selecting the Don’t Store action in the Then statement of
the trigger clause. The trigger sample is always stored.

None. Do not store samples.

You can explicitly store a sample by selecting the Store Sample action in the Then statement of the
trigger clause.

The following selections generate a special storage clause:

Transitional. Store samples only if one of the specified channel groups changes state.

To select the channel groups, click Change Detect in the Trigger Detail.

NOTE. On TLA7Lx and TLA7Mx modules, the first transition state indication is random. On TLA7Axx/TLA7NAx
modules and TLA5000B Series mainframes, the first transition state indication is always false. On TLA7Nx, TLA7Px,
and TLA7Qx modules, the first transition state always shows a transition indication (even if there are no probes
plugged in). One way to avoid triggering on a false first transition indication is to set the first state to "If Anything Goto
Next State". This will consume a state, but will ensure that there is no false triggering on the first transition indication.

Conditional. Store samples only if the storage clause is true.

Program this clause in the same way as a regular trigger clause.

Start/Stop. Storage is controlled by the Start Storing and Stop Storing trigger actions in the Then
statement of the trigger clause.

Use the Start Storage/Stop Storage button in the Trigger Detail to select whether storage is initially
enabled. For example, if the button is set to Stop Storage, then the initial state is that no samples are
stored; storage will begin when the trigger action Start Storing occurs.
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Trigger Position for an LA Module

Overview
The Trigger Position selects the amount of pretrigger data to store and determines the position of the
trigger in the data record.

Behavior
Once triggered, a module continues to acquire data until it fills a specified amount of memory. The total
memory depth that the module fills is set in the Memory Depth field in the Setup window. The Trigger
Position field determines the proportion of data that is stored before and after the trigger. For example, if
the Trigger Position is set to 10% and the module triggers, then the module continues to acquire data until
the remaining 90% of memory is filled.

NOTE. Under some conditions, the module cannot meet the pre-trigger data storage requirements. For example, if a
trigger occurs immediately, the module cannot meet the pretrigger data storage requirement unless it was set to 0%.

To Use
Set the Trigger position for a LA module in the toolbar of the LA Trigger window using the Trigger
Pos control.

Related Topics
LA Triggers

System Trigger Placement
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Trigger Programming Tips for an LA Module
Use the EasyTrigger program list

When you create a trigger, start with the trigger program that is closest to your requirements and modify it.

Create your own trigger program folder

Create a folder and save modules that have your own most-used trigger programs. Use the Comment box
to help you identify the trigger program later. To access previously saved trigger programs, click the
button from the trigger toolbar, which displays the Load Trigger dialog box. Then click the Browse
button and navigate to your trigger program folder.

Check the Overview
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After you create a trigger program, review the Overview pane on the PowerTrigger tab to ensure that all
states in the program are linked and that state actions, such as program triggers and arming signals, are
correctly placed.

Start and stop timers

Remember to explicitly start and stop PowerTrigger timers. They do not start and stop automatically.

Use the Status Monitor to debug trigger programs

The status monitor displays the activity within each state.

Trigger state references

Do not delete PowerTrigger states to which you reference Go To State actions unless you change the
reference to another appropriate state or delete the Go To action.

Use event text that is always true

A PowerTrigger clause with an Anything event or another event that is always true, such as Group xyz
= XXXX, prevents any subsequent clauses from being evaluated. Such clauses should be considered as
default clauses; place them after all other clauses for a given state.

Use range recognizers

When using range recognizers, the individual probe channels must be in hardware order; otherwise the
trigger program can cause unexpected results. Range recognizers will only be allowed to encompass
channels on the first three modules of a merged set.

Use of complex trigger events

If you are unsure that a complex trigger event will occur, you should first use a broadly defined trigger
condition and then subsequently add events to narrow the search. If your trigger program is too narrowly
defined or over specified, the trigger program may not acquire the desire data or may never trigger.

Use of counters when using Internal clocking at fastest clocking rate

For TLA7Axx/TLA7NAx logic analyzer modules and TLA5000B Series logic analyzers, when using
Internal, Internal 2X or Internal 4X clocking and running at the fastest clocking rate, a 2 ns delay is required
to allow the counter event to propagate through the system before the trigger state machine can respond.

Related Topic
Range Recognizers and Hardware Order
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Range Recognizers and Hardware Order
When using range recognizers, the probe groups and probe channels must be in hardware order.

Probe groups must be used from the most-significant probe group to the least-significant probe group
based on the following order:

C3 C2 C1 C0 E3 E2 E1 E0 A3 A2 D3 D2 A1 A0 D1 D0 Q3 Q2 Q1 Q0 CK3 CK2 CK1 CK0

Probe channels must be from the most-significant channel to the least-significant channel based on the
following order:

7 6 5 4 3 2 1 0

The above example assumes a 136-channel LA module. The missing channels in LA modules with
fewer than 136 channels are ignored. With merged modules, range recognition extends across the first
three modules; the master module contains the most-significant groups, while slave2 contains the
least-significant groups.

Related Topic
Signed Decimal Values
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Signed Decimal Values
Signed Decimal Values can create confusing interpretations, especially when the listing display uses
signed decimal values.

The following is an example of a problem that can be caused when using signed decimal values in the
listing display in an If/Then statement:

If Group A3 < -128

Then Trigger

A3 is an 8-bit group, so it should never trigger since -128 is the smallest signed value possible; however,
-128 is also 80 Hex, so many values will cause the logic analyzer to trigger, all of which will appear as
larger values when displayed in the listing with a signed decimal radix.

In this example there is no way to program the range recognizer hardware to behave correctly and not
trigger.
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Module Arming Using an LA

Overview
Using the arm feature, you can use one module to control when another module begins acquisition.

When module A arms module B, this means that module B does not begin looking for a trigger until it
receives an arm signal from module A.

Behavior
Arming is done through PowerTrigger actions specified in the Clause Definition dialog box. A module
can arm any other module, and you can set up an arming relationship between more than one set of
modules. But only one module can arm another. The same arming action can, however, appear multiple
times within the same trigger program.

Arming and internal signaling are mutually exclusive. You cannot simultaneously arm modules and
set signals.

For TLA7Lx/Mx/Nx/Px/Qx logic analyzer modules, the trigger state machine is disabled when arming
a module and does not store data until the module is armed. For TLA7Axx/TLA7NAx logic analyzer
modules and TLA5000B Series logic analyzers, the trigger state machine is also disabled when arming a
module but this does not restrict data storage. The current setting of the Storage list box, located in the
Trigger window, determines whether data is stored.

Related Topics
Signals Properties (External signals)

Clause Definition Dialog Box
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Internal Signaling

Overview
Internal signaling is for users with special trigger programming requirements. Internal signaling adds
flexibility to trigger programming, but also adds complexity. When using internal signaling you must
take care that the signals are correctly set and cleared, and that the trigger programs for all modules are
compatible with regard to signal usage. Also, you must have correctly set the internal signal attributes in
the Signals tab.

Behavior
All LA modules can set and clear any of the four internal system signals. The DSO can monitor and set
but not clear any signal. The logical output of these signals can be used as an event in other modules’
trigger programs. You can also connect the internal signals to the External Signal In and External Signal
Out connectors on the mainframe, so that you can use an external signal as a trigger event or send a
signal out when a trigger condition is met.

Internal Signaling is done through PowerTrigger actions specified in the Clause Definition dialog box.

NOTE. Arming and internal signaling are mutually exclusive. You cannot simultaneously arm modules and set signals.

Related Topics
Signals Properties

Clause Definition Dialog Box

Trigger Action Signal Restrictions

Internal Signal Selection
Signals 1 and 2 are high-speed, ECL-rate signals, and are usually the preferred choice for both
internal and external signal applications. Signals 3 and 4 are functionally equivalent to signals 1 and
2, but operate at the slower TTL rate.

Signals 1 and 2. 162 MHz maximum (internal), 62.5 MHz maximum (at External Signal Out connector)

Signals 3 and 4. 12.5 MHz maximum
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Trigger Action Signal Restrictions
There are some differences between modules in how they handle triggers, arming and internal signals.
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LA modules, DSO modules, and external oscilloscopes have different numbers of signal inputs and
outputs. As a result, their signaling capabilities are different.

Conceptually, a module has three inputs and three outputs, as shown:

In reality, the LA module has three inputs and two outputs, designated as shown:

The DSO module has two inputs and a single output, as shown:

The External Oscilloscope has one input and either zero or one output, as shown:
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This shows why Arming and Signaling are mutually exclusive on both the LA and DSO modules, and why
a DSO module does not allow you to set a system trigger and an internal signal at the same time.

Related Topics
Internal Signal Selection

Module Arming Using an LA Module

Signals Properties
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Change Detect Dialog Box
Use this dialog box to select the channel groups that will detect a change in state for Transitional storage.
Once a change is detected in any of the selected groups, storage begins.

To open this dialog box, perform the following:

1. In the System window, click the Trigger button for the module.

2. Click the PowerTrigger tab.

3. Select Transitional in the Storage box, which is located in the toolbar.

4. Click the Change Detect button.

TIP. To detect a change on a single channel, you can define a channel in the Setup window as a group.

On TLA7Lx and TLA7Mx modules, the first transition state indication is random. On
TLA7Axx/TLA7NAx modules and TLA5000B Series mainframes, the first transition state indication is
always false. On TLA7Nx, TLA7Px, and TLA7Qx modules, the first transition state always shows a
transition indication (even if there are no probes plugged in). One way to avoid triggering on a false first
transition indication is to set the first state to "If Anything Goto Next State". This will consume a state, but
will ensure that there is no false triggering on the first transition indication.

You cannot use transitional storage if your PowerTrigger program is set up with Group Changes or
Channel Goes events.

When global storage is set up to use transitional storage, to ensure that a false transition is not recorded, the
first state must be "If Anything Then Next State".
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Select Channel Dialog Box
Use the Select Channel dialog box to select a specific logic analyzer channel. You can use the following
options, available from the Select group box, to specify how the system displays channels in the dialog box.

By Group - displays channels organized by channel group. Only channel groups that are defined in the LA
Setup window can be displayed using this option.

By Probe - displays channels that are alphanumerically organized by individual channel. All channels are
displayed when this option is selected, regardless of whether they are defined in the LA Setup window.

By Name - displays channels by the name assigned to them from the LA Setup window. You must enter
names for each channel for channel names to display when using this selection option.

Related Topics
Selecting Channels for an LA trigger Channel Event.

Routing a Signal from a Logic Analyzer Output Channel
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Transition Definition Dialog Box

Overview
Use this dialog box to define transition events used in the Clause Definition dialog box. Each transition
event displays values for valid channel groups defined in the Setup window. The value of each channel
group is compared against live data.

Behavior
You can disable the channel group in each transition event by removing the check mark adjacent to
the channel group name; this causes the transition event to ignore the data for the channel group. You
can also disable or enable all channel groups by clicking either the Clear All or Select All button. This
either removes or adds check marks adjacent to each channel group name. You can additionally rename
the current transition event by clicking the Rename button and entering a new transition name in the
Rename group box.

You change the group radix for each channel group by selecting the desired radix at the bottom of the
dialog.

Conflicts are possible when groups share channels. Conflicts are noted in the boxes. Conflicts do not
prevent acquisition.

The Trigger Conflict dialog box displays when a trigger conflict occurs, allowing you to select a trigger
replacement option to resolve the conflict.

Value settings closer to the top of the list override later settings.
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To Use
Each transition event is identified by a unique name.

To open the Transition Definition dialog box, perform the following:

1. From the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click either the If/Then or the Else If/Then button or the clause you are interested in defining.

4. Click Transition from the drop-down list available from the If section of the Clause Definition dialog
box.

5. Click the Define Transition button in the If section of the Clause Definition dialog box to display
the Transition Definition dialog box.

Related Topics
Add Transition Dialog Box

Defining Multiple Transition Recognizers
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Add Transition Dialog Box

Overview
The Add Transition dialog box supplies words that are defined in the Transition Definition dialog box, and
are available for defining PowerTrigger Clause Definition If statements.

To Use
Use this dialog box to add a new transition event. Click Use Existing Transition as Template to copy the
settings from an existing word event.

To display the Add Transition dialog box, perform the following:

1. From the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click either the If/Then or the Else If/Then button for the clause you are interested in defining.

4. Click Transition from the drop-down list available from the If section of the Clause Definition dialog
box.

5. Click the Define Transition button in the If section of the Clause Definition dialog box to display
the Transition Definition dialog box.

6. Click the Add button to add a new transition event.

Related Topics
Defining Multiple Transition Recognizers

Transition Definition Dialog Box
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Rename Transition Dialog Box
Use this dialog box to change the name of the currently selected transition event.
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Word Definition Dialog Box

Overview
Use this dialog box to define word events used in the Clause Definition dialog box. Each word event
displays values for valid channel groups defined in the Setup window.

Behavior
The value of each channel group is compared against live data. You can disable the channel group in each
word event by removing the check mark adjacent to the channel group name; this causes the word event
to ignore the data for the channel group. You can also disable or enable all channel groups by clicking
either the Clear All or Select All button. This either removes or adds check marks adjacent to each
channel group name.

You can change the group radix for each channel group by selecting the desired radix at the bottom of
the dialog.

Each word event is identified by a unique name.

To Use
To open the Word Definition dialog box, perform the following:

1. From the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click either the If/Then or the Else If/Then button for the clause you are interested in defining.

4. Click Word from the drop-down list available from the If section of the Clause Definition dialog box.

5. Click the Define Word button in the If section of the Clause Definition dialog box to display the Word
Definition dialog box.

Conflicts are possible when groups share channels. Conflicts are noted in the boxes. Conflicts do not
prevent acquisition.

The Trigger Conflict dialog box displays when a trigger conflict occurs, allowing you to select a trigger
replacement option to resolve the conflict.

Value settings closer to the top of the list override later settings.

The Word Definition dialog box is also available from the EasyTrigger tab, depending on the program that
you select.
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Add Word Dialog Box

Overview
Use this dialog box to add a new word event. Click Use Existing Word as Template to copy the settings
from an existing word event.

Behavior
The Add Word dialog box supplies words that are defined in the Word Definition dialog box, and are
available for defining PowerTrigger Clause Definition If statements.

To Use
To open the Add Word dialog box, perform the following:

1. From the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click either the If/Then or the Else If/Then button for the clause you are interested in defining.

4. Click Word from the drop-down list available from the If section of the Clause Definition dialog box.

5. Click the Define Word button in the If section of the Clause Definition dialog box to display the Word
Definition dialog box.

6. Click the Add button to add a new word event.

NOTE. The Add Word dialog box is also available from the EasyTrigger tab, depending on the program that you select.
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Rename Word Dialog Box
Use this dialog box to change the name of the currently selected word event.
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Detecting Violations
One of the logic analyzer’s most useful features is its ability to detect and trigger on both signal glitches
and setup and hold violations.
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Glitches
A glitch is a signal that makes a transition through the threshold voltage two or more times between
successive acquisition samples. Because glitches are often signal transitions that occur intermittently, they
can cause circuit malfunctions that are extremely difficult to diagnose.

Although you could try using a very fast sample clock rate to ensure that you never miss any glitches, a
better solution is to use the glitch-detection feature. The logic analyzer can trigger on a glitch, either alone
or in combination with other signal events. This capability is useful for catching intermittent glitches that
might not occur very often or appear only when a particular operation is taking place.

You can capture noise spikes and pulse ringing using the glitch capture feature. The following figure
shows data captured by triggering on a glitch. In the Waveform window, a glitch captured by the logic
analyzer is indicated by a band of color.

Glitch mode affects the storage of glitches in memory, which allows you to display the glitches in the data
window. Selecting Glitch mode reduces the available memory depth by half.

Glitch storage is independent of glitch events. Therefore, you can trigger on a glitch even when you
are not storing glitches.

Setup and Hold Violations
A setup and hold violation is a data signal that transitions within the setup and hold time period. You could
identify setup and hold violations by looking at each clock edge and reviewing all relevant data signals.
However, it is faster and reliable to use Setup/Hold triggering to identify violations.

You must select the correct clocking mode to use either the glitch detection or the setup and hold violation
features. Choose internal clocking to use glitch detection; choose external clocking or custom clocking to
use setup and hold detection.
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Selecting the Acquisition Mode
The acquisition mode determines the data to store. The acquisition modes that are available depend upon
the clocking type that you specify, as shown in the following table. You can store channel data (only),
glitch data, setup and hold violation data, or blocks of data around selected samples. Use the Acquire list
to select the acquisition mode you want.

Clocking Type Acquisition Mode and Resulting Data
Internal Normal - stores channel data (only)

Blocks - stores blocks of data around selected samples

Glitches - stores both channel and glitch data
External Normal - stores channel data (only)

Blocks - stores blocks of data around selected samples

Setup/Hold - stores both channel and setup and hold data
Internal 2X Internal 4X External 2X External 4X External 450 Normal - stores channel data (only)

Blocks - stores blocks of data around selected samples

NOTE. Selecting an acquisition mode of Glitches or Setup/Hold decreases the maximum memory depth by half.
Selecting an acquisition mode of Glitches or Setup/Hold decreases maximum clocking speed.

Use the following steps to select an acquisition mode:

1. In the System window, click a module Setup button.

2. From the Clocking list, select a clocking type.

3. From the Acquire list, select an acquisition mode.

Related Topic
Blocks Mode

Setup and Hold Violation Storage Mode
Setup/Hold violation storage mode captures both setup and hold violation data and regular data
for each channel. You must select External clocking for Setup/Hold storage violation mode to be
available. Note that Setup/Hold mode limits memory depth to half of the memory depth and limits the
sample period to 4 ns or greater for TLA7Axx/TLA7NAx logic analyzer modules and TLA5000B
Series logic analyzers .
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Glitch Storage Mode
Glitch mode captures both glitch data and regular data for each channel. You must select internal
clocking for glitch mode to be available. Note that glitch mode limits memory depth to half of the
maximum depth and limits the sample period to 4 ns or greater for TLA7Axx/TLA7NAx logic
analyzer modules and TLA5000B Series logic analyzers.
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Blocks Mode Details

Overview
Blocks mode provides the ability to acquire data before and after desired points and to limit acquired data
to a minimum, enabling you to analyze a very long time window. Circumstances under which Blocks
mode is useful include the following:

Troubleshooting interrupt or subroutine calls and returns

Troubleshooting DMA data transfers

Troubleshooting certain types of hardware timing problems when using internal clocking

Behavior
From the Setup menu, Acquire mode can be set to either Normal or Blocks. In normal mode, only the
samples selected by the trigger actions and qualifications are sorted. In Blocks mode, you store 31 samples
before and after the target sample, or a block of 63 samples centered on the point where the qualified
sample is normally stored.

The ability to use blocks acquisition with either state (external clock) or timing (internal clock) allows you
to use this feature for both software and hardware timing analysis.

In blocks mode only channel data is stored.

If you store blocks, they will override other forms of data qualification.

All samples in the block are always stored if post-fill has not matched any of its limits.

You cannot change block size; it is fixed in the hardware.

Blocks Mode Example
The following example troubleshoots the stack operation on a microprocessor system during the start of an
interrupt routine that is repeatedly called, such as a video vertical retrace interrupt. In this example, the
group name used for data is DATA. The channel names used for an interrupt and an instruction fetch strobe
are INTR and IFETCH, respectively.

This example checks the stack push operation by storing the start and end of every interrupt routine until
the instrument memory is filled. You first set the storage control to None (do not save anything unless
explicitly stored in trigger states) and specify the trigger state machine as follows:
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STATE 1: IF channel INTR goes low, THEN goto state 2.

STATE 2: IF group DATA = A333 AND channel IFETCH = 1, THEN store sample AND goto state 3.

STATE 3: IF group DATA = 0551 AND channel IFETCH = 1, THEN store sample AND goto state 1.

This trigger setup stores one sample at the instruction (A333) starting the interrupt service routine, and one
sample at the instruction (0551) ending the routine.

Since no trigger was set up in the example, set the trigger position to 100% and enable the status screen.
This will cause the memory to fill while waiting for a (never occurring) trigger. Then, after the memory is
full (state screen shows 0 remaining), you press the RUN/STOP button to force a manual trigger at the end
of memory. If MagniVu is displayed, the 1 us display is centered at the end of the regular data display.

In normal acquisition mode, only these instructions (A333 and 0551) are stored until memory is filled.
Unfortunately, this prevents you from seeing what happened in the stack push and pop at the start and
end of the routine. In blocks mode, because 31 samples before and 31 samples after each target sample is
stored, you can see the stack push and first few instructions at the start of the interrupt service routine
and the last few instructions and stack pop at the end of the routine.
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Glitch Detect Dialog Box

Overview
Use this dialog box to select which LA channel groups should have glitch detection in the clause definition
associated with a PowerTrigger program. Once a glitch is detected in any of the selected channel groups,
the glitch event condition has occurred.

Behavior
You can enable glitch detection in a given channel group by adding a check mark adjacent to the channel
group name. You can also enable or disable glitch detection for all channel groups by clicking either the
Select All or Clear All button. This either adds or removes check marks adjacent to each channel group
name.

Clocking must be set to Internal (this is set in the module Setup dialog box) for the Glitch condition to
appear in the If condition list. Otherwise, the S & H fault option must be used.

For information on how to open the Glitch Detect Dialog Box, see Triggering a LA Module on a Glitch.

TIP. To detect a glitch on a single channel, define a channel in the Setup window as a group.

NOTE. The Glitch Detect dialog box is also available from the EasyTrigger tab, depending on the program that
you select.
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Setup and Hold Event Dialog Box

Overview
Use this dialog box to find groups or channels that do not meet their setup and hold specifications. A
violation occurs when the data signal transitions during a period when it should be stable.

The Setup/Hold Window graphic displays both the clock signal and a channel group. The white area of the
channel group signal is variable and is determined by the setup and hold settings of the selected channel
group. If the data signal transitions within the white area of the signal, an event is generated.

For information on how to open the Setup and Hold Event dialog box, see Triggering an LA Module on
a Setup and Hold Violation.

Behavior
If you enter a time in one setup and hold box and the sum of both boxes is less than the minimum setup
and hold time, the value in the other box is changed. For example, if you select a setup time of 500 ps
for a TLA7Qx module channel group, and select a hold time of 0, the hold time will change to 500 ps
when you click OK.

NOTE. Values set in the Setup and Hold Event dialog box are also reflected in the Setup and Hold Storage dialog
box. Conflicts are possible when groups share channels. However, they do not prevent acquisition. Value settings
closer to the top of the list override later settings.

To Use
To find channel groups that have a setup and hold violation, select the check box associated with the
channel group for which you want to detect a setup and hold violation. Then enter the setup and hold
values in the corresponding channel group setup and hold list boxes. You can also detect or ignore setup
and hold violations for all channel groups by clicking either the Select All or Clear All button. This either
selects or clears the check boxes associated with all channel groups.

For TLA7Lx/Mx/Nx/Px/Qx logic analyzer modules, you can set the values in the setup and hold
boxes in 500 ps increments. The sum of the setup and hold time per channel group must be equal
to or greater than 1 ns.

For TLA7Axx/TLA7NAx logic analyzer modules and TLA5000B Series logic analyzers, you can set
the values in the setup and hold boxes in 125 ps increments. The sum of the setup and hold time per
channel group must be equal to or greater than 250 ps.
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Setup and Hold Storage Dialog Box

Overview
Use this dialog box to define the violation regions that will generate violations using the Setup/Hold
violation storage mode. The violations will be stored in acquisition memory.

The Setup/Hold Window graphic displays both the clock signal and a channel group. The white area of the
channel group signal is variable and is determined by the setup and hold settings of the selected channel
group. If any of the data signals in the group change within the defined setup and hold regions, indicated
in white, a violation is generated and stored in acquisition memory.

For information on how to open this dialog box, see Storing LA Module Setup and Hold Violations.

Behavior
You can set values in the setup and hold boxes in 125 ps increments for TLA7Axx/TLA7NAx logic
analyzer modules and TLA5000B Series logic analyzers. For the TLA7Lx/Mx/Nx/Px/Qx logic analyzer
modules, you can set the values in 500 ps increments. For TLA7Lx/Mx/Nx/Px/Qx logic analyzer
modules, the sum of the setup and hold time per channel group must be equal to or greater than 1 ns. For
TLA7Axx/TLA7NAx logic analyzer modules and TLA5000B Series logic analyzers, the sum of the setup
and hold time per channel group must be equal to or greater than 250 ps. If a time is entered in one box and
the sum of both boxes is less than the minimum setup and hold time, the value in the other box is changed.

For example, if you select a setup time of 500 ps for a TLA7Qx module channel group, and select a hold
time of 0, the hold time will change to 500 ps when you click OK.

NOTE. Conflicts are possible when groups share channels. However, they do not prevent acquisition. Value settings
closer to the top of the list override later settings. Setup and hold storage always applies to all defined groups and
uses the setup and hold values specified, even when the group is disabled for setup and hold events.
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Clause Definition Dialog Box

Overview
Use this dialog box to define the If/Then clause (or Else If/Then) of your PowerTrigger program. The
clause definition contains the most vital part of the trigger state. (The trigger state is shown in the
Overview pane of the LA PowerTrigger tab). It is in this dialog box that you define the condition for an
event to occur before an action can take place. You can have up to 16 clauses per state, depending on the
number and types of events monitored within a state.

The dialog box is divided into two parts, If and Then.
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If
Use the first part to select the events you are interested in and the condition those events must meet
before any actions can take place.

For example, you may be interested in an address channel group reaching a certain value. The group is the
event and the value is the condition. After the condition occurs, the program executes the actions specified
in the Then part of the dialog box. For information on trigger events refer to LA trigger Event Table.

Then
Use the Then part of the clause to define the action that occurs after the If part is true. For example, after
the If condition is met, the action you might want is to trigger the module or trigger all modules. Some
actions interact with others and some actions can only be used under certain conditions. For information
on actions refer to LA Trigger Action Table. Up to eight simultaneous actions can be specified for a clause.

To open Clause Definition dialog box from the System window, click the LA Trigger button. Then click
the If/Then button or the Else If/Then button, located on the LA PowerTrigger tab.

Keep the following in mind when using this dialog box:

The S & H fault event appears only when clocking in the Setup window is set to External or Custom.
Glitch appears only when clocking is set to Internal.

Events can be ANDed or ORed with each other. To add another event, click Add while an event is
selected. Click the first And button to change to the Or expression. You can have up to eight events.

You can use an Anything or Nothing event as a placeholder. Anything is used when the events are
combined with And. Change the And to Or and the event changes to Nothing.

When using events you should be aware of the number of event resources available for a trigger
program. For more information, refer to LA Trigger Resources.

Related Topics
Storage Definition Dialog Box

Signed Decimal Values
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Define Snapshot Dialog Box

Overview
TLA7Axx/TLA7NAx logic analyzer modules and TLA5000B Series logic analyzers support the use of a
snapshot to capture a given data sample and compare it with data that the trigger state machine subsequently
processes. Based on criteria that you specify, the result of the snapshot comparison can cause a predefined
event to occur. You set up the snapshot using the Define Snapshot dialog box, which allows channel groups
to be included or excluded from the snapshot definition. By default, all channel groups are included.

Behavior
You can exclude a given channel group by removing the check mark adjacent to the channel group name.
In addition, you can exclude all channel groups by clicking the Clear All button, which removes check
marks adjacent to all channel group names.

Four types of events operate on the snapshot. At any given time, only one of these events is true:

Snapshot equals the current sample - A snapshot has been previously loaded and it matches the current
data sample from the target system.

Snapshot does not equal the current sample - A snapshot has been previously loaded and it does not
match the current data sample from the target system.

Snapshot is not loaded - A snapshot has not been loaded or is still in the process of being loaded.

Snapshot is loaded - A snapshot has been loaded and is ready to compare acquisition data.

NOTE. Use of a snapshot event requires both an additional dedicated word recognizer and a timer. If either resource
is unavailable, a warning message displays and the event type reverts to its previous value.

Related Topics
Triggering an LA Module on a Snapshot Event

Trigger Program Structure for an LA Module
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System Trigger and Reference System Trigger Relationship

Overview
The system trigger is the primary reference point for the entire data acquisition. In data windows, timing
and location information is relative to the system trigger. There is only one system trigger per acquisition.

Behavior
If you add reference data to your data window, you can also add the system trigger for this reference data.
In this case you have two system triggers in the display: The active system trigger and the reference system
trigger. You can tell the two apart by the marks that identify them.

The active system trigger is identified by a large yellow T mark: The reference system trigger is
shown as a gray T mark .

You may not be able to see the reference system trigger in some data windows. For example, you create
a reference system (Save System) that contains two LA modules, A and B. The time domain of both
modules’ acquired data do not overlap, and the system trigger is within module B’s time domain.

A data window created from module A will not contain a reference system trigger. If you open the Go
To dialog box, a reference system trigger will not be listed. However, because timing and location
information are relative to the system trigger, the Timestamp column of module A will be referenced to the
system trigger in module B.
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Group Radix

Overview
Use the group radix to display data in the LA Trigger window and in the Clause Definition dialog box
in an easy-to-read format. Groups are a collection of data channels defined in the Setup window. The
following table lists common radixes used to view data.

Radix Valid characters
Binary 0, 1, X
Octal 0-7, $, X
Decimal 0-9, $
Signed decimal 0-9, -, $
Hexadecimal 0-9, A-F, $, X
Symbolic Symbol name

Behavior
A Symbol name refers to a set of characters defined in a symbol file.

The X and $ characters normally appear in the Trigger window. An X represents any character, often
known as a "don’t care" character.

The X can represent a binary, octal, or hexadecimal value depending on the radix selection. The $ character
appears when you select a radix where the binary combination contains one or more X characters. The
following example shows how a binary combination with an X character displays in different radixes.

Radix Display Value when X=0 Value when X=1
Binary 10101X11 10101011 10101111
Octal 25$ 253 257
Hexadecimal A$ AB AF
Decimal $$$ 171 175
Signed decimal $$$$ -85 -81

Tip
To identify the contents of a $ character in the Trigger window, change the group radix to binary.
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LA trigger Event Table
The following LA trigger events are available in the If section of the PowerTrigger Clause Definition
dialog box.

Event Description Interactions
Word Tests the channel groups for the word

values defined in the Word Definition
Dialog Box.

Uses one trigger resource across all
defined channel groups.

Group Tests a specified channel group for a
specific value, a range of values, or a
value change.

Only one change detection event
(group or channel) is available in a
trigger program. Range recognizers
use three trigger resources per
group event. Word recognizers or
change detectors use only one trigger
resource.

Channel Tests the specified channel for a value
or a value change.

Only one change detection event
(group or channel) is available in a
trigger program. Each channel event
uses one trigger resource.

Snapshot Available only on TLA7Axx/TLA7NAx
logic analyzer modules and TLA5000B
Series logic analyzers; compares
the current acquisition sample with
a previously loaded sample in the
snapshot recognizer.

Only one snapshot recognizer event
is available in a trigger program. Uses
two event lines and one timer.

Transition Tests the specified channel group for
the transition values defined in the
Transition Definition Dialog Box.

Cannot use the following within the
same trigger clause: Group Changes,
Unchanged Group, Channel Goes,
Channel Doesn ’t Go, and Transitional
Storage capabilities.

Glitch Detects glitches in channel groups
as defined in the Glitch Detect Dialog
Box.

Only available with internal
(asynchronous) clocking. Uses
one trigger resource.

S & H fault Tests setup and hold parameters as
defined in the Setup & Hold Event
Dialog Box.

Only available as an event with
external (synchronous) or custom
clocking. Uses one trigger resource.

Counter and timer events Tests the specified counter or timer
value.

Counter 1 and 2 events conflict with
Timer 1 and 2 events respectively.
They also conflict with their respective
counter and timer actions.

Signal Looks for one of the four internal
system signals.

Only one signal event is available in
a trigger program. Uses one trigger
resource.
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Event Description Interactions
Anything All sampled data makes this event

true.
Available with the AND conjunction.

Nothing All sampled data makes this event
false.

Used as a placeholder with the OR
conjunction.

NOTE. These event selections are also available from the EasyTrigger tab, depending on the EasyTrigger program
that you select.

Related Topics
Signals Properties

Clause Definition Dialog Box

LA Trigger Resources
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LA Trigger Action Table
The following LA trigger actions are available in the Then section of the PowerTrigger Clause Definition
dialog box.

Action Description Interactions
Trigger Triggers the current module and

causes both MagniVu and main
memory postfill to begin.

When Trigger is used in the trigger
program, Trigger All Modules cannot
be used.

Trigger All Modules Also known as a System trigger. This
signal is also available at the System
Trigger Out connector.

When Trigger All Modules is used in
the trigger program. Trigger cannot be
used.

Wait for System Trigger Used for a module that does not
trigger itself or any other module,
but waits to be triggered by another
module.

Capable of receiving the following
three (mutually exclusive) trigger
actions: Trigger, Trigger all Modules,
or Wait for System Trigger.

Trigger Main Triggers the module, and causes main
memory postfill to begin.

At most, one type of main triggering
can be used in the trigger program
(Trigger, Trigger Main, or Trigger
System)

Trigger MagniVu Causes MagniVu memory postfill to
begin.

Trigger MagniVu can be used in
combination with one of the main
memory trigger actions (Trigger,
Trigger Main, Trigger System, or Wait
for System Trigger)

Snapshot Current Sample Reloads the snapshot recognizer. Snapshot is not available for event
recognition while the snapshot is
loading its sample.
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Action Description Interactions
Go To Causes a change to a different trigger

state.
Use only one in clause definition.

Counter and Timer actions Starts, stops, resets, clears,
increments, or decrements counters
or timers.

Counter 1 and 2 actions conflict with
Timer 1 and 2 actions respectively.
The actions also conflict with their
respective events.

Set and Clear Signal Sets or clears one of the four internal
system signals.

Use only one in a trigger program.
Mutually exclusive with Arm Module
action.

Arm Module Sends an Arm signal to another
module. The other module begins
running its trigger program.

Can only arm one module in a trigger
program, but actions can be taken
throughout the trigger program.
Mutually exclusive with Set and Clear
Signal actions.

Store Sample Stores exactly one sample. Not available in Start/Stop storage
mode.

Start and Stop Storing Begins or ends storing of samples.
Used in conjunction with Start/Stop
storage mode in the Trigger window.

Available only in Start/Stop storage
mode.

Do Nothing Used as a placeholder when defining
a complicated trigger program.

Does not override other actions
specified in a clause.

Don’t Store Does not store this sample. Not available in Start/Stop storage
mode.

Related Topic
Signals Properties

Clause Definition Dialog Box

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

LA Trigger Resources

Overview
A trigger resource is a hardware constraint. Use trigger resources as tools to build a trigger program. A
trigger program can use up to 16 trigger resources.

Behavior
A trigger resource can be used more than once in a trigger program. However some events use more than
one trigger resource. The following table lists the trigger events, the event operator, the number of trigger
resources, and resource restrictions for each trigger event.
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Event Operator Trigger resources and restrictions
Word =, Is Not 1 trigger resource
Group (word recognizer) =, Is Not 1 trigger resource
(range recognizer) <, <=, >=, >, Is In, Is Not In 3 trigger resources
(change detector) Changes, Unchanged 1 trigger resource, one change

detector allowed in a trigger program,
not available when transitional storage
is used

Channel (word recognizer) = 1 trigger resource
(change detector) Changes, Unchanged 1 trigger resource, one change

detector allowed in a trigger program,
not available when transitional storage
is used

Snapshot =, Is Not, Is Loaded, Is Not Loaded 2 trigger events and 1 timer event
Transition Occurs, Doesn’t occur 1 trigger resource for each of the 16

available transition recognizers used.
Glitch 1 trigger resource, only available with

internal (asynchronous) clocking
S & H fault 1 trigger resource, not available with

internal (asynchronous) clocking
Counter >, <= 0 trigger resources, 2 counters or 2

timers

Maximum width 51 bits
Maximum clocking 250 MHz
(TLA7Lx/Mx/Nx/Px/Qx) 500 MHz
(TLA7Axx/TLA7NAx and
TLA52x) Maximum count
2,251,799,813,685,246

Timer >, <= 0 trigger resources, 2 counters or 2
timers

Maximum width 51 bits
Maximum clocking 250 MHz
(TLA7Lx/Mx/Nx/Px/Qx) 500 MHz
(TLA7Axx/TLA7NAx and TLA52x)
Maximum time 2,000,000 s or 23 days
Resolution 4 ns (4 ns is the minimum
target value) for TLA7Lx/Mx/Nx/Px/Qx
2 ns for TLA7Axx/TLA7NAx and
TLA52x

Signal (Signal In) Is True, Is False 1 trigger resource, uses one of four
internal system signals

Anything/Nothing 0 trigger resources

EasyTrigger programs are designed to take into account resource limitations so that, in most cases, you do
not have to be concerned with resources.
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For TLA7Axx/TLA7NAx logic analyzer modules and TLA5000B Series logic analyzers, when using
Internal, Internal 2X or Internal 4X clocking and running at the fastest clocking rate, a 2 ns delay is required
to allow the counter event to propagate through the system before the trigger state machine can respond.

Related Topics
LA trigger Event Table

LA Trigger Action Table

Clause Definition Dialog Box

Trigger Action Signal Restrictions

Internal Signaling
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Force Main Prefill

Overview
By default, the Force Main Prefill check box is selected, which defers execution of the trigger state
machine until the main memory prefill amount is met. Use the Memory Depth field, located in the LA
Setup window, to set the total memory depth that the module fills. Use the Trigger Pos slider or box,
located in the LA Trigger window, to set the main prefill amount that must be met before the trigger state
machine is activated.

Behavior
When you use Force Main Prefill functionality, you specify which data samples are stored by selecting the
desired sample type from the Storage drop-down list. Note that if you select either the None or Stop/Start
storage settings, the Force Main Prefill check box and related functionality become unavailable.

System triggers produced by other modules override force prefill functionality and immediately start
execution of the trigger state machine. An externally generated system trigger does not purge the force
prefill data samples stored in main memory. However, the TLA7Axx/TLA7NAx logic analyzer module
or the TLA5000B Series logic analyzer stops acquiring further prefill data samples and begins acquiring
postfill data samples until main memory allocated for postfill data samples is filled.

NOTE. To change the default setting for Force Main Prefill, from the System menu select Options, and then click the
Defaults tab.

Related Topics
LA Triggers

LA Trigger Action Table
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MagniVu
MagniVu functionality is designed to acquire data at a high sample rate so that you can see the timing
of signals in much greater detail. This is useful when you are debugging hardware and needing higher
resolution data samples for viewing events that change very quickly. Although the TLA7Axx/TLA7NAx
logic analyzer module and the TLA5000B Series logic analyzer hardware supports storage at slower
rates, data sampling is always performed at the maximum PowerFlex MagniVu sample rate. MagniVu
memory depth is set to a fixed 16K.

Related Topic
LA Trigger Action Table
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MagniVu Storage Rate

Overview
This is the rate at which MagniVu data is stored in memory. By slowing the MagniVu storage rate, you
can stretch MagniVu memory over a greater span of time, providing a lower resolution data sample from
a greater time period.

Behavior
The MagniVu storage rate cannot be set slower than the effective main memory rate, according to 1X, 2X
or 4X modes. The available rates are:

8 GHz <-> 125 ps

4 GHz <-> 250 ps

2 GHz <-> 500 ps

1 GHz <-> 1 ns

The MagniVu storage rates are limited by the fastest storage rate of the main memory under 1X, 2X, and
4X modes. The slowest MagniVu Storage rate is half of the fastest storage rate of the main memory.

1X MagniVu Storage Selections 2X MagniVu Storage Selections 4X MagniVu Storage Selections
125 ps, 250 ps, 500 ps, 1 ns 125 ps, 250 ps, 500 ps 125 ps, 250 ps

NOTE. MagniVu storage rate adjustments do not affect setup and hold violation or glitch violation.
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MagniVu Trigger Position

Overview
The MagniVu trigger position, available with TLA7Axx/TLA7NAx logic analyzer modules and
TLA5000B Series logic analyzers, selects the amount of pretrigger MagniVu data to store and determines
the position of the trigger in the data record. You can control the MagniVu trigger position independently
of main trigger position by a set of controls in the advanced toolbar.

Behavior
Once triggered, a module continues to acquire MagniVu data until it fills a specified amount of memory.
MagniVu memory depth is set to a fixed 16K. The Trigger Position field determines the proportion of data
that is stored before and after the trigger. For example, if the Trigger Position is set to 15% and the module
triggers, then the module continues to acquire data until the remaining 85% of memory is filled.

The MagniVu trigger position controls mirror the corresponding controls for main memory trigger
position. They consist of a slider control, an edit box, and a spin control positioned beneath the main
memory trigger controls. They behave like the main memory counterparts, except that the MagniVu
trigger position is constrained by the MagniVu storage rate as follows.

Storage Rate Resulting Trigger Position Constraint
125 ps 0% to 58%, in 1% increments
250 ps 0% to 79%, in 1% increments
500 ps 0% to 89%, in 1% increments
1 ns 0% to 94%, in 1% increments

NOTE. MagniVu data acquisition starts prior to the run line and fills memory before any possible trigger event.
Therefore, there is no MagniVu forced prefill control.

Related Topics
MagniVu

LA Triggers

LA Trigger Action Table
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2X Clocking Mode Trigger Programs

Overview
Trigger Programs need special attention in order to work properly in 2X clocking mode. In some
situations, it may be necessary for a data value to be present on the probe input for two clock cycles for a
word recognizer to detect it. In other situations, it may be necessary to use word recognizers logically
ORed together across the source and destination channels to detect a value.

Behavior
It is important to remember that in internal 2X or external 2X clocking mode, trigger programs operate on
the acquired data only at the 1X speed. In other words, in 2X mode the current trigger machine state is
evaluated at the physical sample rate and not the logical sample rate.

To illustrate this point, take the following internal 2X clocking mode acquisition samples:

NOTE. A minimum sample period of 2 ns is assumed in internal clocking mode.

A3 Channels D3 Channels Timestamp
01 02 0 ns
03 04 2 ns

The data was acquired with the trigger: If Group A3 equals 01, then Trigger.

However, if the "01" data value happened to be stored in the demultiplex destination (D3) channels,
it would not have been triggered on, even though it occurred on the A3 lines and was captured in the
acquisition memory.

To reliably trigger on an event that only lasts for 1 ns, you must use two word recognizers: one to
watch the demultiplex source channels, and the other to watch the demultiplex destination channels.
The following trigger will always catch the 02 pattern in 2X mode: If Group A3 equals 02 or Group
D3 equals 02, then Trigger.

If the desired event for triggering is present on the data lines for at least 2 ns, then it follows that the
demultiplex source channels will always capture the event. In this case, the normal 1X trigger will work
correctly in the 2X acquisition mode.

NOTE. You can use the Trigger on 2X clocking group match or Trigger on 2X clocking channel match EasyTrigger
Programs to automatically set up this type of triggering on a data value that you specify.

Related Topic
Internal 2X Clocking Details
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Entering a Symbol Plus an Offset in a Trigger
In a group value field that has a symbolic radix you can directly type in a symbol with an offset. For
example you can type into that field:

MyFunction+55

The application software will parse the symbol and the number and redisplay the result. The software
takes the offset as a HEX number. As in other places where you type in numbers, you can force the
radix to be something else. For example:

MyFunction+\d10 ’decimal 10

MyFunction+\b1111 ’binary 1111

MyFunction+\o33 ’octal 33

MyFunction+\haa ’hexadecimal AA
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Triggering Problems
When trigger program is not being satisfied, check the following:

The trigger program is correct.

Storage qualification is correct.

The system under test or module does not have an exception or fault. The system or acquisition
module might have experienced a hardware or software exception or fault after the trigger condition
was satisfied.

A clock is available. Click Status in the toolbar to open the Status Monitor and verify that a clock is
available. If no clock is available, check your clocking connections.

If the previous suggestions do not fix the problem, try the following:

Reload the support package to restore the instrument to a default state.

Possible loading problems might be remedied by removing one or more of the protective sockets from
the probe adapter. These sockets might add enough additional capacitance or delay to your system
under test to affect it.
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Serial Analyzer Trigger Window

Serial Analyzer Trigger Window
The serial analyzer Trigger window is similar to a Power Trigger window on a logic analyzer module. You
use it to construct a trigger program. The trigger program is made up of one or more trigger states. Each
state has one or more clauses. Each trigger state contains an area where you can enter a brief description of
the state. You can have up to eight trigger states in the trigger window.

Each clause has a trigger event section that specifies a trigger event that you are looking for. The second
part of the clause contains a trigger action section describing the appropriate action to take when the event
information has been satisfied. You can have up to eight trigger clauses per trigger state.

Some suggestions for using the Trigger window follow:

Click to collapse the current trigger state to provide more room on the screen.

Click to expand the current trigger state.

Look for the or to expand or collapse information in the current clause. They are indicators that
there may be more or less information to display on screen.

TIP. Configure the Setup window before the Trigger window, because the Setup window settings may affect Trigger
window selections.

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Trigger Tool Bar
The trigger tool bar in the serial analyzer Trigger window has controls for common tasks. Icons at the left
side of the tool bar provide an easy means to do the following tasks:

Click to set the default Trigger window.

Click to load a previously saved Trigger window.

Click to save a Trigger window.

Use the On Run control to specify the storage control options. Select Start Storing to begin storing data
when you click the Run button. Select Don’t Store to not store data until the conditions have been met
in the trigger program.

Use the Store control to specify the amount of data to acquire. The data volume is expressed in terms
of symbols with a maximum of 32 M symbols. Use the Trig Pos control to specify where the trigger
will appear in memory (1% accuracy within the data record). Both of these controls perform the same
functions as in the serial analyzer Setup window.
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Creating a Serial Analyzer Trigger Program
Use the following guidelines to create a serial analyzer trigger program:

1. Open the serial analyzer Trigger window.

2. In State 1, enter a meaningful description in the Description field.

3. In Clause 1, click Add Event, and select a trigger event from the drop-down list.

Depending on the event, additional controls will appear. Select the information that you want from the
drop-down lists. For some packets (such as TLPs, DLLPs, Sequences, or Link Events) you can click

to open a dialog box where you can further define the packet.

4. If necessary, click Add Event to add additional events to the current clause. You can logical OR or
AND the events.

5. In the action area of the clause, select an action from the drop-down list and then fill out the necessary
information to complete the trigger action.

6. If necessary, you can add additional clauses and states to complete your trigger program.

TIP. You can also add states, clauses, events, and actions by right-clicking the mouse.
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Serial Analyzer Trigger Events
The following table lists the serial analyzer trigger events.

Event Description
Anything Recognizes any data.
TLP Recognizes the presence or absence of a specific TLP. You can choose the TLP

from a list, or define a TLP.
DLLP Recognizes the presence or absence of a specific DLLP. You can choose the

DLLP from a list, or define a DLLP.
Sequence Recognizes a specific ordered set or symbol sequence. You can choose the

Sequence from a list, or define a Sequence.
Link Event Recognizes link events and link error signals. You can choose the Link Event

from a list, or define a Link Event and specify which lanes to monitor.
Timer Recognizes a specified timer value. You can have a maximum of four global

counters or timers.
Counter Recognizes a specified counter value. You can have a maximum of four global

counters or timers.
Signal In Recognizes a signal from another module.
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Defining Packets in Trigger Windows

The serial analyzer lets you define packets for triggering on PCI Express data. Click in the Event
section of the trigger program to open a dialog box where you can define the event.

1. Enter a meaningful name for the packet or select one from the drop-down list.

If you select a packet from the list, a copy is automatically created.

2. Fill in the information as needed to define the packet.

3. To change the radix of a particular field, right-click the mouse in the field and then select a radix
from the context menu.

4. Click close to save the changes.

NOTE. The X and $ characters appear whenever you define a TLP, DLLP, or a symbol sequence Event. An X
represents any character, often known as a "don’t care" character. The X can represent a binary, octal, or hexadecimal
digit depending on the radix selection. The $ character appears when you select a radix where the binary combination
contains one or more X characters. To identify the contents of a $ character change the radix to binary.

LA Trigger Program

Trigger Program Structure for an LA Module
A trigger program is made up of one or more states (up to 16). Only one state is active at a time.

Each state is made up of one or more clauses. If there are more than four trigger event resources used in
a state, you can have up to four clauses per state. If there are four or fewer trigger event resources in a
state, you can define up to 16 clauses per state. However, if you use a snapshot recognizer as an event in
your clause definition, your use of clauses per state is restricted as follows (note that neither counters nor
timers are included as trigger resources).

If you use a snapshot recognizer and more than two additional events, you can have up to two clauses
(and one counter or timer) per state.

If you use a snapshot recognizer and no more than one additional event, you can have up to eight
clauses (and one counter or timer) per state.

During each clock cycle, all clauses within the active state simultaneously evaluate the acquired data. The
priority of evaluation of a clause is assigned from top to bottom. The If statement of a clause can contain a
single event, or it can contain multiple event conditions. When the correct event conditions occur, the logic
analyzer passes control to the actions specified in the Then statement. There are several actions to choose
from, including triggering the system, or transferring control of the trigger program to another state.

If multiple clauses are true in the same clock cycle, only the clause with the highest priority that goes true
will have its actions executed.
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NOTE. Avoid using the If Anything event in the top-most clause of a state with multiple clauses. Successive If-Then
clauses will never become active. If you decide to use the If Anything event, it should be in the last clause of a state.

PowerTrigger Tab
The Overview portion of the LA PowerTrigger tab shows the relationship between states.

Arrows indicate the transfer of trigger program control
between states. Marks indicate system-level actions that
could occur if a clause in that state goes true. Use the
trigger Overview to check that all states are connected.
With the exception of State 1, all states must have an arrow
leading to them (indicating activation by another state),
or they will not execute. These actions are defined in the
Clause Definition dialog box.
Trigger Detail

The Trigger Detail, located in the right portion of the LA
PowerTrigger tab, shows summary information about the
clauses within the states. For lengthy trigger programs, click
the State icon in the Overview to jump to the corresponding
PowerTrigger details. Click the If/Then icon to open the
Clause Definition dialog box, for complete information about
the clauses for that state.

TIP. To check the progress of your trigger program during acquisition, click the Status button in the toolbar to display
the status monitor.

To track a sequence of events, create trigger programs with multiple states.

To simultaneously monitor different events, create trigger programs with states containing multiple clauses. Each
clause can carry out different actions when the events occur within each state.

Related Topics
Clause Definition Dialog Box

LA trigger Event Resources

Trigger Clauses
Trigger clauses are made up of two parts: An If statement that defines the data events to search for,
and the Then statement which specifies the actions taken when the If statement is true.

Clauses contain the most important part of the trigger program; they specify the data and conditions
to look for. Clauses also define the relationship between the states by specifying when control is
passed from one state to another state.
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Event Conditions
Event conditions are a logical combination of trigger events within a single clause.

If you set up a logical AND statement, all event conditions in the clause must be met before
the clause can execute the action.

If you set up a logical OR statement, any one of the event conditions can be fulfilled before
the clause can execute the action.

You cannot define both AND and OR statements. You must define one or the other.

Trigger States
Trigger states monitor and act on a sequence of data events. States break up the trigger program
into stages.

States make the trigger program easier to read and provide more program flexibility by providing a
method to define the program in greater detail. During acquisition, trigger program control passes
from one state to another. The contents of the active state are evaluated each clock cycle.

Each state contains up to 16 clauses.
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EasyTrigger Program List

Overview
An EasyTrigger program list contains a collection of predefined trigger programs for the LA module. A
list of predefined trigger programs is available from the EasyTrigger tab of the Trigger window. These
predefined trigger programs are designed to hide program implementation details, allowing you to focus
on acquiring and displaying data. However, you can use the PowerTrigger tab to view the selected trigger
program’s inherent trigger states and related clauses that define the data event, and possible resulting
actions.

To Use
You can also use the predefined trigger programs as the basis for designing increasingly complex trigger
programs that meet your data requirements. Selecting a predefined trigger program from the EasyTrigger
tab and then displaying it using the PowerTrigger tab also allows you to modify the preexisting state
and clause definitions. After making trigger program modifications, you can save the resulting trigger
program to a specified folder for later reuse by clicking the button, which is available from the Trigger
window toolbar.

Symbol Meaning
A, B, C Replaces Events
Range A A Range value
N A count (counter)
T A time (timer)

NOTE. When you use the PowerTrigger tab to make changes to a predefined trigger program, you can no longer
use the EasyTrigger tab to view the modified program. Attempting to do so will display a message warning you
that, if you proceed, your unsaved program changes will be lost. Only predefined trigger programs can be viewed
from the EasyTrigger tab.

After you become familiar with defining trigger states and related event and action clauses, you can use the
PowerTrigger tab to create new trigger programs that are specifically designed to your data requirements.

Related Topic
Loading a Trigger from the Trigger Tab Page
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LAListing Window Information

Listing Window

Overview
Use the Listing window to view and evaluate acquisition data. This window displays the acquired data
as a result of what you specified in Setup and Trigger windows. To open a Listing window from the
Window menu, click Listing.

Columns
Data is presented as tabular text in columns. There are several types of columns; logic analyzer channel
groups, individual logic analyzer channels, DSO channels, Disassembly, Sample numbers, and Timestamp
values.

Columns can be dragged and dropped. Click and drag the column label to where you want the column
displayed. An arrow shows where the column will be placed.

Double-click a column label to open the Column Properties tab.

Add columns by clicking the Add Column toolbar button .

Remove columns by selecting the column label and clicking the Cut toolbar button. You can paste the
removed column to the right of any selected column.

Expand columns to show the individual channels in a group by clicking the + . Collapse the
individual channels by clicking the - .

.

Marks
Marks are used to make time measurements, locate triggers, and mark specific samples for evaluation.

Marks you can move include Cursor 1, Cursor 2, and any marks you add. The numbers 1 and 2 on the
mark handles denote the cursor marks. Readouts for Cursor 1, Cursor 2, and the time difference (Delta

Time) between the two are located on the Delta Time toolbar. .
You can add any number of delta time toolbars by clicking the Add Delta Time button at the top

of the Listing window.

Marks on the left side of the window are data area marks. These marks are in the portion of the
acquisition that is currently viewable. Use data area marks to move within the data area.

You cannot move System Trigger, Module Trigger, or Begin and End marks.

Marks on the right side are overview marks. These marks show where marks are located relative to the
entire acquisition. Use overview marks to move throughout the acquisition. For example, move Cursor
1 to a particular sample as shown in the Cursor 1 readout. Click the Go To toolbar button and select
Cursor 1. You can also click the right mouse button on any overview mark, and then click Go To Mark.
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Double-click a mark to open the Marks properties tab. You can assign a unique name to the Mark in
the Mark Name field.

You can add marks by clicking (the Add Mark toolbar button). Remove a mark by selecting the
mark and using the Cut toolbar button. When you add or paste a mark, it appears in the center of
the display.

You can move to any mark using the Go To toolbar button.

System trigger
The system trigger is the reference point for the acquisition.
Timing and location information is relative to the system
trigger. Trigger marks cannot be moved.

The system trigger associated with the current data is called
the active system trigger. The system trigger associated
with saved data is called the reference system trigger. The
active system trigger is indicated by a yellow T; the reference
system trigger is indicated by a gray T.

The system trigger appears even if no data from the module
that generated the system trigger is around it.

Module trigger
The point at which the module triggered. Trigger marks
cannot be moved.

Begin data and end data and
The start and end of a module’s data record. These data
marks cannot be moved.

Cursors 1 and 2

and

Moveable marks used for visual reference and for data
measurements.

User mark User-created marks. Use marks to make specific data easier
to identify and find.

Lock Delta Time check box Click this check box to lock the delta time value. When you
lock delta time, the channel marks move across the data
simultaneously, maintaining a fixed delta time.

Data Area
The Data area can be split vertically by dragging the split box from the left end of the horizontal
scroll bar. This allows you to compare columns.

Qualification Gaps are indicated with a horizontal gray line above the first data after the gap. Turn
indicator gaps on or off from the Listing Window Properties tab.

Glitches are indicated by highlighted text of the complete sample, except for binary radixes. Only the
glitch bits are highlighted in binary. Select the color of highlighted glitch text from the Listing window
properties tab. Select radixes from the Column properties tab.

Enable Glitch storage in the Setup window before acquiring data. Glitch storage is not available when
using internal 2X clocking.

Memory differences and equalities are indicated by highlighted data. You can enable data comparison and
select the color of highlighted data from the Listing window properties tab.
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Before you can acquire and compare data, you must first enable the comparison in the Setup window and
define both the channels to compare and a valid data reference.

The Listing and Waveform windows both support viewing internal 2X clocking data. For an example of
internal 2X clocking data, see Internal (Asynchronous) 2X Clocking Mode.

Qualification Gaps
Positions between data samples where one or more samples have not been stored.

Data Differences
Highlighted data shows where there are differences between the two channels or channel groups
being compared.

Data Equalities
Highlighted data shows where there are no differences between the two channels or channel groups
being compared.
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Add Column/Waveform Dialog Box
Use to add a column to the Listing window, or a waveform to the Waveform window:

1. Select the data source and its associated group or channel to add it to the display.

2. Click the Add Data Source button to add a source to the selection box.

To open the Add Column or Add Waveform dialog box from the System window, click the appropriate
data window icon. Then go to the Edit menu and click either Add Column or Add Waveform.

TIP. To quickly add columns and waveforms, right-click in the Listing or Waveform window and select either Add
Column or Add Waveform.
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Lock Windows Dialog Box

Overview
Use the Lock Windows dialog box to lock cursors and the display areas of selected data windows. Locking
windows provides an easy method to compare data from two different windows.

Use the Lock Windows dialog box to select how windows are locked together with respect to cursors C1
and C2 and the center screen.

Behavior
To have the cursors and center screen of all locked windows go to the same time stamp position as the
selected reference window, click the No time offsets option button. To have each window’s cursor and
center screen retain its current position, click the Current time offsets option button.

You can only lock Listing, Waveform, Protocol, and Graph windows.

TIP. One way to jump over big time gaps in the Waveform window is to create a Listing window of the same data, and
then lock the two windows together. As you move the cursor through the Listing window, the cursor in the Waveform
window will track and jump over the "dead" space between samples.

To Use
To open the Lock Windows dialog box from the System window, click the Listing, Waveform, Protocol, or
Graph data window icon. From the System menu, click Lock Windows.
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Export Data Dialog Box

Overview
Use the Export Data dialog box to export data from the current Listing window to an ASCII text file or to a
binary file. You can export the following listing data:

All data from the acquisition

A range of listing data between two selected marks

A range of listing data between two samples

Behavior
If you choose to export the listing data to a text file, you can click Options to define the format of the data.
The data is saved in a file with the .txt extension.

If you choose TLA Data Exchange the text format is predefined as follows. The first line displays vectors
and the second line contains the column headings Sample, Address, Data, and Timestamp.

If you choose to export the listing data to a binary file, the data is saved in a file with a .tbf (TLA binary
format) extension. Sample numbers and mnemonics groups are not exported; time stamps are listed in
picoseconds and are relative to the start of the acquisition. The binary option is available only when the
data window has a single data source.

To Use
To open the Export Data dialog box, open a Listing window. From the File menu, click Export Data.

Related Topic
Export Data Options Dialog Box

TLA Binary File Format
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TLA Binary File Format

Overview
The TLA Binary File Format is used to export data from Listing windows in binary rather than ASCII
format. You can use this format to export DSO data and MagniVu data in Listing windows, in addition to
the standard listing data.

LA Module Binary Format
The binary data for an LA module is exported as a stream of bytes with the following characteristics:

The binary data uses big endian fields (the most significant bit is the left-most data bit).

Each group field is zero-padded to the nearest byte.

Sample numbers and mnemonics groups are not exported.

Time stamp data is seven bytes wide and represents the number of picoseconds since the start of
the acquisition.

The left-most column in the Listing window corresponds the first exported field of a sample.

The first sample in the Listing window appears at the beginning of the exported file.

MagniVu data follows the same guidelines as regular listing data.

DSO Module Binary Format
The binary data for a DSO module (in a Listing window) is exported as a stream of bytes with the
following characteristics:

The binary data uses little endian fields (the most significant bit is the right-most data bit).

Each channel is a 16-bit value.

Sample numbers, mnemonics groups, and time stamp values are not exported.

The left-most column in the Listing window corresponds the first exported field of a sample.

The first sample in the Listing window appears at the beginning of the exported file.

MagniVu data follows the same guidelines as regular listing data.

DSO data values are in twos-compliment format.

The formula used for converting a channel field into a voltage is as follows:

((Vertical Range in volts / 64512) X Channel field) + Vertical Offset in volts
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Export Data Options Dialog Box

Overview
Use the Export Data Options dialog box to customize listing data for export. The settings are retained
after you close the dialog box.

To Use
To open the Export Data Options dialog box, open a Listing window. From the File menu, click Export
Data, and then click Options.

1. Choose a field delimiter to separate the listing data columns.

2. Click the Include Unit Character check box to export data with measurement units. If you export data
without unit characters, time stamp values are in picoseconds and analog values are in volts.

3. Click the Fixed Data Radix check box to export data in the specified radix.

4. Click the Use Enhanced Column Headers check box to export group width and radix information in
column headers.

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Repetitive Properties Dialog Box

Overview
Use the Repetitive acquisition features of the logic analyzer to automate repetitive and time-consuming
tasks. For example, you can specify the number of times that you want the logic analyzer to acquire data.
With each acquisition, you can save the data to a file for analysis. You can also set up the logic analyzer to
open a file or execute a program when all of the acquisitions have been completed.

Behavior
Click the Save check box to save the setups or export data to a file. You can overwrite the file with each
acquisition or you can save the data in separate files by entering a starting file suffix number.

During compare operations, you can acquire data until the compare conditions are met. Then click OK to
close the dialog box and save your settings.

The following is an example of such a setup where the acquired data is exported to a file for each
acquisition. When a data-mismatch occurs, the logic analyzer stops acquiring data and exports the data to a
file. The faulty data can now be analyzed by another application.
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NOTE. You must click the Enable Data Compare check box, located in the Compare Definition dialog box, to stop
the acquisitions when the compare conditions are met.

After completing the repetitive operation, you can have the logic analyzer open a document or execute an
operation as defined in the Open dialog box. Click Open to access the Open dialog box.

TIP. To improve the response time of the logic analyzer during repetitive operations, you can delete any unnecessary
data windows. This allows the logic analyzer to spend time on processing data rather than redrawing data in data
windows.

To open the Repetitive Properties dialog box from the System menu, click Repetitive Properties.

Related Topics
Compare Definition Dialog Box

Export Data Dialog Box

Open Dialog Box
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Open Dialog Box

Overview
Use the Open dialog box to open a document or an application after fulfilling the requirements of a
repetitive operation.

To Use
Enter the path and name of the document or application that you want to open. If you do not know the
path name of the document or the application, click the Browse button to navigate to the document or
application.

Use the Arguments list to enter any command line arguments that are required by the application or
document.

Use the Initial Directory box to specify the default working directory for the application or document.

Click the Test Open button to verify the selections for the Open dialog box.

To access the Open dialog box from the System menu, click Repetitive Properties, and then click the
Open button.

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Define Search Dialog Box

Overview
Use the Define Search dialog box to search for specific data within the current data window. Search
definitions can search any number of data sources at the same time. By default, searches begin from the
active cursor, but you can specify any cursor or mark to begin the search. All data sources begin searching
at the same point and continue until the number of occurrences specified is found. Neither hidden data
nor suppressed data can be found by the search function. Suppressed data can be identified by gaps in
the sequence numbers.

Behavior
Module sample numbers and stored time stamps can be searched.

All module channels and groups can be searched; each has unique conditions to aid you in searching.
Types are LA channels, LA groups, DSO channels, and disassembly.

You can search for data differences and data equalities during compare operations.

You can add an unlimited number of events.

After adding an event, click the AND/OR button to alternate between logic expressions.
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The Radix for groups can be set independent from those used in Listing or Waveform windows.

The polarity state set in the module setup applies to the search values.

Searches on numeric disassembly groups with partial invalid bits (indicated by dashes) will match
across the entire unqualified value. Set invalid bits to "don’t care" values (X) for a proper match.

Searches on numeric disassembly groups that contain all invalid bits always fail.

To Use

To open the Search Definition dialog box, open a data window and click in the toolbar.

Click either the Search Back or the Search Fwd button to begin the search.

Click the Search Options... button to set the action that you want the logic analyzer to take when the
search is successful.

NOTE. You can type the following meta-characters in the value box for text searches.

Character Matches
Zero or more characters

? Any single character
< or > One or more delimiters. A delimiter is any character that is

not: a - z, A - Z, 0 - 9, _ (underscore) or - (dash).
% Opcode mark. This character can only be used in a

disassembly mnemonics column search.
space One or more spaces
\ Makes the next character literal.

Right-click in the Search area to activate a short cut edit menu. The short cut edit menu allows you to
add or delete data sources and events, to enable or disable searches and to cut, copy, or paste. Where you
right-click in the Search area determines which menu selections are active.

Clicking in the Search area will activate a icon. Holding your cursor over the arrow activates the
short cut edit menu.

Related Topics
Column Properties Tab

Waveform Properties

Compare Definition Dialog Box

Search Definitions
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Search Definitions Dialog Box

Overview
Use the Search Definitions dialog box to create new search definitions or load saved searches.

Behavior
Clicking the New button adds a new search to the selected data window. Clicking the Load button opens
the Load Search dialog box where you can select and load searches. Selecting a search, and then clicking
the properties button, opens the Define Search dialog box where you set the criteria for the search.

Related Topic
Define Search Dialog Box

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Time Alignment Dialog Box
Use to align the time of data sources. The data source’s alignment is offset by the adjusted time in all data
windows. LA and associated MagniVu data sources are always offset together.

Saved data and current data are time-correlated by aligning their system triggers. You can manually adjust
this alignment using the Time Alignment dialog box.

To open this dialog box, open a data window. From the Data menu, click Time Alignment.

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Go To Dialog Box
Use to scroll the data window to a new position by selecting any current mark, column, or waveform.

To open the Go To dialog box, open a data window and then click the Go To toolbar button.

Related Topics
Adding a Mark to a Data Window

Adding a Column in a Listing Window

Adding a Waveform
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. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Mark Opcode Dialog Box
Use this dialog box to place an opcode mark into a disassembly analysis. To do so, select an opcode from
the list and click OK. To remove an existing opcode mark, click Undo Mark.

For details about opening the Mark Opcode dialog box, refer to Adding an Opcode Mark.

NOTE. You must have a support package loaded to use this feature.

Related Topic
Load Support Package

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

About Data Properties
Provides information about the data source used for the active data window.

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Column Properties
Use the Column properties tab to format a column in the Listing window.

Click the Column drop-down list to view properties of another column. Note that changing columns
applies changes that you made to the previous column.

Color selection changes the color of text in the column.

Column data can be displayed with user defined foreground and background colors by setting up
the column to use TSF symbol file with color.

The Show Column check box can be used to temporarily remove a column from the display, but
still retain its properties.

Column selection of Sample or Timestamp provides controls for reference points (for example, you may
want to reference all time stamp values to the module trigger point rather than the beginning of data).

Select the radix if the selected column is a data column. If you select Symbolic, controls appear
to aid you in finding the symbol file.

NOTE. Radix and Polarity selections for disassembly mnemonics cannot be changed. Polarity cannot be changed for
any disassembly column.

To open the Column properties tab, open a Listing window and double-click the column label.
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Marks Properties
Use to format any mark in the current data window. You can also enter comments for any mark you
have added.

To open the Marks properties tab, open a data window and double-click the mark.

NOTE. Changing the selected mark applies any changes that you made to the previous mark.
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. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Listing Window Properties
Use to format the current Listing window.

Qualification gaps in the Listing window are indicated by a gray horizontal bar above the first data
after the gap.

Data Font Size allows you to select the size of the text within the columns and the column labels.

Click Acq != Ref to display data differences during data compare operations.

Click Acq = Ref to display data equalities during data compare operations.

NOTE. To display differences and equalities, you must define a valid data reference and enable the comparison.

Glitches are indicated by highlighted text of the complete sample for all radixes except binary; in
binary radix the actual bits containing the glitches are highlighted.

NOTE. Select Glitches in the Storage box of the Setup window before acquiring data.

Background allows you to select the color for the data area background.

Selecting a different color scheme resets the colors shown in the Column tab, Marks tab, and Listing
Window tab to their default settings for that color scheme. Color schemes are defined in the Colors
tab of the Options dialog box.

NOTE. Default colors are set in the Defaults tab of the Application Options dialog box, available from the System
menu.

To display the Listing Window property tab from a Listing window, click in the toolbar, and then
click the Listing Window tab.

Related Topics
Defaults Tab

Color Tab

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Disassembly Properties
Use to select the display format of disassembly groups.
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You must have a support package loaded for this page to be active.

If you have more than one disassembler loaded, you can select from all modules that have a
disassembler currently loaded.

You can select which disassembled data to display: Hardware, Software, Control Flow, or Subroutine.
Other display options may be available depending on your support package.

You can highlight lines appropriate for the current selection in the Show list box.

NOTE. The highlight controls are disabled if the Mnemonics column is colored the same as another column.

You can select whether to continue disassembly analysis across storage qualification gaps in the
acquisition data.

Other selections are support package dependent. Refer to your instruction manual for specific selections
and choices.

To display the Disassembly Properties tab from a Listing window, click in the toolbar, and then
click the Disassembly tab.

Hardware Disassembly
Shows bus cycles in the order they were sampled. The disassembler displays certain cycle type
labels in parentheses.

Refer to the support package manual for a list, and definition of, the labels.

Software Disassembly
Shows only executed instructions.

The displayed information resembles assembly language.

Control Flow Disassembly
Shows only calls, exceptions, returns, and branches; which are types of instruction that changes the
flow of control.

Subroutine Disassembly
Shows only the first fetch or subroutine call and return instructions.
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. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Error Message Dialog Box
This dialog box displays error messages, usually in relation to disassembly support and symbol table
loading. The following are attributes of the Error Message dialog box:

Holds up to 100 messages.

The oldest messages are discarded when the message area fills.

The most recent message is at the bottom.

NOTE. Closing the Error Message dialog box discards all messages; minimizing does not.

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Define Suppression Dialog Box
The Define Suppression dialog box defines what module samples will be shown. This dialog box defines
how many samples will be shown for only the data sources in this display.

Related Topic
Sample Suppression
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Show Samples Dialog Box
The Show Samples Dialog Box shows preciously suppressed samples to be shown starting with the
current mouse position.

Show by Samples
Making this selection indicates that the selected number of samples will be shown starting from my
current mouse position within the view.

Show by Mark
Marking this selection causes all samples between the current mouse position and the selected mark to
be shown.

Apply to Mark
Normally the data source pointed to by the mouse pointer is the only source that will be acted on. If this
check box is selected the action will be applied to all data sources in this display.

Related Topic
Sample Suppression
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. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Suppress Samples Dialog Box
The Suppress Samples dialog box suppresses samples from the view.

Suppress the <selection> <number> Samples
Making this selection indicates that the selected number of samples will be suppressed starting from my
current mouse position within the view.

Suppress to Mark <selection>
Marking this selection causes all samples between the current mouse position and the selected mark
to be suppressed.

Apply to all Data Sources in this Data Window
Normally the data source pointed to by the mouse pointer is the only source that will be acted on. If this
check box is selected the action will be applied to all data sources in this display.

Related Topic
Sample Suppression

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Sample Suppression Dialog Box
The Sample Suppression dialog box settings define if any samples are to be suppressed each time new data
is acquired. This dialog box can be accessed from the LA Setup menu.

Changes made to the Sample Suppression dialog box do not take effect until new data is acquired. Once
data is acquired, samples can be further shown or suppressed within any Listing or Waveform window.

Related Topic
Sample Suppression
Waveform Window Information

Waveform Window
Use the Waveform window to display and evaluate acquisition data. You may display both analog
waveforms and digital waveforms. Each window contains a data area, a waveform label, marks, and
several toolbars that allow you to measure and manipulate your waveforms:
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Waveforms
The following waveforms can appear in a waveform display. Click the buttons for more information on
each type of waveform.

Single-Channel LA Waveforms

Multi-Channel Busform LA Waveforms

Multi-Channel Magnitude LA Waveforms

DSO Waveforms

Sample Waveforms

Overlay Waveform

Time Gaps

Waveforms can be dragged and dropped. Click the waveform label and drag it to where you want to
display the waveform. An arrow shows where the waveform will be placed.

Double-click a waveform label to open the Waveform dialog box.

Add waveforms using the Add Waveform toolbar button.

Remove waveforms by selecting the waveform label and clicking the Cut toolbar button. You can paste
the removed waveform below any selected waveform.

To quickly display the waveform from an external oscilloscope, click the iView button.

To display MagniVu waveforms click the MagniVu button. To turn the iView or MagniVu display
off, click the button again.

To display the probe activity in the Waveform window, click the Activity button. Click the button again
to turn the probe activity display off.

To display the value of each channel group at Cursor 1, click the Value button. Click the button again
to turn the value display off.

Marks
Marks are used to make time measurements, locate triggers, and mark specific waveform events for
evaluation.

Marks you can move include Cursor 1, Cursor 2, and any marks you add. The numbers 1 and 2 on the
mark handles denote the cursor marks. Readouts for Cursor 1, Cursor 2, and the time difference (Delta

Time) between the two are located on the Delta Time toolbar. .
You can add any number of delta time toolbars by clicking the Add Delta Time button at the top of

the Waveform window.
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Marks on the top of the window are data area marks. Use moveable data area marks to move within the
data area. You cannot move System Trigger, Module Trigger, or Begin and End marks.

Marks on the bottom of the window are overview marks. These marks show where marks are located
within the entire acquisition. Use moveable overview marks to move throughout the acquisition.
For example, move Cursor 1 to a particular sample as shown in the Cursor 1 readout. Click the Go
To toolbar button and select Cursor 1. You can also use the right mouse button on any overview
mark and click Go To Mark.

Double-click a mark to open the Properties dialog box and display the Marks tab. You can assign a
unique name to the Mark in the Mark Name field.

You can add marks using the Add Mark toolbar button. Remove an added mark by selecting it and
using the Cut toolbar button. When you paste a mark, it appears in the center of the display.

You can go to any mark using the Go To toolbar button.

System trigger The system trigger is the reference point for the acquisition.
Timing and location information is relative to the system
trigger. Trigger marks cannot be moved.

The system trigger associated with the current data is called
the active system trigger. The system trigger associated
with saved data is called the reference system trigger.
The active system trigger is indicated by a yellow T; the
reference system trigger is indicated by a gray T.

The system trigger appears even if no data from the module
that generated the system trigger is around it.

Module trigger The point at which the module triggered. Trigger marks
cannot be moved.

Begin data and end data

and

The start and end of a module’s data record. These data
marks cannot be moved.

Cursors 1 and 2

and

Moveable marks used for visual reference and for data
measurements.

User mark User-created marks. Use marks to make specific data
easier to identify and find.

Data Area
The Data area can be split by dragging the split box from the top of the vertical scroll bar. This allows
you to compare waveforms.

Several situations can cause long periods of time (Time Gaps) to elapse between acquired samples.
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Acquired glitches display directly on the affected waveform. Glitches display as a vertical bar behind
the sample data in the glitch color. Glitches are drawn as if they were behind the waveform. You can
disable the display of glitches and select their color in the Waveform window.

Memory differences and equalities in logic analyzer waveforms are indicated by different colored text
for each trace. Enable data comparison and select the color of highlighted data from the Waveform
window.

Highlighted data shows where there are no differences between the two channels or channel groups
being compared.

NOTE. Define the channels to compare, define a valid data reference, and enable the comparison in the LA Setup
window before acquiring data and viewing differences and equalities.

Related Topics
Waveform Properties

Waveform Labels

Marks Tab

Symbol Tables

Selecting Objects

. . Use the Waveform Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Time Gaps
Several situations can cause long periods of time to elapse between acquired samples:

Qualification gaps in a single LA module record.

Acquisition gaps between the last sample in one data source and the first sample in another data source.

As with any data samples, a horizontal vector is drawn from the last sample before a qualification gap to
the first sample after the gap. If the values of these two samples are different, the transition is drawn at
the sample after the qualification gap.

Qualification gaps within a module are compressed. If there are acquisition gaps when no modules are
acquiring (including reference waveforms), this time is eliminated.

Cursor time values that fall within an acquisition gap are forced to the closest valid display point. If
you place cursors on both sides of an acquisition gap, the displayed delta value is greater than the time
between the two data points.
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Selecting Objects

Selected Objects
You can select waveform labels, navigation marks, and data window regions in a Waveform or Listing
window. Only one of these elements can be selected at one time; however, several waveforms can be
selected as a single element.

For example, you can select three waveforms or a cursor, but you cannot select a waveform and a cursor
at the same time.

Active Objects
There is a distinction between selected and active. While you can only select one element (or set of
waveforms), there are element types for which one item is active at all times.

For example, there is always one active cursor (C1 or C2) and one active waveform. The active waveform
is the top waveform of a selected set of waveforms. Measurements pertain to this waveform.
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Waveforms

Overlay Waveform

Overview
Overlay waveforms provide you with the ability to visually compare two or more waveforms by dragging
one waveform over the other. The overlay waveform can contain LA single-channel, DSO, external,
and clock waveforms.

LA waveforms have a horizontal resolution of one pixel per display point. A displayed point has three
possible states: high, low, or transition. When the sample period and time per division are set so that one
pixel is exactly one sample, every displayed sample is either high or low and may show a transition vector.
When the Time/Div is increased, the instrument stretches out the waveform by padding between the
samples. At slower Time/Divisions, the data is compressed.

Vertical lines or vertical vectors are drawn at high-to-low and low-to-high transitions.

Acquired glitches are displayed directly behind the affected data points. Glitches are displayed as a vertical
line in the glitch color. Glitches are drawn as if they were behind the waveform. You can disable the display
of glitches using the Waveform Window tab, which is located in the Waveform Properties dialog box.

Behavior
For DSO and external waveforms, each horizontal, pixel-wide time slice has either a point or a vertical
line to represent the vertical value of the acquired data sample. If the time per division is fast enough that
each display point represents one or fewer acquired points, the vertical value is represented by a point.
If the time per division is slower and multiple acquired data samples need to be represented within a
pixel width, the vertical value is represented by a vertical line whose length and offset are determined
by the acquired data values.
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When the time per division is decreased, waveforms are horizontally expanded, using (sine x)/x
interpolation to create display points between acquired sample points. A vertical value is calculated for
every horizontal time point between the acquired data points.

To Use
You can select whether to display range readouts for the selected waveform, to display all DSO and
external waveforms range readouts, or to not display range readouts at all. You can also select the readout
color. For each waveform, two readouts display the maximum and minimum vertical input voltage
settings. The readouts may contain symbols indicating AC or Ground coupling, 50 Ohms input impedance,
and the bandwidth limit. The ground line is indicated as a horizontal dotted line. The trigger threshold
is indicated with a T and an up arrow if the threshold is above the maximum voltage or a down arrow
if the threshold is below the minimum voltage.

Waveform size is dependent on the signal size and the input voltage range set in the DSO setup window.
The entire input voltage range is used to set the default minimum and maximum values of the vertical
range. Set the vertical range values from the Waveform Properties dialog box by clicking the Waveform
tab, and then clicking the Options button.

To display no more than one data sample per display point, add a sample waveform from the same data
source and decrease the time per division until you can see individual clock tick marks.

Related Topics
Creating an Overlay Waveform

Removing Waveforms from an Overlay Waveform

Waveform Properties

Sample Waveforms
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Overlay Waveform Properties

Overview
The Waveform tab displays overlay waveform properties when you double-click the label of an overlay
waveform in the Waveform list box. The following graphic displays the resulting content of the Waveform
tab.
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Behavior
The following are properties associated with overlay waveforms:

Overlay Waveform Name: permits you to rename overlay waveforms.

Waveforms Available lists all of the individual waveforms and overlay waveforms. You can move and
copy waveforms in this list to the Overlay Waveforms list using the Move and Copy buttons. You can
also remove buttons from the Overlay Waveforms list and return them to the Waveforms Available
list using the button.

Overlay Waveforms lists the waveforms currently in the selected overlay waveform group. You can
move and copy waveforms from the Waveforms Available list to this list using the Move and Copy
buttons, respectively. You can also remove waveforms from the Overlay Waveforms list and return
them to the Waveforms Available list using the button.

To Use
To change waveform properties, from the System window click a Waveform window icon, double-click
the label of a waveform, and then click the Waveform tab.

Related Topics
Waveform Properties

Individual Waveform Properties

Individual Waveform Properties within an Overlay Waveform

Waveform Window Properties

Color Settings

Waveform Options
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Measurement Setup

. . Waveforms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Setting the Overlay Waveform Offset
1. In the System window, click the Waveform window icon.

2. Double-click the desired waveform label to display the Waveform Properties dialog box, and then
click the Waveform tab.

3. Set the desired pixel value in the Offset list box and click the Apply button.

NOTE. Offset can only be specified for waveforms that are members of an overlay waveform.

Alternate Method
1. In the System window, click the Waveform window icon.

2. Highlight the desired waveform label.

3. Use the vertical scroll bar to set the waveform offset.
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Individual Waveform Properties

Overview
The Waveform tab displays individual waveform properties when you double-click the label of a single
waveform in the Waveform list box. The following graphic displays the resulting content of the Waveform
tab.
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Behavior
The following are properties associated with individual waveforms:

Source. displays the data source of the selected waveform. The source file (or current system), module
name, and channel information are displayed. Depending upon the way the channels were originally
added, the information will be a group-based channel name (for example, Address (31-0)), a single
channel name, or a probe-based name (A2-4, A3(7-0)). If the module is a secondary module of a
merged pair, an S is prepended to probe-based names. If the module is part of a three-way merge, S and
S2 are prepended to probe-based names. If the module is part of a five-way merge, S, S2, S3 and S4 are
prepended to probe-based names. No text is displayed for multiple waveform selections.

Color. permits the selection of either a fixed waveform color or a waveform color that is the same
as another waveform, which is designed to promote comparison of waveforms. If you are selecting a
fixed color, you can select a color from the list. Select the color scheme using the Waveform window
tab. Select the colors of each color scheme by clicking Options from the System menu and then
clicking the Color tab.

Radix. controls the radix for LA group data displayed as busform or cursor value readouts. Radix is
only enabled when a single LA group waveform is selected. Set the default radix by clicking Options
from the System menu and then clicking the Defaults tab.

Show Waveform. temporarily hides a waveform without deleting it. This check box determines if the
waveform is visible in the data window. If a waveform is not visible, you cannot search for it.

Use Polarity. enables the display of waveform channel polarity as defined in the Setup window. This
check box is only enabled for LA waveforms.
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Readouts. determines whether waveform readouts are displayed and their color. Readout options only
display for logic analyzer, DSO and external waveform channels.

Measurements. displays the user defined measurement selections for DSO waveforms. Click the
Measurement Setup button to modify the list of selected measurements.

To Use
To change waveform properties from the System window, click a Waveform window icon, double-click
the label of a waveform, and then click the Waveform tab.

Related Topics
Waveform Properties

Overlay Waveform Properties

Individual Waveform Properties within an Overlay Waveform

Waveform Window Properties

Color Settings

Waveform Options

Measurement Setup
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Individual Waveform Properties within an Overlay Waveform

Overview
The Waveform tab displays the properties of an individual waveform within an overlay waveform, when
you double-click the label of a waveform, from within an overlay waveform, in the Waveform list box.
The following graphic displays the resulting content of the Waveform tab.
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Behavior
The following are properties associated with individual waveforms within an overlay waveform:

Offset. allows you to visually compare two or more waveforms by specifying their vertical position in
the Waveform window.

Source. displays the data source of the selected waveform. The source file (or current system), module
name, and channel information are displayed. Depending upon the way the channels were originally
added, the information will be a group-based channel name (for example, Address (31-0)), a single
channel name, or a probe-based name (A2-4, A3(7-0)). If the module is a secondary module of a
merged pair, an S is prepended to probe-based names. If the module is part of a three-way merge, S and
S2 are prepended to probe-based names. No text is displayed for multiple waveform selections.

Color. permits the selection of either a fixed waveform color or a waveform color that is the same
as another waveform, which is designed to promote comparison of waveforms. If you are selecting a
fixed color, you can select a color from the list. Select the color scheme using the Waveform window
tab. Select the colors of each color scheme by clicking Options from the System menu and then
clicking the Color tab.

Radix. controls the radix for LA group data displayed as busform or cursor value readouts. Radix is
only enabled when a single LA group waveform is selected. Set the default radix by clicking Options
from the System menu and then clicking the Defaults tab.

Show Waveform. check box determines if the waveform is visible in the data window. If a waveform
is not visible, you cannot search for it. Use this box to temporarily hide a waveform without deleting it.

Use Polarity. check box enables the display of waveform channel polarity as defined in the Setup
window. This check box is only enabled for LA waveforms.

Readouts. determines whether waveform readouts are displayed, as well as their color. When selected,
the Show readouts when selected check box allows waveform readouts to display only when the
associated waveform label is highlighted. Note that Readout Options only displays for logic analyzer,
DSO and external waveform channels.
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Measurements. displays the user defined measurement selections for DSO waveforms. Click the
Measurement Setup button to modify the list of selected measurements.

To Use
To change waveform properties, from the System window click a Waveform window icon, double-click
the label of a waveform, and then click the Waveform tab.

Related Topics
Waveform Properties

Individual Waveform Properties

Overlay Waveform Properties

Waveform Window Properties

Color Settings

Waveform Options

Measurement setup
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Multi-Channel Busform LA Waveforms
Busform waveforms can contain group value readouts. If the width between transitions is sufficient, a
value is displayed. If the width is not sufficient, no readout is shown in that segment. The readout is
displayed in the selected radix.

Acquired glitches are displayed directly behind the affected waveform. Glitches are displayed as vertical
lines in the glitch color. Glitches are drawn as if they were behind the waveform and any readouts. You
can disable the display of glitches using the Waveform Window tab, which is located in the Waveform
Properties dialog box.

TIP. To display no more than one data sample per display point, add a sample waveform from the same data source
and decrease the time per division until you can see individual clock tick marks.

Waveform height is set from the Waveform tab, which is located in the Waveform Properties dialog box.

Waveforms can be displayed with user defined foreground and background colors by setting up the
busform to use a TSF symbol table with color.

Related Topic
Sample Waveforms
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Multi-Channel Magnitude LA Waveforms

Overview
In Magnitude mode, the vertical placement of a data point in waveforms represents the numeric value of
the channel group. By default, the possible range of values (determined by the group channel width) is
scaled to the selected waveform size.

Behavior
When the time per division is decreased, waveforms are horizontally expanded, using linear interpolation
to create display points between the acquired sample points. A vertical value is calculated for every
horizontal time point between the acquired data points.

When the time per division is increased, waveforms are horizontally compressed and decimated. The
minimum and maximum values are used as the endpoints of the vertical line that represents the data values
for that time point. The cursor readout displays the value of the top endpoint.

If you compress the waveform, the minimum and maximum values at each display point are displayed to
create a vertical line at each horizontal data point.

To Use
You can change the waveform minimum and maximum values by accessing the Waveform tab, located
in the Waveform Properties dialog box, and clicking the Options button. You can also select the radix
used in cursor measurements.

TIP. To display no more than one data sample per display point, add a sample waveform from the same data source
and decrease the time per division until you can see individual clock tick marks.

Waveform height is set in the Waveform tab of the Waveform Properties dialog box.

Waveforms can be displayed with user defined foreground and background colors by setting up the
busform to use a TSF symbol table with color.

Related Topic
Sample Waveforms
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Sample Waveforms
You can select sample waveforms in the Add Waveform dialog box. Each module has its own sample
waveform. A sample waveform consists of a row of short vertical marks on the time axis at each display
point that represents an actual acquired sample for the module.

When the display is expanded, points without a sample are empty. When the display is compressed, the
sample waveform looks like a thick horizontal line.

Two time stamp values are displayed at the edges of the sample waveform.

If the sample waveform is the active waveform, the Measurement Bar readouts are empty.

The waveform size is fixed.
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Single-Channel LA Waveforms
Single-channel LA waveforms have a horizontal resolution of one pixel per displayed point. A displayed
point has three possible states: high, low, or transition. When the sample period and time per division are
set so that one pixel is exactly one sample, every displayed sample is either high or low and may show a
transition vector. When the Time/Div is decreased, the instrument stretches out the waveform by padding
between the samples. At slower Time/Divisions, the data is compressed.

For example, if the time per division is set so that two acquired samples must be represented in each
horizontal pixel width and both of the acquired samples in a pixel are high, the displayed sample is high. If
both samples are low, the displayed sample is low. If the two acquired samples are a high and a low, in
either order, the display will be a vertical line representing both samples. At even slower time per division
settings, more acquired samples are represented by each displayed point.

Vertical lines or vertical vectors are drawn at high-to-low and low-to-high transitions.

Acquired glitches are displayed directly behind the affected data points. Glitches are displayed as a vertical
line in the glitch color. Glitches are drawn as if they were behind the waveform. You can disable the display
of glitches using the Waveform Window tab, which is located in the Waveform Properties dialog box.

TIP. To display no more than one data sample per display point, add a sample waveform from the same data source
and decrease the time per division until you can see individual clock tick marks.

Waveform height is set from the Waveform tab, which is located in the Waveform Properties dialog box.

Waveforms can be displayed with user defined foreground and background colors by selecting "Color Same
As" on a LA busform waveform, and then setting up the busform to use a TSF symbol table with color.

Related Topic
Sample Waveforms
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Waveform Labels

Overview
Waveform labels serve as handles to mark the waveform location and name of each waveform. The label
allows you to adjust the position and other properties of waveforms.

The waveform name is the logic analyzer group or channel name, the oscilloscope channel name, or the
name for a special waveform type. The name is prepended with the module name when there are multiple
modules, the waveform is included as part of a waveform overlay, and with the file name of the data source
file if the waveform is a reference waveform. If the name will not fit in the label, characters on the left,
which are the most likely to be redundant, are clipped until the name fits in the label.

To Use
You can select and drag one or more waveform labels. When you drag a label, a drop marker indicates
where the label will be dropped. If there are waveforms beyond the top or bottom edge of the data area,
dragging a label past that boundary will scroll the display.

You can change the width of the label area by dragging the border between the label area and the data
area. You can change the height of a label by clicking and dragging its bottom edge. Double-clicking a
waveform label opens the Properties dialog box and displays the Waveform tab, which contains the
settings for that waveform.
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Waveform Options
Waveform Options allows you to set waveform characteristics that are specific to a waveform type.

Waveform Limits sets the minimum and maximum values that will be displayed in the selected waveform.

Behavior
Max Value sets the maximum value displayed in the waveform.

Min Value sets the minimum value displayed in the waveform.

For DSO waveforms, Lock to Setup determines if the Max and Min values are reset when the DSO
setup parameters are changed. When checked, the values are reset to the maximum and minimum
values possible with the current range and offset settings. Checked is the default.

For LA group waveforms, Lock to Setup determines the minimum and maximum values based on
the number of channels in the group. When not checked, you can specify a subset range of the
group min and max.

LA Waveform Style selects the style of displayed LA data. These controls are disabled unless a single LA
group waveform is selected.

Busform displays LA group data as a bus form.

Magnitude displays LA group data as a graph display (Magnitude mode).

Signed data selects whether acquisition data is interpreted as signed or unsigned. Signed data is only
active for magnitude style LA waveforms.

Draw Interpolation inserts vectors between data points, thereby approximating a magnitude waveform.

To Use
To change waveform options from the System window, click a waveform data window icon, double-click a
waveform label, click the Waveform tab, and then click the Options button.

Related Topics
Setting Waveform Options

Setting the Waveform Style

Setting the Waveform Limits
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Histogram Window Information

Histogram Window

Overview
Use the Histogram window to set up, capture, and display performance analysis data from an LA module
channel group, counter, or timer. Each Histogram window displays address ranges and the corresponding
counts, percentages, and histogram bars based on the defined ranges and selected data source.

Before you can acquire and display histogram data, you must first set up the LA module using the LA
Setup and LA Trigger windows. Use the Setup window to set up the channel groups, clocking, and
memory requirements. Use the Trigger window to set up a trigger program, counters, and timers. You
should configure the Setup window before the Trigger window, because some of the Setup window
settings affect Trigger window selections.

Use the New Data Window wizard to create a Histogram window for the first time.

Statistics
The Histogram statistics provide an overview of the data.

The number of displayed lines depends on the data source. Statistics for a channel group use only one
line. Statistics for counters or timers use two lines.

The Percentages Based On list shows the number of data samples depending on whether you select
All Samples or Matched Samples.

If the data source is a counter or timer, the second line lists the minimum, maximum, and average
values of the counter or timer.

Header Control
Use to resize columns, sort ranges, and specify the magnification value for the histogram bars.

Resize columns by dragging and dropping the column separators in the Histogram Header Control.

NOTE. Dragging a column separator behind another column separator may hide a column.

When ranges are displayed as symbols, you can sort the ranges by ascending or descending alphabetical
order by clicking the Range heading.

When ranges are displayed as bounds, you can sort the ranges by increasing or decreasing lower
bounds by clicking on the Range heading.

Click the Count heading or the Percentage heading (%) to sort between increasing and decreasing
counts.

Change the magnification or the histogram bars by clicking on the bar heading and selecting a new
value from the displayed list.
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Data Area
Displays ranges, counts, percentages, and histogram bars.

You can resize the data area by turning the toolbar and the statistics on or off.

You can split the Histogram window horizontally by dragging the split box from the top of the vertical
scroll bar.

All ranges are displayed in columns. When ranges are used as a timer, the bounds include a time
unit suffix.

A clip indicator (<) in a text column indicates that only part of the row can be displayed. To view the
entire row, you can resize the column by dragging the column header.

Counts, percentages, and histogram bars are updated as new data becomes available.

You can sort ranges, counts, and percentages by clicking on the column headers.

Changing the ranges in the Histogram Properties updates the new ranges with zero counts.

Related Topics
Creating a New Histogram Window

Defining Histogram Ranges

Data Source Property Page

Histogram Range Properties

Histogram Window Properties

All Samples
The total number of samples analyzed that matched a define range and all samples that fell outside
of the defined ranges.

Matched Samples
The total number of samples analyzed that matched a defined range. These samples exclude any
samples outside of the defined ranges.
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Histogram Window Properties

Overview
Use the Histogram Window properties tab to change and view the properties of the Histogram window.

Behavior
Range Labels control the labels in the Range column in the data area. When the ranges are defined
from a symbol file, select Symbols or Bounds. The Symbols selection is unavailable when the ranges
are not defined in a symbol file. There is no limit to the number of symbolic ranges for histogram data.

Data Fonts Size selects the size of the data in the Histogram data area. You can change the data font
size as necessary to view the data.

Radix determines the format of range labels when Range Labels is set to Bounds. The Radix is only
present when the data source is a channel group or a counter.

Background selects the color of the data area background.

Foreground selects the color of the text in the data area.

Bar color selects the color of the histogram bars.

Selecting a different color scheme resets the colors shown. Color schemes are defined in the Colors
page of the Options property sheet.

Data is accumulated until you clear the data.

You can analyze live data or saved data.

You can use up to 32 bits of data in an address group.

You can enable or disable channel group polarity.

NOTE. Default colors are set in the Defaults page of the Applications Options property sheet, available from the
System menu.

To Use
To display the Histogram Window properties, open a Histogram window, right-click the window and select

Properties, or click (the Property toolbar button), and then click the Histogram Window tab.
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Data Source Properties

Overview
Use the Data Source properties tab to display information about the current data source or to select a new
data source for the Histogram window.

Behavior
If you change the channel groups in the Setup window or if you change counters or timers in the Trigger
window, the histogram data source may become invalid. The data analysis will stop until you define a new
data source or until you restore the current data source.

The Use Polarity box controls whether or not channel polarities are applied to the group data.

Changing the histogram data source generates new range definitions; existing counts are lost.

To Use

To display the Data Source properties, open a Histogram window, click (the Property toolbar button),
and then click the Data Source tab.

Select the LA module from the drop-down list. (If the data source is not included in the drop-down list,
click Add Data Source to add data from a saved setup.

Click either the Group or Counter/Timer buttons to use for the histogram data. The name of the data is
displayed in the drop-down list next to the buttons. The button selections are active when valid data is
available based on the channel groups and trigger setups.

Histogram Data Source
A histogram data source consists of histogram data from an LA module. The data can be from a
valid channel group or from a counter or a timer defined in the Trigger window. DSO modules and
MagniVu data are not allowed as data sources for Histogram windows.

Histogram Group
A group can consist of a single data channel or up to 32 data channels. Channel groups are defined in
the LA Setup window.
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Ranges Properties

Overview
Use the Ranges properties tab to define the data ranges for the Histogram window. To define ranges, you
must already have specified a data source for the Histogram window.

Behavior
The Default Ranges button creates default histogram ranges based on the data source.

The Define Ranges Using list specifies how the ranges will be defined: Linear Generation, Log
Generation, or Symbolic.

The Symbol File button opens the Load Symbol File dialog box to load a range symbol file when using
symbolic range generation. Use the Symbol File list to select one of the loaded symbol files.

The Number of Ranges specifies the number of ranges available with Linear Generation or Log
Generation. When used with Linear Generation, the number or ranges can be changed. The Bound1
and Bound2 controls determine the maximum number of ranges.

The Radix controls the format of the Bound1 and Bound2 controls. In Log Generation, the Radix also
controls how ranges are generated. Changing the radix also changes the display radix in the Histogram
Window properties tab. The Radix control is not present when the data source is a timer.

The Bound1 and Bound2 controls limit the overall boundaries or size of the ranges. The limits depend
on the data source. When used with a symbol file the bounds are limited by the smallest and largest
symbol file boundaries. When used with linear or log generation, the lowest bound is 0 and the highest
bound is limited by the data source size.

The Range Size shows the size of a single range when used with Linear Generation.

Use Time Units to format the timer values.

To Use

To display the Ranges properties, open a Histogram window, click (the Property toolbar button), and
then click the Data Ranges tab.

Related Topics
Defining Histogram Ranges

Load Symbols Options Dialog Box
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Linear Generation
The histogram ranges are evenly distributed from the highest range boundary to the lowest range
boundary.

Log Generation
The histogram ranges are distributed over a logarithmic scale.

Symbolic Range Generation
The histogram ranges are defined in a range symbol file. The highest and lowest ranges depend on the
maximum and minimum boundaries for the ranges defined in the symbol file.
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Histogram Scale Dialog Box
Use this dialog box to change the scale (magnification) of the histogram bars for the current Histogram
window. You can change the scale factor from the Histogram window or from this dialog box.

To open the Histogram Scale dialog box from the Histogram window, go to the View menu and click Scale.
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Histogram Add Counts Dialog Box
Use this dialog box to add data from an LA module or from a saved setup. Select the data from a module
in the displayed list, or click Add Data Source to add data from a saved setup. Select a channel group, a
counter, or a timer from the group list.

To open the Histogram Add Counts dialog box from the Histogram window, go to the Data menu and
then click Add Counts.
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Export Histogram Dialog Box
Use this dialog box to export Histogram window information to a file. Specify the export file path and the
rows of the histogram information. The exported data will be saved in the specified format. The dialog box
uses any export options specified in the Export Histogram Options Dialog Box.

To open the Export Histogram dialog box from the Histogram window, go to the File menu and then
click Export Histogram.

Related Topics
Exporting Histogram Data

Export Histogram Options Dialog Box
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Export Histogram Options Dialog Box
Use this dialog box to customize the export histogram operation. You can specify file formatting options
and how to export the bounds. You can select the label button if you want to export the bounds as a string
("00-FF") or click the numbers button to export the bounds as two delimited numbers. You can also
include headings with the exported data.

To open the Export Histogram Options dialog box from the Histogram window, click Export Histogram
from the File menu, and then click the Options button.
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Histogram Tasks

Measuring Histogram Data

Overview
There are two basic ways of using the Histogram window to analyze data. One is to provide a graphic
overview of the address activity of software execution. The other is to use counters or timers to measure
specific events.

If you want to use counters or timers to measure events, you must set up the counters or timers in the Trigger
window. You can then select the data source in the New Data Window wizard when you create a Histogram
window or select the source from the Data Source properties tab for an existing Histogram window.

Viewing Address Activity
To provide an overview of the address activity of a software routine, define a set of ranges (numeric,
logarithmic, or symbolic). Then you can set up the Trigger window to look for data within the defined
ranges. The data is processed and displayed in the Histogram window for the current acquisition.

If you set up the logic analyzer to repetitively acquire data, the sampling errors will decrease over time
as you acquire more data. The resultant data provides a stable display in the Histogram window where
you can view the overall activity of the software.

You can use this method of analyzing data to determine which sections of code are being accessed or not
accessed. You can also determine the time spent in a routine relative to other areas of code.

Measuring Counter or Timer Events
To measure an event, define a starting point, a target event, a counter or a timer, and a stopping point in
the Trigger window. Use the Data Source properties tab to select the counter or timer as the data source
for your analysis. When you acquire data, the Histogram window displays the minimum, maximum,
and average value of the counter or timer data.

Related Topics
Defining Histogram Ranges

Selecting the Histogram Data Source
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Sorting Histogram Data
1. In the System window, click the Histogram data window icon.

2. If the ranges are defined as symbols, click the Range header to toggle the sort between increasing
and decreasing alphanumeric values.

3. If the ranges are defined as bounds, click the Range header to toggle the sort between increasing
and decreasing bounds.

4. Click the Count header or the Percentage header to toggle the sort between increasing and decreasing
counts or percentages.
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Defining Histogram Ranges
1. In the System window, click the Histogram data window icon.

2. From the Edit menu, click Properties.

3. Click the Ranges tab in the Properties dialog box.

4. From the Define Ranges Using list, click Linear Generation, Log Generation, or Symbols.

5. If using Symbols, select a symbol file.

6. Select a radix.

7. Specify the bounds.

8. Click OK.

TIP. Define the data source before you define the ranges.

Click to open the Properties dialog box.

Click Default Ranges to return to the default range settings.
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Selecting the Histogram Data Source
1. In the System window, click the Histogram data window icon.

2. From the Edit menu, click Properties.

3. Click the Data Source tab in the Properties dialog box.

4. Select the new data source from the list or click Add Data Source to add data from a saved data source.

5. Select the channel group or a Counter/Timer source if defined in the Trigger window.

6. Click OK.

TIP. Click to open the Properties dialog box.

Set up the channel groups in the LA Setup window and the counters or timers in the LA Trigger window
before you select a histogram data source.
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Resetting Histogram Data
1. In the System window, click the Histogram data window icon.

2. From the Data menu, click Clear Counts.

TIP. Click in the Histogram window toolbar to clear all counts and to reset all accumulated ranges and
percentages.
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Displaying Information About the Histogram Window
1. In the System window, click the Histogram data window icon.

2. From the Edit menu, click Properties.

3. Click the About Data tab.

TIP. Click in the Histogram window.
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Halting Histogram Analysis
1. In the System window, click the Histogram data window icon.

2. From the Data menu, click Stop Analyzing.

TIP. Click in the Histogram window toolbar to stop histogram analysis.

Source Window Information

Source Window

Overview
The Source window displays source code that you wrote, correlated with the executed (disassembled)
code acquired by the logic analyzer and displayed in the Listing window. You can monitor actual code
execution and correlate it directly with your source code statements. The logic analyzer links the Source
and Listing windows, and provides additional tools to help you view the code and data.

Behavior
The Listing window displays an execution trace of the object code derived from the source files. The
relationship between the acquisition data and the specific source is determined by examining the debug
information stored in the executable file that was created by code creation tools such as compilers, linkers
and loaders. The specific file being displayed, the cursor positions, and user-defined marks in the file are
automatically updated as you use the controls in the Source window and the associated Listing window.

The source statements in each of the source files displayed in the Source window have associated address
ranges that define the memory locations occupied by the microprocessor instructions that implement the
statement. The address ranges determine the mapping from samples in the Listing window to statements in
the Source window. The address ranges must be absolute. The Source window does not support code that
is dynamically relocatable. The address group that you use depends on whether you use a disassembler.
The disassemblers typically set up address groups for the specific support package.

Because Source windows interact with associated Listing windows, you may want to display both windows
at the same time. Moving the cursors in the Source window moves the cursors in the associated Listing
window, and moving the cursors in the Listing window moves the cursors in the Source window.

Source Window Structure
The Source window consists of three main components; the Source toolbar, the Source control bar and
the Source data area.

The Source toolbar provides access for tools to change the appearance of the data area and to search
for data. A Scan Listing field specifies the search direction in the Listing window when you move the
cursors in the Source window.
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The Source control bar provides means for stepping through data, stepping between marks, and
scrolling through data. These controls directly affect the active cursor in the associated Listing window
and indirectly affect the active cursor in the Source window.

The source data area displays the contents of the source file. This area is also used to display diagnostic
messages if the Source window is unable to display a source file. When the window displays a source
file, the header displays the path of the file.

Marks and Cursors
Marks and cursors identify specific statements in source files. Marks consist of horizontal lines and may
include highlighted blocks of text signifying individual source statements.

Marks you can move are: Cursor 1, Cursor 2, and any marks you add. The numbers 1 and 2 on the
mark handles denote the cursor marks. Readouts for Cursor 1 and Cursor 2 are located at the top of the
window. The numbers in the readouts indicate the line number position of the cursor in the source file.

Only one of the two cursors is active at a time. An active cursor appears as a solid horizontal line; an
inactive cursor appears as a dashed line.

Marks on the left side of the window are data area marks. These marks are in the part of the source file
that is currently visible in the window. Use data area marks to move within the data area.

Marks on the right side are overview marks. These marks show where marks are located within the
entire source file. Use overview marks to move throughout the source file.

Marks are only visible in the currently displayed source file. Marks and cursors in other source files
are not shown in the overview area.

Double clicking a mark opens the Marks properties tab. You can assign a unique name to the Mark in
the Mark Name field.

You can add marks using the Add Mark toolbar button. Remove a mark by selecting it and using the
Cut toolbar button. When you add or paste a mark it appears in the center of the display.

You can add a mark at a specific source statement by right-clicking the source statement and then
selecting Add Mark Here from the context menu. If the line in the source window contains multiple
source statements, you can add marks to the individual statements.

You can move to any mark, including those is other source files, by using the Go To toolbar button.

Marks are saved in the Source window with system setups so they can be made available for use
when you load a saved system.

Cursors 1 and 2

and

Moveable marks used for visual reference and for data
measurements.

User mark User-created marks. Use marks to make specific data
easier to identify and find.
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Related Topics
Listing Window

Moving Through Source Files

Symbol Files

Symbols Dialog Box
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Moving Through Source Files

Overview
You can move through source files from the Source window or from the Listing window. Moving
a cursor in one window will cause the corresponding cursor to move to a corresponding location in
the other window.

Use the Step Forward or the Step Backward buttons to step through source statements in execution order in
the Source window. You can also use the Next Mark or the Previous Mark buttons to jump to the next
or previous executed source statement that has a user-defined mark.

Use the cursor controls in either window to move the cursors. You can also move the cursors in either
window by clicking and dragging the cursor handles or by adjusting the cursor list box controls.

For more information on moving the cursors, click one of the buttons below.

Source-Relative Cursor Positioning

Listing-Relative Cursor Positioning

Behavior
There are situations when you move the cursor in the Listing window to a location where there is no
corresponding source statement. The cursor in the Source window remains at the current location and
changes the color of the Source window to signify an uncorrelated state exists between the Source and
Listing windows. When this happens click the Step Forward or the Step Backward buttons to search for an
executable source line in the Listing window; this correlates the active cursors in both windows.

Clicking the Step Forward or Step Backward buttons forces the Listing window to search for a data sample
that corresponds to the next or previous line of executed source code. The line of executed code may be
in a different source file. If this happens, the Source window will display the required file or prompt
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you for a path name. The ability to locate source files depends on the Search Path List and Suffix List
defined in the Source Files properties tab.

Related Topics
Step Forward and Step Backward Buttons

Next Mark and Previous Mark Buttons

Active Cursor Readout

Source Files Properties

Uncorrelated State
The Source window enters an uncorrelated state when the active Source window cursor is moved to a
statement that was not executed and captured in the acquisition memory. An uncorrelated state also
occurs when the active Listing window cursor is moved to a sample with an address for which there is
no corresponding symbol information in the loaded symbol file.

When the Source window becomes uncorrelated, the window displays text in a different color:
the uncorrelated color. You can change the color of the uncorrelated state in the Source Window
properties tab.

To return the Source window to a correlated state, click the Step Forward or the Step Backward
button in the Source window.
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Step Forward and Step Backward Buttons

Overview
Use the Step Forward and Step Backward Buttons to trace the order of execution of source statements.
Click the Step Forward button to move to the next executed source statement. Click the Step Backward
button to move to the previous executed source statement.

Behavior
When you click the Step Forward or Step Backward buttons, the Source window tells the Listing window
to search forward or backward beginning at the active Listing cursor for the next or previous executed
source statement. When a match is found, the Listing window positions the active Listing cursor to the
matching sample. The Source window converts the address from that sample to a file name and line
number, and then updates the active Source cursor position to the corresponding source statement. The
statement may be located in a source file that is different than the original displayed file. In this case, the
new file is displayed and the cursor is placed on the proper statement.

A single line in the Source window may consist of more than one statement on a single line, for example:

for ( i=0; i < NUM_STATES; i++ )

The ability of the Source window to discriminate between multiple statements on the same line depends
on the amount of information provided by the code-generation tools. If there is enough information to
identify multiple statements per line, the Source window cursors will include character highlighting to
identify individual statements on a line.

Related Topics
Moving Through Source Files

Next Mark and Previous Mark Buttons
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Next Mark and Previous Mark Buttons

Overview
Use the Next Mark and Previous Mark buttons to move the active cursor in the Source window to the next
or previous user-defined mark position (if any marks have been defined). Next and previous refer to the
execution sequence and not to the position of the mark in the window.

Behavior
The Next Mark and Previous Mark buttons operate similarly to the Step Forward and Step Backward
buttons. However, rather than stepping through every executed statement, you can define marks in the
Source window as breakpoints and then step between marks in execution order to move though the source
code. You can use the Next Mark and the Previous Mark buttons to get around loops or acquired code
that you are not interested in viewing.

When you click the Next Mark or Previous Mark buttons, the Source window tells the Listing window
to search for addresses corresponding to the marked source statements. When a corresponding sample
is found, the Listing window positions it’s active cursor to the matching sample. The Source window
converts the address to a file name and line number, updates the active Source cursor position, and then
displays the corresponding source statement.

If the code generation tools provide column information for symbol files, you can mark individual
statements of multiple statement lines in the source code. You can then use the Next Mark and Previous
Mark buttons to step between the marks and highlight the individual statements.

The Next Mark and Previous Mark buttons are not active if there are no marks defined in the Source
window.

Related Topics
Moving Through Source Files

Step Forward and Step Backward Buttons
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Active Cursor Readout

Overview
The Source window Active cursor readout displays the address of the source statement at the active
cursor. The address shown is the low address bound of the source statement as indicated by the loaded
symbol file, not the value of the address group in the listing window. The radix of the address is always
hexadecimal. If you position the cursor on a nonexecutable statement, such as a comment or white space,
the address of the next executable statement is displayed.

Behavior
You can also use the Active cursor readout to jump to a new location in the source file. Enter an address in
this field and the active cursor moves to the corresponding statement. If you enter an address that does not
correspond directly to the address of a source statement, the next statement is used and the address adjusted.

You can copy and paste the readout value into other locations such as in the event portion of the Clause
Definition dialog in the LA Trigger window.
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Source Files Edit Dialog Box

Overview
The Source window uses a single file name to locate the source files. Use the Source Files Edit dialog box
to specify a list of paths to the locations of source files in the file system. You can also specify a list of
source file suffix entries in the Source Files properties tab.

Behavior
The appearance of the dialog box depends on which option (Search Path List or Suffix List) is selected
in the Source Files properties tab. If the Search Path List is selected, the title of the dialog box displays
Modify Search Path List; if the Suffix List is selected, the title of the dialog box displays Modify Suffix
List. The selection box is blank if you clicked Add to access the dialog. If you clicked Edit to access the
dialog, the selection contains the highlighted entry from the Source Files properties tab.
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To Use
When you enter the dialog box to add or edit the search path, you can enter a path in the Selection field.
Often the source files will be located on a networked drive. You can click Browse to specify a search path
to the networked drive or to any other directory in the file system.

When specifying the search path, you can use an asterisk (*) as the final component of a search path
directory.

For example, to specify the following path:

C:\MySources\*

The MySources directory and all directories (one-level deep) within MySources will be searched.
However, you cannot use the asterisk as a general-purpose wild card character.

For example, the use of an asterisk in the following is invalid:

C:\MySources\*\*

or

C:\MySources\abc*

NOTE. When you specify a search path or file suffix, make sure that the source file you are looking for has a unique
file name or file suffix. When searching for source files it is possible to load the wrong file if there is another file with
the same name and suffix in the directories specified by the search path. The Source window loads the first file
that matches the search criteria.

To open the Source Files Edit dialog box from a Source window, click the Properties toolbar button, click
Source Files, and then click either Add or Edit.

Related Topic
Source Files Properties
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Source Go To Dialog Box
Use the Source Go To dialog box to move in the source code. Double-click a cursor or mark from the
displayed list to go to the mark in the Source window.

To open this dialog box, open a Source window and click .
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Scan Listing Direction Dialog Box
Use the Scan Listing Direction dialog box to specify the direction to search for samples in the associated
Listing window. This dialog box displays when the Scan Listing field in the Source window is set to Ask
and you move the cursor in the Source window by dragging the cursor, adjusting the cursor line number,
or doing a search.

Click << Earlier to search for samples from the present active Listing cursor position towards the beginning
of data. Click Later >> to search forward from the active Listing cursor.

Related Topic
Scan Listing Mode
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Source Window Search Dialog Box

Overview
Use the Source Window Search dialog box to search for text patterns in the current file or in all source files
identified by the loaded symbol file.

Behavior
When searching for data in multiple files, the search operation follows the order of files as listed in the
Source Window properties tab in the Displayed Source File list. When you search for data in all files and
one or more of the files cannot be found, the Source File Locator dialog box displays asking you to
specify the file location.

If the search is not completed in a set amount of time, the Search Progress dialog box displays the status
of the search operation. You can allow the search to continue or you can click the Abort button to halt
the search.

To Use

To open the Source Window Search dialog box, open a Source window and click .

Enter an ASCII value in the pattern field and click the search direction. The search string can include
leading and embedded white space. Trailing white space is ignored.

Related Topic
Source Window Properties
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Source File Locator Dialog Box
The Source File Locator dialog box appears when a source file cannot be located. This may happen
under the following conditions:

When you first attempt to create a new Source window

When you move the active cursor in either the Source window or the Listing window

When you do a text search

When you select a different source file while in the Source Window properties tab

This dialog box appears when the Source window searches for source files and is unable to find the files as
specified in the Search Path List and Suffix Lists specified in the Source Files properties tab.

You must specify the path of the source file or click Browse to select a path.

In some cases, there may not be an available source file to load. If this happens, you can provide an empty
placeholder file to prevent the Source File Locator dialog box from appearing.

TIP. When specifying the search path use an asterisk (*) as the final component of a search path directory. For
example, if you specify the following path:

C:\MySources\*

The MySources directory and all directories (one-level deep) within MySources will be searched.
However, you cannot use the asterisk as a general-purpose wild card character, and the wild card character
may only be used as the last character in the search string. For example, the use of an asterisk is invalid
in the following:

C:\MySources\*\*

or

C:\MySources\abc*

NOTE. The wild card character may only be used in the source path, and only as the last character in the search string.

Related Topics
Source Files Properties

Source Files Edit Dialog Box
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Source Window Properties

Overview
Use the Source Window properties tab to change the appearance and content of the Source window.

Behavior
Display Line Numbers turns line numbers on or off. Turn the line numbers off if you need more
room to display the source file.

Font Size selects the size of the displayed text and the line numbers.

Tab Spacing specifies the spacing between tab columns.

NOTE. You may need to adjust the tab spacing if the highlighting is incorrect. Use the same tab spacing values
as in the editor that you used to create the source files. If you are unsure of the actual setting, you may need to
experiment with tab settings until the highlighting is correct.

Foreground Color specifies the color of displayed text and line numbers.

Background Color specifies the color for the data area background.

Uncorrelated Color specifies the color of the text in the Source window when the active cursor position
in the Source window does not correlate to the active cursor position in the Listing window.

Color Scheme sets the colors shown in the Source window. The color scheme can be user-defined
colors, as specified in the Color tab. Access the Color tab by selecting Options from the System menu.

Displayed Source File lists the source file currently displayed in the Source window. To view the entire
path name of the source file, click the About Data tab. The path name also appears in the source code
column header in the Source window.

To Use

To open the Source Window properties tab, open a Source window and click in the toolbar.

TIP. You can also double-click the header in the data area to open the Source Window properties tab.
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Source Files Properties

Overview
Use the Source Files properties tab to define the location of source files in the file system.

The Source Files properties tab lists the directories to search for the source files in the file system. It also
lists the file suffixes to try attaching to the file names provided by the compiler (used for compilers that
do not include the source file suffix).

Behavior
The Source window uses the file path and file suffix in combination to locate the correct source file. It
searches for the file name in each directory indicated by the file path list in the order specified. If a
file name does not have a suffix, then suffixes from the suffix list are tried until a match is found or all
file path and suffix combinations are exhausted.

Select Search Path List to specify source file locations; select Suffix List to specify possible file suffixes.

Click Add to add items.

Click Edit to edit the selected items.

Click Delete to delete a selected entry from the list.

Check the box at the bottom of the Source Files properties tab to save the file paths and suffixes
as defaults.

When specifying the search path, you can use an asterisk (*) as the final component of a search path
directory.

For example, if you specify the following path:

C:\MySources\*

The MySources directory and all directories (one-level deep) within MySources will be searched.

However, you cannot use the asterisk as a general-purpose wild card character.

For example, the use of an asterisk is invalid in the following:

C:\MySources\*\*

or

C:\MySources\abc*

You must specify the complete absolute (not relative) path name for the file in the Search Path List.
Otherwise the Source window will not locate the source file. Make sure that the source file you are looking
for has a unique file name. When searching for source files it is possible to load the wrong file if there is
another file with the same name in the directories specified by the search path. The Source window always
loads the first file that matches the search criteria.
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The format of the file path information can take the form of a file path, a file path list file, or both. Each
entry is prefaced with either Path: or Path File: to indicate which type of information it contains. For
example:

Path: C:\Program Files\TLA700\Samples\Source Files

Path File: C:\My Documents\filePathList.txt

Note that the file path list can contain numerous file paths, which are searched according to the order in
which the paths appear in the file. In addition, both file paths and file path lists can be listed in the Source
Files tab of the Properties dialog box. In this case, the paths will be searched according to the position of
the entry in the Source Files tab, and according to the order in which the paths appear in the file path list file.

NOTE. When using file path list files to define the location of source files in the file system, either DOS or UNIX end
of line controls are acceptable.

Because some compilers do not include a source file suffix, you may also need to specify the correct file
suffixes in the file suffix list (examples of correct file suffixes are: .c .cpp , and .s). The Source window
always loads the first file that matches the criteria in the file suffix list.

The logic analyzer searches for files using both lists from top to bottom. Therefore, you should place the
most likely search path and file suffix at the beginning of the lists.

To Use

To view the Source Files properties, open a Source window, click in the toolbar, and click the
Source Files tab.

NOTE. The wild card character may only be used in the source path, and only as the last character in the search string.

Related Topics
Source Files Edit Dialog Box

System Source Files Properties
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Source Window Data Properties

Overview
Use the Data properties tab to specify Source window attributes. You can specify the Listing window, data
source group (Listing window column), and symbol file.

Behavior
When working with disassembled data, the quality of a disassembler ’s fetch prediction and queue tracking
will determine the quality of the source correlation. You should consider using Mark Opcode to fix
any disassembly problems across gaps.

TIP. Load your microprocessor support package and set the Listing window disassembly mode to Software before
you create the Source window. The software disassembly mode filters out non-instruction cycles to make it easier to
view and trace data in the Listing window.

To Use
Select a Listing window from the list of all currently available Listing windows containing data.

Select a data source from the selections based on the Listing window. The data source can be data from
an installed module or from a saved data file.

Select a column (data group) from the selected data source. In most cases, you will want to select a
microprocessor address column. Timestamp columns, Sample columns, and channel groups without
assigned data channels are not available as data groups for this purpose.

Select a symbol file that contains the source code symbols from a list of all loaded symbol files. Valid
symbol files include those that correspond to the data group column (when used with a symbolic
radix). The symbol file can be the executable file that has been compiled and linked for debug or a
TSF format file.

If the symbol file has not yet been loaded, click Symbol File to browse and load a symbol file.

To view the Source window Data properties, open a Source window, click in the toolbar, and click
the Data tab.

Related Topic
Tektronix Symbol File Format (TSF)
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Source Window Marks Properties
Use the Marks properties tab to format marks in the Source window. You can also enter comments for
any marks that you have added. Changing a mark in the Source window does not affect the marks in the
Listing window.

To view the Source window Marks properties, open a Source window, click in the toolbar, and click
the Marks tab.

TIP. You can also open this property page by double-clicking a mark in a Source window.

. . Histogram Tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Source-Relative Cursor Positioning

Overview
Source-relative cursor positioning refers to updating the Listing window cursor position as a result of
changing the position of the active cursor in the Source window.

Behavior
When you move the Source window active cursor to a new statement, the Source window determines
the address range of the source statement based on information from the loaded symbol file. The Source
window uses the Scan Listing mode setting to determine the search direction in the Listing window.

The Listing window searches the acquisition data for a matching address. When the matching address is
found, the active cursor in the Listing window is moved to the matching sample. If the Source window
cursor is moved to a nonexecutable statement, such as a comment, the address of the next executable
statement is used.

To Use
You can move the Source window cursor directly in the Source window using the following methods:

Clicking or dragging the cursor handles

Using the cursor list box controls

Entering an address in the Active Cursor Readout

Right-clicking the mouse and selecting Move Cursor 1 (or 2) Here

Doing a search
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Listing-Relative Cursor Positioning

Overview
Listing-relative cursor positioning refers to updating the Source window cursor position as a result of
changing the position of the active cursor in the Listing window.

Behavior
When you move the Listing window cursor to a new sample, the active Source window cursor attempts to
move to a corresponding source statement in the Source window. The Source window uses information
from the loaded symbol file to convert the address of the Listing cursor position to a source file name and
statement (line number) location. The Source window then updates the active Source window cursor
position and displays the corresponding source statement.

To Use
You can move the Listing window cursor using the following methods:

Clicking the Next Mark or Previous Mark buttons in the Source window

Clicking the Step Forward or Step Backward buttons in the Source window

Directly by using the controls in the Listing window

Indirectly by locking cursors to another Listing or Waveform window
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Source Window Tasks

Displaying Information About the Source Window
1. In the System window, click the Source data window icon.

2. From the Edit menu, click Properties.

3. Click the About Data tab.

TIP. Click in the Source window.

Related Topic
Creating a New Source Window
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Tracing the Execution of Source Code
1. In the System window, click the Source data window icon.

2. Click (Step Forward) or (Step Backward) to move the cursor to the next or previous
executed statement.

3. The cursors in the Source window, and in the associated Listing window, will advance to the next or
previous executed source code statement.

Related Topic
Creating a New Source Window
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Getting Out of a Loop in a Source Window
This procedure assumes that you have a Source window and a Listing window open.

1. In the Source window, locate the code for the loop.

2. Position the cursor on an executable statement outside of the loop.

3. Right-click the mouse and click either Move Cursor 1 Here or Move Cursor 2 Here (depending on
which cursor is active).
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Setting a Trigger from Source Window Data
This procedure assumes that you have a Source window and a Listing window open.

1. In the Source window, position a cursor on the statement of interest so that the address displays in
the Active Cursor Readout.

2. Select the address in the Active Cursor Readout by double-clicking the left mouse button.

3. Copy the address to the clipboard by selecting Copy Text from the Edit menu, or by typing the
CTRL+C key combination.

4. Open the Trigger window for the LA module.

5. Click the If-Then button to open the Clause Definition dialog box.

6. Click Group and paste the address into the group value field by selecting Paste Text from the File menu
or by typing the CTRL+V key combination. The radix for the group value must be set to Hex.

7. Click OK.

When you start the acquisition, the logic analyzer will be set to trigger on the group address.
Packet Structure Definition Language (PSDL)

Packet Structure Description Language

Overview
Packet Structure Description Language or PSDL is used for describing and creating protocols. It is based
on the Abstract Syntax Notation One (ASN.1). A complete description of the syntax and notation used can
be found in the International Telecommunication Union X.680 document. For a high level overview on
PSDL syntax and notation, select one of the related topics.

Use PSDL to define packet structures in the Protocol Editor pane of the Protocol Designer Window.
The PSDL files have the .spz protocol file suffixes. For more information on PSDL, click on one of
the links below.
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Syntax

Overview
You can use PSDL to edit standard protocols or create your own. The symbols and conventions used in the
PSDL are described in the related topics. PSDL uses Abstract Syntax Notation One (ASN.1).

An ASN.1 item consists of a sequence of characters listed in the ASN.1 Character table.
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General rules for ASN.1 items are as follows:

PSDL is case sensitive.

Most items appear on a single line and do not contain white space.

Line length is unrestricted.

Items in production sequences may appear on more than one line.

Items in production sequences may be separated by white space, empty lines, or comments.

Items must be separated from each other by white space, newline, or comment if the following item
begins with a character that is allowed in the preceding item.

For information on the following syntactical items, click one of the related topics.

Related Topics
ASN.1 Types

Length and Value Expressions

Packet Structure
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PSDL Additions to ASN.1

PSDL Types

Tags

Miscellaneous Commands

Type Definitions

Value Definitions
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Packet Structure Definition
PacketDef: DescrList PacketTypeDef TypeValueDefList

DescrList: empty

| Descr DescrList

Descr: DESCRIPTION "::=" cstring

BIT_ORDER "::=" BitDecodeOrder

| DECODING_RULES "::=" EncRules

EncRules: BER

| BASIC_PER_ALIGNED

| BASIC_PER_UNALIGNED

PacketTypeDef: PACKET "::=" typereference
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Operators
The assignment operator (::=) defines a type reference (assigning a name to a type definition):

TypeRefName ::= Type

Type can be another type reference or a basic type (such as BYTE_HEX, BIT_BIN, or
PSDL_SEQUENCE).

The semantic of a type reference is that it can be replaced by its definition. For example, given

TypeRef1 ::= BIT_DEC { LENGTH(4) }

TypeRef2 ::= BYTE_DEC { LENGTH(2) }

TypeRef3 ::= PSDL_SEQUENCE {

field1 TypeRef1,
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field2 TypeRef1,

field3 TypeRef2

}

Packet ::= TypeRef3

The definition of the Packet is equivalent to:

Packet ::= PSDL_SEQUENCE {

field1 BIT_DEC { LENGTH(4) },

field2 BIT_DEC { LENGTH(4) },

field3 BYTE_DEC { LENGTH(2) }

}

NOTE. In the above statements, field1, field2, field3 are the field names of three components that constitute the
Packet Structure.

===============================================================

The field name is required if the value of a field is to be used in the LENGTH expressions of other fields,
for example:

PSDL_SEQUENCE {

length BYTE_DEC{ LENGTH(2) } "Length Field",

data BYTE_HEX { LENGTH(length - 2) } "Data Field"

}

It is a good idea to always specify an internal name. It can be omitted, because the standard ASN.1 syntax
allows it to be omitted.

===============================================================

The expression syntax of LENGTH expressions is:

Expr: "(" Expr ")"

| Expr "+" Expr

| Expr "-" Expr

| Expr "*" Expr

| Expr "/" Expr

| Expr "%" Expr

| number

| identifier
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| PACKET_LENGTH

| REST_LENGTH

| ALIGN "(" Expr ")"

The "identifier" refers to a field name, PACKET_LENGTH is the total length of the frame,
REST_LENGTH is the length of the not yet decoded frame, and BYTE_HEX { LENGTH(ALIGN(4)) }
tells the decoder to make the field long enough so that it ends on a four byte boundary (for bit strings, the
alignment is counted in bits).

================================================================

The VALUE expression tells the encoder how to compute the value of a field. For example,

PSDL_SEQUENCE {

dat_len BYTE_DEC { LENGTH(2) } VALUE(LENGTH(data)),

data BYTE_HEX { LENGTH(dat_len) } USER_DATA

}

This specifies that the value of ’dat_len’ is the length of the data field. Because you are in a decoding only
environment, you will never have to deal with VALUE expressions.
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Control Statements
The syntax for a PSDL tag is as follows:

PsdlTag: ’[’ Offset ’,’ TagVal ’]’ or

’[’ ABSOLUTE Offset ’,’ TagVal ’]’

Offset: decimal_value

TagVal: binary_value or hex_value

The units for the offset are bits for binary_value and bytes for hex_value.

The offset is relative to the point in the packet data stream that has to be decoded next, unless ABSOLUTE
is specified, which means relative to the start of the frame. Offsets can be negative, therefore it is possible
to match bits before the point in the packet data stream that will be decoded next. The following example
shows PSDL_CHOICE statements:

IpContents ::= PSDL_CHOICE {

[50 ABSOLUTE, ’00000000000000’B] user_data BYTE_HEX { LENGTH(total_length -

(ihl * 4)) } USER_DATA "Data",

[50 ABSOLUTE, ’x’B] frag_data BYTE_HEX { LENGTH(total_length - (ihl * 4)) }

"Fragment Data"

}

In the above structure, if bits 50 through 63 (counting from 0) relative to the start of the frame are all zeros,
then user_data is selected, otherwise frag_data is selected.

The PSDL_CHOICE statement can be used like an If-Else statement. You cannot refer to fields directly in
PSDL_CHOICEs. In other words, you cannot use field names here.

You can avoid a given number of bytes or bits in a packet being decoded by skipping the bytes or bits in
the packet data stream.

To skip bits or bytes, use the key word NODISPLAY. NODISPLAY means that the field is not shown in
the monitor window. It can be used as follows:

BIT_BIN { NODISPLAY LENGTH(3) }

This skips three bits from the point in the packet data stream that was already decoded, and continues
decoding.

BYTE_HEX { NODISPLAY LENGTH(1) }

This skips one byte from the point in the packet data stream that was already decoded and continues
decoding.
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Loop Statements
You can decode fields with loop statements using the UNTIL (’xxxx’H) statement. You can have up to
4 bytes within the UNTIL statement.

Phrase::=BYTE_ASCII { UNTIL(’0D0A’H) }

This statement tells the compiler to start decoding the packet data from hexadecimal bytes to ASCII
characters until it sees the data ‘0x0D’ immediately followed by ‘0x0A’.

Use the UNTIL statement in PSDL octet/bit strings instead of the LENGTH expression. The UNTIL
statement specifies that the field extends up to the point where the UNTIL pattern matches. The following
example shows a field that extends up to (and includes) the next CR/LF.

BYTE_ASCII { UNTIL(’0D0A’H) }

The UNTIL statement can also be used for PSDL_SETs to specify where the set ends. The following
example shows a set of ElemType fields that end at the first null byte (not part of the set).

PSDL_SET UNTIL(’00’H) { [0, ’xx’H] set_elem ElemType }

This can be mixed with a LENGTH expression. For example:

PSDL_SET OF LENGTH(10) UNTIL(’00’H) { ... }

This means the set ends either after 10 octets or if a null byte is encountered, whichever happens first.

The UNTIL statement can also be used with a PSDL_SET statement as

HeadSet ::= PSDL_SET UNTIL(’0D0A’H)

{

[0, ’xx’H] param_line ParamLine

}

ParamLine::=BYTE_ASCII { UNTIL(’0D0A’H) }

The above statement sets a loop for the ‘ParamLine’ field type, which continues until the packet data
equals ‘0x0D’ immediately followed by ‘0x0A’.
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Sample PSDL Program
The following sample program and its explanation are intended to give you a high-level overview of a
protocol definition file in PSDL.

For the purposes of this example, assume that the Packet A structure below has two header fields, Address
and Length, followed by the Information field.

Address Length Information
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1 byte 2 bytes variable length (rest of frame)

The protocol definition file is shown below.

====================================================

DESCRIPTION::= "Packet A"

DECODING_RULES::=BER

PACKET::= PacketA

PacketA::= PSDL_SEQUENCE {

address Address "Pkt_Address",

length Length "Pkt_Length ",

info Information " Pkt_Information "

}

Address::= BYTE_HEX{LENGTH(1)}

Length::= BYTE_HEX{LENGTH(2)}

Information::= BYTE_HEX {LENGTH(REST_LENGTH)}

====================================================

Packet Description
The DESCRIPTION is assigned to the packet description string that specifies the protocol name whose
definition is written and other details such as: RFC details, Standard details, or Version details. The
description string appears with the protocol filename in various "Protocol Designer" dialog boxes (Open
Protocol dialog, Save Protocol dialog). Refer to Packet Structure Definition below for information
on specifying the description.

Decoding Rules
This is an optional field. The DECODING_RULESis assigned to the type of decoding rules. Refer to
Packet Structure Definition below for information on specifying the description.

Packet Structure Definition
Consider the following line of code:

PACKET::= PacketA

This statement specifies which type in the type definition list defines the packet structure. If this statement
is omitted, the first type definition is considered to be the packet type (in this example the PACKET
statement can be omitted).
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Consider the next few lines of code:

PacketA::= PSDL_SEQUENCE {

address Address "Pkt_Address",

length Length "Pkt_Length",

info Information "Pkt_Information"

}

In the preceding code, the PacketA structure is defined as having the following three fields: "address",
"length", "info". The address field is of type "Address" with field label "Pkt_Address". Similarly, the
length field is of type Length with field label "Pkt_Length" and the info field is of type "Information"
with the field label "Pkt_Information".

For more information, refer to Protocol Stack, SPZ Files, Packet Structure Overview.

Related Topic
Defining a Protocol
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Type Definitions

Type Definitions
TypeValueDefList:

TypeValueDef

| TypeDefList TypeValueDef

TypeValueDef: TypeDef

| ValueDef

TypeDef: typereference "::=" AsPhType

| DefaultTag

DefaultTag: EXPLICIT TAGS

| IMPLICIT TAGS

| AUTOMATIC TAGS

AsPhType: AsTag AsType Open UserData

| PhType Open UserData

CompTypeList: CompType

| CompTypeList "," CompType

CompType: NamedType

| NamedType OPTIONAL
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| NamedType DEFAULT Value

| COMPONENTS OF SubType

AltTypeList: AltType

| AltTypeList "," AltType

AltType: NamedType

NamedType: PhTag OptIdentifier SubType AttributeList

OptIdentifier: identifier

| empty

SubType: AsPhType

OptSizeConstraint:

Constraint

| SizeConstraint

| empty

Type References

Name

The name used for type references is typereference.

Rules

A type reference consists of one or more letters, numbers, and hyphens.

The first character must be upper case and a hyphen cannot be used as the last character.

Identifiers

Name

The name used for identifiers is identifier.

Rules

An identifier consists of any number of letters, digits, or hyphens.

The initial character is upper case.

A hyphen cannot be the last character nor be followed by another hyphen.
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Empty Item

Name

The name used for empty items is empty.

Rules

Contains no characters
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ASN.1 Types
AsType: AsSequence

| AsSequenceOf

| AsChoice

| AsSet

| AsSetOf

| AsAnyDefbyCase

| AsEllipsis

| AsTerminal

OptConstraintList

| typereference

OptConstraintList

AsSequence: SEQUENCE "{" CompTypeList "}"

AsSequenceOf: SEQUENCE OptSizeConstraint OF

OptIdentifier SubType AttributeList

AsSet: SET "{" CompTypeList "}"

AsSetOf: SET OptSizeConstraint OF

OptIdentifier SubType AttributeList

AsChoice: CHOICE MsgChoiceInd "{" AltTypeList "}"

OptConstraintList:

empty

| OptConstraintList Constraint

AsTerminal: BOOLEAN
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| OCTET STRING

| REAL

| AsInt

| AsEnum

| AsBitStr

| NullType

| ANY DefinedBy

| OBJECT IDENTIFIER

| NumericString

| PrintableString

| TeletexString

| VideotexString

| VisibleString

| IA5String

| GraphicString

| GeneralString

| BMPString

| UniversalString

| UTF8String

AsInt: INTEGER "{" NumberList "}"

| INTEGER

AsEnum: ENUMERATED "{" EnumNumberList "}"

AsBitStr: BIT STRING "{" NamedBitList "}"

| BIT STRING

EnumNumberList: NamedEnumNumber

| EnumNumberList "," NamedEnumNumber

NamedEnumNumber: identifier EnumNumber

| "..."

EnumNumber: "(" IntVal ")"

| empty

NumberList: NamedNumber
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| NumberList "," NamedNumber

NamedNumber: identifier NamedNumberVal

NamedNumberVal: "(" SignedNumber ")"

| empty

NamedBitList: NamedBit

| NamedBitList "," NamedBit

NamedBit: identifier "("number ")"

DefinedBy: DEFINED BY identifier

| empty

AsEllipsis: "..."

NullType: NULL

Type: BuiltinType

| ConstrainedType

BuiltinType: NullType

ConstrainedType: Type Constraint

Constraint: "(" ConstraintSpec ExceptionSpec ")"

ConstraintSpec: SubtypeConstraint

ExceptionSpec: "!" ExceptionIdentification

| empty

ExceptionIdentification:

SignedNumber

SubtypeConstraint:

ElementSetSpecs

ElementSetSpecs: RootElementSetSpec

| RootElementSetSpec "," "..."

| "..." "," AdditionalElementSetSpec

| RootElementSetSpec "," "..." ","

AdditionalElementSetSpec

RootElementSetSpec:

ElementSetSpec

AdditionalElementSetSpec:
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ElementSetSpec

ElementSetSpec:

Unions

Unions: Intersections

| UElems UnionMark Intersections

UElems: Unions

Intersections: IntersectionElements

| IElems IntersectionMark IntersectionElements

IElems: Intersections

IntersectionElements:

Elements

Elems: Elements

UnionMark: "|"

| UNION

IntersectionMark: "^"

| INTERSECTION

Elements: SubtypeElements

| "(" ElementSetSpec ")"

SubtypeElements: SingleValue

| ValueRange

| PermittedAlphabet

| SizeConstraint

Includes: | empty

ValueRange: LowerEndpoint ".." UpperEndpoint

LowerEndpoint: LowerEndValue

| LowerEndValue "<"

UpperEndpoint: UpperEndValue

| "<" UpperEndValue

LowerEndValue: Value

| MIN

UpperEndValue: Value
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| MAX

SizeConstraint: SIZE Constraint

PermittedAlphabet:

FROM Constraint

SingleTypeConstraint:

Constraint

ValueConstraint: Constraint

| empty

PresenceConstraint:

| empty

SingleValue: Value

Value: BuiltinValue

| ReferencedValue

BuiltinValue: IntegerValue

| BooleanValue

| CharacterStringValue

IntegerValue: SignedNumber

| identifier

BooleanValue: TRUE

| FALSE

CharacterStringValue:

RestrictedCharacterStringValue

RestrictedCharacterStringValue:

cstring

SignedNumber: number

| "-" number

ReferencedValue:

DefinedValue
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Character String Item

Name

The name used for character string items is cstring.

Rules

A cstring consists of any number of graphic symbols and spacing characters.

A cstring may span more than one line of text.

White spaces that appear immediately before or after the end of the cstring have no significance.

Control characters cannot be represented in a cstring.

Number Item

Name

The name used for number items is number.

Rules

A number consists of one or more digits.

The first digit cannot be zero unless the number item is a single digit.
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PSDL Additions to ASN.1
AsAnyDefbyCase: ANY DEFINED BY identifier CASE "{" OptCaseList "}"

OptCaseList: CaseList

| empty

CaseList: CaseElement

| CaseList CaseElement

CaseElement: IdentOrNum EN TRY SubType

| AsEllipsis

IdentOrNum: identifier

| number
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PSDL Types
PhType: PhSequence

| PhChoice

| PhSetLenCnt

| PhSetUntil

| PhTerminal OptConstraintList

PhSequence: PSDL_SEQUENCE "{" CompTypeList "}"

PhChoice: PSDL_CHOICE MsgChoiceInd "{" AltTypeList "}"

PhSetLenCnt: PSDL_SET OF LengthCount "(" Expr ")" OptUntil

MsgChoiceInd "{" CompTypeList "}"

OptUntil: empty

| UNTIL "(" EndTag ")"

LengthCount: LENGTH

| COUNT

PhSetUntil: PSDL_SET UNTIL "(" EndTag ")" "{" CompTypeList "}"

PhTerminal: MAC_ADR

| IP_ADR

| IPV6_ADR

| SPC

| SLS

| CIC

| BCD_STRING "{" Decod LengthSpec "}"

| BYTE_HEX "{" Offset Decod LengthUntilSpec CommSpec "}"

| BYTE_BIN "{" Offset Decod LengthUntilSpec CommSpec "}"

| BYTE_DEC "{" Reverse Offset Decod LengthUntilSpec CommSpec "}"

| BYTE_SDEC "{" Reverse Offset Decod LengthUntilSpec CommSpec "}"

| BIT_HEX "{" Decod LengthSpec CommSpec "}"

| BIT_BIN "{" Decod LengthSpec CommSpec "}"

| BIT_DEC "{" Reverse Decod LengthSpec CommSpec "}"

| SESSION_LI "{" Decod "}"
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| ASN1_TAG "{" Decod "}"

| ASN1_LI "{" Decod CommSpec "}"

| BYTE_ASCII "{" Offset Decod LengthUntilSpec CommSpec "}"

| BYTE_EBCDIC "{" Offset Decod LengthUntilSpec CommSpec "}"

| BREAK_LAYER

Offset: empty

| RELATIVE TO END

Decod: empty

| NONDISPLAY

| NONDEC

| BitDecodeOrder

Reverse: empty

| REVERSE

LengthUntilSpec: LengthSpec

| UNTIL "(" EndTag ")"

LengthSpec: LENGTH "(" Expr ")"

Val: hstring

| bstring

| number

| SignedNumber

| cstring

CommSpec: empty

| COMMENT "(" cstring ")"

| COMMENT "(" CommList "," cstring ")"

| COMMENT "(" CommList ")"

CommList: Comment

| CommList "," Comment

Comment: "[" Val "]" cstring
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Hexadecimal String Item

Name

The name used for hexadecimal string items is hstring.

Rules

An hstring consists of any number of the following characters: A B C D E F 0 1 2 3 4 5 6 7 8 9,
preceded by a single quote and followed by ‘H.

White space and newlines are allowed, but within an hstring have no significance.

Binary String Item

Name

The name used for binary string items is bstring.

Rules

A bstring consists of any number of zeros or ones, preceded by a single quote and followed by ‘B.

White space and newlines are allowed within a bstring, but have no significance.
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Value Definitions
ValueDef: identifier ValueNotation

ValueNotation: INTEGER "::=" number

| OCTET STRING "::=" hstring

| VisibleString "::=" cstring

| OBJECT IDENTIFIER "::=" "{" ObjIdCompList "}"

ObjIdCompList: ObjIdComp

| ObjIdCompList ObjIdComp

ObjIdComp: identifier Rest

| number

Rest: empty

| "(" NumOrId ")"

NumOrId: number

| identifier
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Length and Value Expressions
Expr: "(" Expr ")"

| Expr "+" Expr

| Expr "–"

| Expr "*" Expr

| Expr "/" Expr

| Expr "%" Expr

| number

| identifier must not contain "-"

| PACKET_LENGTH

| REST_LENGTH

| ALIGN "(" Expr ")"
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Tags
PhTag: "[" TagOffset TagVal "]"

| "[" TagOffset ABSOLUTE TagVal "]"

| empty

TagOffset: IntVal

TagVal: hstring

| bstring

AsTag: empty

| "[" Class number "]" ImplExpl

Class: empty

| UNIVERSAL

| APPLICATION

| PRIVATE

ImplExpl: empty

| IMPLICIT

| EXPLICIT

EndTag: hstring

| bstring
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Miscellaneous Commands
AttributeList: empty

| Attribute AttributeList

Attribute: ShortName

| ShortName "/" LongName

| PROTECTED

| MULTIPLE

ShortName: cstring

LongName: cstring

IntVal: Sign UnsignedIntVal

UnsignedIntVal: number

BitDecodeOrder: MSBF

| LSBF

MsgChoiceInd: empty

| MSG

Sign: "+"

| "–"

| empty

Open: empty

| OPEN

UserData: empty

| USER_DATA

| USER_DATA "(" identifier ")"
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Reserved Words

Reserved Words (Ab to Con)
This topic is a list of reserved words for PSDL. This list represents reserved character sequences. White
space does not occur in these sequences.

ABSENT ABSOLUTE ALIGN
ANY APPLICATION ASN1_LI
ASN1_TAG AUTOMATIC BASIC_PER_ALIGNED
BASIC_PER_UNALIGNED BCD_STRING BER
BIT BIT_BIN BIT_DEC
BIT_HEX BIT_LENGTH BIT_ORDER
BMPString BOOLEAN BREAK_LAYER
BY BYTE_ASCII BYTE_BIN
BYTE_DEC BYTE_EBCDIC BYTE_HEX
BYTE_LENGTH BYTE_SDEC CANONICAL_PER_ALIGNED
CANONICAL_PER_UNALIGNED CASE CER
CHOICE CIC COMMENT
COMPONENT COMPONENTS CONDITIONAL

. . Reserved Words . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Reserved Words (Cou to Max)
This topic is a list of reserved words for PSDL. This list represents reserved character sequences. White
space does not occur in these sequences.

COUNT DECODING_RULES DEFAULT
DEFINED DER DESCRIPTION
DISP_GROUP ENCODING_RULES END
ENTRY ENUMERATED EXCEPT
EXPLICIT FALSE FRAME_BEGIN
FRAME_END FROM GENERIC_TYPE
GROUP GeneralString GraphicString
IA5String INDENTIFIER IGNORE
IMPLICIT INCLUDES INTEGER
INTERSECTION IP_ADR IPV6_ADR
ISO646String LENGTH LSBF
MAC_ADR MANDATORY MAX

371



Packet Structure Definition Language (PSDL) Reserved Words (Min to Ta)
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Reserved Words (Min to Ta)
This topic is a list of reserved words for PSDL. This list represents reserved character sequences. White
space does not occur in these sequences.

MIN MSBF MSG
MULTIPLE NODISPLAY DONDEC
NUL NumericString OBJECT
OCTET OF OPEN
OPTIONAL OVERLAY PACKET
PACKET_LENGTH POS PRESENT
PRIVATE PROTECTED PSDL_CHOICE
PSDL_SEQUENCE PSDL_SET PrintableString
RANGE REAL RELATIVE
REST_LENGTH REVERSE SEQUENCE
SESSION_LI SET SIZE
SLS SPC STATION
STRING T61String TAGS
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Reserved Words (To to Wi)
This topic is a list of reserved words for PSDL. This list represents reserved character sequences. White
space does not occur in these sequences.

TO TRUE TeletexString
UNION UNIVERSAL UniversatString
UNTIL USER_DATA USER_PART_ID
UTF8String VALUE VideotexString
VisibleString WIDTH

372



Packet Structure Definition Language (PSDL) Lexical Items

. . Reserved Words . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Lexical Items

Overview
In addition to reserved words there are other lexical items used in PSDL. The conventions and syntax
regarding their usage vary based on the item. Click the name for details on each item.

Lexical Item Name
Type references typereference
Identifier identifier
Value references valuereference
Module references modulereference
Empty item empty
Number item number
Character string item cstring
Binary string item bstring
Hexadecimal string item hstring

Module References

Name

The name used for module reference items is modulereference.

Rules

A module reference consists of one or more letters, numbers, and hyphens.

The first character must be upper case and a hyphen cannot be used as the last character.

A module reference is distinguished from a type reference by the context in which it is used

Value References

Name

The name used for value reference items is valuereference.

Rules

A value reference consists of any number of letters, digits, or hyphens and is distinguished from
an identifier by the context in which it is used.
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Protocol Stack and Packet Structures

Protocol Stack, SPZ Files, Packet Structure Overview
The PSDL programming is similar to ASN.1 programming that defines a protocol definition. The protocol
file has the .spz file extension.

Prerequisites
To write protocol files, you need to be familiar with the following concepts:

The protocol stack definition to which the packet structure maps; the stack definition should follow
the packet structure.

The packet structure that encapsulates the protocols of higher layers

Knowledge of all fields of the protocols mentioned in the stack and the relation between protocols

Protocol Stacks
A protocol stack is made up of protocols at different layers. The most common four layers in a network
stack are:

Link Layer

Network Layer

Transport Layer

Application Layer

Stacks are defined using the protocol layers. Each layer (box) is a protocol. There can be many protocols
in a given layer. For example, transport layer protocols are TCP and UDP, and link layer protocols are
PPP and Ethernet.
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Differences Between Link Layer Packets and Packets at Higher Layers
A link layer packet structure maps an entire protocol stack. The link layer packet header contains the
network layer packet headers. The network layer packets contain the transport layer packet header and the
application header and data.

Other packets (above Link layer) map a part of the stack. For example, a PPP packet is a link layer
protocol that maps the entire stack, and a TCP packet is a transport layer protocol that maps a part of the
stack file (TCP->Telnet, TCP->FTP).

What is Defining a Protocol?
Defining a protocol means writing the protocol packet header definition using PSDL. Each protocol file
in the stack has the .spz extension. For example, a PPP protocol file definition consists of the following
PPP header fields: Flag, Address, Control, and Protocol. Similarly, an Ethernet protocol file definition
consists of the following header fields: SFD, Destination, Source, and Type/Length. A TCP protocol file
definition consists of TCP header fields.

Defining a Protocol Structure
Use a top-down approach to define the packet structure. Note all of the possible packet formats that map
the stack. For example, consider the stack in the last illustration.

The possible packet formats of PPP frames are shown below (the square brackets refer to a packet header
that contains another packet):

PPP [ IP [ UDP [ HTTP ] ] ]. In this example, PPP encapsulates an IP header, which in turn encapsulates
a UDP header. The UDP header encapsulates HTTP.

PPP [ IP [ UDP [ SNMP ] ] ]

PPP[ IP [ TCP [ FTP ] ] ]

PPP[ IP [ TCP [ TELNET ] ] ]

PPP[ IP [ UDP [ DNS ] ] ]

PPP[ IP [ UDP [ RIP ] ] ]

Start defining the protocol by writing the .spz file in the Protocol Editor.

Related Topic
Defining a Protocol

. . Protocol Stack and Packet Structures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Defining a Protocol
Use the following guidelines to define a protocol:
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Describe the protocol
Normally, this will be a single string assigned to the DESCRIPTION keyword using the following syntax:

DESCRIPTION::=<string>

For example:

DESCRIPTION::="IP – Internet Protocol, RFC791"

Specify the Decoding Rules
In the next few lines, specify the decoding rule using the DECODING_RULES keyword.

DECODING_RULES ::= <rule name>

The rule name can be one of the following: BER, DER, CER, BASIC_PER_ALIGNED,
BASIC_PER_UNALIGNED, CANONICAL_PER_ALIGNED, or CANONICAL_PER_UNALIGNED.

For example:

DECODING_RULES ::= BER

Consider the following stack definition:

Protocol4

Protocol3

Protocol2

MyProtocol

The bottom-most layer is MyProtocol. A MyProtocol packet encapsulates higher layer protocols in the
data field (the packet header consisting of Protocol2, Protocol3, and Protocol4).

You can start writing a protocol definition for MyProtocol using PSDL.

DESCRIPTION::="IP – Internet Protocol, RFC791"

DECODING_RULES ::= BER

Hand the Length of the Protocol Packet to the Protocol Layer
To hand the length of the MyProtocol packet to the MyProtocol layer, use the following syntax:

PACKET ::= PSDL_SEQUENCE OF LENGTH "("PACKET_LENGTH")" "{"PacketName"}"

You must specify the PacketName. It can be the protocol name with a Packet suffix (for example,
HTTP_Packet, or IP_Packet). The following example uses MyProtocol_Packet as the PacketName:

PACKET ::= PSDL_SEQUENCE OF LENGTH ( PACKET_LENGTH ) { MyProtocol_Packet }

Further Define the Packet Using PSDL Structures
Continue defining the packet using the following syntax:
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PacketName ::= PSDL_SEQUENCE

"{"

<field name> <type name> <field label>

"}"

The <field name> variable is a user-defined string starting in lower case letters. This variable is optional
and is used to improve the readability of the specification.

The <type name> variable is a user-defined string for the field type and begins with an upper-case letter.

The <field label> variable is an optional user-defined string (normally the packet field name) that will be
displayed in the field column of the decode view.

For example:

MyProtocol_Packet ::= PSDL_SEQUENCE

{

field1 Field1 "Field1",

length Length "Length",

address Address "Address",

type Type "Type",

payload Payload "Payload"

}

In the example above, MyProtocol_Packet is a structure with five components. The first component
is called field1 (starts with a lower-case letter) and denotes the data type field Field1 (starts with an
upper-case letter). The second component is called length and denotes the data type field Field1. Here
the packet decoder takes the data bytes from the packet at the beginning of the packet and relates them
to the defined MyProtocol structure. It takes the first byte at the beginning of the packet, relates it to
Field1, the next byte to Length, the next two bytes to Address, and the following nibble to Type. It then
assigns the remaining items to Payload.

Specify the Type and Size of Each Field
Specify the type and size of each field as shown below:

Field1 ::= BYTE_HEX { LENGTH(1)} Length ::= BYTE_HEX { LENGTH(1) } Address ::=
BYTE_HEX { LENGTH(2) } Type ::= BYTE_BIN { LENGTH(4) } Payload ::= BYTE_HEX { LENGTH
(REST_LENGTH) } USER_DATA

In the above example, Field1 is a byte-oriented data type (BYTE_*) with the size of one byte. Similarly,
Length and Address are byte-oriented data types with the sizes of one byte and two bytes. Type is a
bit-oriented data type (BIT_*) with a size of four bits. The Payload data type is a byte-oriented hex
string within the MyProtocol layer. When you tag the Data field with USER_DATA, this indicates that
the contents of the field have to be handed to the next protocol layer.
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The line BYTE_HEX { LENGTH (REST_LENGTH) } USER_DATA means hand the rest of the frame to
the next protocol layer (for example, Protocol2).

Note that PACKET_LENGTH and REST_LENGTH can only be used in length expressions such as:

TypeBla ::= BYTE_HEX {LENGTH(REST_LENGTH) }

Related Topics
Sample PSDL Program

Create New Protocol Files
Protocol Analysis

Protocol Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
. . Protocol Stack and Packet Structures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Protocol Window Information

Protocol Window

Overview
The Protocol window supports protocol decoding across multiple levels of a stack. Use the Protocol
window to view and evaluate acquisition data. The Protocol window has three panes: Packet View, Decode
View, and Hex View. Each pane displays the acquisition data at different resolution levels. To open a
Protocol window from the Window menu, click New Data Window and then select Protocol from the list.

Acquisition data is typically analyzed one block of samples at a time. This makes the analysis faster and
uses less memory. The range of samples currently analyzed is displayed in a readout in the Packet View
title bar. To change the position and size of the block of samples to analyze, go to the Protocol Framing
Options properties tab.

NOTE. You must have either a protocol support package loaded into your system or a user-defined framer before you
can add a Protocol window. The Protocol window requires the framing setup from the protocol support package or
user-defined framer to display the protocol.

Packet View
The Packet View displays all the packets of the current acquisition along with the Time stamp information.
Erroneous packets are displayed in red.

Marks
Marks in the Packet View pane help you to navigate through the data displayed in that pane. There are two
cursor marks, a System Trigger mark, and an unlimited number of user-assigned marks. Marks are used to
measure time, and mark specific samples for evaluation.

Add user marks by clicking the button.

Delete user marks by right-clicking the mark handle, and then selecting Delete from the context menu.
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Marks you can move are Cursor 1, Cursor 2, and any marks you add. The numbers 1 and 2 on the mark
handles denote the cursor marks. Readouts for Cursor 1, Cursor 2, and the time difference (Delta Time)
between the two are located at the top of the data area.

Marks on the left side of the window are data area marks. These marks are in the portion of the
acquisition that is currently viewable. Use data area marks to move within the data area.

The System Trigger mark is fixed, you cannot move it.

Marks on the right side are overview marks. These marks show where marks are located relative to the
entire acquisition. Use overview marks to move throughout the acquisition. For example, move Cursor
1 to a particular sample as shown in the Cursor 1 readout. Click the Go To toolbar button and select
Cursor 1. You can also click the right mouse button on any overview mark, and then click Go To Mark.

You can move to any mark using the Go To toolbar button.

Decode View
The Decode View decodes the protocol parameters of the packet selected in Packet View and displays
them line by line. Each protocol parameter size is displayed as well as any comments contained in the
description file associated with the protocol. The protocol stack that is currently in use determines which
protocol parameters are shown.

Hex View:
You can choose one of the following formats to display the packet selected in Packet View in the Hex
View pane:

Hex

ASCII

HEX+ASCII

BINARY

If you select an individual protocol parameter in Decode View, the corresponding values are highlighted in
Hex View.

Related Topic
Protocol Design

379



Protocol Analysis Compilation Result Pane

. . Protocol Window Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Compilation Result Pane

Overview
The Compilation Result pane is where the results of compiling are displayed.

Behavior
Double-clicking an error message in the Compilation Result pane highlights the line with the error in the
Protocol Editor pane.

Related Topic
Protocol Editor Pane
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Frames and Framers
The following information provides high-level answers to questions regarding frames and framers.

What is Framing?
Frames are logical groupings of information sent as data layers. Frames are basically data and control
information that flow between link layer devices and physical layer devices. The cells or packets received
from network layers are transformed into frames by link layer devices and passed on to physical layer
devices. This entire process is known as framing.

What is a Generic Framer?
A generic framer is an application that processes acquired data from the logic analyzer (data and control
information) from any bus that carries packetized data. It works on any type of bus that connects the
link layer and physical layer devices.

What is a Bus-Specific Framer?
A bus-specific framer is an application that processes acquired data from the logic analyzer (data and
control information) from a particular bus that only carries packets. Tektronix supplies framers for the
SPI-3 TX and RX , SPI-4.2 LVDS, and LVTTL TX and RX buses.
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What is the Difference Between Generic Framers and Bus-Specific Framers?
Bus-specific framers require their corresponding support packages. The packets created by the bus-specific
framers are exact packets. Generic framers add more information to the packets that need to be decoded
using protocol definition files. As a result, you may not get exact packets if you use a generic framer.

What are the Limitations of the Generic Framer?
The generic framer has the following limitations:

Scrambling is not supported.

Fragmentation is not supported.

Encoded data will be framed "as is."

Transmit and receive busses cannot be linked.

Only multiples of 8-bit bus widths are supported.

In some cases, additional information is added to the packets depending on the specified field
conditions. You can further decode the packet using protocol definition (Protocol Designer).

When Should You Use the Generic Framer?
When setups do not have associated bus-specific framers, the Define Bus check box in the New Protocol
Window wizard is automatically selected. If a specific framer is available, the Define Bus box is cleared.
However, you can enable the check box even if a specific framer is available.

Use the generic framer when the information (cells, packets, and control words) flowing on a bus is
captured and framed by the logic analyzer. The Protocol window displays the decoded framed packets.
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Protocol Filter Setup Dialog Box

Overview
The Protocol Filter Setup dialog box allows you to selectively filter specific packets from the acquired
data. You can choose to filter all packets based on the protocols and their fields.

Behavior
The filter options are active when you select the Enable Filter check box. This dialog box contains all the
Filter Options: Fields, Operation, Value, and Format. You can select an item from the Fields, identify the
Operation, and specify the Value and the Format.

The Protocol drop-down list shows all the protocols contained in the stack. When you select a protocol,
its fields are listed in the Field box. When you select an item from the Field box, its value (if any),
is displayed in the Predefined Values.

Select the Enable Fields check box to filter the packets based on the specific fields. If you clear the Enable
Fields check box, you can filter the data based on the selected protocol.

You can specify the values in any of the following formats: Decimal, Hex, ASCII or Binary.

To Use

Click (the Filter Setup toolbar button) to access the Filter Setup dialog box.

Use this dialog box to define operations and value for the filter. By default, the filter is not enabled. To
enable the filter, select the Enable Filter check box.

Related Topic
Filtering the Protocol Display
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Protocol Properties: About Data Tab

Overview
The Protocol Properties: About Data tab provides information about the data source used for the active
data window.

To Use

From the Protocol window, click the button and then click the About Data tab. This is a read-only tab.

382



Protocol Analysis Protocol Window Properties Tab

. . Protocol Window Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Protocol Window Properties Tab

Overview
The Protocol Window properties tab allows you to view or change the default settings of Protocol window.

Behavior
You can change the background color settings of all three panes and enable or disable the grid lines in
the Packet View pane.

To Use

From the Protocol window, click the button and then click the Protocol Window tab. Click the
Background drop-down list to select a background color. Use the Grid Lines check box to enable or disable
the grid lines in the Packet View and Hex View panes.
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Protocol Column Properties

Overview
The Column properties tab allows you to view or change the column settings in the Packet View pane of
the Protocol window.

Behavior
The drop-down Column list shows all columns from the current acquisition. Select the column that you
want to view or change from the drop-down list. Use the width box to change the width of the selected
column; you can enter a value or use the arrows to change the width.

To hide a column, clear the Show Column selection. The column properties are retained when you want
to display the column again.

You can specify a fixed column color by selecting Fixed in the Color section and then selecting one of the
fixed colors. You can also use the same color as an existing column by selecting Same As in the Color
section and then selecting the column from the drop-down list.

When you select the time stamp column, you can use the Time Stamp Reference selection to set the
reference point for calculating time stamps. The Time Stamp Reference selection is only available for
time stamp column.

To Use

From the Protocol window, click one of the columns and then click button. The selected column
appears in the Column drop-down list. If necessary select the column that you want to update and use the
other settings in the dialog box to change the column width or color.
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Protocol Color Properties Tab

Overview
The Protocol Color Properties tab allows you to view or change the color settings of the protocols in the
Packet and Decode View pane of the Protocol window.

Behavior
The Protocol Color Properties tab lists all the protocols present in the current acquisition and the available
color options. Select a color for each protocol. The selected color is used for display in the Decode View
of the Protocol window. A preview is displayed in the Protocol Properties Color tab. This tab allows you
to set default colors for all the protocols.

To Use

From the Protocol window, click the button, and then click the Color tab. Select the protocol from the
Protocol list. Use the Color for Protocol drop-down list to select the color for the protocol. Click the Set
all to default button to change the color to black for all protocols.
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Protocol Marks Properties Tab

Overview
The Protocol Marks properties tab allows you to view or change the color settings of marks placed in the
Packet View pane. You can also associate a comment for each mark. The Protocol Marks properties tab
lists all the marks and cursors placed in the Packet View. Selecting Show Hairline allows you to enable or
disable the hairline properties.

Behavior
Marks in the Packet View pane help you to navigate through the data displayed in that pane. There are two
cursor marks, a System Trigger mark, and an unlimited number of user-assigned marks. Marks are used to
measure time and mark specific samples for evaluation.

To Use

From the Protocol window, click the button to display the Protocol Properties dialog box, and then
click the Marks tab. Use the Marks drop-down list to select a mark. Use the color drop-down list to select
the color for the mark. Enter any comments into the comment text box. Use the Show Hairline check box
to enable or disable the hairline properties of the mark.
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Protocol Framing Options Properties Tab

Overview
The Protocol Framing Options Properties Tab allows you to set the range of samples in the acquisition
memory to analyze and frame. This tab also allows you to set bus-specific settings, such as the port address,
bus width, and other settings for the packet data bytes that have to be framed. You can enter framing
options for the framer support provided for the specific communication bus, such as the port address.

Behavior
Analyzing data can be memory intensive. It is best to analyze acquisition data in blocks of approximately
100, 000. Use the Start and Number of Samples settings to specify the ranges of samples to analyze.
You can experiment to find the optimum block size for your situation. The samples are analyzed when
you exit the property sheet.

If the bus definition for acquiring data is user-defined, there are no framing options on the Framing
Options tab.

If you select Frame Across Gaps, the acquisition will not be considered for framing.

To Use

From the Protocol window, click the button to display the Protocol Properties dialog box, and then
click the Framing Options tab. Enter the port address in the Port Address text box and other options
pertained to the bus-specific framers. Use the Enable Gaps check box to enable and disable gaps.
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Protocol Search Dialog Box

Overview
The Protocol Search dialog box allows you to search in the Packet View pane of the Protocol window.

Behavior
This dialog box contains all the Search Options. You can select a protocol from the Protocols drop-down
list. The Search Options are: Fields, Operation, Value, and Format. You can select an item to search for
from the Fields, identify the Operation, and specify the Value and the Format.

You can specify the Value in Decimal, Hex, ASCII, or Binary formats. You can clear the Enable Fields
check box and search on the selected protocol. The search is completed once for each packet of data. If
the search is successful, the packet is highlighted in the Packet View pane and the corresponding packet
information displays in the Decode View pane.

To Use

From the Protocol window, click the button to open the Define Search dialog box.

Use this dialog box to define operations and specify the value for the search. Select either <<Back or
Forward>> buttons to search before or after the current cursor position.
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Export Protocol Data Dialog Box

Overview
The Export Data dialog box allows you to export data to a text file in a location that you choose. You can
choose options that customize what will be exported.

Behavior
Use the Export Data dialog box to export data from the current Protocol window to an ASCII text file. You
can export the following Protocol data:

All packets from the acquisition

A range of packets between two selected marks

A range of packets between two packet indices

If you choose to export the protocol data to a text file, you can click Options to define the format of the
data. The data is saved in a file with the .txt extension.

To Use
Place the cursor in the Protocol window, and click Data> Export to display the Export Data dialog box.
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New Protocol Display Window

Overview
Use this dialog box to create a new Protocol Display window. To access the dialog box from the Window
menu, select New Data Window….

Behavior
Select Data From if you want to use a data source from the current system. If the data source you want is
not listed, click the Add Data Source button to add a data source from the TLA system or logic analyzer
file to the current system. You can also click the Browse button to search for a desired TLA system file.

Select No data to create an empty Protocol Display window.

Checking the Define Bus check box activates the Select Bus dialog box. Use this dialog box when you
want to select a different bus from the data source. You can also create a new bus or modify an existing
bus to meet your needs.

NOTE. If your data source does not have a framer associated with it, the Define Bus check box is automatically
selected and you must choose an existing bus or define a new one.

To Use
Specify the data source for your new data window or select No data: Check the Define Bus check box to
define your own bus or clear the check box if you want to use the bus from the data source. Click Next,
and then enter a name for the new Protocol window. Click Finish to create the new window.

Related Topic
Creating a New Protocol Display Window
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Select Bus Page

Overview
The Select Bus page allows you to select a Bus from a list of Available Bus Definitions. You can also
create a new bus or edit an existing bus.

Behavior
Clicking either the New…or Edit… button will activate the Define Bus Dialog Box. Clicking Next
attaches the selected bus to the data source.

To Use
To attach an available bus to your data source, select the bus definition from the list and click Next. If
you want to define a new bus, click New…. To modify an existing bus, select that bus from the list of
available busses, and then click Edit….
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Define Bus Dialog Box

Overview
Use the Define Bus dialog box to modify an existing bus or create a new one. You can select groups from
drop-down lists and then define the data patterns by entering data in the adjacent boxes.

Behavior
The Bus Name text box contains information on a bus that you can edit. For a new bus you must enter a
unique name in the text box. By default, MyBus displays in the Bus Name text box for a new bus; the text
description is optional. The Field Definition area describes the details of the bus. Use the drop-down lists
to define the field, group name, operation, value, and radix. The Field drop-down list shows all of the
groups available in the Setup window; the group that you select will become the data group of the bus. Use
the Group Name drop-down list to select the group and pattern for the selections for the field selections.

If the packet length is fixed, enter the packet length in bytes in the Packet Length box at the bottom
of the dialog box.

You can enter Binary or Hexadecimal values for Data Valid, Error Condition, Start of Packet, or End of
Packet. You can also use don’t care values.

Fields
The Data field is a required field.
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The Start of Packet (SOP) is an optional selection. Use it to define the SOP condition of the bus. Enter
the data pattern in the Value box. An SOP or EOP condition is expected for packets.

The End of Packet (EOP) is an optional selection. Use it to define the EOP condition of the bus. Enter
the data pattern in the Value box. When designing the data groups in the Setup window, you need to
maintain the bit and byte order such that the least-significant byte follows the most-significant byte.

The Data Valid condition is optional and is used for defining the Data Valid condition of the bus.

The Abort Condition is optional and is used for defining the Abort condition of the bus.

The Port Address is optional and only applies to the inbound port address. You can select any group for
the port address. You can enter a mask value for the port address.

The Port Address Condition is an optional selection. If you enter a port address condition, you must at
least enter a port address in the Value box.

To Use
Enter a name and a description for the bus. Use the drop-down lists to define the field, group name, and
operation. If you are comparing the operation against a value, enter the value and the radix. Click the Add
button to add the definition to the list. You can also modify an operation by selecting the operation, making
the change, and then clicking the Modify button.
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Stack Definition Pane

Overview
The Stack Definition pane allows you to create or modify protocol stacks and displays the properties of
the selected protocol. A protocol stack is made up of protocols at different layers. There can be many
protocols at a given layer.

Directly below the Stack Definition pane is the Stack Protocol Information pane, which displays the
properties of the selected protocol within the stack.

Behavior
The Stack Definition pane allows you to open, edit, and save protocol stacks as well as adding and deleting
protocols to a stack. In the Stack Definition pane, you can also define and modify relations between
the protocols in a stack.

The Stack Protocol Information pane displays the properties of the selected protocol in the Stack Definition
pane. The application displays properties of the selected protocol classified as name, description, compile
file name with date and time, source file name with date and time, type of relation, and relation parameters.
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Select Stack Dialog Box

Overview
Use this dialog box to select and apply a stack for the current acquisition.

Behavior
The stack that you select has a relationship between the defined protocols. You can select only a single
stack. The stack that you select will be applied to the current acquisition when you click OK. To search for
a stack, enter a stack name in the Search box and then click the Next button.

To Use
From the Protocol window, click Select Stack in the Data menu. Click the stack that you want to use and
then click OK to apply the stack for current acquisition.
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Select Stack Page

Overview
Use this wizard page to select a stack from the list of available stacks.

Behavior
Selecting a stack from the list applies the stack to the data source defined in the previous wizard page.

To Use
Select a stack from the list and then click the Next button to continue defining the Protocol window.
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Generic Framer Example
This example shows how the generic framer works for Utopia3 support packages.

Data Acquisition
The logic analyzer acquires the Utopia signals using an external clocking setup. Data and control signals
are acquired on every rising edge of the clock. The control signals are Enb* and SOC. You must set up the
Data group and the Control group on the logic analyzer (as described in the following procedure).

Framing
1. In the Define Bus dialog box, enter the Bus name, description, and then select the data group.

2. For the Start of Packet (SOP), select the Control group that contains the SOC and Enb* signals. For
example, if the Control group has the Enb* and SOC signals, enter the value of 01 for the SOP (the
Enb* signal is low and the SOC signal is high to show the start of the cell).

3. Enter the packet length in bytes. For Utopia the packet length can be 52, 53, 54, or 56. However the
packet length will be fixed for a system.

4. Acquire the data using the logic analyzer.

The Generic Framer looks for the 01 pattern in the SOP control group. When the pattern is matched,
the framer starts to fill the cells. The data from the present sample is considered as the Start of the cell.

5. Create your own protocol (for example, Utopia3) and stack using the Protocol Designer for further
decoding of the Utopia3 cells.

A typical Utopia3 cell format consists of the Header with 6 bytes followed by the payload with 48 bytes.
The payload is called SAR (Segmentation and Reassembly) PDU (Protocol Data Unit); it will have
AAL type data.

Limitation
You will be unable to decode beyond SAR PDU. (This limitation also applies to Utopia2 and
Utopia3 support packages and dedicated framers for Utopia2 and Utopia3.)
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Protocol Window Tasks

Setting Up the Protocol Window
Follow these steps to set up the Protocol window: This procedure assumes that a support package is
already loaded on the logic analyzer.

1. From the Window menu, select New Data Window or click the New Data Window icon in the toolbar.

2. In the New Data Window dialog box, select the type of data window as Protocol and click OK.

3. Select Data From, and then select a data source from the list. If the source you want is not listed, click
Add Data Source. Select No data to create an empty window.

4. If you want to define a bus to attach to the data source, select Define Bus, or clear the check box
to use the bus from the data source.

5. Select a stack from the predefined list.

6. Enter a name for the new Protocol window and click the Finish button to view the Protocol window.
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Selecting Stacks
Follow these steps to select the stack:

1. Place the cursor in the Protocol window and click Data > Select Stack.

2. The Select Stack Dialog Box lists all stack files available in a predefined folder.

3. Click the stack that you want to apply for the current acquisition.

4. Click OK to apply the stack for current acquisition.
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Filtering the Protocol Display
Follow these steps to filter the Protocol Display:

1. Place the cursor in the Protocol window and click Data > Filter Setup to display the Protocol Filter
Setup dialog box.

2. Enable or disable the filter using the Enable Filter check box.

3. Select a protocol from the Protocols drop-down list.

4. Select which fields you want to filter from the Fields text box.

5. Select the operation to be used to compare field values from the Operation group box.

6. Specify the value or select predefined values and the format for the selected field. The packets that have
the specified options are filtered and displayed in the Packet View.

7. Clear the Enable Fields selection to filter the packets based on the selected protocol.

8. Click OK.
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Viewing Decoded Data in a Protocol Window
Follow these steps to view protocol decoding in a Protocol window:

1. Acquire data or load a reference memory.

2. If you already have a stack defined, create a new protocol window.

3. If you do not have a stack defined, invoke the Protocol Designer window, define the protocols and
compile. If required, use one of the defined protocols from the Add New Protocol dialog boxes under
the stack editor and define the stack.

4. Apply the stack file to the window and define the framer options. The desired packets from the
acquisition (or reference memory) will be framed and decoded.
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Protocol Designer Information

Protocol Setup Window Properties

Overview
The Protocol tab allows you to set up the name, description, and the color of the selected protocol.

Behavior
The Protocol tab displays the current name, description, conditions of protocol relations, and the color of
the selected protocol. You cannot change the conditions of protocol relations in this tab page. You can
select a display color and set the default color. The Preview pane displays a preview of the selected color.

To Use
1. In the Stack Definition pane, right-click the protocol you want to edit. The Protocol context menu
appears.

2. From the Protocol shortcut menu, select Protocol Setup… to display Protocol Setup dialog box.
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Protocol Relations Properties

Overview
The Relations tab allows you to define and modify relations between protocols in a protocol stack.

Behavior
The relations are viewed from a higher-order level in the protocol stack and are therefore called "on
top of relations".

You can add protocols from the Available Protocols to Current Relations list to create relations between the
protocols. You can define the type of relation as Unconditional, Single Parameter, and Raw Data.

Use Unconditional to specify that the protocol defined as "on top of" is to maintain all protocol data
without restriction.

Use Single Parameter if you want the current protocol to receive data only if a certain parameter of the
carrier protocol accepts one or more values. Enter the exact condition in the Name and Value fields.

Use Raw Data as a condition for transfer of the protocol data. Enter the values of the data frame to be
checked in the Byte offset, Value and Bit offset fields.

To Use
1. In the Stack Definition Pane, right-click the protocol you want to define. The Protocol context menu
appears.

2. From the Protocol shortcut menu, select Modify Relations…. The Protocol Setup dialog box appears,
displaying the Relations tab.
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Stack Definition Display Properties

Overview
The Display properties option allows you to set the foreground color for the protocols. You can also set
the default color.

Behavior
Selecting Set to default will change the foreground color of all the protocols to black.

To Use
1. Right-click in the Stack Definition Pane to display the context menu.

2. Select Display Properties…. The Display Setup dialog box appears.

3. Change the properties as necessary.
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Protocol Designer Window
The Protocol Designer is an Integrated Development Environment (IDE) that combines the functionality
of a protocol and stack editor with a protocol compiler. There are four panes in the Protocol Designer
window. Two of the panes are editors: the Stack Definition pane and the Protocol Editor pane. In the Stack
Definition pane, you can add protocols, define a stack, and create relations between the protocols in a stack.

The Stack Protocol Information pane displays detailed information on a selected protocol including the
relations of that protocol in the stack. The Compilation Result pane displays the results of compiling a
protocol. To open the Protocol Designer window, click the Protocol Designer button on the toolbar.

NOTE. Tektronix recommends that you create and save new protocols and stacks using the Protocol Designer tool
rather than another editor. You should open and edit existing protocol and stack files using the Protocol Designer.
Avoid editing files directly in the Protocol folder and Stack folder.
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Protocol Editor Pane

Overview
The Protocol Editor pane allows you to modify existing protocols or create new ones.

Behavior
Use the Packet Structure Description Language (PSDL) for defining and creating the protocols.

You can display several protocols in the Protocol editor at the same time. However, you can only edit or
compile one protocol at a time.

When you compile the protocols from the Protocol Editor pane, the results of the compilation are displayed
in the Compilation Result Pane.

NOTE. Tektronix recommends that you use the Protocol Editor pane to edit existing protocol or stacks rather than
using other editors.

. . Protocol Designer Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Add Protocol Dialog Box

Overview
The Add protocol dialog box allows you to add protocols from the list of compiled protocol files (.tpa).

Behavior
The list displays descriptions for all available protocols. If you select a protocol description, the associated
protocol description file is displayed below the list.

Enter a search string in the Search field to find a certain protocol.

Click Next to search the list for more protocols that match the search string. When you have reached the
end of the list, the search will continue from the beginning.

To Use
1. In the Stack menu, click Add New Protocol… to add protocols to the stack.

2. In the Add Protocol dialog box, select a protocol to add and click OK.
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Replace Protocol Dialog Box

Overview
The Replace protocol dialog box allows you to replace one protocol with a different version of the same
protocol or with a different protocol.

Behavior
The properties (relations and display) of the respective protocols remain the same when replaced with a
different version of the same protocol.

To Use
1. Right-click the protocol you want to replace. The Protocol context menu appears.

2. From the Protocol shortcut menu, select Replace Protocol… to display the Replace with dialog box.

3. Select the replacement protocol and click OK.
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Save Protocol or Stack Dialog Box

Overview
This dialog box is used to save a stack or protocol file. To access this dialog box from the toolbar in the
Protocol Designer window, select Save, and then choose either Save Stack As… or Save Protocol As….

Behavior
Saving by using a name from the list causes the previously saved file to be overwritten.

To Use
Type the name you want to use to save the Stack or Protocol file and Click Save.
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Open Protocol or Stack Dialog Box

Overview
Use this dialog box to open a previously saved stack or protocol. To access this dialog box from the toolbar
in the Protocol Designer window, select Open, and then choose either Stack… or Protocol….

Behavior
When you select an available stack or protocol file and click Open, the selected file displays in the
corresponding editor pane. You can enter a name (either complete or partial) in the Search field and
click Next to search for that file.

To Use
From the Protocol Designer window, click Open and then select either Stack… or Protocol…. Select the
available Stack or Protocol file that you want to open. You can search for the file by typing a name in the
Search text box and then clicking Next.
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Delete Protocol or Stack Dialog Box

Overview
Use this dialog box to delete a previously saved stack or protocol. To access this dialog box from the
toolbar in the Protocol Designer window, select Open, and then choose either Stack… or Protocol….

Behavior
When you select an available stack or protocol file and click Delete, the selected file will be deleted from
the editor pane. You can enter a name (either complete or partial) in the Search field and click Next
to search for that file.

To Use
From the Protocol Designer window, click Delete and then select either Stack… or Protocol…. Select the
available Stack or Protocol file that you want to delete; you can select multiple files and delete them in one
step. You can search for the file by typing a name in the Search text box and then clicking Next.
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Import Stack Dialog Box

Overview
Use this dialog box to import a stack exported from another Tektronix logic analyzer or computer.

Behavior
This dialog box operates the same as most Open dialog boxes except that it looks for Stack files with
the .pde file extensions.

To Use
1. Open the Import Stack dialog box, open a Protocol Designer window.

2. From the Stack menu, select Import.

3. Navigate the file system to locate the stack and click Open.
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Export Stack Dialog Box

Overview
Use this dialog box to export an opened stack and all of the protocols that belong to the stack to a .pde file.
You can then use the stack and protocols on another Tektronix logic analyzer or computer.

Behavior
This dialog box operates the same as most Save dialog boxes except that it saves Stack files with the
.pde file extension. The Export selection in the Stack menu is disabled if there is no open stack in the
Protocol Designer window.

To Use
1. Open the Export Stack dialog box, open a Protocol Designer window.

2. Open a Stack Definition (click the Open button, select Stack, and select an available stack from the list).

3. From the Stack menu, select Export.

4. Navigate to the location where you want to save the file.

5. Enter a file name and enter comments as needed in the comment box.

6. Click the Save button to export the file to the desired location.
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Protocol Designer Tasks

Add Protocols
1. From the Stack menu, select Add New Protocol… to add protocols to the stack.

2. In the Add Protocol dialog box, select a protocol to add and click OK.

NOTE. You can search for the protocols that you want to add by using the Search field, and then clicking Next to find
the next occurrence of the search string.
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Define Relations Between Protocols
1. In the Stack Definition pane, right-click the protocol for which you want to define relations. The
Protocol shortcut menu appears.

2. In the Protocol shortcut menu, select Define Relations. The Protocol Setup dialog box appears,
displaying the Relations tab.

3. Select the protocols from the Available Protocols list and click Add.

4. The Current Relations list displays the added protocols and the existing relations.

5. To remove any protocol from the Current Relations list, select the protocol, and then click the Remove
button.

6. In the Type of Relation options do one of the following:

Select Unconditional to specify that the protocol defined as "on top of" is to maintain all protocol
data without restriction.

Select Single Parameter if you want the current protocol to receive data only if a certain parameter
of the carrier protocol accepts one or more values. Enter the exact condition in the Name and Value
fields. Enter hexadecimal values preceded by 0x or binary values preceded by 0b.

Select Raw Data as a condition for transfer of the protocol data. Enter the values of the data frame
to be checked in the Byte offset, Value, and Bit offset fields. Enter hexadecimal values preceded by
0x or binary values preceded by 0b.

7. Click Up or Down to determine the order of the relations, and then click OK.

404



Protocol Analysis Go To Protocol Dialog Box

. . Protocol Designer Tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Go To Protocol Dialog Box
1. Right-click in the Stack Definition pane. The Protocol shortcut menu appears.

2. In the Protocol shortcut menu, select Go to Protocol. The Go to Protocol dialog box appears.

3. From the Go to protocol drop-down list, select the protocol that you want to view, and then click OK.
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Delete Protocols
1. In the Stack Definition pane, right-click the protocol you want to remove. The Protocol shortcut
menu appears.

2. In the Protocol shortcut menu, select Remove Protocol to display a message to confirm the deletion.

3. To delete, click Yes. To cancel, click No.
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Define Protocol Setup
1. In the Stack Definition pane, right-click the protocol you want to define. The Protocol shortcut menu
appears.

2. In the Protocol shortcut menu, select Setup to display Protocol Setup dialog box.

3. In the Protocol tab, do the following:

Change the name of the protocol in the Name text box, if required.

Enter a description in the Description text box.

Use the Color drop-down list to select the foreground color.

Click Default to set the color of the protocol to default.

4. Click OK.
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Create New Protocol Files
1. From the Protocol Designer window, click the New toolbar button, and then select Protocol to open a
blank protocol definition file in the Protocol Editor.
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2. Define your protocol in PSDL Language.

List the description of the protocol. For example: DESCRIPTION::="IP – Internet Protocol,
RFC791"

Specify the decoding rule to be used. For example: DECODING_RULES ::=BER

Define the length of each packet in the protocol. For example: PACKET ::=PSDL_SEQUENCE of
LENGTH (PACKET_LENGTH){ PPP_Packet}

Define the sequence. For example: PPP_Packet::= PSDL_SEQUENCE "{" <field name> <type
name> <field label>"}"

Specify the type and size of each variable in the sequence.

NOTE. Tagging the Payload variable with USER_DATA indicates that the contents of that variable are to be handed
to the next protocol layer.

3. Click the Save toolbar button and select Save Protocol As… to display the Save Protocol dialog box.

4. Type a name for the protocol in the Name field and click Save.

5. Click the Compile toolbar button to compile the protocol. After compilation, the Protocol Designer
saves the protocol in .tpa file format.

NOTE. Any errors in the compilation are displayed in the Compilation Result pane.

Type Name
Type name is a user-defined name for the type of a variable. It always begins with an uppercase
character.

Field Label
The field label is a user-defined, optional name that is displayed in the Field column of the Decode
view. It is usually the same as the packet field name.

Field Name
The field name is a user-defined, optional field that is assigned to increase the specification readability.
The field name always starts in lower case.
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Create New Stack Files
1. Click the New toolbar button, and then select Stack to display the Stack Definition pane with the Base
layer and stack protocol information.

2. From the Edit menu, click Add New Protocol to add protocols to the stack.

3. In the Add Protocol dialog box, select a protocol to add and click OK.

4. Create or modify relations between the protocols.

5. The Stack Definition pane displays the protocol and protocol relations.

6. To save the stack, select Save Stack As From the File menu. The Save Stack dialog box appears.

7. Type a name for the stack in the Stack Name field, and then click Save.
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Replace Protocol Files
1. In the Stack Definition pane, right-click the protocol you want to replace. The Protocol shortcut menu
appears.

2. In the Protocol shortcut menu, select Replace Protocol to display Replace with dialog box.

3. Select the replacement protocol from the Available Protocols list and click OK.
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AutoDeskew Information

AutoDeskew Window

Overview
The AutoDeskew window provides the controls necessary for setting up the AutoDeskew analysis
tool, displaying the AutoDeskew analysis results, and applying the analysis results for use with normal
acquisitions. AutoDeskew works independently of the current logic analyzer clocking and trigger program
settings. When you set up and perform the AutoDeskew analysis, the current clocking and trigger
program settings are not disturbed. However, you can apply the results to the asynchronous clocking
mode selections to improve the ability of normal acquisitions to find stable data. You can also apply the
AutoDeskew setup and hold violation settings to the trigger program violation settings.
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Behavior

You use the AutoDeskew window to select the analysis
type, initiate analysis, apply analysis results, clear analysis
results, and reset the AutoDeskew setup to factory default
settings.

In addition, you can use controls in this window to customize the colors of elements contained in the
AutoDeskew Analysis Results area.

AutoDeskew Toolbar

Click the Define Setup icon, , to open the AutoDeskew Setup dialog box to define a new setup or edit
an existing setup. Once you have defined the setup, close the dialog box and then click the Analysis Type

button, to select an analysis type. To begin the analysis, click the Analyze button. If you want to
apply the results to one of the synchronous clocking modes, click the Apply button. Similarly when doing
a Setup/Hold analysis, you can apply the settings by clicking the Apply button.

Analysis Display Area
The Clock and Scale area displays clock and scale information. A representation of the reference clock
0 point (the point at which the AutoDeskew reference clock changes) displays on the top, along with a
representation of the AutoDeskew analysis range. You can manually set the analysis range from 16 ns
before the clock edge to 8 ns after the clock edge using the controls under the Analysis tab under the
AutoDeskew Setup Dialog Box (the Clock 0 point is not required as part of the analysis range. The Clock 0
point enables you to characterize a signal with respect to the reference clock edge. The clock tick intervals
of the displayed search range will reflect the MagniVu resolution of the module being analyzed.

The Analysis Results area displays the Data Valid window or Setup/Hold Violation window analysis
results in graphical format.
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Data Valid Window Analysis Mode
In the Data Valid Windows analysis mode, each selected channel is analyzed with respect to the reference
clock edge to determine the regions where the data is stable. This mode determines the transitions between
adjacent MagniVu data samples. If two adjacent samples have the same polarity, they are considered stable
with respect to each other. AutoDeskew scans samples throughout the entire analysis range, two samples
at a time; the AutoDeskew results area graphically displays these data valid windows as bars or windows.
These bars or windows appear as elongated eyes. The regions between the data valid windows are regions
of invalid or unstable data (represented by horizontal black lines).

The purpose of the data valid window analysis is to find regions where the data is stable and to pick a
suggested sample point for each analyzed channel. You can then apply the suggested sample points to
the channel setup and hold settings for selected synchronous clocking modes (external clocking) by
clicking the Apply button in the toolbar.

After making all of the settings in the AutoDeskew Setup dialog box, click the Analyze button to start the
data valid window analysis. When the analysis is done, the results appear in the Analysis Display area.
The suggested sample points found by the analysis appear as diamond markers. You can readjust the
markers by dragging them or by selecting values to the right of the display area.

TIP. To set AutoDeskew in the data valid window mode, select Data Valid Window Analysis from the Analysis Type
button in the AutoDeskew toolbar.

Setup and Hold Violation Window Analysis Mode
In Setup and Hold Violation Window analysis mode, selected channels are collectively analyzed for
setup and hold violations. This analysis mode operates identically to the setup and hold violation trigger
programs that analyze channel groups for violations. The purpose of the analysis is to determine if the data
is stable in the regions that you analyzed.

The analysis proceeds throughout the defined setup and hold violation window analysis range for each
channel. If any violations are found, they are reported on the entire set of channels being analyzed. Once
the analysis completes, you can apply the range settings to the setup and hold violation trigger settings for
each channel in the application by clicking the Apply button in the toolbar.

You can change the setup and hold violation range values for any channels by doing one of the following:

Manually drag each setup and hold violation window bar and resize it to the MagniVu resolution of the
module being analyzed. (Make sure that you select the Setup/Hold Violation Window check box in the
AutoDeskew Properties dialog box so you can drag and resize the window bar.)

Selecting values for each channel in the controls to the right of the display area.

Use the controls in the AutoDeskew Setup dialog box under the Analysis tab to set the setup and
hold violation range channels.
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You can display graticule lines on both the top and bottom of each group’s results by selecting the Show
Graticule option in the AutoDeskew Properties dialog box.

TIP. To set AutoDeskew in the Setup and Hold Violation Window mode, select Setup/Hold Violation Window Analysis
from the Analysis Type button in the AutoDeskew toolbar.

Channel Column
The Channel column displays the group, probe, or user name of the displayed channels. The channel
names depend on how the channel is selected in the AutoDeskew Setup dialog box.

Suggested Sample Point Column
For each channel, the Suggested Sample Point column displays the position of the suggested MagniVu
sample found by the Data Valid Window analysis. You can adjust the suggested position for each channel
using the controls for this column. AutoDeskew must be in the Data Valid Window analysis mode to
enable and display this column.

Setup and Hold Columns
For each channel the Setup and Hold column displays the setup and hold analysis range values used for the
Setup and Hold Violation analysis. You can adjust the setup and hold values for each channel using the
controls to the right of the display area.

AutoDeskew Legend
The AutoDeskew legend displays the legend information for the analysis windows. You can use the
AutoDeskew Properties window to change the color associated with any of the analysis windows.
Double-click on the colored square for any item in the AutoDeskew window legend to open the
AutoDeskew Properties dialog box.

Related Topics
AutoDeskew Properties Dialog Box

AutoDeskew Setups Dialog Box
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Load AutoDeskew Setup Dialog Box

Overview
The Load AutoDeskew Setup dialog box allows you to load an AutoDeskew setup from any saved
system setup file. When you select an AutoDeskew setup, the load operation replaces all the current
AutoDeskew settings.

Behavior
The operation of the AutoDeskew Setup dialog box depends on what you select to load. If you select a
module in the Load AutoDeskew Setup dialog box, then the selected setups are added to the module. If
you select a setup in the Load AutoDeskew Setup dialog box, then the loaded setup replaces the one
in the AutoDeskew Setups dialog box.

Use the File Name box to enter the file name containing an AutoDeskew setup to load or use the Browse
button to browse the file system for a setup. The modules and their setup, when found, will be listed in
the Modules and their Setups text box. You can select any setup listed in this box. Once you highlight
the desired setup, you can load the setup by clicking Load button.

The Modules and their Setups box allow you to highlight a single selection or multiple selections, based
upon the following scenarios:

When you select a setup, the Modules and their Setups box allows you to select only one setup and,
once loaded, it replaces the selected setup.

When you select a module, the Modules and their Setups box allows you to select multiple setups to
be loaded. This operation loads a copy of the selected setups and adds it to the list of setups for the
selected module.

Click the Load button to load your selected AutoDeskew setups. The loaded AutoDeskew setup either
creates a new setup or replaces an existing setup. If the AutoDeskew setup being loaded uses groups or
channels not included in the module, they are discarded and a message informs you of the setup revision.
When loading, an AutoDeskew setup will overwrite an existing setup; a message informs you of the
impending change. You can choose to either continue loading the setup or cancel the operation. Setup
naming conflicts are resolved by appending a number to the setup name.

Related Topic
AutoDeskew Setup Dialog Box
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AutoDeskew Setup Dialog Box

Overview
Use the AutoDeskew Setup dialog box to edit the settings of a selected AutoDeskew setup, add a new
AutoDeskew setup, and specify analysis parameters (such as channels and clocking).

Behavior
The AutoDeskew Setup box displays all module or instrument names and the name of any AutoDeskew
setups they contain. Modules that contain one or more AutoDeskew setups are listed in < modulename >
- <AutoDeskew setup name> format.

Click the New Setup button to open the New AutoDeskew Setup dialog box, which you can use to specify
a new AutoDeskew setup. To change the name or description of an existing setup, use the AutoDeskew
Setups Dialog Box.

The AutoDeskew Mode group box allows you to specify the mode in which the AutoDeskew setup will
be used. You can choose between Manual mode and Custom Mode.

Manual mode allows you to define the Channel setups and the Clock setups in their respective tabs.
In addition, it disables the AutoDeskew Configurations box, the AutoDeskew Settings box, and
the Reload Custom Settings button.

Custom mode derives the settings from the loaded support package if the package includes
AutoDeskew support (not all support packages have such support). Selecting Custom mode enables
AutoDeskew configurations, AutoDeskew settings and the Reload custom settings button. Custom
mode is disabled unless a support package with AutoDeskew support is loaded in the selected module.

The following selections are available when you select the Custom mode:

Reload custom settings

The reload custom settings button reloads the custom settings from the loaded support package.

AutoDeskew configurations

AutoDeskew configurations lists all of the AutoDeskew configurations defined in the loaded support
package. You can create an AutoDeskew configuration for each physical configuration of the target
system. If the loaded support package includes the AutoDeskew support with multiple configurations,
you can select the configuration from this list.

AutoDeskew settings

AutoDeskew settings lists all of the settings available for the selected AutoDeskew configuration. For
each configuration there will be one or more settings. Each setting defines the channels to analyze,
a clocking specification, and a range over which each channel will be analyzed. Using a custom
setting allows you to override the channels to be analyzed; but there is no way to adjust the analysis
clocking or the data valid window analysis range.
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Channels Tab
Use the Channel tab to select the channels that you want to analyze and which channels will have their data
valid window analysis results applied. The data valid window analysis results are applied when you click
the Apply button and specify the settings in the Apply dialog box.

Use the Channels tab to list channels by group, by probe, or by a user-defined name. Then specify the
channels that you want to analyze by selecting the check box associated with each group or channel in the
Analyze column. To specify the channels for which the analysis results will be applied when you click the
Apply button, select the check boxes associated with each group or channel in the Apply column. To select
or clear all Analyze or Apply check boxes, select the check box located next to the Analyze or Apply
column title. By default, when you select an Analyze check box, the related Show check box is selected.

Clock Tab
Use the Clock tab to set up the clock definitions for the Data Valid Window and Setup and Hold Violations
Window analysis. The Clock tab contains inputs that you use to specify the clock, clock transition edge,
and qualifiers to use for the analysis.

NOTE. When you choose Custom AutoDeskew mode, clock definitions are derived from the support package. All the
controls that normally display on the Clock tab are hidden. The system displays a message indicating that the clock
definitions will be handled by the AutoDeskew setup you selected from the loaded support package.

Analysis Tab
Use the Analysis tab to specify parameters for Data Valid Window and Setup/Hold Violation analysis.

The Data Valid Window group box contains the Start (Setup) and End (Hold) controls that specify the
beginning and end of the analysis range for all channels. Positive values represent times before the clock
edge, while negative values represent times after the clock edge. In the AutoDeskew Manual mode, the
start and end times are applied to all analysis channels and cannot be adjusted on a per-channel basis. In
the Custom mode, these controls are disabled. However, the individual values show the aggregate analysis
range over all channels specified in the loaded custom setting.

Use the Analysis Quality options to control the amount of time that AutoDeskew uses to perform the data
valid window analysis. Each selection displays the number of acquisition samples tested for each pair of
MagniVu bits within the analysis range. For example, if your logic analyzer has 125 ps resolution, the
number of such tests performed over a 24 ns range is 192. The number of acquisition samples that are
examined depends on the AutoDeskew clock setting. In AutoDeskew Manual mode using one clock, the
number of acquisition samples examined corresponds to the number of clock edges. In the Custom
mode, the clocking can be very complex such that the number of acquisition samples does not necessarily
correspond to simply looking at a single clock edge.

The Setup/Hold Violation Window group box includes the Start and End controls that specify the setup
and hold violation window analysis range for all channels. Positive values represent times before the
clock edge, while negative values represent times after the clock edge. These controls are not affected
by the AutoDeskew Custom settings. Use the Stop Analysis Condition options to specify when to stop
the analysis. Select Run until user stop to let the analysis to continue until you click the Abort button in
the progress dialog box.
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AutoDeskew Properties Dialog Box

Overview
The AutoDeskew Properties dialog box contains controls that affect the display properties of the
AutoDeskew window.

Behavior
By selecting properties from this dialog box, you control which windows display in the analysis results
area of the AutoDeskew window, and the colors used to display them. The property selections will not
display in the AutoDeskew window if you do not select the check box.

The Show Graticule box allows you to indicate whether to display the graticule and, specify the graticule
color. You can also define the following settings for the AutoDeskew window:

The Invalid Data Region check box allows you to display the invalid data region using the specified
color.

The Data Valid Window check box allows you to display the Data Valid Window using the specified
color.

The Suggested Sample Point check box allows you to display the suggested sample point for each
channel using the specified color.

The Setup/Hold Violation Window check box allows you to display the Setup/Hold Violation window
for each channel using the specified color.

The Current Sample Point check box allows you to display the current sample point for each channel
using the specified color. The actual sample point depends on the Current Clocking Mode setting.

The Current Clocking Mode group box allows you to select synchronous clocking mode. The clocking
mode you choose controls the current sample point displayed in the AutoDeskew window.

Related Topic
AutoDeskew Window
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AutoDeskew Setups Dialog Box

Overview
The AutoDeskew Setups dialog box displays the setups available in all physical modules. You can also
view saved AutoDeskew setups that were downloaded from a module that was loaded from another system.

Behavior
You use the Setups group box to manage AutoDeskew setups. This includes creating, duplicating, deleting
and renaming setups. The type of setup you highlight in the Setup box (module vs AutoDeskew setup)
determines the functionality associated with the following toolbar icons. Right-click a setup to open a
context menu where you can manage the setups.

Click the New button to open the New AutoDeskew Setup dialog box. Use this dialog box to create
and name a new AutoDeskew setup. When a module or instrument is highlighted in the Setup box, the
newly added AutoDeskew setup is attached to that module or instrument. When an AutoDeskew setup is
highlighted, the newly added AutoDeskew setup is associated with the highlighted setup. You can also use
the New AutoDeskew Setup dialog box to rename an existing setup.

Click the Load button to open the Load AutoDeskew Setup Dialog Box. Use this dialog box to load an
AutoDeskew setup from a saved system file. When a module is highlighted in the Setup box, the loaded
setup is added as a new setup to the selected module or instrument. When an AutoDeskew setup is
highlighted, the loaded setup replaces the highlighted setup.

When a module is highlighted in the Setup box, the Cut button is disabled. When an setup is highlighted,
clicking Cut copies the selected setup to the clipboard and removes it from the module. You cannot
remove the last setup.

When a module is highlighted in the Setup box, the Copy button is disabled. When an setup is highlighted,
clicking Copy copies the selected setup to the clipboard.

When a module or instrument is highlighted in the Setup box, clicking the Paste button creates a new setup
from the clipboard contents and attaches it to the selected module or instrument. The logic analyzer will
add an integer to the clipboard setup name; you can change the description as needed. When a setup is
highlighted, clicking the Paste button replaces the highlighted setup with the contents of the clipboard.

Related Topic
Load AutoDeskew Setup Dialog Box
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Apply AutoDeskew Results Dialog Box

Overview
The Apply AutoDeskew Results dialog box allows you to apply the Data Valid Window analysis results
to one of the synchronous clocking modes or the Setup/Hold Violation Window analysis settings to the
setup and hold storage violation or setup and hold event violation trigger settings. You can apply the data
valid window analysis result to only one clocking mode at a time.

Behavior
The analysis results are applied only to those channels that you select in the Channel Setup tab of the
AutoDeskew Setup dialog box.

Selecting the Apply Suggested Setup/Hold Window Settings option enables the Clocking Mode box.
Depending on the clocking mode that you select, the setup and hold alignment values that you specified
in the AutoDeskew Setup dialog box will be applied to the setup and hold storage violation and event
violation. The suggested sample points are actual MagniVu samples, while the setup and hold alignment
values in the synchronous clocking dialog boxes are probe-tip values. AutoDeskew does the necessary
conversion between the suggested sample points and the setup and hold alignment values. The applied
changes will display in the AutoDeskew window.

If you select External 4X clocking mode, then the Second Edge Delay group options are enabled. When
you select the Set External 4X Setup/Hold Values, the suggested sample points are used to set the External
4X setup and hold alignment values. The applied changes will display in the AutoDeskew window.

When you select Set External 4X Second Edge, the suggested samples are used to set the External 4X
Second Edge Delay values. AutoDeskew makes the necessary adjustments to the suggested sample point
position to meet the constraints for a second edge delay value if the suggested sample point position
violates those constraints. The applied changes will display in the AutoDeskew window, but you can move
the suggested sample point positions to meet any constraints.

Selecting the Apply Setup/Hold Violation Settings option disables the Clocking Mode box and Second
Edge Delay group. This option applies setup and hold violation settings. You can adjust the setup and
hold settings on a per-channel basis if they are not consistent with the per-channel alignments of the
current synchronous clocking mode.

Related Topic
AutoDeskew Setup Dialog Box
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Data Measurements

Data Measurements Overview
Data measurements can be taken on Waveform and Listing windows.

Overview
You can select the data measurements that you want to take on an active window from a list of available
measurements. Data measurement results are displayed in the Statistics page of the Measurement tab and
updated each time you run an acquisition. You can, however, configure data measurements without the
acquisition data. You can quickly perform counts and averages on your data set. Data measurements can
be exported to a file and saved with your TLA system.

Behavior
When system changes are made that affect the measurement results an icon appears in the Info column
on the Statistics page.

To perform measurement analysis on virtual data, you must use the Recalc button. Clicking Run does not
have any affect on the measurement analysis results if you are using virtual data.

Changes in the TLA setup or system will effect the data measurements in the following ways:

If you delete a group, the measurement using the group is also deleted.

If the active window that had data measurements taken on it is deleted from the system, all the
measurements done on that window are also deleted.

If you merge data sources, all measurements taken on that window are removed.

If you return to a default setup, all data measurements are removed.

Loading a TLA data window that had data measurements taken, restores the measurements that were
taken on this window.

Data measurements to not include suppressed or filtered samples.

If the radix of any group is changed, the results and statistics for measurements done on that group
is also updated.

Measurement results are cleared when the module is turned off and Run is clicked.

If the module is turned on in the SystemWindow, measurement results are updated when you click Run.
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LA Measurement Setup

Overview
The Setup page contains the controls necessary to add a new measurement. You can also enable or
disable the measurements listed and specify whether to refresh the measurements results on successive
acquisitions or accumulate results and statistics over multiple acquisitions.

Behavior
The Setup page is affected by the active data window. If no data window is active, then the Measurement
tab is unavailable.

Removing a channel or group from a data window causes the associated measurement to be removed
from the Setup page.

The icons in the Add Measurement group box display measurements that are available to add. You can
create new measurements by dragging and dropping the measurement icons onto the data window display
area. These measurements are then added to the Measurement grid. You can also create measurements by
right-clicking and selecting Add LA Data Measurement from the context menu.

For a definition of each measurement, click one of the measurement type buttons:

The Measurements grid contains all the measurements that are added to the active data window.
Selected measurements are enabled. Clearing the Enable check box disables the measurement. When a
measurement is disabled, it will not be computed.

You can rename the measurement in the Name column if you so choose. The Source column reflects the
channel or group on which the measurement is done. You cannot edit the Source column. The Gate
column offers three choices: Display, Cursors, and Full Record for gating. Measurement analysis is
immediately performed whenever this column is changed.

The type of measurement gating determines what samples are used in the measurement analysis.

Gating Type Measurement Analysis
Full Record—spans across the full memory depth Samples in the full memory depth are used for data analysis.
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Gating Type Measurement Analysis
Display— spans across the visible region Samples in the visible portion of the data window are used

for data analysis.
Cursor— spans between Cursor1 and Cursor2 Samples between Cursor1 and Cursor2 are used for data

analysis.

Measurement analysis is performed when:

The Gate option on the Setup page is changed.

The Gate option is set to Display and you zoom on the active data window.

The Gate option is set to Display and data is suppressed or suppressed data is shown.

The Gate option is set to Display and data is filtered.

The Gate option is set to Cursors and you change the cursor positions on the active data window.

When measurement analysis is in progress, you can abort the analysis by clicking the Cancel button. You
can also recalculate a completed analysis by clicking the Recalc button. This button toggles between
Cancel and Recalc, depending on the state of the analysis.

To Use
Select a measurement by dragging and dropping an icon from the Add Measurement group box to a
data window.

Select the Enable check box from the Measurements grid to enable the measurement. To disable the
measurement, clear the check box. You can also enable or disable all measurements by clicking the Enable
All or Disable All button. You can delete all measurements from the Measurements grid by clicking the
Delete All button, or you can right-click and delete them individually.

The Clear Values button removes the results. If you want to accumulate results over several acquisitions,
select the Accumulate check box. To refresh the results each time the measurements are analyzed, clear
the Accumulate check box.
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Data Measurement Statistics

Overview
This page displays the measurement results and statistics for the active data window. When the active
window changes so will the Statistics page. If the active data window does not have any measurements,
then the Statistics page is empty. The measurements are displayed in the order in which they are added.

For a definition of each available statistic, click here:

Behavior
Removing a channel or group from a data window causes the associated measurement result to be removed
from the Statistics page.

None of the columns are editable, but you can auto size the column by clicking the right border.

The Info column indicates that the results are outdated due to TLA system or setup changes. Data can
be outdated for the following reasons:

Group definition was changed

The measurement was aborted while the analysis was in progress

There is no data for analysis

The results and statistics are cleared

To Use
Click Export to export the data to a file. You can export in either .TXT or .CSV file format.

To refresh outdated results, click the Run button in the TLA System window to acquire new data or click
the RECALC button on the Measurement Setup page to recalculate the measurements on existing data.

Click the Clear Values button to remove all the measurement results and statistics from the Statistics page.
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Graph Window

Overview
Use the Graph window to display data in an X-Y graph format. Use this format to identify valid data in
patterns such as tracking the flow of digitized analog values throughout your target system by looking at
data values written to a set of memory addresses.

Axis readout bars provide information on the data in the Graph window. You can customize the readouts
using the Graph Window property page. A legend at the bottom of the graph display provides an overview
of the contents of the Graph window. A progress bar below the legend shows the status of the graph when
it takes time to update the graph data.

Data Series
Graph data is represented by a data series, a collection of related data points plotted in a graph.

Each data series in the window can have unique color or patterns.

Each data series can have a unique title. You can specify the minimum and maximum data ranges
for the series as well as an offset for each axis.

Add a new data series by clicking the Add Series toolbar button .

Remove a data series by selecting it, and then clicking the Cut toolbar button. You can paste the
removed data series by clicking the Paste toolbar button.

Marks
Use marks to take measurements, locate triggers, and mark specific events for evaluation.

Marks you can move are cursors X1, Y1, X2, Y2, and any marks you add. The numbers 1 and 2 on
the marks handles denote the X-axis (vertical) and Y-axis (horizontal) cursor marks. Readouts for the
cursors, and the time differences (Delta Time) between the cursors are located at the top of the data area.

Marks on the top and right sides of the window are data area marks. These marks are in the portion of
the acquisition that is currently viewable. Use data area marks to move within the data area.

You cannot move System Trigger, Module Trigger, or Begin and End marks.

Marks on the bottom and left sides are overview marks. These marks show where marks are located
relative to the entire acquisition. Use overview marks to move throughout the acquisition.

Double-click a mark to open the Marks properties page. You can assign a unique name to the Mark in
the Mark Name field.

You can add marks by clicking (the Add Mark toolbar button). Remove a mark by selecting the
mark and using the Cut toolbar button. When you add or paste a mark, it appears in the center of
the display.
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System trigger The system trigger is the reference point for the acquisition.
Timing and location information is relative to the system
trigger. Trigger marks cannot be moved.

Under some conditions the system trigger associated with a
module’s data might not be displayed in the data window. If
the system trigger was caused by another module, whose
data is not included in the current display, then the system
trigger is not shown. Nevertheless, all time measurements
still relate to that system trigger, even if it is not shown.

The system trigger associated with the current data is called
the active system trigger. The system trigger associated
with saved data is called the reference system trigger.
The active system trigger is indicated by a yellow T; the
reference system trigger is indicated by a gray T.

Module trigger The point at which the module triggered. Trigger marks
cannot be moved.

Begin data and end data The start and end of a module’s data record. These data
marks cannot be moved.

Cursors 1 and 2 Moveable marks used for visual reference and for data
measurements.

User mark User-created marks. Use marks to make specific data
easier to identify and find.

Lock Delta Value check box Click this check box to lock the delta values. When you
lock delta values, the cursors move across the data
simultaneously, maintaining a fixed delta time.

Toolbar Area

Toolbar buttons allow you to customize the Graph window. You can access most of the Graph window
controls directly from the toolbar buttons. Other buttons open either dialog boxes or property pages
where you can supply specific information to adjust the Graph window. If you are unsure of the purpose
of the individual buttons, use the tooltips to identify the buttons.

Add Series Click the Add Series toolbar button to open the Add Series
Dialog Box where you can add a new data series from
different data sources.

Add Mark Click the Add Mark toolbar button to add a mark to the data
points in the series.

Cut Copy, Paste Use these buttons to cut, copy, and paste the individual data
series multiple data series, or marks.
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Go To Click the Go To button to open the Go To dialog box so you
can easily go to a mark or data series.

Properties Click the Properties button to open the Graph window
property pages where you can change the properties of the
data or the graph.

Automatic Update Click this button to enable or disable the automatic update
tool. When you select Enable Auto Update, the current
data in the window is automatically updated when new
acquisition data is available.

Hit Frequency Mode Click the Hit Frequency toolbar button to display the data
points using the colors defined in the Hit Frequency property
page. The color of the data points depend on the number
of hits.

Persistence Mode Click the Persistence toolbar button to retain the previous
graph data along with the current graph data.

Zoom You can zoom Graph window data similar to data in a
Waveform window. The horizontal and vertical axis each
has their own zoom controls. Click on one of the zoom
buttons to zoom either in or out. You can also click and drag
the mouse over the area that you want to zoom; when you
release the mouse button, zoomed data will appear in the
center of the Graph window.

Abort Use the Abort toolbar button to stop the processing of data
in the graph. The data series will not be updated. You may
want to abort the data processing if the data takes too long
to process due to size and other reasons.

You can add a data series to the graph; add marks; and cut, copy, and paste a data series.

You can enable automatic updates, the hit frequency mode, and the persistence mode by clicking the
appropriate toolbar buttons.

Use the zoom toolbar buttons to zoom in and out on the horizontal and vertical axis, or zoom to the
current selection. When you use the zoom buttons, the display centers at the current location.

Click the Abort toolbar button to abort any updates that may take a long time due to the amount of
memory involved with the graph data.
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Graph Window Properties

Overview
Use this property page to change the default appearance of the Graph window.

Behavior
Use the controls in this property sheet to help you do the following tasks:

Display the graph graticule

Specify the color, style, and line thickness of the graticule

Specify the minimum and maximum ranges of the X-axis and Y-axis as well as specifying the values
per division

Label the X-axis and Y-axis

Specify the readout radix

Turn the graph readouts on or off

Specify the color of readouts

Specify the background color of the graph

Enable or disable automatic updates of the graph. (You can also enable or disable the automatic updates
by clicking the toolbar button in the Graph window.)
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Series Data Properties

Overview
Use this property page to change the default settings of an individual data series.

Behavior
Use the Series drop-down list to select the series that you want to display in the Graph window. The text
below the Series List displays the data source (logic analyzer module and slot location). You can change
the title of the series by entering a new title in the Title box. Otherwise, you can use the default name.

The logic analyzer obtains the axis data range values from the selected series. You can adjust these values
or add an offset value to either axis by entering values in the boxes.

You can normalize the data range for each axis. When you normalize the data ranges, you rescale the data
in the ranges. For example, if you normalize all of the X-axis data to 1, all of the data would fall in
proportion to its original values, between 0 and 1. This can be useful when you want to redraw the X-axis
and Y-axis for normalized data series where you want to analyze vector displacement, which uses the
origin of the graph (0,0) as part of the data measurement. The default range values are –1 and 1, but you
can change these values as necessary to meet your needs.

. . Graph Window Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Series Format Properties

Overview
Use this property page to define the appearance of the selected data series.

Behavior
The controls in this property page allow you to select one or more data series where you can specify the
line type and data point type. You can further define the color and thickness of the lines or data points. A
sample image of the selected data series gives a preview of the data series format.

To Use
Select the series that you want to change from the Series List. Click the Series Type drop-down list to
select the series type, straight lines with data points, straight lines without data points, curved lines with
data points, curved lines without data points, or data points only. You can further define the lines as dotted,
dashed, or solid. You can select the type of data points, dots, plus signs (+), or asterisks (*). You can
change the thickness of the lines and marks as well as specify the colors of the lines and data marks.

If you select a series type without data points, the data point elements are disabled. Similarly, if you select
a series type with data points only, the line elements are disabled.
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Hit Frequency Properties

Overview
Use this property page to define the colors for hit ranges.

Behavior
This window uses color schemes to help you determine the frequency of hits. The color schemes are
similar to those used by Tektronix TDS oscilloscopes. For example, if you select a temperature color
scheme, colors move from dark (cool) to bright (hot). Alternately, if you select a spectral color scheme, the
colors move from bright to dark. The colors are fixed when you select a predefined color scheme. If you
select the User-Defined color scheme, you can define your own colors.

The color ranges move from the maximum number of hits to minimum as indicated in the property page. If
you click Invert Colors, the ranges move from the minimum number of hits to maximum.

To Use
Use the drop-down list to select a color scheme. If you select the User-Defined color scheme, you can
define the colors by clicking the color buttons and selecting a color. Use the Default button to return the
colors to their default settings.

After you close the property sheet, click the Hit Frequency button on the toolbar to display the data
points in the graph based on the number of hits.

. . Graph Window Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

New Graph Data Window

Overview
Use this page to create a new Graph window and specify the data source for your new window.

To Use
Click Data from to select a data source from the current system. If the data source you want is not
listed, click the Add Data Source button to add one from the TLA system or logic analyzer file to the
current system. You can also click the Browse button to search for a desired TLA system file.

Click No data to create an empty Graph window. After the window displays, you can add data series
from different sources.

Related Topic
Adding a New Series
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New Graph Window Select Series
Use this page to specify the X-axis and Y-axis for the new Graph window.

For either axis, you can select one of the following:

Sample Number. Use the drop-down list to select Begin, Trigger, or End.

Row Number. This selection is the same as the Sample Number but does not include any gaps due
to filtering.

Timestamp. Use the drop-down list to select either an Absolute timestamp or the Previous timestamp.

Value of Group. Use the drop-down list to select an Address, Data, or Control group.

The axis label will be the same as the type that you specify from the above list. After you set up the new
window, you can use the Graph Window to further define each axis of the graph.

NOTE. Once you have specified the axis type using the wizard, you cannot change the type without creating a
new Graph window.

Related Topic
Add Series Dialog Box
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New Graph Window name
Enter a name for the new Graph window or use the default name. Then click the Finish button to create
the new Graph window.
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Add Series Dialog Box

Overview
Use this dialog box to add a data series to the existing graph from different data sources.

Behavior
The default X-axis and Y-axis data sources depend on the initial graph. You specify these when you create
a new data window using the New Data Window wizard.

You can add a new series from different data sources such as a logic analyzer module or a reference
memory. However, the data source must be from the same Data Source type. For example, you can’t add
an address group to the X-axis if the Data Source type was set up as a sample number. If you want to
change the Data Source type, you must create a new Graph window through the New Data Window wizard.

The appearance of the dialog box changes depending on the Data Source type. For example, if you defined
the X-axis Data Source type as Row Number, the selection is fixed to that type and is grayed out. If you
defined the X-axis as a group, you can use the drop-down list to select the individual group or click the
Add Data Source button to search the file system for a group.

To Use
Define the series for each axis and then click the Add Series button to add the series to the Series list. The
series will be displayed in the form of X-axis versus Y-axis. To remove a series from the graph, select
the series in the Series list and then click the Remove Series button.

To access this dialog box, click the Add Series button in the Graph window toolbar.

NOTE. If you have an empty Graph window (a Graph window with no data) and you click the Add Series toolbar
button, you will launch the Axis Type wizard where you can select the data source, define the X-axis and the Y-axis,
before opening the Add Series dialog box.
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Graph Window Go To Dialog Box

Overview
Use this dialog box to locate a mark or a series in the Graph window.

Behavior
Use to scroll the Graph window to a new position by selecting any current mark or series. Select Mark
to display a list of all marks related to the Graph window. Select Series to display a list of all series
related to the Graph window.

To Use
Double-click on the desired mark or series in the list. The dialog box closes and displays the mark or series
in the center of the window.

To open the Go To dialog box, open a data window and then click the Go To toolbar button.
Analysis Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
. . Graph Window Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Graph Window Tasks

Adding a New Series
1. In the System window, click the Graph data window icon.

2. From the Edit menu, click Add Series.

3. Select the Data Source.

4. If the data source you want is not listed, click Add Data Source to open the Add Data Source dialog box
and browse the file system to locate the data source.

5. Select the series and click Add.

6. Click OK.

TIP. Click to add a series.
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Taking Cursor Measurements
In the Graph window use the X and Y cursors to take measurements:

1. Move each cursor to the points you want to measure.

2. The measurements are displayed in the cursor readouts.

3. Use Lock Delta Time to lock the cursors together.
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Going to a Specific Series
1. In the System window, click the Graph data window icon.

2. Click in the toolbar of the Graph window to open the Go To dialog box.

3. Select Series to display a list of all series in the Graph window.

4. Double-click the series that you want to see.

The series that you selected will display in the center of the Graph window.
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Going to a Specific Graph Window Mark
1. In the System window, click the Graph data window icon.

2. Click in the toolbar of the Graph window to open the Go To dialog box.

3. Select Mark to display a list of all marks in the Graph window.

4. Double-click the mark that you want to see.

The mark that you selected will display in the center of the Graph window.
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Zooming a Graph
The zoom behavior is controlled by the System Options: Preferences settings. The default setting is to
zoom immediately. You can zoom a Graph window three different ways:

Zoom both the X-axis and Y-axis

Zoom the horizontal (X) axis

Zoom the vertical (Y) axis

To zoom a Graph window using the default zoom setting (immediately), perform the following steps:

1. In the System window, click the Graph data window icon.

2. Click and drag the mouse over the area that you want to zoom. When you release the mouse button, the
Graph window will zoom the area of interest and center it in the window.

430



Analysis Tools Turning Hit Frequency On and Off in a Graph Window

. . Graph Window Tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Turning Hit Frequency On and Off in a Graph Window
In the Graph window, click the Hit Frequency toolbar button.

Hit frequency is turned on when the toolbar button is recessed. Click the toolbar button again to turn
the Hit frequency mode off.
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Turning Persistence Mode On and Off in a Graph Window
In the Graph window, click the Persistence mode toolbar button.

The persistence mode is turned on when the toolbar button is recessed. Click the toolbar button again to
turn the persistence mode off.
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Viewing Persistence Data
1. In the System window, click the Graph data window icon.

2. Click in the toolbar of the Graph window to open the Graph window property pages.

3. Click the Series Data tab.

4. Enter an offset value for the X-axis or Y-axis data range.

5. Click OK to close the dialog box.

6. Click the Hit Frequency toolbar button to enable the Hit Frequency mode (button should appear
depressed).

7. Click the Run button to start an acquisition.

The number of hits will increase due the overlapping of data on the same region.

NOTE. The Persistence data will not be visible when you resize the Graph window or scroll data in the Graph window.
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iVerify Information

iVerify Window

Overview
iVerify allows you to generate eye diagrams, or voltage/time graphs, for both individual channels and
groups of channels. Use the controls in the iVerify window to set up iVerify; and to analyze, display,
and perform measurements on the eye diagrams.

iVerify Toolbar

Click the Define Setups icon , , to open the iVerify Setups dialog box to define a new iVerify setup or
edit an existing setup. Once you have defined the setups, close the dialog box and click the Analyze button
to begin building the eye diagram. The eye diagram will be drawn, based on the eye coloration selections
made in the Eye Coloration tab of the iVerify Properties dialog box.

Click the Measurement icon, , to display a list of measurements for the eye diagram. Click a
measurement button to perform a measurement on the eye diagram. Click the button a second time to turn
off the measurement. When the measurements are made, the corresponding cursors are drawn on the eye
diagram. In case of histogram, the cursor is drawn on the eye diagram and the corresponding histogram is
drawn on top or left of the eye diagram, depending on whether it is a horizontal or vertical histogram.

Selecting any measurement from the Measurement icon in the toolbar will overlay the measurement
diagram on the eye diagram and display the corresponding measurement tab.

Measurement Information View
This area of the iVerify window provides general information about the eye diagram. In addition, it
provides information about each measurement on the eye diagram. Measurement information parameters
and measurement results are shown in separate tabs.

General tab

When analysis is complete, the General tab displays peak-to-peak information. In addition, it displays
information pertaining to your cursor’s present position over the eye diagram such as the time and
volt value, number of hits, and displays the highlighted channel.

4 Point Mask tab

The 4-Point Mask tab displays 4 point mask measurement information, such as the mask coordinate
values and the number of hits for each channel within the 4 point mask.

6 Point Mask tab

The 6-Point Mask tab displays 6 point mask measurement information, such as the mask coordinate
values and the number of hits for each channel within the 6 point mask.

Eye Limit Cursor tab

432



Analysis Tools iVerify Window

The Eye Limit Cursor tab displays Eye Limit Cursor measurement information, such as the cursor
position and the eye height and width.

Upper Lower Mask tab

The Upper Lower Mask tab displays upper mask and lower mask measurement information, such as
the upper mask voltage value, lower mask voltage value, the number of hits for each channel in the
masking region, and upper violation and lower violation.

Slope tab

The Slope tab displays information about the slope measurement such as the upper point coordinates,
lower point coordinates, and slope value.

Horizontal Histogram tab

The Horizontal Histogram tab displays the voltage level of the histogram cursor value. In addition,
it displays information pertaining to the cursor’s present position over the eye diagram, such as the
number of hits for each channel over the time level.

Vertical Histogram tab

The Vertical Histogram tab displays the time level of the histogram cursor value. In addition, it
displays information pertaining to the cursor’s present position over the eye diagram, such as the
number of hits for each channel at that voltage level.

Display Time and Voltage Ranges
Use the Display Time Range and Display Voltage Range to select the horizontal and vertical display settings
for the eye diagram. These controls do not affect the acquisition of data from the external oscilloscope.

The Min and Max boxes allow you to set the minimum and maximum time value from where iVerify
will plot the data. These boxes allow you to choose start and end points for the eye display from the
data acquired by the external oscilloscope. Use the Min and Max controls to choose the time period of
interest from all data acquired by the external oscilloscope. By default, the external oscilloscope displays
all acquired data.

The Per Div boxes allow you to divide the eye display area into equal horizontal and vertical divisions and
spread the values accordingly.

The Offset box allows you to move the eye diagram to the left or right by the values specified in the Offset
edit controls. You can also use this offset to measure the time between two points.

NOTE. The Min and Max time controls are relative to the clock shown above the diagram display area.

Related Topics
iVerify Properties Dialog Box

iVerify Setup Dialog Box
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iVerify Setups Dialog Box

Overview
The iVerify dialog box displays iVerify setups that are available in all physical TLA7Axx logic analyzer
modules. You can also view saved iVerify setups that were downloaded from a module that was loaded
from another system.

Behavior
You can use the iVerify Setups group box to manage iVerify setups. This includes creating, duplicating,
deleting and renaming setups. Right-click an iVerify setup to open a context menu where you can manage
the setups.

Click the New button to open the New iVerify Setup Dialog Box. Use this dialog box to create and name a
new iVerify setup under a selected module. When a module is highlighted in the Setup box, the newly
added iVerify setup is attached to that module.

Click the Load button to open the Load iVerify Setup Dialog Box. Use this dialog box to load an iVerify
setup from a saved file. When a module is highlighted in the Setup box, the loaded setup is added as a
new setup to the selected module. When an iVerify setup is highlighted, the loaded setup replaces the
highlighted setup.

When a module is highlighted in the Setup box, the Cut button is disabled. When a setup is highlighted,
clicking Cut copies the selected setup to the clipboard and removes it from the module. You cannot
remove the last setup.

When a module is highlighted in the Setup box, the Copy button is disabled. When a setup is highlighted,
clicking Copy copies the selected setup to the clipboard.

When a module is highlighted in the Setup box, clicking the Paste button creates a new setup from the
clipboard contents and attaches it to the selected module. The logic analyzer will add an integer to the
clipboard setup name; you can change the description as needed. When a setup is highlighted, clicking the
Paste button creates a new setup from the clipboard contents and attaches it to the selected module.

Related Topics
Load iVerify Setup Dialog Box

iVerify Setup Dialog Box
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Load iVerify Setup Dialog Box

Overview
The Load iVerify Setup dialog box allows you to load an iVerify setup from any saved system setup file.
When you select an iVerify setup, the load operation replaces all the settings. However, when you select a
module, a new iVerify setup is added.

Behavior
The operation of the iVerify Setups dialog box depends on what you select to load. If you select a module
in the iVerify Setups dialog box, you can select multiple setups in their individual setup boxes. If you
select a setup in the Load iVerify Setup dialog box, then the loaded setup replaces the one in the iVerify
Setups dialog box.

Use the File Name box to enter the file name containing a module setup or use the Browse button to
browse the file system for a setup. The modules and their setups, when found, will be listed in the Modules
and their Setups text box. You can select any setup listed in this box. Once you highlight the desired
setup, you can load the setup by clicking the Load button. The loaded setup either creates a new setup
or replaces an existing one.

If you select a module in the iVerify Setups dialog box, the Modules and their Setups box allows you to
select multiple setups. However, if you select a setup in the iVerify Setups dialog box, then the Modules
and their Setups box allows you to select only one setup.

If you select a setup from the iVerify Setups dialog box, and then select a setup from the Modules and their
Setups box and click the Load button, a system confirmation message displays. Click OK to confirm that
you intend to replace the current setup with the setup you selected in the Modules and their Setups box.

NOTE. An error message displays if the setup you are trying to load uses groups or channels that are not included in
the selected module. Also, an error message displays when you try to load a module without any saved data.

Related Topic
iVerify Setups Dialog Box
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iVerify Setup Dialog Box

Overview

The iVerify Setup dialog box allows you to edit the settings
of a selected iVerify setup or add a new iVerify setup.
In addition, this dialog box allows you to define various
analysis parameters through the respective tabs. Note that
only TLA7Axx logic analyzer modules and related setups
display in the iVerify Setup dialog box.

Behavior
Use the Setup Name box to select the modules and the iVerify setups that they contain. Modules that
contain one or more iVerify setups are listed in <modulename > - <iVerify setup name> format.

The Description box allows you to enter a new description for, or change the existing description of, the
loaded iVerify setup. Click the New Setup button to open the New iVerify Setup dialog box, which
you use to specify a new iVerify setup.

NOTE. You need to provide information in the Channels, Clock and Qualifier, and Analysis Configuration tabs before
viewing the Inter-Probing tab. This is because the optimum analog routing information contained in the Inter-Probing
tab depends upon the information contained in these tabs. If the setup that you have specified is physically invalid, an
error message appears.

Related Topics
iVerify Setup Dialog Box: Channel Tab

iVerify Setup Dialog Box: Clock/Qualifier Tab
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iVerify Setup Dialog Box: Analysis Configuration Tab

iVerify Setup Dialog Box: Inter-Probing Tab
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iVerify Properties Dialog Box

Overview

The iVerify Properties dialog box shows the properties of
the iVerify Window. These properties include information
about the logic analyzer and external oscilloscope modules,
functionality that you use to set eye diagram colors,
and functionality that you use to color the measurement
diagrams and set their properties.

Behavior
The contents of the iVerify Properties dialog box are logically organized into three tabs. Click the tabs to
navigate to the contents for each iVerify Properties tab.

Related Topics
About Data Tab

iVerify Window Tab

Eye Coloration Tab
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iVerify Properties - About Data Tab
Overview

The About Data tab contains information about both
the logic analyzer and the external oscilloscope for the
current acquisition. This information includes the version
and quantities of logic analyzer modules installed in the
mainframe, the type of external oscilloscope, channel
information, and other configuration information. Click the
tabs in the graphic to navigate to the help contents for each
iVerify Properties tab.

Behavior
The About Data tab contents is read-only information.

Related Topics
iVerify Properties Dialog Box

iVerify Window Tab

Eye Coloration Tab
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iVerify Properties - iVerify Window Tab
Overview

The iVerify Window tab allows you to color the measurement
drawings that are overlaid with the eye diagram. It
also allows you to specify the position and color of the
measurement drawings.
Behavior

The Show Graticule box allows you to indicate whether to
display the graticule and specify the graticule color. You can
also define the following settings for the eye diagram:

The Background drop-down list allows you to select the background color of the eye diagram.

The Clock Edge drop-down list allows you to select the color of the clock edge in the eye diagram.

The Highlight Color drop-down allows you to select the color for the highlighted channel.

The Line Color drop-down list allows you to select the color of the measurement lines.

The controls that are available in the Measurement group box depend on your Option selection. The
following selections are available:

4 Point Mask. The 4 Point Mask option allows you to view or edit the mask coordinate values and the
line color for this measurement in the Measurement group box.

6 Point Mask. Selecting the 6 Point Mask option allows you to view or edit the mask coordinate values
and the line color for this measurement in the Measurement group box.

Eye Limit Cursor. Selecting the Eye Limit Cursor measurement option allows you to view or edit the
time, voltage, and line color for this measurement in the Measurement group box.
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Upper/Lower Mask. Selecting the Upper/Lower Mask measurement option allows you to view or
edit the upper and lower mask positions and the line color for this measurement in the Measurement
group box.

Slope. Selecting the Slope measurement option allows you to view or edit point 1, point 2, and line
color for this measurement in the Measurement group box.

Horizontal Histogram. Selecting the Horizontal Histogram measurement option allows you to view or
edit the scale, voltage and line color for this measurement in the Measurement group box.

Vertical Histogram. Selecting the Vertical Histogram measurement option allows you to view or edit
the scale, time, and line color for this measurement in the Measurement group box.

Related Topics
iVerify Properties Dialog Box

About Data Tab

Eye Coloration Tab
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iVerify Properties - Eye Coloration Tab
Overview

The Eye Coloration tab allows you to set coloration for the
eye diagram. Click the tabs in the graphic to navigate to the
help contents for each iVerify Properties tab.
Behavior

You can select a color scheme that controls the colors of
the eye diagram or, if you choose the color setting of User
Defined, you can individually set the colors used in the eye
diagram.

The Color Scheme drop-down list shows all the color schemes that you can apply to the eye diagram. A
description of the color scheme selections follows:

Temperature Grading. Using Temperature Grading, the areas of the eye with the highest sample density
appear in warmer colors (red shades), and the areas of lowest sample density appear in cooler colors
(blue shades). Temperature Grading is the default eye diagram color scheme.

Spectral Grading. Using Spectral Grading, the areas of the eye with the highest sample density appear
in blue shades, and the areas of lowest sample density appear in red shades.

Monochrome Gray. The Monochrome Gray color scheme displays the eye diagram in shades of gray.
The areas of the waveform with the highest sample density appear in lighter shades of gray, and the
areas of lowest sample density appear in darker shades of gray.

Monochrome Green. The Monochrome Green color scheme displays the eye diagram in shades of
green. The areas of the waveform with the highest sample density appear in lighter shades of green, and
the areas of lowest sample density appear in darker shades of green.

User Defined. Selecting the User Defined color scheme displays the eye diagram in shades of the color
that you select from the Scheme Definition group box.
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Using the color boxes contained in the Scheme Definition group box, you can individually assign colors
that will indicate sample density in the eye diagram. However, this group box is enabled only when you
select the User Defined color scheme.

Click the Default button to return the eye diagram coloration to the Temperature Grading color scheme,
which is the default color scheme.

Click the Invert Colors button to swap the colors that indicate the highest and lowest sample density.

Related Topics
iVerify Properties Dialog Box

About Data Tab

iVerify Window Tab
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iVerify Statistical Analysis Dialog Box

Overview
The iVerify Statistical Analysis dialog box displays information regarding measurements that you
performed. This dialog box numerically represents the contents of the measurement data contained in the
iVerify window.

You can select the measurements to be performed from the toolbar of the iVerify window or by selecting
Data > Measurements from the iVerify menu bar.

Behavior
The iVerify Statistical Analysis dialog box content is read-only information. You can save the statistics to
a text file by clicking the Save As button and then saving the file in a desired location.

Related Topics
iVerify Window

iVerify Properties Dialog Box
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iVerify Setup Dialog Box: Analysis Configuration Tab
Overview

Use the Analysis tab to select the necessary settings for the
external oscilloscope which will be used for analysis. This
tab allows you to set up the time and voltage settings, and
time limit for analysis.
Behavior

The Horizontal Range group box contains Min and Max
controls that you set to affect the frequency horizontal scale
parameters in the external oscilloscope.

The values that you enter in the Min and Max fields are rounded as necessary to the closest horizontal
scale, which is between -40s and 40s.

The Horizontal Range group box contains a read-only Resolution box that internally calculates and
displays the horizontal resolution for both the given number of clocks and horizontal scale.

The Vertical Range group box contains controls that affect the voltage range for the oscilloscope channels.
The Range box allows you to select from predefined voltage ranges for the external oscilloscope channels.
If you select the range setting of User Defined, you can then use the Min and Max controls to specify
the minimum and maximum voltage limits for the external oscilloscope. Otherwise, these controls are
read-only. The values that you enter in the Min and Max fields are rounded as necessary to the closest
vertical scale, which is between 5 V and -2.5 V.

The Approximate Stop Condition group box contains the After control, which allows you to limit the
time that the iVerify takes to perform analysis.

The Oscilloscope Acquisition Mode group box allows you to use the FastAcq acquisition mode of the
oscilloscope if it is available on the external oscilloscope.
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NOTE. You need to provide information in the Channels, Clock and Qualifier, and Analysis Configuration tabs before
viewing the Inter-Probing tab. This is because the optimum analog routing information contained in the Inter-Probing
tab depends upon the information contained in these tabs. If the setup that you have specified is physically invalid, an
error message appears.

Related Topics
iVerify Setup Dialog Box

iVerify Setup Dialog Box: Channel Tab

iVerify Setup Dialog Box: Clock/Qualifier Tab

iVerify Setup Dialog Box: Inter-Probing Tab
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iVerify Setup Dialog Box: Channel Tab
Overview

The Channels tab allows you to select both the channels
that you want to analyze and the channel data that will
display in the eye diagram, which is located in the iVerify
window.
Behavior

Use the Channels tab to list channels by group, by probe,
or by name. Then specify the groups or channels that you
want to analyze by selecting the check box associated with
each group or channel in the Analyze column.

To specify the groups or channels for which the analysis results will be displayed in the eye diagram, select
the check boxes associated with each group or channel in the Apply column. By default, when you select
an Analyze check box, the related Show check box is selected.

NOTE. You need to provide information in the Channels, Clock and Qualifier, and Analysis Configuration tabs before
viewing the Inter-Probing tab. This is because the optimum analog routing information contained in the Inter-Probing
tab depends upon the information contained in these tabs. If the setup that you have specified is physically invalid, an
error message displays.

Related Topics
iVerify Setup Dialog Box

iVerify Setup Dialog Box: Clock/Qualifier Tab

iVerify Setup Dialog Box: Analysis Configuration Tab

iVerify Setup Dialog Box: Inter-Probing Tab
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iVerify Setup Dialog Box: Clock/Qualifier Tab
Overview

Use the Clock and Qualifier tab to set up the clock channel
and qualifier channel and the edge that will be routed to the
oscilloscope for analysis. Any of the channels displayed can
be selected as a clock channel or qualifier.
Behavior

The Channels to be Used as Clock group box contains
a Select list which you use to arrange the channels that
display in the clock list.

If you choose By Probe, the clock list will display all channels regardless of whether they are part of
a group that is defined in the LA Setup window.

If you choose By Name, the clock list will display only the channels that have been assigned custom
names in the LA Setup window.

Select the reference clock edge by clicking the clock edge icon until it displays your preference: rising edge
or falling edge. Then select the channel to be used as a clock that is routed to the oscilloscope for analysis.

Select the Select Qualifier check box when you want to send a qualifier to the oscilloscope along with
the clock channel. When this check box is selected, the analysis of channels selected in the iVerify setup
occurs in the oscilloscope only if the qualifier is valid in the same timeframe.

The Channels to be Used as Qualifier functions similarly to the Channels to be Used as Clock group box.
Select the high or low condition of the qualifier by clicking the qualifier edge icon until it displays your
preference: high level or low level. Then select the channel to be used as a qualifier that is routed to
the oscilloscope for analysis.

NOTE. If you have a five-module setup, you cannot select any status bits.
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NOTE. You need to provide information in the Channels, Clock and Qualifier, and Analysis Configuration tabs before
viewing the Inter-Probing tab. This is because the optimum analog routing information contained in the Inter-Probing
tab depends upon the information contained in these tabs. If the setup that you have specified is physically invalid, an
error message appears.

iVerify Setup Dialog Box

iVerify Setup Dialog Box: Channel Tab

iVerify Setup Dialog Box: Analysis Configuration Tab

iVerify Setup Dialog Box: Inter-Probing Tab
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iVerify Setup Dialog Box: Inter-Probing Tab

Overview

The Inter-Probing tab displays optimum analog routing
information that you make between the logic analyzer and
external oscilloscope to achieve analysis results for the
selected channels. The logic analyzer modules that are
displayed on this tab depend upon the channel selections
that you made in the Channels tab of the iVerify Setup
dialog box.

Behavior
The Inter-Probing tab is a read-only tab.

NOTE. You need to provide information in the Channels, Clock and Qualifier, and Analysis Configuration tabs before
viewing the Inter-Probing tab. This is because the optimum analog routing information contained in the Inter-Probing
tab depends upon the information contained in these tabs. If the setup that you have specified is physically invalid, an
error message appears.

Related Topics
iVerify Setup Dialog Box

iVerify Setup Dialog Box: Channel Tab

iVerify Setup Dialog Box: Clock/Qualifier Tab

iVerify Setup Dialog Box: Analysis Configuration Tab
Analysis Tools . . . . . Analysis Tools . . . . .
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Microprocessor Support

Microprocessor and Bus Support Package Basic Operation
Microprocessor and bus support packages are used to disassemble data from microprocessor and bus based
systems. For information on a specific support package, refer to the documentation that came with the
support package.

The support can be used to perform timing analysis.

To acquire and display timing data, you need to change the clocking selection and trigger program. The
support includes a saved system setup file to view data in a Waveform window.

Related Topics
Clocking

LA module Trigger Window

. . iVerify Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Load Support Package
Loads the selected support package onto the selected logic analyzer module. The destination module must
have sufficient channel width for the support package to load.

From the File menu, click Load Support Package.
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Channel Group Definitions for Microprocessor and Bus Support
Each support package contains channel group definitions. Many supports have channel groups defined for:
Address, Data, and Control signals, and additional groups defined for other signals. If you want to know
which signal is in what group, refer to the channel assignment tables in the support instruction manual.
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Microprocessor and Bus Support Package Triggering
All the Trigger window selections available with your instrument are also available with the support
package. However, if the support package displays exception cycle types, the cycle types are computed
and cannot be used to control triggering.

A control group symbol table, which includes special symbols for triggering, is supplied with many
support packages.

You can trigger on pattern or range symbol values. However, only the = and Is Not operators in the Clause
definition dialog box can use pattern symbol values. All operators can use range symbol values.
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Disassembly Display Formats
Four different display formats offer optional selections to modify the way disassembled data is displayed.
This makes it easier to analyze data.

The display formats are: Hardware, Software, Control Flow, and Subroutine. Other display options may
be available depending on your support package.

To select a disassembly display format:

1. Open a Listing window.

2. From the View menu select Properties.

3. Click the Disassembly tab.

4. Go to the Show box and select the display format.

. . iVerify Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Saved System Timing Format File
In the Waveform window, every channel shows as a waveform, and channel groups show as busforms.

The support package includes a saved system setup file that you can use to view data in the Waveform
window. To load this file, do the following:

1. Go to the File menu and select Load System.

2. Click Browse.

3. Move through the directory structure as follows:

C:\Program files\TLA700\Supports\(support package folder)\timing.tla

4. Click Yes or No to indicate whether or not you want to save your current system.

NOTE. A message may appear stating that the configuration of the file does not match your configuration. Click OK
and follow the directions in the Load System Options dialog box, or click Help in the dialog box for more information.

5. Click the waveform data icon after it appears in the System window to view the timing file.
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Custom Clocking Dialog Box
Use to select clocking options associated with the current support package. The available selections
vary with each support package. For details on the clocking options, refer to the documentation shipped
with your support package.
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Clocking Problems
If you have clocking problems check the following:

A clock is available. Click Status in the toolbar to open the Status Monitor and verify that a clock is
available. If no clock is available, check your clocking connections.

The system under test is powered on and running. Verify the system is not halted.

Custom is the clock selection in the Setup window.

Connections between the acquisition module and the probe adapter are correct. Open the Activity
dialog box.

The clock and probe connections between the interface housings and probe adapter are correct (module
name, clock, section names, and channel numbers match), are properly oriented, and are fully engaged.

The connections between the interface housings and acquisition module probe cables have matched color
labels, matched slot numbers, and are properly keyed.

The connections between the acquisition module probe cables and probe connectors have matched color
labels, matched slot numbers, and are properly keyed.

The configuration of jumpers or switches on the probe adapter is correct. Refer to the support product
instruction manual for configuration information.

If the previous suggestions do not fix the problem try the following:

Reload the support package to restore the instrument to a default state.

If there are loading problems, remove one or more of the protective sockets from the probe adapter. These
sockets might add enough additional capacitance or delay to your system under test to affect it.

If the instrument is still not performing correctly after trying these solutions, there might be a problem
with your system under test. Perform timing analysis on your system to ensure the signals are valid
when the probe adapter samples them.
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Incorrect Data
If the data acquired is obviously incorrect, check that:

The correct support application is loaded into the system.

If the microprocessor has an internal instruction cache, you should disable it. The support product
instruction manual contains information on when and how to disable the instruction cache.

Custom clocking is selected in the Setup menu.

The connections between the acquisition module and the probe adapter are correct:

The clock and 17-channel probe connections between the interface housings and probe adapter are
correct (module name, clock, section names, and channel numbers match), are properly oriented,
and are fully engaged.

The connections between the interface housings and acquisition module probe cables have matched
slot numbers, and are properly keyed.

The connections between the acquisition module probe cables and probe connectors have matched
slot numbers, and are properly keyed.

The configuration of jumpers or switches on the probe adapter is correct. Refer to the support product
instruction manual for configuration information.

If the previous suggestions do not fix the problem, try reloading the support package to restore the
instrument to a known state.
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Troubleshooting/Diagnostics

Extended Diagnostics Properties
Use to run extended diagnostics for the following purposes:

Incoming inspection. Run these diagnostics when first receiving this instrument.

Functional procedure. Run these diagnostics after the instrument or module has been repaired.

Suspected problem. Run these diagnostics if you think your instrument is not performing correctly.

NOTE. Disconnect all probes from the instrument before running the diagnostics.

Test Name
This column has an indented hierarchical structure.

All Modules, All Tests – Runs all tests in the list.

TLA700 System – Selects all mainframe tests.

Last Result
This column shows the pass or fail result of the most recent test. When a test is running, the word
"Running" displays until the test is complete and results show. When a series of tests is running and
an individual test is complete, results are displayed and the next test is executed. The result Unknown
indicates that a particular test is in question. Run the diagnostic again. If Unknown appears again, contact
your local Tektronix service representative.

Fail Count
This column shows the number of times a test has failed since the RUN button on this page was clicked.
This count is mainly used when the run mode is set to Continuous. One Time and Until Fail run modes
always display a count of one. All values are cleared when you click the RUN button.

Contact Technical Support for questions regarding diagnostic test results.

To Use
To open the Extended diagnostics tab from the System menu, click Calibration and Diagnostics and then
click Extended Diagnostics.

Related Topics
Running Extended Diagnostics

Running Mainframe Diagnostics
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Troubleshooting Triggering

Overview
If the logic analyzer does not trigger, you should check the following:

Check that your target system is powered on.

Check the System window to verify that required modules are turned on.

If the module has correctly clocked data, acquired the specified events, triggered, but has not stopped,
the module probably has not acquired enough additional data to fill acquisition memory. Click Stop to
manually stop the acquisition, and then change the Module Memory Depth (reduce) or Trigger Position
(increase).

LA Triggering
The following conditions apply to the logic analyzer only:

Check the Status Monitor for an external clock warning. If the logic analyzer does not receive an
external clock, the Status Monitor displays the following message: External Clock Source Idle.

Check for signal activity at the probe tip. If there is no activity, check the probe connections.

Check the clock signal to ensure that the logic analyzer actually receives clock data. Problems with
the clock signal can impact setups using external clocking, custom clocking (microprocessor support
packages only), or storage qualification.

Similar to the previous item, check clock qualifier signals and clocking equations.

Check the threshold voltages for probes and clocks.

If the logic analyzer is correctly clocking data and the data events have occurred, but the trigger
program did not generate a trigger, check the trigger program itself. The trigger program might not be
reaching the state that generates the trigger. Use the Status Monitor to track trigger program progress
and identify the state in which trigger progress stops.

Check the complexity of your trigger program. If your trigger program is too narrowly defined,
or over-specified, the trigger program might not acquire the desired data or might not trigger. A
less-specific trigger program might acquire the desired data and also verify that you have set up the
proper clocking and threshold levels.

Oscilloscope Triggering
The following condition applies to the oscilloscope module only:

Check the trigger Mode setting. If Mode is set to Normal, and the data does not meet the trigger
conditions, the module will not trigger. (Conversely, if Mode is set to Auto, the module will trigger
after a set length of time, even if the specified data does not occur.)
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Arming or Intermodule Triggering
The following conditions apply only if you are using arming or intermodule triggering:

Internal signal logic function. If your trigger depends on setting an internal signal, and that signal has
been set to Wired-And, all modules in the system must set the signal or it cannot assert.

If any modules are turned off, check that the trigger program is not waiting for input from an inactive
module.

First Transition Indication Problems
Because the logic analyzer does not clear the first transition indication, check that the modules always
show a first transition indication (even if there are no probes attached).

To avoid triggering on a false first transition indication, set the first state to " If Anything, Go to Next
State." This will use a state, but it ensures that you do not trigger on a false transition indication.

Related Topic
Troubleshooting LA Power Trigger Programs
Reference
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Application Overview

TLA Application Overview
The logic analyzer user interface is a Windows-based application. Most of the tools and menus are
very similar to a Microsoft Windows PC. If you are unfamiliar with Windows, refer to the Windows
documentation.

The following topics provide an overview of how to use the TLA logic analyzer application. Click one of
the links to continue.

Window Overview

Where to Go Next

Microsoft Windows
The user interface operates under the Microsoft Windows XP Proffessional operating system.
Microsoft recommends the following to ensure that your instrument is protected when working in
an networked environment:

Use an internet firewall

Install operating system updates regularly

Use up-to-date antivirus software
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Window Overview
The Tektronix Logic Analyzer (TLA) application uses multiple windows to accomplish key tasks. Each
logic analyzers may have one or more hardware modules. Typically, you use the hardware modules and
the application windows in the following order:

Select the hardware module.

Use the Setup window configure the hardware modules:

Define the clocking.

Establish the acquisition options.

Define the probe or channel setups.

Use the Trigger window to define the trigger requirements (to capture the data of interest):

Use the Easy Trigger tab to use predefined trigger programs to capture the data of interest.

Use the Power Trigger tab to define custom trigger programs to capture the data of interest.

Press the Run button to acquire data.

View and analyze the acquired data in the Listing, Waveform, or other data window.
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Where to Go Next
Click one of the following buttons for detailed information on the key windows of the logic analyzer:

System Window

LA Setup Window

LA Trigger Window

Listing Window

Waveform Window

Histogram Window

Source Window

Other Recommended Topics
MagniVu Data

Microprocessor Support Package Indicator

You may also want to review the TLA Quick Start User Manual to step through the windows for typical
logic analyzer applications. The TLA Quick Start User Manual is available on the documentation browser
on this instrument, on the TLA Product Documentation CD, or downloadable from the Tektronix Web site.
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Symbol Files

Symbol Files

Overview
Symbol files are files of alphanumeric symbol names and associated data values. Symbol files are used to
map a channel group’s value to a text string and/or color. For example, a symbol file could map an address
group value to a function name. This is faster and easier to interpret than a numeric value.

Behavior
The logic analyzer uses two kinds of symbol files: Pattern Symbol Files and Range symbol files. The range
symbol files can contain Function Symbols, Variable Symbols, Source Code Symbols, and Color Symbols.
The following table shows the types of symbol files and the windows in which they are commonly used.

Range symbol filesWindow Pattern
symbol
files

Functions Variables Source code Color

Listing Yes Yes Yes Yes Yes
Waveform Yes Yes Yes Yes Yes
Histogram No Yes Yes No No
Source No No No Yes No
Trigger Yes Yes Yes Yes No

Often, the application software will define symbols for you. For example, when you load a microprocessor
support package, a symbol file is also loaded (typically, to the control group). These symbols represent
data values that correspond to bus cycle types.

Symbol files work like look-up tables. For example, if the address of a printer I/O port is F734BC, you can
define a pattern symbol, printer-port, corresponding to that value for use in the Trigger window. Then, in
the If/Then Clause dialog box, you can specify the symbol name as the word recognizer value and cause
the module to trigger when printer-port (F734BC) appears on the address bus. You can also specify
symbolic display radix for the address channel group and the symbol name printer-port will be displayed
in the Listing window every time F734BC appears on the address bus.
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Symbol Value Width

Overview
Symbol values are limited to a width of 32 bits. If your application uses channel groups wider than 32
bits (for example, in the Trigger window), you could experience some unexpected results when using
symbols with those channel groups.

Behavior
For triggering purposes, if the symbols are wider than 32 bits, zeros are added to the most-significant bits.
In pattern symbols, don’t cares (Xs) are added to the most significant bits. Refer to the tables below for
examples on how the Trigger window handles symbols wider than 32 bits.

Pattern example Value Symbol
32-bit example FFFFAB23 IO-3
40-bit example (32-bit with padding
for most-significant bits)

XXFFFFAB23 IO-3

Range example Lower bound Upper bound Symbol
32-bit example FFFF0055 FFFFAC00 Sym 12
40-bit example (32-bit with
padding for most-significant
bits)

00FFFF0055 00FFFFAC00 Sym 12
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Range Symbol Files

Overview
Range symbols define a range of 32-bit addresses represented by a contiguous set of integers, marked by
specific lower and upper bounds. The types of range symbols are: Function Symbols, Variable Symbols,
Source Code Symbols (source), and Color Symbols.

Behavior
The various range symbols may overlap each other. When overlaps occur, and the logic analyzer needs
to convert a numeric value to a symbol, it may need to choose between the symbols. The logic analyzer
assigns a preference order to symbol types with function symbols having the highest precedence, followed
by variable symbols, and then source symbols. Color symbols are looked up separately and may overlap
with any of the other types.

Most TLA applications will typically not display source symbols when function symbols are present
because of the preference rule (source symbols are covered or overlapped by function symbols). There
may be situations when you prefer the source symbols. You can then use the Load Symbols Options dialog
box to specify that function symbols should not be read when loading the symbol files.
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Pattern Symbol Files
Pattern symbols consist of data patterns of up to 32 bits. Each bit in a pattern symbol can be 0, 1, or X
(don’t care). Pattern symbols are used when a group of signals define a logical state. Each pattern symbol
may also have a color associated with it.

For example, a microprocessor has a set of pins that indicate the type of bus cycle in progress. A
memory-read cycle is indicated when the RD~ and MREQ~ pins are 0 (logic low) and the BUSAK~ and
M1~ pins are 1 (logic high).

You can define a pattern symbol name called mem-read that corresponds to bit pattern 1100 and mark all
memory read bus cycles in the Listing window. For other bus cycles the logic state of these pins is also
important and you can define different bit patterns for each cycle type.
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Function Range Symbols

Overview
Function range symbols define the beginning and ending addresses where instructions that implement a
function (subroutine) are located in memory.

Functions are composed of multiple source statements. The address range of a function symbol can overlap
a set of ranges defined by one or more source symbols. A partial range file with functions is shown below:

#+ Function

# Symbol Name Low High

# ============================== ======== ========

displayBanner 006035ba 00603675

buildMenus 00603676 006036e5

displayLCDmenu 006036e6 0060372f

Behavior
The first line tells the file reader that the following symbols represent functions.

The next two lines are comments used as headers.

The symbol name can contain up to 220 ASCII characters. However, the file name may be truncated when
displayed. To include embedded spaces in the symbol name, enclose the symbol name in double quotes.

The Low and High columns describe the lower and upper bounds. The bounds are expressed as 32-bit
values; the radix is specified in the header. The bounds are inclusive; the specified range includes both
bound values, as well as all values between the bounds.
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Variable Range Symbols

Overview
Variable range symbols define the beginning and ending addresses where the value of a variable is located
in memory. Variable symbols can also be overlapped by either function or source symbols. A partial
range file with variables is shown below:

#+ Variable

# Symbol Name Low High

# ============================== ======== ========

menu 00000100 00000102

userMenu1 000004c0 000004c2

binBits 000004d4 000004d6

Behavior
The first line tells the file reader that the following symbols represent variables. If this line is not included,
the file reader will assume that the symbols represent functions rather than variables.

The next two lines are comments used as headers.

The symbol name can contain up to 220 ASCII characters; however, the file name may be truncated when
displayed. To include embedded spaces in the symbol name, enclose the symbol name in double quotes.

The Low and High columns describe the lower and upper bounds. The bounds are expressed as 32-bit
values; the radix is specified in the header. The bounds are inclusive; the specified range includes both
bound values, as well as all values between the bounds. If the variable is a single byte in memory, the
lower and upper bound values are equal.

. . Symbol Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Source Range Symbols

Overview
Source symbols are similar to function range symbols, except that the address range for a source symbol
describes the location of the instructions that implement only one source statement. Source symbols also
contain the following information that defines the location of the source code associated with a symbol:

Source file name

Source line number

An optional column range
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A partial range file with source symbols is shown below:

#+ Source stoplite

# Line Low High Beg End Symbol Name

# ==== ======== ======== === === ===========

27 006043ec 006043ef 0 25 # stoplite_27_25

35 006043f0 006043f5 0 23 # stoplite_35_23

47 006043f6 006043ff 0 30 # stoplite_47_30

48 00604400 00604409 0 30 # stoplite_48_30

49 0060430a 00604413 0 30 # stoplite_49_30

50 00604414 0060441d 0 30 # stoplite_50_30

51 0060441e 00604427 0 30 # stoplite_51_30

Behavior
The first line tells the file reader that the following symbols represent source code. The first line also
specifies the name of the source file (stoplite). If this line is not included, the file reader will assume that
the symbols represent functions rather than variables and source symbols. Each set of symbols for a unique
source file must be introduced with an initial source directive to specify the file name for the symbols.

The next two lines are comments used as headers.

The line number specifies the line of the source file containing the source statement. Line numbers are
always expressed in decimal.

The Low and High columns describe the lower and upper bounds. The bounds represent the range of
addresses occupied by the instructions that implement a single source code statement. The radix of the
bound is defined in the file header. The value of the bounds can range from 0x00000000 to 0xFFFFFFFF.
The bounds are inclusive; the specified range includes both bound values, as well as all addresses between
the bounds. If the source symbol is a single byte in memory, the lower and upper bound values are equal.

The Beg and End columns are optional. When present, they define the beginning and ending column
position for the source statement. This makes it possible to define the exact location of the statement
on the line.

The symbol name appears as a comment at the end of the line. The file reader ignores the symbol name
because it is a comment. When the logic analyzer exports range symbol files, the symbol name is a
concatenation of the symbol file name, line number, and column number (if present). This is the symbol
value that the logic analyzer displays for addresses that fall within the lower and upper bound for a
source file.
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Symbols
Symbols simplify tasks, such as setting up triggers or identifying specific values within the data. When
you program a trigger or view data, it is cumbersome to remember which numeric channel group values
correspond to particular machine instructions or code modules. The logic analyzer makes this task more
manageable by allowing you to assign symbolic names or mnemonics to group values.

For example, assign the symbol WRITE to the control bus event that causes the target system to write to
a memory location. Then, if you want to trigger when a write cycle occurs, enter WRITE in the trigger
program in place of the actual data value. You can also choose to have WRITE appear in the Listing
window for quick identification of the instruction.
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Symbols Dialog Box

Overview
Use the Symbols dialog box to provide an overview of all currently loaded symbol files. With this dialog
box you can:

Display symbol status and content information of currently loaded symbol files

Load symbol files

Reload symbol files

Unload symbol files

Export symbol files

Status Information
The following status information is available for each currently loaded symbol file:

Last Loaded - Describes the last time the file was loaded into the TLA application software. It also
includes error and warning messages associated with the last load.

File Modified - Displays the time the file was last modified. It also displays a message if the file might
need to be reloaded (such as when the file is modified after it was first loaded).

Format Loaded - Displays the format of the loaded file.

Can Be Unloaded - Describes if the file can be unloaded or if the file is currently in use. Symbol files
can only be unloaded if no data windows or setups are using them.

Content Information
The following content information is displayed:
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Symbol Type - Shows whether the file is a pattern symbol file or a range symbol file. If the file is a
range file, this field also lists the types of symbols loaded.

Total Symbols - Shows the number of symbols loaded from the file.

Total Source Files - Lists the number of source files referenced by source code symbols loaded from
the file.

Range - Lists the minimum and maximum address values and offset information.

Behavior
Click Load to load a new symbol file. You do not need to load all symbol files with the Symbols dialog
box. Symbol files can be loaded through other windows. You can also display information on all symbol
files currently used by the logic analyzer by selecting any loaded symbol file.

NOTE. When you load a symbol file, the symbols are placed in memory. Because symbol files consume memory, you
should unload unused symbol files to keep memory available for your main application.

Click Unload to unload a symbol file from the application software.

NOTE. The Unload button is inactive when the loaded symbol file is in use.

Click Export to save the current file as a TSF-format symbol file. You can view the exported symbol file
with applications such as Wordpad. You can then edit the symbol file by saving it under a new name and
using a text editor, such as Wordpad, to make any changes. Save the edited file in ASCII format. You
can then load the edited symbol file.

To Use
To open the Symbols dialog box from the System menu, click Symbols.

Related Topic
Load Symbols Options Dialog Box
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Load Symbols Options Dialog Box

Overview
Use the Load Symbols Options dialog box to specify options for range symbol files before loading them
into the system. You can specify any of the following symbol file formats (check with your Tektronix
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representative for a complete listing of available formats): OMF51, OMF86, OMF166, OMF286/386,
COFF, IEEE695, and ELF/DWARF or ELF/STAB.

In addition to the above formats, you can also use the Tektronix Symbol file Format if your code generation
tools do not operate on any of the listed formats.

Behavior
Select one or more of the symbol types to load. If you want to use the symbol file with the Source window,
be sure to include the Source Code as the symbol type.

The Bound 1 and Bound 2 fields define the range of symbol addresses that will be loaded. You can enter
any hexadecimal values from 0 through FFFFFFFF. Values outside of these limits are ignored.

NOTE. If the lower bound of an overlapping range symbol is within the Bound 1 and Bound 2 limits and the higher
bound is not, the entire symbol will be valid. However, if the higher bound is within the Bound 1 and Bound 2 limits and
the lower bound is not, the entire symbol will be ignored.

Select either Default Offset or Custom Offset to apply an offset to the symbol values. If you select Default
Offset, the default offset is read from the source file and applied to each symbol in the file. If you select
Custom Offset, you can add or subtract the specified offset value to each symbol in the file as it is loaded.
You can choose any 32-bit hexadecimal value from 0 to FFFFFFFF.

When you enter bound values, enter the values without an offset value. If your application adds an offset,
you must subtract the offset value before you enter the bound values.

To Use
To open the Load Symbols Options dialog box from the System menu, click Symbols and then click the
Load button. Then select a symbol file and click Options.

Related Topic
Symbol Files

OMF51 File Format
This format holds symbolic information and executable images for an 8051 or equivalent
microprocessor.

OMF86 File Format
This format holds symbolic information and executable images for an 8086 or equivalent
microprocessor. It is also used for code intended to run on 80286, 80386, or higher-level
microprocessors in real or 8086-compatible mode.
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OMF166 File Format
This format holds symbolic information and executable images for the Siemens (Infinion) C166 or
microprocessor family, or compatible microprocessor.

OMF80286 and OMF80386 File Formats
These formats hold symbolic information and executable images for 80286, 80386, or equivalent
microprocessors. They are also used for executable images intended to run on the 8086 or other
microprocessors in the 80x86 families.

COFF File Format
The Common Object File Format (COFF) contains a number of variations and extensions, such as
ECOFF, XCOFF, and COFF2.

This flexibility enables the file format to be used with a wide variety of different microprocessors.
Some code-generation tool vendors also extend this format in nonstandard ways that may make their
files unreadable by Tektronix Logic Analyzers.

IEEE695 File Format
This object file format refers to the IEEE695 specification. This format is used primarily by compilers
for a wide variety of Motorola microprocessors, as well as Motorola-compatible microprocessors
from other vendors. This format provides for the inclusion of column information in source symbols,
but not all compilers use this capability.

ELF/DWARF and ELF/STABS File Formats
Elf is an object file format used primarily with PowerPC microprocessors. The Dwarf 1, Dwarf 2 and
Stabs names refer to the format of the portion of an Elf file that contains debug information. This
format provides for the inclusion of column information in source symbols, but not all compilers use
this capability.

NOTE. Although Dwarf 1 and Dwarf 2 debug formats are able to support symbol values in excess of 32 bit
resolution, the Logic Analyzer will use only the least significant 32 bits. The logic analyzer will issue a warning if
any symbols exceeding 32 bits in size are encountered while loading the symbol file.

467



Reference Exporting Symbol Tables

. . Symbol Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Exporting Symbol Tables
Use this export dialog box to export symbol tables in the TSF format. The TSF format is ASCII, which
makes it more suitable for display and modification. The exported file can also be reloaded if desired.

Related Topic
Symbols Dialog Box
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TLA Symbol File Format Overview
The logic analyzer can extract range symbol information directly from object files.

Users whose code generation tools do not generate some file formats can use TLA Symbol File (TSF)
format (a text format). The logic analyzer uses the TSF format when it exports symbol files. The logic
analyzer can also read files in this format.

TLA symbol files consist of alphanumeric symbol names and associated data values. The files contain a
header line and lines defining the symbol names and values. Fields on a line are separated with white space
(blank spaces or tabs). The formats for the pattern symbol files and the various range symbol files differ; if
you need to use pattern symbols and range symbols, use separate files.

Both TLA range and pattern symbol files have a .tsf file name extension (filename.tsf).

The first few lines of a TSF symbol file are typically comment lines describing when and how the file was
generated.

# TLA Symbol File

# Created on Friday, May 29, 1998 at 09:52:03

# From file: "c :\quickstart\tla7qs.x"

All lines in a TSF file that begin with a number sign (#) character are treated as comments, unless the very
next character is a plus sign (+). The plus sign signifies a file reader directive. The number sign character
can also initiate a comment on the end of a symbol definition or other uncommented lines. All text between
the number sign and the end of the line is treated as a comment and ignored.

Related Topics
TLA Symbol File Format - TSF Headers

TLA Symbol File Format - TSF Pattern Symbols

TLA Symbol File Format - TSF Range Symbols
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TLA Symbol File Format - TSF Headers
A TSF header identifies the file format version to potential file readers. It specifies whether the file contains
pattern or range symbols, the radix used to specify symbol values, and an optional offset amount to be
added to each symbol value (for range symbol files).

The TSF Header is a file directive, which means that the following information begins with the special
character combination of a number sign character followed immediately by a plus sign (#+). This is not
a comment line. The special character sequence is used to mark instructions to the file reader; these
instructions are called file directives.

The following examples show sample file headers for a pattern symbol file and a range symbol file. The
first two lines are comments included for readability; they are not required as part of the file header.

# TSF Format Type Display Radix File Radix

# =============== ======= ============= ==========

#+ Version 2.1.0 PATTERN HEX HEX

# TSF Format Type Display Radix File Radix Offset

# =============== ===== ============= ========== ========

#+ Version 2.1.0 RANGE HEX HEX 00000000

The File Format Version number contains three fields. The first two fields are the format major and minor
version numbers. The logic analyzer will only read TSF files where the major and minor version number
of the file is less than or equal to that of the TLA TSF symbol file reader. The third field denotes minor
format changes, which do not impact the file reader.

The File Format Version number is followed by a key word, PATTERN or RANGE, which signifies the
type of symbols found in the file. TSF files can contain either type of symbols, but no single file can
contain both. The header specifies the type for all symbols in the file.

The Display Radix field sets the default radix that will be used to display the numeric symbol value. For
range symbol files, this field must be one of the key words: HEX, DEC, OCT, or BIN. For pattern symbol
files, only the key words HEX, OCT, or BIN are allowed.

The File Radix field specifies the radix used by the symbol values in this file. Like the Display Radix
field, the File Radix field must be one of the key words: HEX, DEC, OCT, or BIN for range symbol files,
or HEX, OCT, or BIN for pattern symbol files.

The Offset field specifies an offset value and is applicable only to range symbol files. The offset value is
specified in the radix indicated by the File Radix field. This offset value will be added to the lower and
upper bounds of each range symbol that is read from the file. The offset is a 32-bit value, so it can have
any value between 0x00000000 and 0xFFFFFFFF. If the sum of the offset and a range symbol bound value
exceeds the 32-bit limit of 0xFFFFFFFF, the overflow bit is discarded. Negative offsets are specified
by using a twos complement value for the offset.
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Related Topics
TLA Symbol File Format Overview

TLA Symbol File Format - TSF Pattern Symbols

TLA Symbol File Format - TSF Range Symbols
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TLA Symbol File Format - TSF Pattern Symbols
Each pattern symbol in a TSF pattern file consists of two fields. The first field is the symbol name, and
the second is the symbol pattern. The symbol name is a sequence of ASCII characters of up to 220
characters in length, although it is impractical to display symbol values much longer than 32 characters.
Symbol names longer than 220 characters will be truncated during loading. The characters in a symbol
name can be any character with an ASCII value between 0x21 (the exclamation point character, !) and
0x7E (the tilde character, ~). You can use symbol names with embedded spaces by enclosing the Symbol
Name in double quotes.

# Symbol Symbol Optional Foreground

# Name Pattern and Background Color

# ====== ======== ====================

NUL X0000000

SOH X0000001 @red @yellow

STX X0000010

"ETX 0x03" X0000011

The symbol pattern consists of numerals in the radix specified by the File Radix field in the header, and Xs
signifying don’t-care values. The number of bits represented by each character position in the pattern
depends on the selected radix. For a HEX radix, each character represents 4 bits. For an OCT radix, each
character represents 3 bits; for a BIN radix, each character represents one bit.

Symbol order in a TSF pattern file is important. When selecting the symbol to display for a particular
value, the logic analyzer scans the list of pattern symbols from top to bottom. It selects the first symbol for
which all non-don’t-care bits of the symbol match the corresponding bits of the target symbol.

Related Topics
TLA Symbol File Format Overview

TLA Symbol File Format - TSF Headers

TLA Symbol File Format - TSF Range Symbols
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TLA Symbol File Format - TSF Range Symbols
There are four different types of range symbols:

Function

Variable

Source

Color

Each of these types define a range of 32-bit addresses associated with some entity.

Function range symbols define the beginning and ending addresses where instructions that implement a
function are located in memory.

Variable range symbols define the beginning and ending addresses where the value of a variable is located
in memory.

Source range symbols are similar to function range symbols, except that the address range for a source
symbol describes the location of the instructions that implement just one source statement. (Source
symbols also contain file name, line number, and an optional column range that define the location of the
source code associated with the symbol.)

Color range symbols define a display color for any value that falls within a range.

Each of the types of range symbols appears in a separate section of the file. Each section begins with a file
directive indicating the type of symbols that follow. The sections may appear in any order, and can be
broken up and separated by other sections if necessary.

The first section might be variables, followed by functions, then followed by another variable section.
Each section is also optional, however some logic analyzer applications are will not use the symbol file
if the appropriate type of symbols are not present. For example, the source window will only correlate
with a listing window if the symbol file contains source symbols.

Range symbol names follow the same rules as pattern symbol names. The symbol name is a sequence
of ASCII characters of up to 220 characters in length, even though it is impractical to display symbol
values much longer than 32 characters.

Symbol names longer than 220 characters will be truncated during loading. The characters in a symbol
name can be any character with an ASCII value between 0x21 (the exclamation point character, !) and
0x7E (the tilde character, ~). You can use symbol names with embedded spaces by enclosing the Symbol
Name in double quotes.

Range symbol address ranges can overlap. This overlap sometimes produces unexpected results. When
overlaps occur, and the logic analyzer needs to convert a numeric value to a symbol, it must choose
between the overlapping symbols. When choosing between overlapping symbols, the logic analyzer
assigns a precedence order to the symbol types. Function symbols have the highest precedence, followed
by variable symbols, and then source symbols.
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Related Topics
TLA Symbol File Format Overview

TLA Symbol File Format - TSF Headers
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TSF Range Symbols - Color
Color range symbols define the beginning and ending group values where a color is displayed. Any
group value in the acquisition falling within this range will be shown in the defined color. The value
range of a color symbol can overlap with the set of ranges defined by one or more Function, Variable,
or Source symbols. In many instances, a Color symbol will use exactly the same range bounds as a
Function or Variable symbol.

A partial range file with colors is shown below:

#+ Color

# Color Low High

# ============================== ======== ========

@magenta 006035ba 00603640

@yellow @navy 00603541 00603675

@default @green 006036e6 0060372f

The first line tells the file reader that the following symbols represent colors. The next two lines are
comments used as headers. The first color name specifies the foreground color, and the second optional
color name specifies the background color. The available color names (keywords) are:

@black, @blue, @cyan, @lime, @magenta, @red, @yellow, @white, @navy, @teal,

@green, @purple, @maroon, @olive, @gray, and @silver.

The special color name@default gives the default text coloring specified by choosing a color in the Column
tab of the Listing Window Property Sheet or the Waveform tab of the Waveform Window Property Sheet.

The Low and High columns describe the lower and upper bounds. The bounds are expressed as 32-bit
values; the radix is specified in the header. The bounds are inclusive; the specified range includes both
bound values, as well as all values between the bounds.

There is a different TSF symbol file syntax for adding color to range and pattern symbol files. For pattern
symbol files, color is an attribute of existing pattern symbols. It is placed on the same line as the rest of the
symbol, and to the right of the pattern definition. For range symbol files, color symbols are added in a
separate section of the symbol file, just like Function, Variable, and Source symbols. This allows the color
information to be independent of the other defined range symbols.

A partial TSF Pattern Symbols file is shown below:

# Symbol Name Pattern Color
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# ============== ========= ============

NUL X000 0000

SOH X000 0001 @blue

STX X000 0010 @white @red

SBZ X000 0100 @default @teal

Each Pattern symbol in a TSF Pattern file consists of three fields. The first field is the Symbol Name, the
second is the Symbol Pattern, and the third is Symbol Color.

The Symbol Color specification may contain zero, one, or two color keywords. If only one color is
given, it specifies the foreground color of the data. If two colors are given, they specify the foreground
color followed by the background color.

To supply a background color, you must give a foreground color. If you want to use the group’s defined
color from the Column or Waveform Property Page, you can use @default as the foreground color.

In addition to specifying the colors by name, you can also specify the color symbols using the RGB
hexadecimal format. For example the earlier example of the partial range file with colors is shown below
using the RGB format:

#+ Color

# Color Low High

# ============================== ======== ========

@FF00FF 006035ba 00603640

@FFFF00 @000080 00603541 00603675

@default @008000 006036e6 0060372f

Similarly the partial TSF Pattern Symbols file using RGB is shown below:

# Symbol Name Pattern Color

# ============== ========= ============

NUL X000 0000

SOH X000 0001 @0000FF

STX X000 0010 @ FFFFFF @FF0000

SBZ X000 0100 @default @008080

Related Topics
TLA Symbol File Format - TSF Range Symbols

TSF Range Symbols - Function

TSF Range Symbols - Variable

TSF Range Symbols - Color
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TSF Range Symbols - Function
The file directive "#+ Function" introduces the function symbol section of a TSF Range file. The file
directive tells the file reader that the following symbols represent functions, as opposed to variables or
source statements. If no symbol type file directive is given, the function symbol type is assumed.

#+ Function

# Symbol Name Low High

# ============================== ======== ========

displayBanner 006035ba 00603675

buildMenus 00603676 006036e5

displayLCDmenu 006036e6 0060372f

Function symbols consist of three fields: the symbol name, the lower bound, and the upper bound.

The lower and upper bound values are each 32-bit values, defined by numerals in the radix specified by the
File Radix field in the file header. These values define the lower and upper limits of the range of addresses
occupied by the instructions that implement a function. Both values are inclusive, which means that the
specified range includes both of the bound values, as well as all of the addresses between them.

Related Topics
TLA Symbol File Format - TSF Range Symbols

TSF Range Symbols - Variable

TSF Range Symbols - Source

TSF Range Symbols - Color
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TSF Range Symbols - Source
The file directive "#+ Source" introduces the source symbol section of a TSF range file. The file directive
tells the file reader that the following symbols represent source statements, as opposed to functions or
variables. The source file directive must be followed by a file name, which specifies the name of the source
file containing the following source statements. Each new set of symbols for a unique source file must
be introduced with an additional source file directive to specify the file name for those symbols. If no
symbol type file directive is given, the function symbol type is assumed.

#+ Source stoplite

# Line Low High Beg End Symbol Name

# ==== ======== ======== === === ===========
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27 006043ec 006043ef 0 25 # stoplite_27_25

35 006043f0 006043f5 0 23 # stoplite_35_23

47 006043f6 006043ff 0 30 # stoplite_47_30

48 00604400 00604409 0 30 # stoplite_48_30

49 0060440a 00604413 0 30 # stoplite_49_30

50 00604414 0060441d 0 30 # stoplite_50_30

51 0060441e 00604427 0 30 # stoplite_51_30

52 00604428 00604431 0 30 # stoplite_52_30

56 00604432 00604437 0 17 # stoplite_56_17

59 00604438 00604439 0 18 # stoplite_59_18

60 0060443a 00604445 0 37 # stoplite_60_37

61 00604446 0060444d 0 33 # stoplite_61_33

59 0060444e 0060444f 35 39 # stoplite_59_35

59 00604450 00604455 19 34 # stoplite_59_19

71 00604456 00604457 0 37 # stoplite_71_37

74 00604458 0060445f 0 35 # stoplite_74_35

77 00604460 00604467 0 36 # stoplite_77_36

80 00604468 0060446f 0 36 # stoplite_80_36

83 00604470 0060447b 0 43 # stoplite_83_43

87 0060447c 00604483 0 34 # stoplite_87_34

71 00604484 0060448d 0 37 # stoplite_71_37

84 0060448e 00604490 0 29 # stoplite_84_29

The source symbols section consists of five fields for each source statement: line number, lower address
bound, upper address bound, beginning column value, and ending column value.

Source symbols do not have a name in the same sense as function or variable symbols, because there is
no name associated with each of the executable statements in a source file. Instead, a source symbol
has a file name, specified in the source directive, and a line number. The line number specifies the line
of the source file that contains the source statement. Line numbers are always in decimal, regardless
of the file radix in the header.

The lower and upper bound values for a source symbol are similar to those of function and variable
symbols. For source symbols, these bounds represent the range of addresses occupied by the instructions
that implement a single source statement.

The bound values are defined in the file radix specified in the header and can range in value from
0x00000000 to 0xFFFFFFFF. The lower and upper bound addresses are inclusive, just like other symbols.
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A source symbol for an instruction occupying a single memory location has matching lower and upper
bound values.

The beginning and ending column fields of a source statement are optional. When present, and non-zero,
they define the beginning and ending column position for the source statement.

The beginning and ending column values define the location of the statement in the line. This is especially
useful when there are multiple statements on a single line, because it makes it possible to define a separate
symbol for each statement. When the column information is not present, or is set to zero, the symbol is
assumed to correspond to the entire line.

Only a few compilers generate column information, but when the information is present in the symbol file,
the logic analyzer uses the column information to provide highly accurate source code correlation. The
example source symbols on the previous page show typical column values.

In most cases only one of the column values is non-zero. This is because those lines contain only one
statement, and the compiler specified only the column at which the statement ended. Some compilers
specify only the beginning column position for such lines, in which case the beginning value would
be non-zero and the ending value zero.

Note that there are three symbols corresponding to line 59 of the file. Line 59 of the original source
file contains the following statement:

for (i = 0; i < NUM_STATES ; i++)

This one line contains three separate statements. The first statement is the initialization (i = 0), the second
statement is the test (i < NUM_STATES), and the third statement is the increment (i++).

Although all three statements appear on the same line, each generates a separate set of instructions, and
the symbols in the example define unique address ranges for each. This enables the Source window to
accurately indicate which of the three statements on the line is associated with any given address.

Each of the source symbols in the example includes a comment at the end of the line showing a symbol
name. Since this is a comment, it is ignored by the symbol file reader, and is optional. When symbol files
are exported by the logic analyzer, they contain comments that show the derived symbol name created by
the logic analyzer itself. The name is a concatenation of the symbol file name, line number, and column
number (if present). This is the symbol value that the logic analyzer will display for addresses that fall
within the lower and upper bounds of a source symbol.

Related Topics
TLA Symbol File Format - TSF Range Symbols

TSF Range Symbols - Function

TLA Symbol File Format - TSF Range Symbols

TSF Range Symbols - Color

476



Reference TSF Range Symbols - Variable

. . Symbol Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

TSF Range Symbols - Variable
The file directive "#+ Variable" introduces the variable symbol section of a TSF Range file. The file
directive tells the file reader that the following symbols represent variables, as opposed to functions or
source statements. If no symbol type file directive is given, the function symbol type is assumed.

#+ Variable

# Symbol Name Low High

# ============================== ======== ========

menu 00000100 00000102

userMenu1 000004c0 000004c2

binBits 000004d4 000004d6

Variable symbols consist of three fields: the symbol name, the lower bound, and the upper bound. Variable
symbols are just like function symbols except that they define the address range occupied by a variable
instead of function. The lower and upper bound values of a variable symbol are inclusive, meaning
that they are themselves a part of the range. For variables occupying only a single byte in memory, the
lower and upper bound values are equal.

Related Topics
TLA Symbol File Format - TSF Range Symbols

TSF Range Symbols - Function

TSF Range Symbols - Source

TSF Range Symbols - Color
Reference . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

System Overview

System Window
The System window is the main window; from here you can access all other setup windows, trigger
windows, and various data windows. The System window also shows instrument configuration, arming,
and triggering relationships.
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Logic Analyzers

An icon represents each installed instrument. Inside each
icon are specific controls where you can do the following
tasks:

Open the properties tab by double-clicking an open
area inside the icon.

Open the logic analyzer Setup window by clicking the
Setup button.

Open the logic analyzer Trigger window by clicking the
Trigger button.

Turn the logic analyzer on or off by clicking the On/Off
button.

Name the logic analyzer by entering text in the text box.

Click the logic analyzer to see which data windows contain
data for the logic analyzer.

Active Logic Analyzer
The logic analyzer highlighted by the pointer in the System window is the active logic analyzer.

Identifying Modules
If you are unsure which physical module an icon represents, double-click the icon to open its System
Properties dialog box. The System Property dialog box lists information about the module, including the
mainframe slot number in which the module is installed.

Disabling Modules
To disable a module, click the module’s On/Off button.

When you disable a module, first verify that no other trigger program is dependent on the module’s output.

Data Windows
An icon represents each data window. You can use the New Data Window dialog box to create Histogram
or Source windows or other windows. To create a new data window click in the toolbar.

NOTE. You can change the default data window for logic analyzer in the Defaults property page. From the System
menu, select Options and click the Defaults tab to display the Defaults tab.
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Inside each data window icon are specific controls where
you can do the following:

Open a data window by clicking its icon located above
the text box.

Open the Properties dialog box to access the product’s
properties tabs by double-clicking the mouse in an open
area close to the icon.

See which data windows are associated with a logic
analyzer (or data window), by clicking the logic analyzer
(or data window text box). White arrows appear, linking
the logic analyzers and data windows.

Renaming a Window
You can rename the window by selecting the current window label and typing over it. Window names
must be unique and the window name is limited to the space available.

Triggering and Arming Relationships

A logic analyzer that is programmed to cause a system
trigger has a trigger indicator symbol on the right edge
of the logic analyzer icon. A black arrow from one logic
analyzer to another indicates one module is programmed
to arm another through the first module’s trigger program.
The example shows a logic analyzer module arming the
DSO module.

Context Menu
You can right-click the mouse in different parts of the System window to display a menu that contains a list
of useful tasks such as opening or displaying properties for the trigger, setup, and data windows.

Related Topics
New Data Window Dialog Box

Triggering other Modules from an LA

Arming other Modules from an LA

Arming other Modules from a DSO
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Armed Module
An armed module is a module that begins running its trigger program once it has received an arm
signal from another module. This allows the armed module to run its trigger program when a
condition is met in the other module’s trigger program.

System Trigger (Trigger All Modules)
The system trigger is an overriding command that causes all modules to acquire their post trigger
data, regardless of whether they have been armed or have fulfilled their own trigger conditions.

The system trigger is the primary data acquisition reference point. In data windows, timing and
location information is relative to the system trigger.

When the system trigger occurs, the trigger signal will appear at the external System Trigger Out
connectors of the instrument.

Trigger Program
The trigger program is a series of conditions, similar to software code that defines the data you want
to capture and view. The trigger program also specifies actions that are expected when conditions
(data events) are true.

The trigger program filters acquired data to find one or more specific data events. The trigger
program can accept signals from other modules or signals from external test equipment through the
external System Trigger In or the External Signal In connectors. Similarly, the trigger program
can also send signals from the module to external equipment through the System Trigger Out and
the External Signal Out connectors.
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New Data Window Dialog Box

Overview
Use to create a new data window.

Behavior
This dialog box lists the different kinds of data windows that you can create in the System window.
When you select a new data window from the list and then click the OK button, a wizard will help you
select the information needed to create the window.

To Use
Select a window from the list and click OK. You can also double-click the window type in the list. Follow
the instructions on each page in the wizard to create the new data window.
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New Listing/Waveform Data window
Use this dialog to create a new Listing or Waveform window. Click one of the following selections to
specify the data source for your new data window:

Click Data from to select a data source from the current system. If the data source you want is not
listed, click the Add Data Source button to add one from the TLA system or logic analyzer file to the
current system. You can also click the Browse button to search for a desired TLA system file.

Click No data to create an empty Listing or Waveform window. After the window displays, you can
add columns or waveforms from different sources.

Click Same columns/windows as active data window to add the columns or waveforms from the
active window to your new data window.

ClickMagniVu columns/waveforms based on the active data window to view MagniVu data (higher
resolution) of the same columns or waveforms as the active window.

Related Topics
Adding a Column in a Listing Window

Adding a Waveform
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New Data Window Name
Enter a name for the new data window or use the default name. Then click the Finish button to create
the new data window.
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Name Data Window Dialog Box
Use to specify a new name for a data window. This dialog box displays when you attempt to name a
data window that is not unique.
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Load Browser Dialog Box
Use to find and load a particular file.
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Load System Options Dialog Box
Overview

Use to load part of a saved system file into the current
system. This is useful when you need to use portions of a
saved system file with the current system. A saved system
consists of one or more modules, data windows, and links
to data sources in other TLA files. A saved module consists
of the module’s setup and trigger settings as well as data.

From a saved module file, you can load any of the following:

An LA module trigger program

A module setup and trigger program

Saved data from the module

From a saved system file, you can load any of the following:

Any previously listed module choices

Full system setup, including data windows

Saved data from one or more modules

Behavior
The Load System dialog box is automatically opened when you perform a Load System and the saved
system file does not match the current logic analyzer configuration (and both systems contain at least
one module).

When necessary, the instrument adjusts the following logic analyzer or DSO module setup parameters to
match hardware limits:
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Memory depth.

Trigger position. Relative position is maintained.

Internal clocking sample period.

If you try to load a module that is not compatible with the saved module, the cursor changes to a no drop
shape. The following might cause the saved file to be incompatible:

The channel width of the current module is less than the width of the saved module.

The module type is not the same. You must use a saved DSO module for a DSO, and a saved logic
analyzer module for a logic analyzer.

If you load a saved system with a different module configuration than your current system, the logic
analyzer displays a dialog box similar to the following:

Click OK to accept the suggested configuration. If you click Cancel, the logic analyzer displays the Load
System Option dialog box. Use this dialog box to load specific modules from the saved system.

NOTE. If you load a setup that you saved with suppressed samples, the suppressed samples are not present
in the setup.

An unmerged module can be loaded into a merged module. The master of the merged pair must have a
channel width equal to or greater than the unmerged module. A merged module can be loaded into a
merged module, provided the master and slave of the destination has a channel width equal to or greater
than the master and slave of the saved pair.
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To Use
To open the Load System Options dialog box:

1. Go to the File menu from any window.

2. Select Load System.

3. Select a TLA system file. The Options button becomes active when a system file is selected.

4. Click Options.

To load a saved module, drag the module icon from the top of the Load System Options dialog box to
a module icon at the bottom of the dialog box.

NOTE. The module icon does not move; however the cursor changes shape to indicate a drag function.

Related Topics
Saving a System

Merge Modules Properties
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Status Monitor Dialog Box
To open the Status Monitor dialog box, click the Status button on the toolbar.

The Status Monitor is used to determine the status of your acquisition while it is running.

The Run animation control indicates when the system is in the acquisition mode by changing from

to when the Run button is clicked.

When you hover your mouse pointer over the icon, a tool tip box provides you with the acquisition
status of your installed modules as shown below.
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The Status Monitor dialog box contains a summary area at the top that lists a one-line summary of each
module installed.

The Status Monitor dialog box shows the following:

Status of the acquisition: Idle, Waiting for Trigger, or Triggered.

The Start Time of the acquisition.

The name of the module.

The status of memory for all modules during acquisition is shown on the left of the status dialog
box. Blocks are filled in to the left of the T (trigger position). Blocks are filled to the right of the T
after the module is triggered.

The number of repetitive acquisitions when in Repetitive mode.

The trigger state of the logic analyzer module trigger program that is executing.

The number of samples remaining to be filled in memory.

The value of each logic analyzer counter and timer when appropriate. Only shown for logic analyzer
modules.

The state of the module’s intermodule output signal, shown as Sig/Arm Out.

The status of data comparison during logic analyzer memory compare operations.

External clock warning when the logic analyzer senses no external clock activity. If this message
appears, check for a missing clock signal or for an error in the clock setup.

The Status Monitor dialog box is resizable.

Related Topic
About Data Properties
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External Signal Selection
When using the External Signal In and External Signal Out functions, you must select an internal signal.

Select None to prevent signals from being sent or received at the external connector.

Select 10 MHz clock to send a 10 MHz clock signal to the External Signal Out connector. This signal
will be available continuously at the connector until explicitly disconnected by changing the External
Signal Out selection in the Signals tab.

NOTE. The 10 MHz clock signal is interrupted briefly during the following actions: Load System, Default System,
diagnostic execution, and calibration.

Select Signal 1-4 to assert External Signal Out when the specified signal is true. Signals 1 and 2
are high-speed, ECL rate signals, and are usually the preferred choice for both internal and external
signal applications. Signals 3 and 4 are functionally equivalent to signals 1 and 2, but operate at
the slower TTL-rate.

Signals 1 and 2 162 MHz maximum (internal)
62.5 MHz maximum (at External Signal Out connector)

Signals 3 and 4 12.5 MHz maximum
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Internal Signal Selection
Signals 1 and 2 are high-speed, ECL-rate signals, and are usually the preferred choice for both internal and
external signal applications. Signals 3 and 4 are functionally equivalent to signals 1 and 2, but operate
at the slower TTL rate.

Signals 1 and 2 162 MHz maximum (internal)
62.5 MHz maximum (at External Signal Out connector)

Signals 3 and 4 12.5 MHz maximum
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Selection Dialog Box
Use the Selection dialog box when you want to do one of the following tasks:

Add a data source from a TLA system or module file to the current system. Click Browse to search for
the required file.

Load a data window from a TLA system file.

Load a module setup onto a selected module in the current system.

Load triggers. Click Browse to select a trigger from your modified trigger list.

Load a trigger setup onto a selected logic analyzer module in the current system.

Load a search definition onto a selected data window in the current system. Click Browse to select
a previously saved search definition.

. . System Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

MagniVu Data

Overview
MagniVu data is the result of asynchronous digital oversampling architecture. This data is automatically
acquired whenever you perform an acquisition. This means that, even if you specify synchronous
acquisition, you can view the asynchronous resolution data at any time without having to reacquire.

Behavior
MagniVu acquisition rates differ based on the module that you have. If you are using a
TLA7Lx/Mx/Nx/Px/Qx logic analyzer module, your acquisition rate is 500 ps. However, if you are using
a TLA7Axx/TLA7NAx logic analyzer module or a TLA5000B Series logic analyzer, your acquisition
rate is selectable, based on your MagniVu Storage Rate, and is constrained by both PowerFlex and the
current maximum acquisition rate for main memory.

Related Topic
Adding MagniVu Data to a Listing or Waveform Window
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System Trigger (Trigger All Modules)
The system trigger is an overriding command that causes all modules to acquire their post trigger data,
regardless of whether they have been armed or have fulfilled their own trigger conditions.

The system trigger is the primary data acquisition reference point. In data windows, timing and location
information is relative to the system trigger.

When the system trigger occurs, the trigger signal will appear at the external System Trigger Out
connectors of the instrument.
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High-Level Language support
You can correlate the High-Level Language (HLL) source code that you wrote with the disassembly
listing, showing how the code was executed on your target system, and then acquired by the logic analyzer.
The correlation is based on symbolic information that is extracted from your object file or load module.
You can configure the logic analyzer to access your source files.

You can step through each executed source statement in the Source window and view the results in
a correlated Listing window.

You can set user-defined marks as break points within the code and then trace the execution of the code
between the marks.

The following file formats are supported: OMF51, OMF86, OMF166, OMF286/386, IEEE695, COFF,
ELF/DWARF and ELF/STABS.

In addition to the file formats listed below, Tektronix also provide the Tektronix Symbol File Format (TSF),
a text format. For information on any other file formats, contact your local Tektronix representative.
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Properties

Start-Up Properties
Use to select which system to open after you power on the instrument. You are presented with the
following choices, form which you must pick one:

Last System file opened in previous session. The TLA application automatically loads at start-up the
last saved system file that you explicitly loaded.

Default System. The TLA application loads the default setups for all modules at start-up.

Saved System. The TLA application loads a saved system file that you specify at start-up.

The default system also consists of the following:

Merged modules if modules are physically connected for merging.

Default setups for all modules.

Default settings for internal signals specified in the System Configuration dialog box.

One data window for each module. A Waveform window is created for each DSO module. A data
window of the default type, as specified in the Defaults tab, is created for each logic analyzer module.
Only data sources from the physical modules in the current system are included.

All usable modules are on.

To open the Start-Up tab from the System menu, click Options and then click Start-Up.

Related Topic
Defaults Properties
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Power-On Diagnostics Properties

Overview
Use to view the results of the power-on diagnostics. The Test Name column lists the mainframe, slot
number and name of installed modules, and specific tests.

Behavior
If any test failed, the Power-On Diagnostics page opens as the first active window and the first failed test is
highlighted. If a test fails you can either select the Extended Diagnostics tab and rerun the test, or dismiss
this page by clicking the Close button. If you dismiss this page, the application finishes loading.

NOTE. Mainframe power-on diagnostics only run when the system powers on.

If a module is not recognized, the module type area is filled in with any available information or the
word Unknown is displayed.

To Use
To open the Power-On Diagnostics tab from the System menu, click Calibration and Diagnostics and then
click Power-On Diagnostics.

Related Topics
Running Extended Diagnostics

Contacting Tektronix
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Self Calibration Properties

Overview
Use to run calibration procedures on installed modules, either individually or as merged pairs. You should
run these procedures after repair and at least once a year for the logic analyzer module. The DSO module
requires self-calibration if the ambient operating temperature has changed more than 5 °C since the
last calibration or once a week if the vertical settings of 50 mV full scale or less are used. A warning
message to calibrate appears if ambient temperature goes out of tolerance. Perform self-calibration after
a 30-minute warm up.

NOTE. Merged modules are represented with a <> indicator. Merged modules must be calibrated in addition to the
calibration of individual modules. TLA7Nx, TLA7Px, and TLA7Qx modules, when merged three-way, must have
both "sets" of modules calibrated.

Status list
The following is a list of status messages:

Running. The calibration procedure is being executed. The text blinks to indicate progress.

Calibrated. The module calibrated successfully.

Fail. The module did not calibrate. Contact your local Tektronix service representative.

No Calibration Required. The module either does not need to be calibrated or it does not have
any self-calibration functions.

Unknown. Try to calibrate again. If the module has the same status, contact your Tektronix service
representative.

To Use
To open the Self Calibration tab from the System menu, click Calibration and Diagnostics, and then
click Self Calibration.

Related Topics
Power-On Diagnostics Properties

Extended Diagnostics Properties

Calibrating Modules

Contacting Tektronix
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Mainframe Properties
Use this information when you contact Technical Support.

To open the Mainframe tab from the System menu, click System Properties and then click Mainframe.
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Modules Properties
Shows information about modules installed in the instrument.

1. From the System menu, click System Properties.

2. Click the Modules tab.
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Module Specifics Properties
Provides information about a selected module. You use this information when contacting Technical
Support.

1. From the System menu, click System Properties.

2. Click the tab of the module for which you want information.
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Merge Modules Properties

Overview
You can merge up to five logic analyzer modules to increase channel width. Merged modules function as a
single unit and the data it acquires is automatically time-correlated. This is useful when analyzing buses or
devices with a high channel count. Some microprocessor supports require merged modules.

Behavior
Modules must be physically connected and in the same mainframe before they can be merged by software.
Modules must be adjacent and connected as described in the user manual. Only modules that have been
physically connected and are capable of being merged are shown in the Merge Modules tab with a merge
button. Refer to Merging Modules for the rules on merging modules.

The state of the button indicates whether the modules are currently merged, as shown:
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To Use
To open the Merge Modules tab from the System menu, click System Configuration and then click Merge
Modules. To merge or unmerge modules, click the merge button between the module icons.

Related Topics
Merging Modules

Self Calibration Properties

Merged Module External Clocking
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Preferences Properties
Use the preference properties page to specify user preferences, such as hiding the Status bar, displaying
confirmation messages, specifying click and drag zoom behavior, or showing the Easy Setup dialog. These
settings cannot be modified anywhere else in the application.

To access user preferences from the System menu, click Options to display the Options dialog box.
Then click the Preferences tab.
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System Source Files Properties

Overview
The System Source Files tab defines the default location of source files for new Source windows. The
settings you specify in this tab will be the default settings used to locate source files when you first create a
Source window. You can specify a list of directory paths and a list of possible file suffixes.

Behavior
When specifying the search path, you can use an asterisk (*) as the final component of a search path
directory. For example, if you specify the following path, C:\MySources\*, the MySources directory and
all directories (one-level deep) within MySources will be searched. However, you cannot use the asterisk
as a general-purpose wild card character. For example, the use of an asterisk in C:\MySources\*\* or
C:\MySources\abc* is invalid.

You must specify the complete absolute (not relative) path name for the file in the Search Path List.
Otherwise the Source window will not locate the source file. Make sure that the source file you are looking
for has a unique file name. When searching for source files it is possible to load the wrong file if there is
another file with the same name in the directories specified by the search path. The Source window always
loads the first file that matches the search criteria.

NOTE. This tab is similar to the Source Window Source Files tab. The information that you supply in this property
page will be used as default settings for new Source windows. The information that you supply for the Source Window
Source Files tab is only used for the current Source window.

To Use
To open this page from the System menu, click Options and then click Source Files.

Select Search Path List to specify source file locations.

Select Suffix List to specify possible file suffixes. The default suffixes are .c and .s.

Click Add to add items.

Click Edit to edit the selected item.

Click Delete to delete a selected item from the list.

Related Topic
Source Window Source Files Properties
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Signals Properties
Overview

The logic analyzer has four internal signals that you can
use to set up trigger conditions between modules, or to
send or receive signals external to the logic analyzer. Use
the Signals tab in conjunction with the module trigger
programs to configure these signals for your application.
The trigger programs and external signal input determines
when the signals occur. The Signals tab specifies signal
characteristics. To configure signals for your application
from the System menu, click System Configuration, and
then click the Signals tab.

NOTE. The logic analyzer and DSO modules use a logical expression (True/False) for Signals 1, 2, 3, and 4. However,
pattern generator modules use a physical expression (High/Low) for these signals. Refer to your TLA7PG2 Pattern
Generator module documentation for information to convert physical expressions to logical expressions or vice versa.

Internal Signals
All logic analyzer modules can set and clear any of the four internal signals. The DSO can set but not
clear any signal. The logical output of these signals can be used as an event in other trigger programs.
You can also connect the internal signals to the External Signal In and External Signal Out connectors
on the mainframe, so that you can use an external signal as a trigger event or send a signal out when a
trigger condition is met.

Internal signaling is for users with special trigger programming requirements. Internal signaling adds
flexibility to trigger programming, but also adds complexity. When using internal signaling you must
take care that the signals are correctly set and cleared, and that the trigger programs for all modules are
compatible with regard to signal usage. Also, you must have correctly set the internal signal attributes in
the Signals tab of the System Configuration dialog box.

Internal signaling is done through trigger actions specified in the Clause Definition dialog box and the
DSO Trigger tab.

NOTE. Arming and internal signaling are mutually exclusive. You cannot simultaneously arm modules and set
signals. You can test for a set signal (for example, If Signal X Is True), but unless you have designated an external
signal for this purpose, you will be unable to set the signal when using the arming feature.
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External Signals
The logic analyzer can send and receive signals external to the logic analyzer using the mainframe External
Signal In and External Signal Out connectors. Use the External Signal In function to include a signal from
your system under test or other test equipment as part of the trigger program. Use the External Signal Out
function to send a signal to the system under test or other test equipment from a trigger program.

The connection from the module to the external connector is made by one of the four internal signals. You
must designate which internal signal is to be used for this purpose.

The external signal connectors are located at the rear of the portable mainframe and at the front of the
benchtop mainframe. The external signals all operate at TTL voltage levels.

The polarity for External Signal In is always set to Low TRUE. You have a choice of low or high true for
External Signal out. For a high true signal, clear the selection Low TRUE.

Signal Logic Function
To use internal signals, you must select which internal signal logic function is appropriate for your trigger
program. Signals 1 and 2 (high speed) can only be asserted by one module each. For signals 3 and
4 the modules can be wired-OR or wired-AND. Selecting the OR function means that any module can
assert the signal. Selecting AND means that all modules must set the signal for it to be asserted. The
same logic applies to clearing signals.

System Trigger Connectors
The System Trigger In/Out Connectors group box contains readouts that reflect the current state of the
System Trigger In and System Trigger Out connectors. You can also set the threshold for the System
trigger in connector.

NOTE. Only modules that are on can send arming or internal signals.

To Use
To open the Signals tab from the System menu, click System Configuration and then click Signals.

Related Topics
Clause Definition Dialog Box

DSO Trigger Settings

External Signal Selection

Internal Signal Selection
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Color Properties
Use to create, remove, and modify color schemes.

1. Select an Element you want to change from the list and then select a color from the color matrix.

2. Click Save As to enter a new name for your scheme or click OK in the Save Scheme dialog box to keep
the existing name and redefine the defaults for it.

NOTE. You cannot redefine or remove factory defaults.

The following table describes each element.

Element Name Description
Data Background Default background color for a data window’s data area
Data Foreground Default text color for the data in a data window
DSO Waveform Default color for DSO waveform data
LA Waveform Default color for logic analyzer waveform data
LA – MagniVu Waveform Default color for logic analyzer MagniVu waveform data
Trigger Default color for trigger marks
Cursor 1 Default color for cursor 1
Cursor 2 Default color for cursor 2
Mark Default color for user marks
Compare: Acq = Ref Default color for highlighting equalities between acquisition

data and reference data
Compare: Acq != Ref Default color for highlighting differences between acquisition

data and reference data
Glitch Default color for glitches
Waveform Readouts Default color for DSO ground, volts readout, trigger level,

magnitude readouts and busform readouts
Graticule Default color for the graticule in a Waveform window
Highlight Default color for disassembly highlighting in a Listing and

Source window
Histogram Bar Default color for bars in a Histogram window
Uncorrelated Source Default color for uncorrelated text in a Source window

A default color scheme can be assigned for new data windows from the Defaults tab, which is located in
the Options dialog box.

From the System menu, you can access the Color settings by clicking Options and then clicking the
Color tab.

498



Reference Software Properties

Related Topic
Defaults Tab
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Software Properties
Shows what TLA software is installed in the instrument.

1. From the System menu, click System Properties.

2. Click the Software tab.
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Defaults Properties
Use to specify defaults used throughout the application. The settings you enter here will be the default
settings used when creating new data windows.

To access these settings from the System menu, click Options and then click the Defaults tab.
Reference . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
System Options

Save Color Scheme Dialog Box
Use to save a new color scheme set in the Color tab of the Options dialog box.

To open this dialog box from the System menu, click Options, click the Color tab and then click Save As.

Related Topic
Color Properties
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Presets Properties

Overview
Use the Options Presets to view and modify preset names and values. The presets are used as list entries in
list box controls for selecting trigger thresholds, vertical range, vertical offset, and probe thresholds.

Behavior
You can modify all preset names and values. Preset names are limited to 12 characters. You can return all
preset names and values to the factory settings by clicking Reset All. If you enter a value that is out of
the range shown below, the value is set to the nearest in-range value.

Parameter Range Step Size Use
DSO Logic Threshold +/-200 V 20 μV DSO Logic Trigger

Threshold
DSO Upper Threshold +/-200 V 20 μV DSO Slew Rate and Runt

Trigger Threshold
DSO Lower Threshold +/-200 V 20 μV DSO Slew Rate and Runt

Trigger Threshold
DSO Vertical Range 10 mV to 100 V 100 μV DSO Setup
DSO Vertical Offset +/-100 V 1 mV DSO Setup
LA Logic Threshold -2 V to +5 V 50 mV TLA7Lx/Mx/Nx/Px/Qx

Probe Threshold
LA Logic Threshold -2 V to +4.5 V 5 mV TLA7Axx and TLA520x

Probe Threshold
LA Logic Threshold -2 V to +5.0 V 5 mV TLA701x Probe Threshold

To Use
To change options presets from the System menu, click Options and click the Presets tab.
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Tools Properties

Overview
The Tools tab of the Options dialog box allows you to define up to 16 external applications (or tools) that
may be launched from within the TLA application.

These tools can be associated with any program that runs under the Windows operating system or any type
of document that Windows knows how to open. When a tool is defined here, it is automatically added
to the Tools sub-menu of the System menu in the TLA menu bar. Also, a toolbar button for each tool
is added to the TLA Toolbar.

Once a tool has been defined, you can run the program by choosing its name from the Tools menu or
clicking on its toolbar button.

To Use
Click the Add button to add a new tool.

Click the Edit button to edit the properties of the selected tool, including its Menu Name, Command,
Arguments, Initial Directory, and Run Minimized status.

Click the Delete button to delete a selected tool from the list.

Click the Move Up arrow button to move the selected tool up one position in the list.

Click the Move Down arrow button to move the selected tool down one position in the list.

To open the Tools property page, from the TLA menu bar select System ® Options, and select the Tools tab.

NOTE. Arguments and commands with embedded spaces must be enclosed in quotes in the Tool Properties (App
Options) dialog box for the commands to work.

Related Topic
Tool Properties Dialog Box
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Tool Properties Dialog Box

Overview
Use the Tool Properties dialog box to specify the properties of an external tool.

To Use
Specify the name of the tool in the Menu Name box. This is the name that is displayed in the Tools menu.
Placing an ampersand before a letter in the tool name makes that letter an accelerator key.

Enter the path and name of the document or application that you want to open in the Command box. You
can click the Browse button to open a Windows file browser to help find the application. If a document is
entered here, the executable to open the document is found based on its registered Windows file type. For
example, a document with a .txt extension is opened with Notepad.

Use the Arguments box to enter any command line arguments that are required by the application.

Use the Initial Directory box to specify the default working directory for the application.

Click Run Minimized to specify that the application will run in a minimized window.

Click the Test Run button to launch the tool with the current dialog settings.

To open the Tools property page, from the TLA menu bar select System ® Options, and select the Tools
tab. Click the Add button, or select the tool you want to modify and click the Edit button.

NOTE. Arguments and commands with embedded spaces must be enclosed in quotes in the Tool Properties (App
Options) dialog box for the commands to work.

Related Topic
Tools Properties
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Shortcut keys

General Purpose Data Window Shortcuts
To Press
Switch data windows CTRL+Tab
Scroll data up 10 pages Shift+Page Up
Scroll data down 10 pages Shift+Page Down
Scroll data to the top of the window Shift+Home
Scroll data to the end of the window Shift+End
Move active cursor up one page CTRL+Page Up
Move active cursor down one page CTRL+Page Down
Move active cursor to top of the data CTRL+Home
Move active cursor to end of the data CTRL+End
Move active cursor up 10 pages CTRL+Shift+Page Up
Move active cursor down 10 pages CTRL+Shift+Page Down
Move active cursor to the top of data CTRL+Shift+Home
Move active cursor to the end of data CTRL+Shift+End

The movement shortcuts follow these general rules:

Arrows with no modifier keys scroll the data

Arrows with the CTRL key move the active cursor

The Shift key provides 10 times the movement

Related Topics
Listing Window Shortcuts

Waveform Window Shortcuts

Source Window Shortcuts

Histogram Window Shortcuts

Menu Shortcut Keys
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Menu Shortcut Keys
You can use the following shortcut keys for manipulating menus, editing windows, and moving around
in data windows.
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File Menu

To Press
Return the system to the default setups CTRL+D
Load a saved system CTRL+O
Save a system setup CTRL+S
Print the active window CTRL+P

Edit Menu

To Press
Cut a selected item to the clipboard CTRL+X
Copy a selected item to the clipboard CTRL+C
Paste items from the clipboard CTRL+V
Undo edit CTRL+Z

Data Menu

To Press
Search backward CTRL+B
Search forward CTRL+F

System Menu

To Press
Display the Status Monitor CTRL+M
Run or Stop CTRL+R

Window Menu

To Press
Create a new data window CTRL+N

Related Topics
Waveform Window Shortcuts

Listing Window Shortcuts

Histogram Window Shortcuts

Source Window Shortcuts
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Waveform Window Shortcuts
To Press
Go to next Sample Suppression change CTRL+0
Go to previous Sample Suppression change CTRL+9
Go to next trigger CTRL+T
Display Go To dialog box CTRL+G
Move Cursor 1 to center of window CTRL+1
Move Cursor 2 to center of window CTRL+2
Zoom in CRTL+I
Zoom out CTRL+U
Add a mark CTRL+K
Add a waveform CTRL+W
Scroll data left 50 pixels Shift+Left arrow
Scroll data right 50 pixels Shift+Right arrow
Move active cursor left five pixels CTRL+Left arrow
Move active cursor right five pixels CTRL+Right arrow
Move active cursor left 50 pixels CRTL+Shift+Left arrow
Move active cursor right 50 pixels CTRL+Shift+Right arrow

The movement shortcuts follow these general rules:

Arrows with no modifier keys scroll the data

Arrows with the CTRL key move the active cursor

The Shift key provides 10 times the movement

Related Topics
Listing Window Shortcuts

Menu Shortcut Keys

General Purpose Data Window Shortcuts
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Listing Window Shortcuts
To Press
Go to next Sample Suppression change CTRL+0
Go to previous Sample Suppression change CTRL+9
Go to next trigger CTRL+T
Display Go To dialog box CTRL+G
Move Cursor 1 to center of window CTRL+1
Move Cursor 2 to center of window CTRL+2
Add a mark CTRL+K
Add a column CTRL+L
Scroll data up 10 samples Shift+Up arrow
Scroll up 10 lines Shift+Up arrow
Scroll data down 10 samples Shift+Down arrow
Scroll down 10 lines Shift+Down arrow
Move active cursor up one sample CTRL+Up arrow
Move active cursor up one line CTRL+Up arrow
Move active cursor down one sample CTRL+Down arrow
Move active cursor down one line CTRL+Down arrow
Move active cursor up 10 samples CRTL+Shift+Up arrow
Move active cursor up 10 lines CRTL+Shift+Up arrow
Move active cursor down 10 lines CTRL+Shift+Down arrow
Move active cursor down 10 samples CTRL+Shift+Down arrow

The movement shortcuts follow these general rules:

Arrows with no modifier keys scroll the data

Arrows with the CTRL key move the active cursor

The Shift key provides 10 times the movement

Related Topics
Waveform Window Shortcuts

Histogram Window Shortcuts

Source Window Shortcuts

General Purpose Data Window Shortcuts

Menu Shortcut Keys
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Source Window Shortcuts
To Press
Display Go To dialog box CTRL+G
Move Cursor 1 to center of window CTRL+1
Move Cursor 2 to center of window CTRL+2
Add a mark CTRL+K
Step Forward CTRL+H
Step Backward CTRL+J
Scroll data up 10 lines Shift+Up arrow
Scroll data down 10 lines Shift+Down arrow
Move active cursor up one line CTRL+Up arrow
Move active cursor down one line CTRL+Down arrow
Move active cursor up 10 lines CRTL+Shift+Up arrow
Move active cursor down 10 lines CTRL+Shift+Down arrow

The movement shortcuts follow these general rules:

Arrows with no modifier keys scroll the data

Arrows with the CTRL key move the active cursor

The Shift key provides 10 times the movement

Related Topics
Listing Window Shortcuts

Waveform Window Shortcuts

General Purpose Data Window Shortcuts

Menu Shortcut Keys
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Histogram Window Shortcuts
To Press
Scroll up 10 ranges Shift+Up arrow
Scroll down 10 ranges Shift+Down arrow

The movement shortcuts follow these general rules:

Arrows with no modifier keys scroll the data

The Shift key provides 10 times the movement

Related Topics
Listing Window Shortcuts

General Purpose Data Window Shortcuts

Menu Shortcut Keys
Reference . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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Triggering Overview

DSO Trigger Settings

Overview
The DSO Trigger tab contains all controls for setting DSO trigger events and actions. Threshold changes
are recognized and executed immediately during acquisitions. Execution of all other controls is delayed
until the next acquisition.

Behavior
Use Mode to select whether the DSO waits for a trigger (Normal) or forces a trigger after a set length of
time has passed without a trigger (Auto).

Use Action to select what happens when a trigger is recognized. The trigger event either triggers the DSO,
triggers all modules, triggers and sets a signal, or triggers and arms another module.

Action Target selects the event or the condition Trigger Action will act on:

Trigger & Set Signal. A Set Signal action allows you to set signal 1, 2, 3, or 4.

Trigger & Arm. An Arm action allows you to arm other installed modules. The default is the module
in the lowest-numbered slot that can be armed.

Use Trigger position to set the amount of data in the data record that occurs before the trigger.

Use Event Type to select the type of event the DSO will recognize as a trigger.

Related Topics
Setting Up the DSO Trigger

System Trigger and Reference System Trigger Relationship

. . Triggering Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Status Bits Type Dialog Box

Overview
Use the Status Bits Type dialog box to select the logic analyzer’s status bits for additional triggering
and data display.

Behavior
Depending on your logic analyzer module, you can select one of five types of status bits for triggering and
display. The status bits of a module (or master module in a merged set) are available for use in the LA
Module Setup table. In most cases, you can use the status bits like any other channel bit such as checking
polarity, comparing data, naming channels, and assigning the bits to a channel group.
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However, because the status bits are not real data channels, you cannot access certain properties of the
status bits such as thresholds, iCapture, and multiplexed (demux) clocking.

The available status bits depend on the logic analyzer module. Some logic analyzer modules allow access
only to the trigger state machine (TSM) status bits, while TLA7Axx/TLA7NAx logic analyzer modules
allow you access to up to five different kinds of status bits.

The following table summarizes which status bits are available for the logic analyzer modules:

Logic analyzer Status bits
TLA7012 Clocking State Machine (CSM) Next State

Trigger State Machine (TSM) Next State

Clocking Group Complete (CGC)
TLA7016 Clocking State Machine (CSM) Next State

Trigger State Machine (TSM) Next State

Clocking Group Complete (CGC)
TLA7Axx/TLA7NAx Clocking State Machine (CSM) Next State

Trigger State Machine (TSM) Next State

Clocking Group Complete (CGC)
TLA7Nx/Px/Qx Trigger State Machine (TSM) Current State
TLA7Lx/Mx Trigger State Machine (TSM) Current State
TLA520x Clocking State Machine (CSM) Next State

Trigger State Machine (TSM) Next State

Clocking Group Complete (CGC)

To Use
Select the status bits from the LA Module Setup menu and use them for triggering and display.
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Saved Triggers

Overview
When saving from the Easy Trigger tab, use the Save dialog box to save your TLA file, which contains
trigger state information as well as information about the currently selected Easy Trigger program. If you
do not use an Easy Trigger program as the basis of your modified trigger design, but instead use the Power
Trigger tab to develop your trigger program, only a TLA file with the state information is saved.

To Use
Saving your trigger program requires that you specify both a file name and the name of the folder where
you would like your customized trigger programs to reside. In addition, you can enter comments about
trigger program construction or functionality.

To open the Save dialog box from the File menu, click Save Trigger. You can alternatively open the Save

dialog box by clicking the button from the toolbar.
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4X Clocking Mode Trigger Programs

Overview
Trigger Programs need special attention in order to work properly in 4X clocking mode. In some situations,
it may be necessary for a data value to be present on the probe input for four clock cycles in order for a
word recognizer to detect it. In other situations, it may be necessary to use four word recognizers logically
OR’ed together across the source and destination channels in order to detect a value.

Behavior
It is important to remember that in 4X clocking mode, trigger programs operate on the acquired data
only at the 1X speed. In other words, in 4X mode the current trigger machine state is evaluated at the
physical sample rate and not the logical sample rate.

To illustrate this point, take the following internal 4X mode acquisition samples:

NOTE. A minimum sample period of 2 ns is assumed in internal clocking mode.

A3 Channels A2 Channels D3 Channels D2 Channels Timestamp
01 02 03 04 0ns
05 06 07 08 2ns

The data was acquired with the trigger: If Group A3 equals 01, then Trigger.

However, if the "01" data value happened to be stored in the demultiplex destination channels (A2, D3, or
D2), it would not have been triggered on, even though it occurred on the A3 lines and was captured in
the acquisition memory.

To reliably trigger on an event that only lasts for 500ps, you must use four word recognizers: one to
watch the demultiplex source channels, and the other to watch the demultiplex destination channels. The
following trigger will always catch the 01 pattern in 4X mode: If Group A3 equals 01 or Group A2
equals 01 or Group D3 equals 01 or Group D2 equals 01, then Trigger.

If the desired event for triggering is present on the data lines for at least 2ns, then it follows that the
demultiplex source channels will always capture the event. In this case, the normal 1X trigger will work
correctly in the 4X acquisition mode.

NOTE. You can use the Trigger on 4X clocking group match or Trigger on 4X clocking channel match EasyTrigger
Programs to automatically set up this type of triggering on a data value that you specify.

Reference . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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Standard and Optional Accessories

Probes and Accessories
For a complete list of Standard and Optional Accessories, check with your local Tektronix representative.

The following is a list of available probes for TLA products. Click the button for a graphic of the probe
and accessories.

P6417 Probe and Accessories 3

P6417 to HP/3M type 3592 Adapter 3

P6418 Probe and Accessories 3

P6419 Probe and Accessories 3

34-Channel Probe Interface Kit Barrel Connectors 3

P6434 High-Density Probe and Accessories 3

P6810 General Purpose Probe and Accessories 1

P6860 High-Density Probe and Accessories 1

P6864 High-Density 4X Probe and Accessories 1

P6880 Differential Probe and Accessories 1

Compression-on-PCB to P6434 Mictor Adaptor 2

Mictor-on-PCB to P6860 Compression Adaptor 2

P6471 Pattern Generator Probe and Accessories
1 Only for TLA7Axx/TLA7NAx modules.

2 Only for P68xx probes.

3 Only for TLA7Lx/Mx/Nx/Px/Qx modules and TLA5000B series mainframes
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Analog Multiplex Cables
Notes

If you choose to use non-Tektronix cables, the signal
path is only compensated up to the front panel of the
TLA7Axx modules. Therefore, the cable you use to
connect the module to the oscilloscope can incur high
frequency loss. For a 36-inch cable, you should expect
0.43 dB of loss at 1 GHz (about 5%).

Time alignment values for the destination oscilloscope channels in the data view Time Alignment
dialog box are set assuming a Tektronix cable. When using non-Tektronix cables, time alignment
values will need to be manually adjusted.
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Probes

P6417 Probe and Accessories
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P6418 Probe and Accessories
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P6419 Probe and Accessories
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P6434 High-Density Probe and Accessories
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P6471 Pattern Generator Probe
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P6810 General Purpose Probe and Accessories
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P6860 High-Density Probe and Accessories
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P6864 High-Density 4X Probe and Accessories
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P6880 Differential Probe and Accessories
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34-Channel Probe Interface Kit - Barrel Connectors
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P6417 to HP/3M type 3592, 2 X 10, 0.1 in Adapter
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Compression-on-PCB to P6434 Mictor Adaptor
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Mictor-on-PCB to P6860 Compression Adaptor
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Theory

Sampling and Digitizing a Signal

Overview
Acquisition is the process of sampling the input signal, digitizing it, and assembling it into a waveform
record. The order and method of accomplishing these functions is different in the LA and DSO modules.

Logic Analyzer
The logic analyzer converts incoming data into binary using a comparator with a user-selectable threshold
voltage.

If the incoming signal is above the threshold voltage, the signal is converted to a one. If the incoming
signal is below the threshold voltage, the signal is converted to a zero.

After digitizing the incoming data, the logic analyzer samples it at regular intervals. The sampled and
digitized points are stored in memory along with the corresponding timing information.

See also the LA Module Block Diagram.

DSO Module
The DSO module converts incoming data into 8-bit digital values.

After digitizing the incoming data, the DSO module samples the voltage levels at regular intervals. The
sampled and digitized points are stored in memory along with the corresponding timing information.

See also the DSO Module Block Diagram.
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LA Conceptual Model

Overview
The logic analyzer conceptual model is made up of two main parts:

The system

The modules

From the operational perspective, a module encompasses
the setup, trigger, and the data associated with the physical
LA or DSO module installed in the logic analyzer mainframe.

The block diagram illustrates the relationship between the
LA and its subparts.

Behavior
Some actions occur at the module level, and some actions occur at the system level.

For example, you can save either system or module files. When you save a system file, you save all
of the setup information for the system including data window display settings, as well as the module
information. When you save a module file, you save all of the setup and trigger information.

. . Theory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

LA Physical Model
The logic analyzer physical model is made up of two main parts:

The mainframe

The modules

The following block diagram illustrates the relationship between the LA and its subparts.
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LA Block Diagram
The logic analyzer can be represented by the following blocks:
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Intermodule Interactions and Time Correlation
Each module has its own setup, trigger, and clocking functions. (Logic analyzer modules can include
microprocessor support as part of their setup.) Each module also acquires and stores its own data.

Acquisition
When you start an acquisition, all modules start acquiring data together. (Exceptions are when one module
has been programmed to arm another or when a module has been turned off.) Modules stop acquiring
data individually, according to their trigger programming. You also have the option of setting the logic
analyzer to operate in repetitive mode, in which the modules acquire data and update the data windows
continually until you manually stop the acquisition.

Triggering
Modules readily communicate with one another by means of their trigger programs. You can specify
functions such as the following:

Trigger all modules (system trigger)

One module arms another

Modules respond to events declared by another module (internal signals)

Analysis
After the modules have captured and stored data, you can view the data in a Listing or Waveform
window. All data is time-correlated in the display, regardless of its source. Due to the precise time stamp
information stored with the data and the tightly-integrated communication between modules, the logic
analyzer interleaves data acquired from various sources. Because time stamp information is always stored
with the data, you can also compare saved data and current data with no loss of accuracy.

MagniVu data is also time-correlated with regular data. Because MagniVu data is always present, you can
easily compare a normal acquisition with the MagniVu counterpart.

Related Topics
Trigger Programs

MagniVu Data
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High Speed Timing
The logic analyzer provides high-speed timing support through MagniVu data. The MagniVu data is stored
in a separate memory that is parallel to the main memory. All data from the sampler goes directly to the
MagniVu memory. The MagniVu memory also works like a circular buffer.

Unlike the acquisition memory, the MagniVu memory does not qualify data storage through the trigger
function block. Like normal acquisition data, MagniVu data can be displayed in the Listing or Waveform
windows.

MagniVu data is continuously acquired on all channels at the fastest sample rate possible for your LA
model. Some LA models allow you to adjust the trigger position. (See the following table.)

LA Model Sample Rate Trigger Position
TLA7Lx/Mx/Nx/Px/Qx 500 ps trigger center unadjustable
TLA7Axx/TLA7NAx 125 ps adjustable
TLA5000B 125 ps adjustable

Related Topic
Adding MagniVu Data to a Listing or Waveform window
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Listing Data Concepts
In many cases, you will use the logic analyzer to observe the data flow in the target system. The data
recorded by the logic analyzer can be displayed in a listing format, as shown:

Listing data is a table of sequential operations performed by the target system. In the Listing window, each
data sample is displayed sequentially. Because each data sample includes time stamp information, it is a
straightforward process to display acquisitions from multiple data sources. Samples from all specified
data sources are interleaved in chronological order. For clarity, each line in the table represents a single
data sample from a single data source.

You control the presentation of the data by selecting the display radix of the columns. You can also
make other format selections such as font size, color, and column width. You can use filters to display
specific data.

You can expand or collapse the Group column to display the individual channels. You can also add
individual channels.

You can include data acquired by the external oscilloscope in the Listing window. As with any module, the
data samples from the oscilloscope are time-correlated with the other data and appear on separate lines.
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Waveform Data Concepts
You can use the logic analyzer to observe the timing relationships between signals by displaying the
recorded signal activity as a series of waveforms in the Waveform window. The following figure shows
waveform data from a logic analyzer.

Waveform window
Each waveform is initially displayed in a separate track, but all waveforms are time-aligned horizontally
and displayed in the same time scale. The inclusion of time stamp information with the stored data samples
makes it easy to display time-correlated acquisitions from multiple data sources.

You control the horizontal scale of the acquired data in the display. (You do not, however, change setup
parameters by changing settings in the waveform display.) You can change the channel group radix,
waveform color, and waveform height. Like the Listing window, you can also use filters to display
specific data.

When viewing logic analyzer data, you can view the data as individual channels. You can also display
the logic analyzer data in groups of channels known as busforms. Use the busforms to display when
data changes with respect to clock or control signals. Another method of displaying logic analyzer data
is to overlay waveform channels. Use overlay waveforms to visually compare two or more waveforms
at the same time.

When you are interested in displaying the value of a group of channels over a period of time, you can
use magnitude mode. For example, using magnitude mode, you can view the channels connected to a
16-bit digital counter. The magnitude waveform appears as a sawtooth waveform as the counter values
increase from the minimum value (00) to the maximum value (FF).
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DSO Module Block Diagram
The DSO module can be represented by the following blocks:

. . Theory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

LA Versus DSO Module and External Oscilloscope Waveforms
A logic analyzer waveform appears to have zero-length rise and fall times. This is because the logic
analyzer is recreating the waveform from the samples stored in memory, which are either a one or a zero.

No electronic signal is perfectly digital in nature; there is always some analog component. Consider a
fast-rising pulse with ringing on the front edge, or glitches that can occur in a noisy circuit.

If you suspect problems caused by analog signal characteristics, such as signal voltages higher or lower
than specified voltage levels or slow transition times, you should use a DSO module or an external
oscilloscope to observe the voltage characteristics of the signal.

Related Topic
Sampling Resolution
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Sampling Resolution
The accuracy of the waveform recreated from the sampled data depends on the sample clock rate used to
record the incoming signals.

This is due to the fact that the waveform recreated by the logic analyzer is based on the sampled signals
stored in memory. If the sample clock rate is too low the recorded data will produce an inaccurate display.

Related Topic
Signal Resolution and Signal Duration

. . Theory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Signal Resolution and Signal Duration
There is an important relationship between the Sampling Resolution of the recorded signal and the
duration in terms of elapsed time.

Because the depth of the acquisition memory sets the total number of samples that can be recorded by
the logic analyzer, increasing the sample clock rate provides better signal resolution but reduces the
duration of the acquired signal. A faster sample clock rate will record a smaller portion of the signal, but
with higher resolution.

It is important to remember that by using the MagniVu data feature, you can view high-resolution data
centered around the logic analyzer trigger. This allows you to zoom in on the data while still maintaining
visibility of a more extended signal duration.
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Displaying Waveforms
Waveforms are rarely displayed in a one-to-one ratio between the sample points and pixels. Waveforms
are usually displayed in a compressed or expanded format.

As a general rule:

Waveforms are compressed when the time per pixel is greater than the time per sample clock.

Waveforms are expanded when the time per pixel is less than the time per sample clock.

For compressed DSO waveforms, the display shows the lowest and highest points that occupy a given
pixel column joined by a vertical line.

For expanded LA waveforms, the display points between the actual sample points are calculated.

For expanded DSO waveforms, Sin(x)/x interpolation computes the display points between the actual
values acquired.

Reference . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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DSO Module

Autoset (DSO Module)
Autoset automatically chooses the DSO setup values, based on the input signal at the time you click
Autoset. If you move the probe to another signal, click Autoset again to reset the setup values.

Autoset works best on repetitive signals that have 0 Volt offset. If the Autoset setup does not display the
waveform as you want it, you can change the setup manually.

Autoset sets up all input channels, the horizontal, and the trigger regardless of which Autoset button
is clicked.

Autoset makes the following selections automatically.

Vertical range: A setting that does not clip the waveform
Sample period: Period of the input signal divided by 100
Input coupling: DC
Vertical offset: 0.0V
Bandwidth: Full
Trigger level: Center of the input signal range
Trigger type: Edge
Trigger slope: Positive
Trigger coupling: DC
Trigger action: Trigger (module)

NOTE. If an acquisition is in progress, Autoset displays the Finishing Acquisition message box. Autoset uses Init
@ 50% to adjust the trigger level to the center of the input signal range. Autoset does not alter any acquisition
data or windows until the next acquisition.

To use Autoset from the System window, click the DSO Setup button, and then click the Autoset button.
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DSO Module Horizontal Settings
Horizontal settings control the rate at which the data is sampled and the amount of data acquired.

The sample period sets the interval between successive samples in a waveform record. Choose a sample
period that is fast enough that the waveform will not be aliased, and slow enough to provide the waveform
record length that you need. For best fidelity of repetitive waveforms, you should set the sample period to
at least five times that of the waveform.

Memory depth sets the total number of data samples to be acquired. If you do not need to use the full
memory depth to acquire data, select a smaller memory depth to get faster acquisitions.

To open the horizontal page from the System window, click the DSO Setup button, and then click the
Horizontal tab.

Related Topic
Autoset
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DSO Module Vertical Input Channel Settings

Overview
Channel settings adjust the vertical input parameters.

The vertical input voltage range control sets the attenuator full-scale voltage. If the range is selected from
the list, it forces an offset value into the Offset control. You can select from the list of standard presets by
clicking Options from the System menu, and then clicking the Presets tab.

Resolution
For best vertical resolution, set the range slightly larger than the expected input signal. Autoset
automatically sets the range for best vertical resolution on signals with 0 offset.

Offset
The vertical input voltage offset is the offset voltage applied to the input signal. If the attached probe can
be offset, it is applied at the probe tip. Otherwise, offset is applied at the BNC. If Range is changed
using the preset list, Range also sets the Offset.
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Bandwidth
Bandwidth is the range of frequencies that can be acquired and displayed accurately. Your bandwidth
selection sets the upper limit of frequencies that will be acquired and displayed. Bandwidth filters reduce
unwanted noise and aliasing, but can substantially change waveform fidelity.

Select the 20 MHz filter to set the upper limit of frequencies that are acquired to 20 MHz. The 20 MHz
filter does not provide complete anti-aliasing protection at slower sample rates.

Select the 250 MHz filter to set the upper limit of frequencies that are acquired to 250 MHz.

Select the Full bandwidth for best fidelity of signals with high frequency components. The Full
bandwidth filter passes the full analog bandwidth.

Coupling
Coupling selects how the input signal is coupled to the vertical input channel.

Use DC coupling to see the entire waveform (both AC and DC components).

Use AC coupling to view only the AC components of the waveform (DC components are blocked).

Use GND coupling to display a zero-volt waveform.

Signal Name
The Signal Name you enter becomes the new name for the waveform when it is displayed.

Termination
Select the vertical termination impedance appropriate for the input signal.

NOTE. Termination is at the BNC connector, not the probe tip. Input signal and vertical range and offset are limited by
50 W termination.

Probe Calibration
Probe calibration optimizes the signal path for this probe/channel/module combination.

Execute Probe Cal if any of these conditions have occurred:

The ambient temperature has changed more than 5 degrees Celsius.

The DSO notifies you that the probe is not calibrated.

More than 1 month has passed since the probe was calibrated.

To open a vertical channel setting page from the System window, click the DSO Setup button, and then
click a vertical channel tab.
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Related Topics
Calibrating Probes

Autoset
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DSO Module Setup
Before acquiring and displaying a waveform, you must first set up the DSO. Use the DSO Setup window
to set the vertical, horizontal, and trigger parameters manually, or use Autoset for a quick, automatic
setup based on the input signal.

NOTE. You cannot change setup parameters by changing the data display. Once you acquire data, you can
manipulate the display, but that will not change the input settings used to acquire the data. You must return to the
DSO Setup window to alter input settings.

To open the DSO Setup window from the System window, click the DSO Setup button.

Click the following selections for more information:

Autoset

DSO Vertical Input Channel Settings

DSO Horizontal Settings

DSO Trigger Settings

. . DSO Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

DSO Measurement Setup

Overview
Use the Measurement Setup dialog box to select the measurements that will be performed on the DSO
or external oscilloscope waveforms and to select the new measurement setup parameters. Click the
Measurement Setup button in the Waveform Properties dialog box to access the Measurement Setup
dialog box.
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Behavior
Available Measurements lists all of the available measurements that are supported on the DSO
waveform. When you select an available measurement, a graphic and a brief description of the
measurement are displayed beneath the Available Measurements list box. The following table lists
the available measurements and provides a description of each.

Selected Measurements displays up to three DSO waveform measurements that you select. You can
modify the list of selected measurements using the Add >> and Remove << buttons.

Base-Top Determination allows you to select the method for determining the base and top for a selected
measurement: automatic, histogram, or min-max. The default setting is automatic, which lets the logic
analyzer choose between histogram and min-max for the waveform under test.

The Reference Levels group box enables you to select either absolute or percentage-based reference
levels for the measured waveform. After selecting the type of waveform reference level, you can either
set the High-, Low-, and Mid-Reference levels or elect to use the defaults.

The Gating group box enables you to select the gating method for the measured waveform. You can
select the entire waveform, window boundaries, or cursors to be used as the gating limits.
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Available measurements Description
High The value used as 100% whenever high-reference,

mid-reference, or low-reference values are needed, such as
in fall time or rise time measurements. This method can be
calculated using either the min/max or histogram method.

Low The value used as 0% whenever high reference, mid
reference, or low reference values are needed, such as
in fall time or rise time measurements. This value can be
calculated using either the min/max or histogram method.

Amplitude This voltage measurement is the high value less the low
value measured over the entire waveform or gated region.

Maximum This voltage measurement is the maximum amplitude. It is
typically the most positive peak voltage and is measured
over the entire waveform or gated region.

Minimum This voltage measurement is the minimum amplitude. It is
typically the most negative peak voltage and is measured
over the entire waveform or gated region.

Peak to Peak This voltage measurement is the absolute difference
between the maximum and minimum amplitude over the
entire waveform or gated region.

Positive Overshoot This voltage measurement is measured over the
entire waveform or gated region and is expressed as:
Positive Overshoot = (Maximum – High) ÷

Amplitude x 100%

Negative Overshoot This voltage measurement is measured over the entire
waveform or gated region and is expressed as:

Negative Overshoot = (Low – Minimum) ÷ Amplitude x
100%

Mean This voltage measurement is the arithmetic mean over the
entire waveform or gated region.

RMS This voltage measurement is the true Root Mean Square
voltage over the entire waveform or gated region.

Rise Time This timing measurement is the time required for the leading
edge of the first pulse in the waveform or gated region to
rise from the low reference value (default = 10%) to the high
reference value (default = 90%) of the final value.

Fall Time This timing measurement is the time required for the falling
edge of the first pulse in the waveform or gated region to fall
from the high reference value (default = 90%) to the low
reference value (default = 10%) of the final value.

Positive Width This timing measurement is the distance (time) between the
mid reference (default = 50%) amplitude points of a positive
pulse. The measurement is made on the first pulse in the
waveform or gated region.
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Available measurements Description
Negative Width Measurement This timing measurement is the distance (time) between the

mid reference (default 50%) amplitude points of a negative
pulse. The measurement is made on the first pulse in the
waveform or gated region.

Period The time required to complete the first cycle in a waveform
or gated region. Period is the reciprocal of frequency and is
measured in seconds.

Frequency This timing measurement is a measure of the first cycle in a
waveform or gated region. Frequency is the reciprocal of
the period; it is measured in Hertz (Hz) where one Hz is
one cycle per second.

Positive Duty Cycle This timing measurement is the ratio of the positive pulse
width to the signal period expressed as a percentage. The
duty cycle is measured on the first cycle in the waveform or
gated region. Positive Duty Cycle = (Positive Width) ÷
Period x 100%.

Negative Duty Cycle This timing measurement is the ratio of the negative pulse
width to the signal period expressed as a percentage. The
duty cycle is measured on the first cycle in the waveform or
gated region. Negative Duty Cycle = (Negative Width) ÷
Period x 100%.

Area Area is a voltage-over-time measurement. The
measurement is the area over the entire waveform or gated
region expressed in volt-seconds. The area above the
common reference point is positive and the area below the
common reference point is negative.

Cycle Area The voltage over time measurement. The measurement is
the area over the first cycle in the waveform or the first cycle
in the gated region expressed in volt-seconds. The area
above the common reference point is positive and the area
below the common reference point is negative.

Cycle Mean This voltage measurement is the arithmetic mean over the
first cycle in the waveform or the first cycle in the gated
region.

Cycle RMS This voltage measurement is the true Root Mean Square
voltage over the first cycle in the waveform or the first cycle
in the gated region.

Burst Width This timing measurement is the duration of a burst and is
measured over the entire waveform or gated region.

Reference levels Description
High Reference This defines the high reference level of a waveform; the

default level is 90%. This reference level is used with the
Low Reference level in the calculation of rise and fall times.
To change this level, touch the control and then set the level
with the multipurpose knob.
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Reference levels Description
Mid Reference This defines the middle reference level of a waveform; the

default value is 50%. This reference value is primarily used
for making measurements between edges such as pulse
widths. To change this level, touch the control and then set
the level with the multipurpose knob.

Low Reference This defines the low reference level of a waveform; the
default level is 10%. This reference level is used with the
High Reference level in the calculation of rise and fall times.
To change this level, touch the control and then set the level
with the multipurpose knob.

Related Topics
Waveform Options

Setting Up Waveform Measurements

Removing Selected DSO Waveform Measurements
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Oscilloscope Waveforms

Overview
Oscilloscope waveforms have a horizontal resolution of one display point per pixel width. Each horizontal,
pixel-wide time slice has either a point or a vertical line to represent the vertical value of the acquired data
sample. If the time per division is fast enough that each display point represents one or fewer acquired
points, the vertical value is represented by a point. If the time per division is slower and multiple acquired
data samples need to be represented within a pixel width, the vertical value is represented by a vertical line
whose length and offset are determined by the acquired data values.

Behavior
When the time per division is decreased, waveforms are horizontally expanded, using sine x/x interpolation
to create display points between the acquired sample points. A vertical value is calculated for every
horizontal time point between the acquired data points.

When the time per division is increased, waveforms are horizontally compressed and decimated. The
minimum and maximum values are used as the endpoints of the vertical line that represents the data values
for that time point. The cursor readout displays the value of the top endpoint.

To Use
You can select whether to display range readouts. You can also select the readout color. For each
waveform, two readouts show the maximum and minimum vertical input voltage settings. The readouts
may contain symbols indicating AC or Ground coupling, 50 Ohms input impedance, and the bandwidth
limit. The ground line is indicated as a horizontal dotted line. The trigger threshold is indicated with a
T and an up arrow if the threshold is above the maximum voltage or a down arrow if the threshold is
below the minimum voltage.

Waveform size is dependent on the signal size and the input voltage range. The entire input voltage range
is used to set the default minimum and maximum values of the vertical range. Set the vertical range
values using the Waveform Options dialog box. You access it from the Waveform Properties dialog box
by clicking the Waveform tab, and then clicking the Options button.

To display no more than one data sample per display point, add a sample waveform from the same data
source and decrease the time per division until you can see individual clock tick marks.

Related Topics
Waveform Options

DSO setup

Sample Waveforms
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Logic Thresholds
Logic Threshold sets the voltage level that determines whether input signals are high or low (1 or 0). You
can select from a list of presets and Init @ 50%.

The list for each channel contains presets from Options, Presets, Logic Threshold. The default threshold
value is the midpoint of the vertical range of the trigger signal. The minimum and maximum threshold
values are the Vertical Offset +/- the Vertical Range of the trigger signal. The probe type, the vertical
range, and the trigger coupling all affect the threshold value.

Init @ 50% sets the threshold value to the midpoint of the trigger signal.
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Probe Calibration

Overview
The Probe Calibration dialog box controls all DSO probe calibration cycles and directs you to perform any
necessary steps. You can calibrate all attached probes or only the probe on the selected channel.

You can start a calibration cycle, view the progress of calibration, and see the results of calibration. Once
calibration starts, the calibration cycle of a single probe cannot be stopped. After a calibration cycle
completes, you can see the status of probe calibration.

Behavior
Instructions direct you to attach probes to the calibration fixture and the input channel.

Channel status shows the current probe and its calibration status.

Channel number shows the channel number of the probe.

Probe Calibration Status shows the calibration status for attached probes.

Calibrate Chan starts probe calibration for the selected channel.

Calibrate All starts probe calibration for all channels that can be calibrated. To stop calibration when
calibration for the current probe is complete, click Abort.

To Use
To open the Probe Calibration dialog box from the System window, click the DSO Setup icon, click a
channel tab and then click the Probe Cal button.

Related Topic
Calibrating Probes
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Pattern Generator

Pattern Generator Module
The pattern generator module adds pattern generator capability to the logic analyzer. You can generate
specific data patterns to a target system and then use the logic analyzer to evaluate the resultant data
from the target system.

The pattern generator module functionality can be divided into blocks as shown. Refer to the figure as
you read about the functional blocks.

Probes
The probe interface serves two purposes: to detect event and inhibit information and to output data to
a target system. In addition to sending pattern generator data to the target system, the probe also sends
clock and strobe information.

You can connect up to four probes to a single module. Each probe supports either 17 or 34 channels.

Pattern Generator Program
The pattern generator program is the heart of the pattern generator module. You can create blocks of
data vectors to work together to create complex pattern generator programs. The program uses external
and internal events to determine specific actions such as loops and branches to other data blocks. The
program can be controlled by an internally selected clock or by an external clock through a front-panel
BNC connector.

Reference . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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Maintenance and Service

General Care
Use the following information to maintain your logic analyzer. When performing maintenance on your
logic analyzer, it must be powered off, so you may want to print this information before proceeding.

Protect the logic analyzer from adverse weather conditions.

This logic analyzer is not watertight.

Do not store or leave the portable mainframe where the LCD display will be exposed to direct sunlight
for long periods of time, as it will degrade the performance of the LCD display.

CAUTION. To avoid damage to the logic analyzer, do not expose it to sprays, liquids, or solvents.

. . Maintenance and Service . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Preventive Maintenance
Tektronix recommends that you check the electrical performance and certify the logic analyzer accuracy
once a year.

For TLA7Axx/TLANAx modules, this service must be performed by a qualified Tektronix Service
Center technician.

For TLA7Nx/Px/Qx modules, this service must be performed by a qualified service technician using
procedures outlined in the TLA7Nx/Px/Qx Service Manual.

For TLA7Lx/Mx modules, this service must be performed by a qualified service technician using
procedures outlined in the TLA700 Series Performance and Adjustment Technical Reference.

Preventive maintenance mainly consists of periodic cleaning. Periodic cleaning reduces instrument
breakdown and increases reliability. Clean the logic analyzer as needed, based on your operating
environment.
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Flat Panel Display Cleaning
Use the following information to maintain your logic analyzer. When performing maintenance on your
logic analyzer, it must be powered off, so you may want to print this information before proceeding.

The display on the portable logic analyzer has a liquid crystal display with a soft plastic display cover that
must be treated with care when cleaning.

CAUTION. Improper cleaning agents or methods can damage the flat panel display. Do not use abrasive cleaners or
commercial glass cleaners. Do not spray liquids directly on the display. Do not scrub the display.

Clean the flat panel display surface by gently rubbing the display with a clean-room wipe. If the display is
very dirty, moisten a clean-room wipe with distilled water or a 75% solution of isopropyl alcohol, and
gently rub the display surface.

Cleanroom Wipes
Clean-room wipes are soft, lint free wiping cloths, such as Wypall Medium Duty Wipes, part number
05701, available from Kimberly-Clark Corporation.
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Exterior Mainframe Cleaning
Use the following information to maintain your logic analyzer. When performing maintenance on your
logic analyzer, it must be powered off, so you may want to print this information before proceeding.

Clean the exterior mainframe surface with a dry lint free cloth or a soft bristle brush. If dirt remains use
a soft lint free cloth or swab moistened with distilled water or a 75% solution of isopropyl alcohol, and
gently rub the surface.

Do not use abrasive cleaners.

CAUTION. Do not get moisture inside the mainframe during external cleaning. Do not wash the On/Standby switch.
Use only distilled water when cleaning. Use a 75% solution of isopropyl alcohol as a cleaner and rinse with distilled
water.

CAUTION. Do not use chemical cleaning solvents as they might damage the logic analyzer. Do not use any cleaning
product that contains benzene, toluene, xylene , acetone, or similar solvents.
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Floppy Disk or CD/DVD Drive Cleaning
Use a commercially available floppy disk drive cleaning kit or CD/DVD drive cleaning kit for routine
maintenance.
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Repacking for Shipment
If you are shipping a mainframe or module is to Tektronix for repair, attach a tag to the mainframe or
module with the owner’s name, phone number (and other contact information) and address. Include the
serial number and a detailed description of the problem.

When packing the mainframe or module, always use the original packaging materials. If the original
packaging is not available Contacting Tektronix to obtain new packaging.
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Functional Check
Use the power-on diagnostics to check the basic functionality of your logic analyzer product. These
diagnostics run every time you turn on your logic analyzer.

You can also check the functionality of the logic analyzer by connecting a probe to a single source
and verifying that the logic analyzer is acquiring data. (For more verification procedures, refer to the
Specifications and Performance Verification Technical Reference manual on the Documentation CD that
came with you instrument.)
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Navigation Tips
Miscellaneous Topics

Setting Up Source Synchronous Clocking
1. In the Setup window, click Source Sync from the Clocking list box.

2. Click the More button to display the Source Synchronous Clocking dialog box.

Click the Tasks button for topics that describe how to set up each of the source synchronous clocking
parameters.

After you finish defining source synchronous clocking options, click the Validate button in the Source
Synchronous Clocking dialog box to determine whether hardware conflicts exist as a result of your
selections.
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Source Synchronous Group Clocking

Overview
Use the source synchronous Group Clocking tab when you are defining advanced clocking parameters that
specify the sync speed, edge detector, setup/hold window, clock group, pipeline delay, and sample clock.
Also note that default values apply to groups that do not override this setting.

Behavior
The following are fields contained in the Group Clocking tab:

Sync Speed

Use Max Sync Speed - Select this option button to accept data at the highest rate that the module supports.
This setting ensures that, regardless of the module’s current maximum data rate, you will always receive
the maximum data rate of modules in the future.

Sync Speed - Select this option button and choose a speed from the drop-down list to set a static sync
speed. For example, dialing down performance (reduction of the maximum data rate that the logic
analyzer can capture—similar to a bandwidth limit) is beneficial when attempting to reduce detectable
noise. With slower speed logic signals, signal quality does not interfere with system operation. This is
particularly true in the presence of glitches.

Group
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The Group field contains the individual channel groups. For each channel group, you can specify a
different edge detector, setup/hold window, clock group, pipeline delay, and sample clock. You can change
the contents of channel groups, or add and delete channel groups from the LA Setup Window.

Edge Detector

This is the signal used to sample data signals coming into the system. You can either use the default edge
detector, or select one from the list box as a data point to send through the logic analyzer.

Edge Detector 0 is the clocking state machine (CSM) heartbeat clock and is distributed to all of the slave
modules. Therefore, it can be used as the edge detector for any channel group. However, if a channel
group is from a slave module, it can only use edge detectors that are local to the channel group’s slave
module. If a channel group contains mixed channels, then you must use Edge Detector 0. For example, a
group that contains only channels SA3(7-0) could be assigned to Edge Detector 0, 4, 5, 6, or 7.

Setup/Hold Window

Use this field to sample data before or after the clock edge captured by the edge detector. The edge detector
is the reference point. Therefore, setup and hold values are set when the data is sampled, in reference
to the edge detector. To graphically view your selected sample data, refer to the Setup/Hold window
located in the upper right of the Group Clocking tab.

Clock Group

A selection of None in the Clock Group field indicates that the master clock pushes data through the
pipeline. You can use an alternate clock group to push data through the pipeline by selecting one from the
drop-down list.

Pipeline Delay

This functionality is used for aligning data. You can set the pipeline delay to hold data for one or more
clock cycles of the CSM heartbeat clock before sending it through the pipeline. The sample clocks collect
data but don’t send it until pipeline delay is satisfied.

Sample Clock

A clock group combined with a qualifier produces a sample clock signal, which latches the data that goes
to the trigger state machine.

Sample Clock 1 is the master sample clock. Whenever the system receives Sample Clock 0, it sends the
data at the end of the data pipeline to the trigger state machine. This data may or may not be stored in
main memory, based on storage qualification. Data being retained in other sample clocks is held until
Sample Clock 0 is received, after which all stored data is logged in.
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Source Synchronous Sample Clocks

Overview
Use the source synchronous Sample Clocks tab to create clocking equations that define a sample clock.
You can define up to four multiple-phased clock expressions that are logically ORed. Each clock
expression can be AND’ed with up to three qualifiers.

Sample Clock
You can select the desired sample clock group from the associated list box. Up to four sample clock groups
are available, with Sample Clock 1 being the master sample clock.

Clocking Equation
Use the clocking equation to combine multiple clock groups into one sample clock.
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Source Synchronous Clock Groups
Each sample clock consists of three clock groups. Each clock group contains up to 20 fast-latch edge
detectors.
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To Use
For each clock group, perform the following:

Select the edge detectors that you want to define each clock group. All selected edge detector outputs
must be seen before the clock group complete signal is released from the clock group.

Enable reset will restart the sample period after a certain time or after a number of heart beat clock
pulses have passed. If the edges have not been seen, it will flush all contents and begin looking again.

Select an option button to specify what method to use for resetting - Counter uses a number of CSM
heartbeat clock pulses (0-255) before resetting. - Timer uses nanoseconds (0-510 ns, specified in 2 ns
increments) to wait before resetting.

Specify a quantity in the Value field, which represents the amount of time, expressed in either
nanoseconds or heartbeat clocks, to wait before resetting.

Optionally select the Use External Reset check box and specify a clock signal. External reset is
mutually exclusive of internal reset. Internal reset uses the counter or timer selections. External reset
uses clock 0, 1, 2, or 3. Reset occurs when the clock signal is high. However, you can change when
reset occurs by selecting the Invert Clock Signal check box.
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Source Synchronous Edge Detectors

Overview
Fast latch edge detectors are designed to recognize a set of clock edges coming into a module. Tektronix
Logic Analyzers contain four fast latch edge detectors, with Edge Detector 0 set as the clocking state
machine (CSM) heartbeat clock that becomes the pulse to drive the rest of the system.

To Use
You can select all, some, or none of the fast latch edge detectors for each module, to create a clock group.
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Source Synchronous Clocking Dialog Box

Overview
To display the Source Synchronous Clocking dialog box, you select Source Sync clocking in the LA Setup
window and click the More button. Then click each tab and enter the appropriate clocking information, as
described below. Once you have set all clocking parameters, click the Validate button to check that there
are no conflicts in the source synchronous clock settings.

Edge Detectors Tab
Use the Edge Detectors tab to specify which clock edges coming into a module will be recognized.
TLA7Axx logic analyzer modules and TLA5000B Series logic analyzers contain four fast latch edge
detectors, with Edge Detector 0 set as the CSM heartbeat clock.

Clock Groups Tab
Use the Clock Groups tab to select the edge detectors that will define each clock group. Then select
the Enable Reset check box to restart the sample period and select both the reset method and quantity.
You can optionally select to override your internal Reset check box by selecting the Use External Reset
check box and selecting a clock channel.

Sample Clocks Tab
Use the Sample Clocks tab to create clocking equations that define a sample clock. You can define up to
four multiple-phased clock expressions that are logically ORed. Each clock expression can be ANDed
with up to three qualifiers.

Group Clocking Tab
Use the Group Clocking tab to define advanced clocking parameters that specify the sync speed, edge
detector, setup/hold window, clock group, pipeline delay, and sample clock. Also note that default values
apply to groups that do not override this setting.

Probe Demux Tab
Use the Probe Demux tab if you are acquiring data from a multiplexed address or data bus that will need to
be demultiplexed before use. Select the demultiplex type that you want performed, and then choose the
probe channels you want to demultiplex. You can choose probe channels by either selecting the check
box associated with each probe channel of interest or by clicking the Select All button to demultiplex all
probe channels.
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Source Synchronous Clocking

Overview
Source synchronous clocking sends the strobe signal with the data signal and the data is synchronized with
the strobe signal instead of the clock signal. The sending device is responsible for synchronizing the data
with the strobe signal. The receiving device is responsible for latching the data inside of itself and for
resynchronizing the data with the clocking state machine (CSM) heartbeat clock.

Behavior
You can merge up to five TLA7Axx logic analyzer modules, each containing four clocks, for a maximum
of 20 independent clock signals. From the master module, you can look at any combination of available
clock signals. However, clock signal access is limited to a given module’s local clock signals.

The front-end of the TLA7Axx logic analyzer modules and the TLA5000B Series logic analyzer state
machine is capable of maintaining event information, based on clock signal. Clock group complete is a
signal that indicates when all user-specified edges have occurred within the CSM heartbeat clock. When the
clock group complete signal is received, then the CSM heartbeat clock logs the data into the logic analyzer.
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Source Synchronous Clocking Validation

Overview
To successfully capture acquisition data, many components of a source synchronous clocking setup must
all work together. To ensure coherency of the Source Sync setup, you can click the Validate button, located
at the bottom of the Source Synchronous clocking dialog. Clicking the Validate button initiates a check
of the settings in all of the tabs of the Source Synchronous clocking dialog box to ensure that there are
no obvious conflicts or omissions that would prevent data from being acquired. This check is also run
automatically when you close the Source Synchronous clocking dialog box.

Behavior
The validation procedure may produce one or more of the following warning messages:

There are no clock edges defined for Edge Detector 0, which is the CSM Heartbeat Clock.

The CSM Heartbeat Clock determines when the clocking state machine moves to the next state and
drives the clock group complete detectors. If no clock edges are included in the Edge Detector 0
definition, then no data will be acquired.

There are no clock groups defined for Sample Clock 0, which is the Master Sample Clock.
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The Master Sample Clock determines when data is sent out to both the logic analyzer trigger state
machine and to main memory. If no clock groups are included in the definition of Sample Clock 0,
then no data will be acquired.

There are no clock edges defined for Edge Detector <e> used in Clock Group <c>.

For a Clock Group Complete signal to be active, the Clock Group Complete Detector must see
inputs from all of its component edge detectors. If a particular edge detector included in the clock
group has no clock edges defined, then it will never be active. This causes the clock group to never
become active.

There are no edge detectors defined for Clock Group <c> used in Sample Clock <s>.

For a Sample Clock signal to be active, it must contain a Clock Group signal that has some activity. If
a particular clock group included in the sample clock has no edge detectors defined, then it will never
be active. This causes the sample clock to never become active.

There are no clock edges defined for Edge Detector <e> used for channel group <group>.

When an edge detector is assigned to a channel group, its activity is used as the sample point for the
channels of that group. If an edge detector definition contains no clock edges, then it will never be
active and the channels of the group assigned to it will never be sampled.

There are no edge detectors defined for Clock Group <c> used for channel group <group>.

When a clock group is assigned to a channel group, it advances the channel group data through the
FIFO in the data pipeline. If the clock group definition contains no edge detectors, then it will never
be active and will never advance the data through the FIFO.

There are no clock groups defined for Sample Clock <s> used for channel group <group>.

When a sample clock is assigned to a channel group, it determines when the channels of that group
are cached for storage into main memory. If the sample clock definition contains no clock groups,
then it will never be active and the data from the channel group will be stored using the Master
Sample Clock only.

Groups <group1> and <group2> contain a common channel but have conflicting settings for their
<attribute>.

<attribute> may be Edge Detector, Setup/Hold Window, Clock Group, Pipeline Delay, or Sample
Clock.

When two or more channel groups contain the same channel, there is a potential for conflicting
attribute settings for that channel. Each group may be independently assigned to each attribute using
the grid in the Group Clocking page of the Source Synchronous clocking dialog. When conflicts arise,
the actual channel setting is taken from the group that appears first in the grid.

Too many Edge Detectors for channel block <block>: <n> were found, but only 2 allowed.
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<block> = A3/A2/D3/D2, A1/A0/D1/D0, C3/C2/C1/C0, or E3/E2/E1/E0 for 136 channel modules

<block> = A3/A2/D3/D2, A1/A0/D1/D0, or C3/C2/C1/C0 for 102 channel modules

<block> = C3/C2/A3/A2 or A1/A0/D1/D0 for 68 channel modules

<block> = C3/C2/A3/A2 for 34 channel modules

Due to hardware signal routing constraints, there are only two edge detectors available for each block
of 32 data channels. Clock and qualifier channels do not have this limitation. The channel grouping in
the LA Setup dialog box and edge detector assignments in the Group Clocking tab of the Source Sync
Clocking dialog box must be configured so that each block of 32 channels uses a maximum of two
edge detectors. Note that ungrouped channels are assigned to Edge Detector 0. This property cannot
be changed, so it may be necessary to create extra groups for the purpose of edge detector assignment.

For example, there are two groups defined in the LA Setup dialog: Group1 that contains channels
A3(7-0) and Group2 that contains channels A2(7-0). Group1 is assigned to Edge Detector 1,
while Group2 is assigned to Edge Detector 2. This configuration uses three edge detectors for the
A3/A2/D3/D2 channel block: Edge Detector 1 for the A3 channels, Edge Detector 2 for the A2
channels, and Edge Detector 0 for the D3 and D2 channels. One way to fix this problem is to
create a Group3 that contains channels D3(7-0) and D2(7-0), and assign it to either Edge Detector
1 or Edge Detector 2.

Too many Clock Groups for channel block <block>: <n> were found, but only 1 allowed.

<block> = A3/A2/D3/D2, A1/A0/D1/D0, C3/C2/C1/C0, or E3/E2/E1/E0 for 136 channel modules

<block> = A3/A2/D3/D2, A1/A0/D1/D0, or C3/C2/C1/C0 for 102 channel modules

<block> = C3/C2/A3/A2 or A1/A0/D1/D0 for 68 channel modules

<block> = C3/C2/A3/A2 for 34 channel modules

Due to hardware signal routing constraints, there is only one clock group available for each block of
32 data channels. Clock and qualifier channels do not have this limitation. The channel grouping
in the LA Setup dialog box and clock group assignments in the Group Clocking tab of the Source
Sync Clocking dialog box must be configured so that each block of 32 channels uses a maximum of
one clock group. If a channel group has a Clock Group of "None" it does not contribute to routing
conflicts. All ungrouped channels are set to a Clock Group of "None."
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Source Synchronous Clocking Data Flow

Overview
The following block diagram shows all of the different clocking hardware resources that may be
programmed when using the Source Synchronous Clocking mode. Data from the system under test is
captured by the MagniVu Sampler and enters the data pipeline from the left. Then, depending on the
settings made in the Source Synchronous Clocking setup, relevant bits of the data are chosen, aligned with
each other and sent on to the Trigger State Machine and the main logic analyzer acquisition memory from
the right of the data pipeline.

556



Miscellaneous Topics Source Synchronous Clocking Data Flow

Data Demux (2X/4X)
Information from some incoming data lines may be duplicated into other data lines. When the data from
one channel is copied to another channel, it is referred to as 2X demultiplexing. When the data from one
channel is copied to three other channels, it is referred to as 4X demultiplexing. Data demultiplexing may
be set up using the Probe Demux tab of the Source Synchronous Clocking dialog box.

NOTE. MagniVu data is unaffected by source synchronous clocking mode because it always acquires
non-demultiplexed 1X data.

Fast Latch Edge Detectors
Fast Latch Edge detectors may be set up to recognize any combination of rising and falling edges from the
four clock signals of the logic analyzer module. There are four Fast Latch Edge Detectors present for each
logic analyzer module, and each may have independent settings for which clock edges it will recognize.
Slave module edge detectors may also be programmed independently of the master module. Therefore,
with a 5-way merge, a total of 20 independent Fast Latch Edge Detectors are available.

Once an edge detector has recognized a clock edge, there is a certain period of time that must elapse before
the detector is ready to look for the next edge. This time is related to the maximum synchronous speed of
the module. For example, when an edge detector of a 450 MHz module recognizes a clock edge, it takes
2.2 ns before the edge detector is ready to look for the next clock edge. Clock edges that occur before
2.2 ns have elapsed are not captured by that edge detector. This property applies to each edge detector
individually, but not across edge detectors.

For example, assume that data comes into the Fast Latch Edge detectors at a rate of 8GHz from the
MagniVu sampler. This means that there are 125 ps between successive samples. If Edge Detector 0
detects one of the enabled clock edges at time t, Edge Detector 1 may detect one of the clock edges
at time t + 125 ps, which is much less than the 2.2 ns delay imposed by the maximum synchronous
speed of the module.

Edge Detector 0 of the master module is a special signal that is called the CSM Heartbeat Clock. The CSM
Heartbeat Clock is used to drive the activity of the Clock Group Complete Detectors and the Clocking
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State Machine, so it must have some activity in order for any data to be acquired. Fast Latch Edge
Detectors are set up on the Edge Detectors tab of the Source Synchronous Clocking dialog box.

Sample Point Select
The Sample Point Select stage of the data pipeline allows a Fast Latch Edge Detector signal to be assigned
to each data channel. Whenever the Edge Detector signal for a channel is active (that is, a clock edge
has been detected), the data value of the channel is propagated out of the Sample Point Select to the next
stage of the data pipeline. All other data values coming from the MagniVu sampler for that channel
are ignored. This has the effect of reducing the frequency of the samples in the data pipeline from the
MagniVu sample rate (for example, 8 GHz) to something at or below the maximum synchronous sample
rate of the logic analyzer module (for example, 450 MHz). By default, all channels are sampled with
Fast Latch Edge Detector 0.

The data value propagated out of the Sample Point Select is normally the value that occurs at the exact
time when a clock edge is detected. However, changing the Setup/Hold window selection for the data
channel may select earlier or later data values to be used. The default Setup/Hold window of 625 ps/0 s
selects the data value at the clock edge. If the MagniVu sample interval is 125 ps, a Setup/Hold Window
of 750 ps/125 ps selects the data value one MagniVu sample before the clock edge, while a Setup/Hold
Window of 500 ps/125 ps selects the data value one MagniVu sample after the clock edge.

Fast Latch Edge Detector signals may be assigned as the sample point for all channels of a channel group
in the Edge Detector column of the grid in the Group Clocking page of the Source Synchronous Clocking
dialog box. The data of a channel group may be sampled earlier or later by choosing a non-default value
in the Setup/Hold Window column of the grid.

Clock Group Complete Detectors
In many cases, it is desirable to set up the Source Synchronous acquisition so that data acquired in multiple
clock domains is stored in a single acquisition sample. This may be done through the use of Clock Group
Complete Detectors. There are three Clock Group Complete Detectors available. A clock group may be
formed from any combination of the available edge detectors (up to 20 in a 5-way merge). For a clock
group signal to be active, activity must be observed on all of the enabled edge detectors. There is no
constraint on what order the edge detector signals must seen, but it is assumed that all of the edge detectors
in a clock group occur with roughly the same frequency. Clock Group Complete Detectors are set up in the
Clock Groups tab of the Source Synchronous Clocking dialog box.

FIFO
The FIFO stage of the data pipeline may be used to hold data values that were sampled with different edge
detectors (at different times) from the same clock group. All of the data channels may then be assigned to
the same clock group signal so that they come out of the FIFO at the same time. By default, the FIFO stage
is transparent, and all data moves through it at the rate it was sampled in the Sample Point Select stage.
However, a clock group signal may be assigned to some channels to move their data through the FIFO at a
different rate. Clock group signals may be assigned to all the channels of a channel group in the Clock
Group column of the grid in the Group Clocking tab of the Source Synchronous Clocking dialog box.
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Clocking State Machine
The Clocking State Machine is used to combine the clock group signals with qualifiers to form sample
clock signals. There are four sample clock signals available. Sample Clock 0 is a special signal that is
called the Master Sample Clock. The Master Sample Clock is used to send out data samples from the
Login Register to the Trigger State Machine and main acquisition memory, so it must have some activity
in order for any data to be acquired. Other sample clock signals may be used to temporarily cache data
at a time when it is valid for some channels, but not for others. Sample clock signals are set up in the
Sample Clocks tab of the Source Synchronous Clocking dialog box.

Adjustable Pipeline
The Adjustable Pipeline allows each data channel to be delayed by 0 to 7 cycles of the CSM Heartbeat
clock. It may be used to align data captured in different heartbeat clock cycles that needs to be stored
together in the same acquisition sample in main memory. By default, a pipeline delay of 0 is set for all
channels. The Adjustable Pipeline delay may be set for each channel group in the Pipeline Delay column
of the grid in the Group Clocking tab of the Source Synchronous Clocking dialog box.

Login Register
The Login Register uses the sample clock signals to log data that will be sent to the Trigger State Machine
and main acquisition memory. When a sample clock signal is active, all of the data channels tied to that
signal are cached in the Login Register. When the Master Sample Clock (Sample Clock 0) occurs, all of
the cached data is sent out together as one sample to the Trigger State Machine and to the logic analyzer’s
main acquisition memory. By default, all channels are tied to the Master Sample Clock. The sample clock
for each channel group may be set in the Sample Clocks column of the grid in the Group Clocking tab
of the Source Synchronous Clocking dialog box.

Related Topics
Probe Demultiplexing

Source Synchronous Edge Detectors

Source Synchronous Group Clocking

Source Synchronous Clocking Groups

Source Synchronous Sample Clocks
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Setting Up Probe Demultiplexing
1. From the System dialog box, click the Logic Analyzer Setup button to display the LA Setup dialog box.

2. Set the Clocking mode to Source Sync. The system responds by displaying the More button.

3. Click the More button to display the Source Synchronous Clocking dialog box.

4. Click the Probe Demux tab to specify which probe groups are demultiplexed.

5. Select the desired demultiplex type.

6. Select the sections, clocks, and qualifiers that will be available for demultiplexing.

TIP. Click the Select All button to select all sections, clocks, and qualifiers for demultiplexing; click the Clear All button
to turn off demultiplexing for all sections, clocks, and qualifiers.

7. Either click the 2X Demux option to route the same data signal to two different logic analyzer channels,
or click the 4X Demux option to route the same data signal to four different logic analyzer channels.
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memory status, 484
mode, 264
normal mode, 264
sample, 226
setup/hold mode, 264
storage, 250

Active cursor readout, 338
Active module, 477
Activity indicators, 32
Activity, 484
Add Column/Waveform Dialog

Box, 290
Add Protocol Dialog Box, 400
Add Protocols, 404
Add Transition dialog box, 260
Add Word dialog box, 262

Adding, 182
columns in a Listing

window, 182
data source to an active Listing

window, 117
data source to an active

Waveform window, 209
file suffixes for the Source

window, 138
histogram data from another

source, 331
If/Then clause to a trigger

state, 155
LA channel groups, 80
LA channels, 80
MagniVu data to a Listing or

Waveform window, 119
mark to a data window, 211
new graph, 429
Opcode Mark, 182
reference data to a Listing

window, 181
reference data to a waveform

window, 205
search paths for the Source

window, 130
state to a trigger program, 154
waveform, 187

Address/data bus multiplexed
signal acquisition, 37

Advanced clocking, 70
Advanced trigger, 247
Alignment of time, 298
Analog multiplex cables, 514
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Analog multiplexing, 59
assigning data signals via the

iConnect Analog Feeds
dialog box, 33

cables, 514
changing signal routing, 108
setting up, 83
signal routing from the logic

analyzer, 59
signal routing to the

oscilloscope, 60
specifying physical

connections, 61
Analog outputs, 33
analog routing, 448
Analog signal routing from the

logic analyzer, 59
analyze data, 329
antivirus, 4
Apply AutoDeskew Results dialog

box, 416
Applying filters to data

windows, 43
Argument and command

entry, 502
Tool Property dialog box, 502

Arming, 496
a module using an LA

module, 253
determining which module

is set to arm the DSO
module, 203

interaction, 496
other modules from a DSO

module, 204
other modules from an LA

module, 169
ASN.1 Types, 364

additions to PSDL, 364
PSDL, 359

Assigning, 80
LA channel groups, 80
LA channels, 80

Associating, 207
data windows with

modules, 207
modules with data

windows, 207

Asynchronous, 487
clocking, 64
digital oversampling, 487

AutoDeskew, 407
Properties, 414
Setup, 412
Setups, 415
Window, 407

Autoset, 534
DSO, 534
serial analyzer, 54

average, 420
Axis Type Wizard, 100

B
Background color for Listing

window, 301
Background color, 193
Bad channels, 32

checking, 32
barrel connectors, 522
Binary file format, 293
Block diagram, 531

DSO module, 531
LA module, 526

Blocks mode, 26
details, 265

Bus support triggering, 449
Bus-specific framers, 380
Busform, 134

displaying LA data as a
busform, 321

selecting the radix of busform
readouts, 134

waveforms, 316

C
Calibrating, 89

modules, 88
probes, 89

Calibration, 89
DSO probes, 89
probe calibration (DSO

module), 543
self calibration properties, 491
when using a three way

merge, 491

Change detect, 257
Changing, 121

color, 142
column properties, 136
data series range, 139
defaults, 137
file suffixes, 112
graphs, 140
If/Then clauses, 155
LA channel polarity, 82
mark properties, 136
position of cursors, 121
properties for the Listing

window, 137
search paths, 113
signal routing, 108
start-up defaults, 137
waveform properties, 194
window properties, 131
zoom options, 135

Channel Activity Indicators, 56
Channel activity, 32
Channel change, 167

triggering on, 167
Channel Compare Mode, 94
Channel compare, 83
Channel group definitions, 449

bus supports, 449
microprocessor and bus

support, 449
microprocessor supports, 449

Channel group, 168
effects on data source, 325
name, 29
ranges, 170
triggering an LA module, 168

Channel grouping table, 28
Channel grouping, 96
Channel Import and Export

Formats, 44
Channel mapping, 74
Channel names for an LA, 31
Channel polarity (LA module), 82
Channel settings, 535

DSO, 535

562



Index

Channel setups, 45
exporting, 46
import behavior, 45
importing, 47

Channel thresholds, 33
Channel-lane assignment,

serial analyzer, 56
Channels, 1

how many can I have?, 1
selecting, 157

character, 272
chart, 421
Choosing system to open at

startup, 489
Clause, 155

adding an If/Then clause to a
trigger state, 155

defining If/Then or Else
If/Then, 268

Cleaning, 546
exterior mainframe, 546
flat panel display, 546
floppy disk drive, 547

Clearing histogram data, 331
Clock groups, 144
Clock, 64

edge, 556
fast sample clock

example, 532
qualifier definition, 64
selecting clock

qualification, 148
serial analyzer, 55
setting delays for the, 144
setup time, 144
signal out, 496
slow sample clock

example, 532
SUT, 55

Clocking details, 238
External 2X DDR, 229
External 2X, 226
External 450, 238
External 4X, 233
Internal 2X, 219
Internal 4X, 222
source synchronous, 556

Clocking group complete
(CGC), 509

clocking mode, 24
Clocking state machine

(CSM), 509
Clocking, 556

advanced, 70
asynchronous, 24
Clocking for support

packages, 83
dialog box, 62
equation definition, 62
equations, 64
External 450, 74
LA setup window, 23
merged module external, 70
problems, 451
setting up, 149
source synchronous clocking

data flow, 556
source synchronous

clocking, 554
synchronous, 145

Code loop, 348
COFF file format, 465
Collapse channels, 214
Color, 300

background, 193
change of marks, 300
graticule, 193
properties, 43
scheme for active data

window, 192
selecting the active data

window, 192
tab, 498

Coloring data, 187
Colors of marks, 136

Column, 299
Add Column/Waveform

dialog box, 290
adding a column to a Listing

window, 182
changing properties, 384
going to a specific

column, 184
moving a, 182
properties, 299
selection, 298
showing and hiding, 299
tab, 299

Columns in a Protocol
window, 378

Comment Lines, 49
Compare Definition Dialog

Box, 38
Compare, 94

channels, 94
data, 93
limitations, 38
parameters, 83

Comparing acquired data with
saved data, 90

Comparing data, 92
Compilation Result Pane, 380
Compression-on-PCB to Mictor

adaptor, 523
Conditional storage, 249
Configuration, 499

mainframe, 492
software, 499

Configure, 11
Configuring external and internal

signals, 496
Connect, 10
Connections, 10
Connectors, 496

mainframe, 496
Contacting Tektronix, 5
Continuous acquisition, 87
Control Lines, 49
Control statements, 354

PSDL, 354
Controlling whether a waveform

is visible, 191
controls, 5
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count measurement, 418
Counters, 170

problems, 170
triggering an LA module on

counter values, 161
Create New Protocol Files, 405
Create New Stack Files, 407
Creating, 184

custom color schemes, 89
new data window, 99
overlay waveform, 210
symbol files, 184

cursor position, 121
cursor readout, 338
Cursors locked together in

different data windows, 291
Cursors, 218
Custom Clocking dialog box, 450
Custom clocking, 450
Custom color schemes, 89
Customer feedback, 5
Cycle marking, 299

D
data area, 18
Data Samples, 542
data series, 428
data source, 329

determining, 133
measuring, 329
properties, 325
time alignment, 298

Data sources, 331
information about, 184

Data storage,
serial analyzer, 55

Data Valid Window, 407

Data window, 96
associating with modules, 207
changing properties, 131
changing the background, 131
creating a New Data

window, 389
locked, 291
New Data Window dialog

box, 480
New Data Window name, 481
System window, 477
wizard, 96

Data, 21
compare, 38
determining the data

source of the selected
waveform, 133

displaying from a saved
sample, 9

examining the listing data, 21
font size, 301
incorrect after acquisition, 452
MagniVu, 487
measurements setup, 418
name, 481
patterns, 544
points, 308
properties, 299
searching on selected data, 22
triggering on group data

values, 165
value triggering, 165
viewing sample data, 18
when to store, 157
window dialog box, 480

Decimal values, 252
signed, 252

Decode View, 378
Default setup, 489

default system, 489
Defaults, 137

changing, 137
properties, 499
tab, 499

Define Bus dialog box, 390
define compare, 38

define filters, 40
Define protocols, 405
Define Search Dialog Box, 296
Define Snapshot dialog box, 270
Define Suppression dialog

box, 303
Defining, 375

compare parameters, 90
data to search for, 296
histogram ranges, 330
If/Then clauses in a trigger

program, 155
multiple transition

recognizers, 156
protocol with PSDL, 375
source data to search for, 129

Definition of MagniVu data, 487
Delete Protocol or Stack Dialog

Box, 402
Delete Protocols, 405
Deleting, 81

LA channel groups, 81
LA channels, 81

Delimiter, 115
When exporting data from a

Listing window, 115
Delta, 201

time measurements, 201
volts measurements, 200
waveform measurements, 201

destination channel, 33
Detecting violations, 262
Determining acquisition

status, 484
Developing custom color

schemes, 89
Diagnostics, 207
Digital signal routing, 107

from a logic analyzer output
channel, 107

to an oscilloscope input
channel, 107

Digitizing a signal, 524
Disabling modules, 477
Disassembler, 182

adding opcodes, 182
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Disassembly, 449
display formats, 450
properties, 301
selecting display formats, 450
tab, 301
using microprocessor and bus

support packages, 449
Displaying, 533

disassembled data, 301
DSO data, 217
glitches, 190
graticules, 194
information about data

sources, 184
information about the

Histogram window, 331
information about the Source

window, 347
magnitude, 196
mainframe information, 206
marks in a data window, 213
module information, 206
violations in a waveform

window, 192
waveform readouts, 189
waveforms, 191

Double data rate, 72
Dragging marks, 212
Drawing Style dialog box, 425
DSO probe, 89
DSO trigger, 509

setup, 204

DSO, 89
Autoset, 534
calibrating probes, 89
compressed waveform

format, 533
cursors, 218
displaying DSO data, 217
expanded waveform

format, 533
horizontal settings, 535
module arming, 204
module block diagram, 531
module setup, 17
naming vertical channel

signal, 197
setting up, 204
storing DSO data, 217
trigger settings, 509
vertical, 535
waveforms, 542

dual channel measurements, 179
Duplicating LA channels, 81
Dwarf file format, 465

E
EasyTrigger, 287

library, 287
list contents, 287
program list, 287

Edge Detectors, 554
Edit Protocol Files, 109
Edit Relations Between

Protocols, 110
Edit stack files, 110
Editing a Tool on the Tools

Menu, 111
editing file suffixes, 112
editing search paths, 113
editing symbol files, 114
Editing, 112
Elf/Dwarf file format, 465
Elf/Stabs file format, 465
Enhanced column headers, 294
Entering a symbol plus an offset

in a trigger, 281
Error Message Dialog Box, 303
Error Messages, 554
Event target value limit, 171

event type, 509
Examining a waveform, 18
Example, 20

getting started, 8
viewing a magnitude

waveform, 20
Executing an operation after an

acquisition, 87
Expand channels, 213
Export Data dialog box, 292
Export Data Options Dialog

Box, 294
Export data, 292
Export Histogram dialog box, 328
Export Histogram Options dialog

box, 328
Export Stack Dialog Box, 403
Export, 388

protocol data, 388
Exporting, 468

channel setups, 46
data from a Listing

window, 115
group width and radix

information, 294
historgram data, 115
protocols, 403
stacks, 403
symbol tables, 468

Extended Diagnostics, 453
Exterior mainframe cleaning, 546
External 2X clocking, 66

details, 226
dialog box, 72

External 2X DDR clocking, 229
External 450 Clocking

Details, 238
External 450 clocking, 74
External 4X Clocking, 68

details, 233
dialog box, 73

external clock warning, 454
External clocking, 24

and merged modules, 70
setting up, 147

External oscilloscope, 58
communication, 58
setup window, 57
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External Signal Selection, 486
External signals, 244
EyeFinder, 407
EyeScan, 432

F
Feedback to Tektronix, 5
feeds, 33
File, 138

format, 465
suffix, 112

Filters dialog box, 40
Filters, 395

applying, 43
copying, 180
creating, 180
dialog box, 40
loading, 42
opening, 181
protocol, 395
renaming, 181

Finding source files, 130
firewall, 4
Flat panel display cleaning, 546
Floppy disk drive cleaning, 547
Force Main Prefill, 277
Format, 299

column, 299
file, 450
listing window, 529
TLA Data Exchange, 292

Formatting, 136
columns, 136
disassembled data, 301
Listing window, 301

Framers, 380
Frames, 380
front panel controls, 5
full screen, 18
Function range symbols, 461
Functional procedure, 453

G
Gaps, 308

time, 308
General care, 545

General purpose data window
shortcuts, 503

Generic Framer Example, 393
Generic framers, 380

limitations, 380
usage, 380

Getting out of a loop in a Source
window, 348

Getting started example, 8
glitch detection, 262
Glitch mode, 26
Glitch, 266

detect (LA), 262
triggering an LA module, 158

Glitches, 183
in a Listing window, 183
LA, 288

Global storage, 216
note on using transitions, 216

Go to (moving to a mark), 120
Go To dialog box, 298
Go To Protocol Dialog Box, 405
Going to a specific column, 184
Going to a Specific GraphWindow

Mark, 430
Going to a specific mark, 213
Going to a Specific Series, 430
GPIB, 58
Graph Window, 99

adding data series, 100
creating, 426
labeling, 140
properties, 140

graticule display, 494
Graticule, 142

selecting the color, 193
showing, 142

Group clocking, 147
Group width information, 294

exporting, 294
Group, 70

clocking table, 70
color, 43
data range triggering, 166
radix, 272

Guidelines for merging
modules, 77

H
Halting histogram analysis, 332
Hardware order, 170
Height, 142
Hex View, 378
High Speed timing, 528
High-Level Language

support, 488
Highlight Channels dialog box, 29
Highlight controls, 301
Highlighting, 29

channels, 29
disassembled data, 301
lines, 301

Histogram window, 508
color selection, 324
data area, 324
font size, 324
Histogram add counts dialog

box, 327
Histogram data source, 325
Histogram scale dialog

box, 327
Histogram window

shortcuts, 508
property page, 324
radix, 324

Histogram, 98
creating a new window from a

data source, 98
creating a window that

contains no data, 97
data page, 98
defining ranges, 330
exporting data, 115
halting analysis, 332
options page, 99
resetting data, 331
selecting data source, 331
sorting data, 330

Hit Frequency Properties, 426
Hit Frequency, 431

turning on and off, 431
HLL support, 488
Horizontal,

scale (time per division), 219
setting up the DSO, 197
settings(DSO), 535
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host name, 15
Hot keys, 507

I
iCapture, 33
iConnect Analog Feeds dialog

box, 33
Identifying modules, 477
IEEE695 file format, 465
If/Then clause, 155

adding to a trigger state, 155
changing an, 155

Import channel setups, 47
Import Stack Dialog Box, 403
import, 44
Incoming inspections, 453
Incorrect data after

acquisition, 452
Individual waveform properties

within an overlay
waveform, 314

Individual waveform
properties, 312

Information Lines, 52
Information, 299

about current data, 299
about data sources, 184
about installed software, 499
about modules, 492
about the Histogram

window, 331
about the mainframe, 492

Input, 535
DSO settings, 535

Installed software informa-
tion, 499

inter-probing, 448
intermodule interaction, 527
Intermodule signals, 496
Internal 2X, 65

clocking details, 219
Internal 4X, 65

clocking details, 222
Internal signals, 162

configuring, 496
triggering an LA module, 162

Internal, 486
2X clocking, 65
4X clocking, 65
clocking, 64
signal selection, 486
signaling, 254

iVerify measurement
properties, 437

iVerify Properties dialog box, 437
Eye coloration, 437

iVerify Properties, 441
About Data tab, 438
Eye Coloration tab, 441
iVerify Window Tab, 439

iVerify Setup dialog box Channel
tab, 445

iVerify Setup dialog box
Clock/Qualifier tab, 446

iVerify window, 432
iVerify, 442

Setup dialog box, 436
Setups dialog box, 434
Statistical Analysis dialog

box, 442
iView external oscilloscope,

setup window, 57

J
jitter, 418
Jumping over "dead" space

between samples, 291

K
Key, 506

shortcut, 505

L
LA Busform, 200
LA channel groups, 80

deleting, 81
LA channel polarity, 82

LA channels, 81
adding, 80
how many can I have?, 1
removing, 81
reusing, 81
selecting for an LA trigger

channel event, 157
LA module,

arming, 204
features, 1
merging, 77

LA Probe Channels/Names
table, 31

LA Setup window, 23
LA versus DSO module

waveforms, 531
LA, 316

acquire control selections, 26
activity indicator, 32
block diagram, 526
channel group name, 29
conceptual model, 525
module memory depth, 27
module setups, 79
physical model, 525
probe channel grouping, 30
probe thresholds, 82
trigger actions table, 274
trigger events, 273
trigger resources, 275
triggers, 244
waveforms, 316

Labeling a graph, 140
Labels, 320

naming, 215
LAN, 10
Language, 488

high-level language (HLL)
support, 488

Length and Value Expres-
sions, 368
PSDL, 368

Lexical Items, 373
PSDL, 373

Limits, 321
Linked cursors, 291
Listing data concepts, 529
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Listing window, 288
adding a data source, 117
adding reference data, 181
changing column

properties, 136
changing properties, 137
creating, 97
properties, 301
showing glitches, 183
showing qualification

gaps, 183
tab, 301
use, 288

Listing-relative cursor
positioning, 347

Listing/Waveform data page, 481
Load AutoDeskew Setup dialog

box, 411
Load iVerify Setup dialog box, 435
Load Symbols Options dialog

box, 465
Load, 482

support package, 449
system options, 482

Loading, 119
a MagniVu data source to

a Listing or Waveform
window, 119

a saved module, 117
a saved system, 116
an LA module with saved

trigger settings, 117
filters, 42
merged modules, 482
part of a saved system, 482
portions of a saved

system, 116
saved data to an active Listing

window, 117
saved data to an active

Waveform window, 209
source code symbol

information, 119
support packages, 77
the timing format file, 450

Locating source files, 130
Lock delta time, 201

Lock Windows dialog box, 291
Lock windows, 291
Locking windows, 210
Logic analyzer, 203

measurements, 203
trigger window, 242

Logic thresholds for a DSO, 543
Logic thresholds, 500
Logic, 82
Loop statements, 355

PSDL, 355
Loop, 348
Lower threshold, 500

M
Magnitude mode, 196
Magnitude waveform, 317

viewing, 20
Magnitude, 321
MagniVu, 274

data source to a Listing or
Waveform window, 119

data, 487
LA trigger action table, 274
signal resolution/signal

duration relationship, 532
storage rate, 278
trigger position, 279

Main window, 477
Mainframe, 206

diagnostics, 207
properties, 492

Maintenance, 545
cleaning the exterior

mainframe, 546
cleaning the flat panel

display, 546
cleaning the floppy disk

drive, 547
general care, 545
preventive, 545
repacking for shipment, 547

Making graticules visible, 194
Making violations visible in a

Waveform window, 192
Mark Opcode dialog box, 299

Mark, 299
next and previous, 337
opcode, 299
selection, 429

Marking cycles, 299
Marks in a data window, 211

adding, 211
Marks in a Protocol window, 378
Marks, 348

properties, 300
tab, 300

max, 179
Measurement Setup, 418
Measurements, 199

count, 171
data, 417
jitter, 174
min/max, 175
multiple, 201
on DSO data, 537
on LA data, 418
time, 175

Measuring, 200
delta time, 201
delta volts, 200
histogram data, 329
time, 201
voltage, 199

Memory depth, 150
for an LA module, 150
LA, 27
most effective use of, 150

Memory, 217
compare, 90
selecting depth, 150
storing DSO data, 217

Menu shortcut keys, 507
Merged Module External

Clocking, 70
Merged modules, 491

loading, 482
note on calibration, 491
properties, 492

Merging LA modules, 79
Meta-characters, 296
Microprocessor and bus support

package basic operation, 449
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Microprocessor support
packages, 77
loading, 77

Microprocessor support, 83
package indicator, 27
specifying clocking, 83
triggering, 449

Microsoft Windows 2000, 4
mictor adaptor, 523
Mictor-on-PCB to Compression

adaptor, 523
min, 175
Miscellaneous PSDL

commands, 370
Modes, 24

acquisition, 264
clocking, 24

Modify, 112
color schemes, 498
file suffixes, 112
location of cursors using the

overview mark bar, 120
search path list, 338
search paths, 113
suffix list, 338

Module specifics properties, 492
module trigger, 244
Module, 253

active, 477
arming using an LA

module, 253
disabling, 477
identifying, 477
merged, 492
properties, 206

Modules, 88
associating with data

windows, 207
calibrating, 88
merging, 77
properties, 492
triggering from an LA, 169

More waveforms, 187

Moving, 182
columns, 182
cursors, 120
marks, 212
to a mark (Go To), 120
to a specific column, 184

Multi-channel, 316
busform LA waveforms, 316
magnitude LA

waveforms, 317
waveforms, 316

Multiple acquisitions, 87
Multiplexed Signals, 37
Multiplexing, 70

N
Name Data Window dialog

box, 481
Name,

waveform, 320
Naming, 215

column and waveform
labels, 215

individual LA channels, 215
the vertical channel signal

(DSO), 197
Negative logic, 82
Network preferences, 12
network properties, 15
network, 12
new graph window, 99
new listing window, 97
new source window, 101
Next Mark and Previous Mark

buttons, 337
Normal mode, 26

O
Object file format, 465
Object selection, 309
offline, 10
Offset, 281

entering a symbol plus an
offset in a LA trigger, 281

OMF166 file format, 465
OMF286 file format, 465
OMF386 file format, 465

OMF51 file format, 465
OMF86 file format, 465
On Run control,

serial analyzer trigger
window, 282

Opcode, 299
Opcodes, 182

adding, 182
Open dialog box (repetitive

properties), 296
Open, 481
Opening, 87

a document after an
acquisition, 87

a document or program after
an acquisition, 87

a saved data window, 209
Operating system, 4
Operators, 351

PSDL, 351
Options, 133

collapse channels, 214
expand channels, 213
powering on and off, 16
setting waveform options, 195

Organizing channel groups, 28
outputs, 33
Overlapping symbols, 465
Overlay waveform, 210

properties, 310
setting the offset, 312

Overview mark bar, 120
OVR Demux data signals, 149

P
P6417 probe and accessories, 514
P6417 to HP/3M type 3592

adapter, 522
P6418 probe and accessories, 515
P6419 probe and accessories, 516
P6434 high-density probe and

accessories, 517
P6471 Pattern generator

probe, 517
P6810 general purpose probe and

accessories, 518
P6860 high-density probe and

accessories, 519
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P6864 high-density 4X probe and
accessories, 520

P6880 differential probe and
accessories, 521

Packet structure definition, 351
PSDL, 351

Packet Structure Description
Language, 349

Packet View, 378
column properties, 384

Partial save, 38
Pattern Generator Module, 544
pattern generator program, 544
Pattern Generator, 141

probe, 517
Run Properties dialog

box, 141
Pattern symbol, 186

file header, 186
files, 460

Performance Analysis, 22
Persistence mode, 431

turning on and off, 431
PG Run Properties dialog box, 141
Placement of system triggers, 246
Placing marks in a data

window, 211
Polarity, 95

changing for an LA
module, 82

logic analyzer, 82
of LA channels, 31

population, 179
Positioning the trigger, 157
Postscript, 121
Power on and off options, 16
Power-On Diagnostics, 490
PowerTrigger, 260

detail, 248
properties, 247
tab overview, 247
tab, 248
troubleshoot, 170

Preferences properties, 494
Preprogrammed LA triggers, 287
Presets tab, 500
Presets, 500
Preventive maintenance, 545

Print dialog, 121
Printing, 115

Printing a Source window, 122
Printing a window, 122

probe demux, 560
probe info tab, 33
probe interface, 544
Probe, 30

accessories, 514
activity, 32
calibration (DSO), 543
channel grouping, 30
demultiplexing, 149
group, 149
P6471 Pattern generator

probe, 517
status (DSO), 543
threshold, 33
thresholds (LA modules), 82

problems, 281
clocking, 451
triggering, 281

programming tips for triggering
an la module, 250

properties, 142
column, 384
graph window, 140
network, 15
protocol display, 383
protocol framing, 386
protocol, 384

Protocol Designer window, 399
Protocol Editor pane, 400
Protocol Filter Setup Dialog

Box, 382
Protocol information pane, 391
Protocol properties, 382
protocol relations, 404
Protocol Search Dialog Box, 387
Protocol Setup window, 396
Protocol stacks, 394

importing, 403

Protocol window, 378
Define Bus dialog box, 390
frames and framers, 380
generic framer example, 393
properties, 383
Select Bus page, 390
Select Stack dialog box, 392

protocol, 403
create new, 389
exporting, 403
importing, 403
saving, 403

PSDL, 371
ASN.1 additions, 364
ASN.1 types, 359
control statements, 354
defining a protocol, 375
length and value

expressions, 368
lexical items, 373
loop statements, 355
miscellaneous commands, 370
operators, 351
overview, 374
packet structure, 351
reserved words, 371
sample program, 355
spz file extensions, 374
syntax, 349
tags, 369
type definitions, 357
types, 365
value definitions, 368

Q
Qualification clock, 148
Qualification gaps, 288

showing in a Listing
window, 183

showing, 301

R
Radix information, 294

exporting, 294
Radix, 142

Radix of column, 299
range recognizers, 273
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Range symbols, 462
Function, 461
Source, 462
Variable, 462

Range, 252
recognition problems, 170
recognition triggering, 166
recognizers and hardware

order, 252
recognizers, 252
symbol file header, 186
symbol files, 460

Ranges properties, 326
Readout radix, 134
Readouts, 189
Rearranging, 182

columns, 182
Reference clock,

serial analyzer, 55
Reference data, 207

adding to a Listing
window, 181

Reference system trigger, 271
Reference, 524

digitizing a signal, 524
DSO module block

diagram, 531
LA block diagram, 526
LA conceptual model, 525
LA physical model, 525
sampling a signal, 524

remote, 10
Removing a Tool from the Tools

Menu, 111
Removing, 214

data from a Listing or
Waveform window, 214

LA channel groups, 81
LA channels, 31
selected DSO waveform

measurements, 199
waveforms from an overlay

waveform, 215
Rename Transition dialog

box, 260
Rename Word dialog box, 262

Renaming, 477
a window, 477
column and waveform

labels, 215
individual LA channels, 215

Repacking for shipment, 547
Repeating acquisitions, 87
Repetitive acquisition data, 124

saving, 124
repetitive acquisition mode, 85
Repetitive mod, 85
Repetitive operations, 296
Repetitive Properties Dialog

Box, 294
Repetitively acquiring data, 87
Replace Protocol Dialog Box, 401
Replace protocol files, 407
Reserved words, 371

PSDL, 371
Resetting, 331

histogram counts, 331
histogram data, 331

Reusing LA channels, 81
Routing a signal from a logic

analyzer output channel, 107
Routing a signal to an oscilloscope

input channel, 107
Rules for merging modules, 77
Running, 207

extended diagnostics, 206
mainframe diagnostics, 207
multiple acquisitions, 87

S
Sample Channel Setup File, 47
sample clock, 70
Sample Suppress dialog box, 305
Sample, 64

clock definition, 64
suppression, 38
waveforms, 318

Sampling, 524
a signal, 524
resolution, 532

Save, 511
color scheme, 499
dialog box, 123
module, 123
system, 123
trigger program, 511

Saved setups, 77
loading to an LA module, 77

Saved, 117
data, 117
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